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Notice
Every effort was made to ensure that the information in this manual was accurate
at the time of release. However, information is subject to change without notice,
and JDS Uniphase reserves the right to provide an addendum to this manual with
information not available at the time that this manual was created.
Copyright
© Copyright 2014 JDS Uniphase Corporation. All rights reserved. JDSU, Network
and Service Enablement, and its logo are trademarks of JDS Uniphase
Corporation (“JDS Uniphase”). All other trademarks and registered trademarks are
the property of their respective owners. No part of this document may be
reproduced or transmitted electronically or otherwise without written permission of
the publisher.
Copyright release
Reproduction and distribution of this document is authorized for Government
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EMC directive compliance
This product was tested and conforms to the EMC Directive, 2004/108/EC and its
amending directives for electromagnetic compatibility. Conformity with this
directive is based upon compliance with the harmonized European standards:
EN61326-1, CISPR11, EN61000-3-2, and EN61000-3-3. A copy of the Declaration
of Conformity is provided upon your request.
Low voltage directive compliance
This product was tested and conforms to the Low Voltage Directive, 2006/95/EC
and its amending directives. Conformity with this directive is based upon
compliance with the harmonized European standard EN61010-1. A copy of the
Declaration of Conformity is provided upon your request.
WEEE and battery directive compliance
JDSU has established processes in compliance with the Waste Electrical and
Electronic Equipment (WEEE) Directive, 2002/96/EC, and the Battery Directive,
2006/66/EC.
This product, and the batteries used to power the product, should not be disposed
of as unsorted municipal waste and should be collected separately and disposed
of according to your national regulations. In the European Union, all equipment
and batteries purchased from JDSU after 2005-08-13 can be returned for disposal
at the end of its useful life. JDSU will ensure that all waste equipment and
batteries returned are reused, recycled, or disposed of in an environmentally
friendly manner, and in compliance with all applicable national and international
waste legislation.
It is the responsibility of the equipment owner to return equipment and batteries to
JDSU for appropriate disposal. If the equipment or battery was imported by a
reseller whose name or logo is marked on the equipment or battery, then the
owner should return the equipment or battery directly to the reseller.
Instructions for returning waste equipment and batteries to JDSU can be found in
the Environmental section of JDSU’s web site at www.jdsu.com. If you have
questions concerning disposal of your equipment or batteries, contact JDSU’s
WEEE Program Management team at WEEE.EMEA@jdsu.com.

Contents
About This Manual ................................................................................................................................ 17
Purpose and scope ......................................................................................................................................................... 18
Assumptions.................................................................................................................................................................... 18
Safety and compliance information .................................................................................................................................. 18
Safety consideration ............................................................................................................................................... 18
Battery .................................................................................................................................................................... 18
Electrostatic discharge precautions (ESD) .............................................................................................................. 19
Using 12 V DC automotive adapter ......................................................................................................................... 20
Conventions .................................................................................................................................................................... 20
Technical assistance ....................................................................................................................................................... 21

JD780A Series Overview ...................................................................................................................... 22
About the JD780A series ................................................................................................................................................. 23
Features and capabilities ................................................................................................................................................. 23
Options............................................................................................................................................................................ 24
Specifications .................................................................................................................................................................. 24
AC power ............................................................................................................................................................... 24
Physical specifications ............................................................................................................................................ 24

Getting Started ..................................................................................................................................... 25
Unpacking the JD780A series.......................................................................................................................................... 26
Exploring the JD780A series............................................................................................................................................ 26
Front panel ............................................................................................................................................................. 27
Top panel ................................................................................................................................................................ 28
Installing battery pack ...................................................................................................................................................... 30
Starting up the JD780A series ......................................................................................................................................... 31
Managing files ................................................................................................................................................................. 31
Using save.............................................................................................................................................................. 31
Using load .............................................................................................................................................................. 34
Using file manager.................................................................................................................................................. 34
Configuring system.......................................................................................................................................................... 35
Setting frequency reference .................................................................................................................................... 35
Setting date and time .............................................................................................................................................. 35
Setting language..................................................................................................................................................... 36
Setting power on..................................................................................................................................................... 36
Changing display mode .......................................................................................................................................... 36
Setting sleep time ................................................................................................................................................... 37
Adjusting LCD brightness ....................................................................................................................................... 37
Adjusting volume .................................................................................................................................................... 37
Upgrading firmware ......................................................................................................................................................... 37
Checking installed firmware version ........................................................................................................................ 38
Installing new firmware ........................................................................................................................................... 38
Managing licenses........................................................................................................................................................... 39
Checking options .................................................................................................................................................... 39
Installing options ..................................................................................................................................................... 40
Loading temporary license ...................................................................................................................................... 40
Viewing OSS license .............................................................................................................................................. 40
Performing service diagnostic.......................................................................................................................................... 41
Viewing system log ................................................................................................................................................. 41
Running self-test..................................................................................................................................................... 41
Performing factory reset ......................................................................................................................................... 41
Re-aligning touch screen ........................................................................................................................................ 42
Using system administration ............................................................................................................................................ 42
Logging in ............................................................................................................................................................... 42
Changing password ................................................................................................................................................ 42
Locking limit key ..................................................................................................................................................... 42
Modifying online help .............................................................................................................................................. 43

Running IP test ................................................................................................................................................................ 43
Activating StrataSync ...................................................................................................................................................... 44
Establishing a connection to StrataSync ................................................................................................................. 44
StrataSync status indicators ................................................................................................................................... 45
Setting communication .................................................................................................................................................... 45
Configuring Ethernet ............................................................................................................................................... 45
Setting for JDViewer and JDRemote....................................................................................................................... 46
Setting USBTMC mode .......................................................................................................................................... 46
Setting SCPI mode ................................................................................................................................................. 47
Configuring LMF setting.......................................................................................................................................... 47
Enabling Bluetooth connection ............................................................................................................................... 47

Analyzing Measurement Results .......................................................................................................... 48
Using marker ................................................................................................................................................................... 49
Using peak search........................................................................................................................................................... 50

Using Spectrum Analyzer ..................................................................................................................... 51
Introduction ..................................................................................................................................................................... 52
Display overview ............................................................................................................................................................. 52
Connecting a cable.......................................................................................................................................................... 53
Selecting measurement mode ......................................................................................................................................... 54
Configuring test parameters ............................................................................................................................................ 54
Setting frequency.................................................................................................................................................... 54
Setting amplitude .................................................................................................................................................... 56
Setting bandwidth ................................................................................................................................................... 58
Setting average ...................................................................................................................................................... 59
Setting sweep ......................................................................................................................................................... 59
Using RF source ..................................................................................................................................................... 61
Conducting spectrum measurements .............................................................................................................................. 61
Setting trace ........................................................................................................................................................... 62
Setting limit ............................................................................................................................................................. 63
Conducting RF measurements ........................................................................................................................................ 64
Channel power ....................................................................................................................................................... 64
Occupied bandwidth ............................................................................................................................................... 66
Spectrum emission mask (SEM) ............................................................................................................................. 67
Adjacent channel power (ACP) ............................................................................................................................... 69
Multi-ACP ............................................................................................................................................................... 71
Spurious emissions ................................................................................................................................................ 73
AM/FM audio demodulation .................................................................................................................................... 75
Field strength meter................................................................................................................................................ 77
Route map .............................................................................................................................................................. 79
Dual spectrum ........................................................................................................................................................ 81
PIM detection (single and multiple carriers) ............................................................................................................ 82

Using Interference Analyzer ................................................................................................................. 85
Introduction ..................................................................................................................................................................... 86
Display overview ............................................................................................................................................................. 86
Connecting a cable.......................................................................................................................................................... 87
Selecting measurement mode ......................................................................................................................................... 88
Configuring test parameters ............................................................................................................................................ 88
Setting frequency.................................................................................................................................................... 88
Setting amplitude .................................................................................................................................................... 89
Setting bandwidth ................................................................................................................................................... 91
Setting average ...................................................................................................................................................... 92
Setting sweep ......................................................................................................................................................... 92
Conducting spectrum measurements .............................................................................................................................. 94
Sound indicator....................................................................................................................................................... 94
AM/FM audio demodulation .................................................................................................................................... 95
Interference ID ........................................................................................................................................................ 95
Conducting interference measurements .......................................................................................................................... 96
Spectrogram ........................................................................................................................................................... 96
Dual spectrogram ................................................................................................................................................... 97
RSSI ....................................................................................................................................................................... 98
Interference finder ................................................................................................................................................ 100
Spectrum Replayer ............................................................................................................................................... 102

Setting limit for interference analyzer ............................................................................................................................. 103

Using GSM/GPRS/EDGE Signal Analyzer ......................................................................................... 105
Introduction ................................................................................................................................................................... 106
Display overview ........................................................................................................................................................... 106
Connecting a cable........................................................................................................................................................ 107
Direct connection .................................................................................................................................................. 107
Indirect connection ............................................................................................................................................... 107
Over the air (OTA) ................................................................................................................................................ 108
Selecting measurement mode ....................................................................................................................................... 109
Configuring test parameters .......................................................................................................................................... 109
Setting frequency.................................................................................................................................................. 109
Setting amplitude .................................................................................................................................................. 110
Setting average .................................................................................................................................................... 112
Setting sweep mode ............................................................................................................................................. 112
Setting trigger source............................................................................................................................................ 112
Conducting spectrum measurements ............................................................................................................................ 113
Setting measure setup .......................................................................................................................................... 113
Setting trace ......................................................................................................................................................... 114
Conducting RF measurements ...................................................................................................................................... 114
Channel power ..................................................................................................................................................... 114
Occupied bandwidth ............................................................................................................................................. 115
Spectrum emission mask (SEM) ........................................................................................................................... 116
Spurious emissions .............................................................................................................................................. 117
Setting limit for RF tests........................................................................................................................................ 119
Conducting power vs. time measurements .................................................................................................................... 120
Power vs. time (slot) ............................................................................................................................................. 120
Power vs. time (frame).......................................................................................................................................... 122
Conducting constellation measurements ....................................................................................................................... 123
Setting measure setup .......................................................................................................................................... 123
Setting limit for constellation ................................................................................................................................. 124
Measurement example ......................................................................................................................................... 124
Performing auto measurements .................................................................................................................................... 125
Setting limit for auto measure ............................................................................................................................... 125
Setting measure setup .......................................................................................................................................... 125
Setting display ...................................................................................................................................................... 126
Conducting GSM OTA measurements ........................................................................................................................... 127
Channel scanner .................................................................................................................................................. 127
Frequency scanner ............................................................................................................................................... 128
Multipath profile .................................................................................................................................................... 130
Modulation analyzer ............................................................................................................................................. 131

Using WCDMA/HSPA+ Signal Analyzer ............................................................................................. 133
Introduction ................................................................................................................................................................... 134
Display overview ........................................................................................................................................................... 134
Connecting a cable........................................................................................................................................................ 135
Direct connection .................................................................................................................................................. 135
Indirect connection ............................................................................................................................................... 135
Over the air (OTA) ................................................................................................................................................ 136
Selecting measurement mode ....................................................................................................................................... 137
Configuring test parameters .......................................................................................................................................... 137
Setting frequency.................................................................................................................................................. 137
Setting amplitude .................................................................................................................................................. 138
Setting average .................................................................................................................................................... 140
Setting sweep mode ............................................................................................................................................. 140
Setting trigger source............................................................................................................................................ 140
Setting external clock............................................................................................................................................ 141
Conducting spectrum measurements ............................................................................................................................ 142
Setting trace ......................................................................................................................................................... 142
Conducting RF measurements ...................................................................................................................................... 143
Channel power ..................................................................................................................................................... 143
Occupied bandwidth ............................................................................................................................................. 144
Spectrum emission mask (SEM) ........................................................................................................................... 145
ACLR.................................................................................................................................................................... 146
Multi-ACLR ........................................................................................................................................................... 147

Spurious emissions .............................................................................................................................................. 148
Setting limit for RF tests........................................................................................................................................ 150
Conducting modulation measurements.......................................................................................................................... 151
Constellation......................................................................................................................................................... 151
Code domain power ............................................................................................................................................. 152
Relative code domain power ................................................................................................................................. 155
Codogram............................................................................................................................................................. 157
RCSI..................................................................................................................................................................... 159
CDP Table ............................................................................................................................................................ 161
Setting limit for modulation tests ........................................................................................................................... 162
Performing auto measurements .................................................................................................................................... 163
Setting limit for auto measure ............................................................................................................................... 163
Setting measure setup .......................................................................................................................................... 164
Setting display ...................................................................................................................................................... 164
Performing power statistics CCDF measurement .......................................................................................................... 165
Setting measure setup .......................................................................................................................................... 165
Measurement example ......................................................................................................................................... 166
Conducting WCDMA/HSPA+ OTA measurements ......................................................................................................... 166
Channel scanner .................................................................................................................................................. 166
Scramble scanner................................................................................................................................................. 168
Multipath profile .................................................................................................................................................... 168
Code domain power ............................................................................................................................................. 169
Route map ............................................................................................................................................................ 171

Using LTE - FDD Signal Analyzer....................................................................................................... 175
Introduction ................................................................................................................................................................... 176
Display overview ........................................................................................................................................................... 177
Connecting a cable........................................................................................................................................................ 177
Direct connection .................................................................................................................................................. 177
Indirect connection ............................................................................................................................................... 178
Over the air (OTA) ................................................................................................................................................ 178
Selecting measurement mode ....................................................................................................................................... 179
Configuring test parameters .......................................................................................................................................... 180
Setting frequency.................................................................................................................................................. 180
Setting amplitude .................................................................................................................................................. 180
Setting average .................................................................................................................................................... 182
Setting sweep mode ............................................................................................................................................. 183
Setting trigger source............................................................................................................................................ 183
Setting external clock............................................................................................................................................ 183
Conducting spectrum measurements ............................................................................................................................ 184
Setting measure setup .......................................................................................................................................... 184
Setting trace ......................................................................................................................................................... 185
Conducting RF measurements ...................................................................................................................................... 186
Channel power ..................................................................................................................................................... 186
Occupied bandwidth ............................................................................................................................................. 187
Spectrum emission mask (SEM) ........................................................................................................................... 187
ACLR.................................................................................................................................................................... 189
Multi-ACLR ........................................................................................................................................................... 189
Spurious emissions .............................................................................................................................................. 191
Setting limit for RF tests........................................................................................................................................ 193
Conducting power vs. time (frame) measurements ........................................................................................................ 194
Setting measure setup .......................................................................................................................................... 194
Measurement example ......................................................................................................................................... 195
Conducting modulation measurements.......................................................................................................................... 195
Constellation......................................................................................................................................................... 195
Data channel ........................................................................................................................................................ 197
Control channel .................................................................................................................................................... 200
Subframe.............................................................................................................................................................. 203
Frame ................................................................................................................................................................... 206
Time alignment error ............................................................................................................................................. 209
Data allocation map .............................................................................................................................................. 210
Setting limit for modulation tests ........................................................................................................................... 213
Performing auto measurements .................................................................................................................................... 214
Conformance test ................................................................................................................................................. 214
Maintenance test .................................................................................................................................................. 216
Signal performance test ........................................................................................................................................ 218

DAS test ............................................................................................................................................................... 219
Performing power statistics CCDF measurements......................................................................................................... 221
Setting measure setup .......................................................................................................................................... 221
Measurement example ......................................................................................................................................... 222
Performing carrier aggregation measurements .............................................................................................................. 222
Setting measure setup .......................................................................................................................................... 222
Setting display ...................................................................................................................................................... 223
Measurement example ......................................................................................................................................... 224
Using marker ........................................................................................................................................................ 224
Conducting LTE - FDD OTA measurements .................................................................................................................. 225
Channel scanner .................................................................................................................................................. 225
ID scanner ............................................................................................................................................................ 227
Multipath profile .................................................................................................................................................... 228
Control channel .................................................................................................................................................... 229
Datagram ............................................................................................................................................................. 231
Route map ............................................................................................................................................................ 233

Using LTE - TDD Signal Analyzer ....................................................................................................... 238
Introduction ................................................................................................................................................................... 239
Display overview ........................................................................................................................................................... 240
Connecting a cable........................................................................................................................................................ 240
Direct connection .................................................................................................................................................. 240
Indirect connection ............................................................................................................................................... 241
Over the air (OTA) ................................................................................................................................................ 241
Selecting measurement mode ....................................................................................................................................... 242
Configuring test parameters .......................................................................................................................................... 243
Setting frequency.................................................................................................................................................. 243
Setting amplitude .................................................................................................................................................. 243
Setting average .................................................................................................................................................... 245
Setting sweep mode ............................................................................................................................................. 246
Setting trigger source............................................................................................................................................ 246
Setting external clock............................................................................................................................................ 246
Conducting spectrum measurements ............................................................................................................................ 247
Setting measure setup .......................................................................................................................................... 247
Setting trace ......................................................................................................................................................... 248
Conducting RF measurements ...................................................................................................................................... 249
Channel power ..................................................................................................................................................... 249
Occupied bandwidth ............................................................................................................................................. 250
Spectrum emission mask (SEM) ........................................................................................................................... 251
ACLR.................................................................................................................................................................... 252
Multi-ACLR ........................................................................................................................................................... 253
Spurious emissions .............................................................................................................................................. 255
Setting limit for RF tests........................................................................................................................................ 257
Conducting power vs. time measurements .................................................................................................................... 258
Power vs. time (slot) ............................................................................................................................................. 258
Power vs. time (frame).......................................................................................................................................... 260
Conducting modulation measurements.......................................................................................................................... 261
Constellation......................................................................................................................................................... 261
Data channel ........................................................................................................................................................ 264
Control channel .................................................................................................................................................... 267
Subframe.............................................................................................................................................................. 270
Time alignment error............................................................................................................................................. 273
Data allocation map .............................................................................................................................................. 275
Setting limit for modulation tests ........................................................................................................................... 277
Performing auto measurements .................................................................................................................................... 279
Conformance test ................................................................................................................................................. 279
Maintenance test .................................................................................................................................................. 280
Signal performance test ........................................................................................................................................ 283
DAS test ............................................................................................................................................................... 284
Performing power statistics CCDF measurements......................................................................................................... 286
Setting measure setup .......................................................................................................................................... 286
Measurement example ......................................................................................................................................... 287
Performing carrier aggregation measurements .............................................................................................................. 287
Setting measure setup .......................................................................................................................................... 287
Setting display ...................................................................................................................................................... 288
Measurement example ......................................................................................................................................... 289

Using marker ........................................................................................................................................................ 289
Conducting LTE - TDD OTA measurements................................................................................................................... 290
Channel scanner .................................................................................................................................................. 290
ID scanner ............................................................................................................................................................ 292
Multipath profile .................................................................................................................................................... 293
Control channel .................................................................................................................................................... 294
Datagram ............................................................................................................................................................. 296
Route map ............................................................................................................................................................ 298

Using CDMA Signal Analyzer ............................................................................................................. 303
Introduction ................................................................................................................................................................... 304
Display overview ........................................................................................................................................................... 305
Connecting a cable........................................................................................................................................................ 305
Direct connection .................................................................................................................................................. 305
Indirect connection ............................................................................................................................................... 306
Over the air (OTA) ................................................................................................................................................ 306
Selecting measurement mode ....................................................................................................................................... 307
Configuring test parameters .......................................................................................................................................... 307
Setting frequency.................................................................................................................................................. 307
Setting amplitude .................................................................................................................................................. 308
Setting average .................................................................................................................................................... 310
Setting sweep mode ............................................................................................................................................. 310
Setting trigger source............................................................................................................................................ 311
Setting external clock............................................................................................................................................ 311
Conducting spectrum measurements ............................................................................................................................ 312
Setting trace ......................................................................................................................................................... 313
Conducting RF measurements ...................................................................................................................................... 314
Channel power ..................................................................................................................................................... 314
Occupied bandwidth ............................................................................................................................................. 315
Spectrum emission mask (SEM) ........................................................................................................................... 315
ACPR ................................................................................................................................................................... 316
Multi-ACPR........................................................................................................................................................... 317
Spurious emissions .............................................................................................................................................. 318
Setting limit for RF tests........................................................................................................................................ 320
Conducting modulation measurements.......................................................................................................................... 321
Constellation......................................................................................................................................................... 321
Code domain power ............................................................................................................................................. 322
Codogram............................................................................................................................................................. 324
RCSI..................................................................................................................................................................... 325
CDP Table ............................................................................................................................................................ 327
Setting limit for modulation tests ........................................................................................................................... 328
Performing auto measurements .................................................................................................................................... 329
Setting limit for auto measure ............................................................................................................................... 329
Setting measure setup .......................................................................................................................................... 330
Setting display ...................................................................................................................................................... 330
Performing power statistics CCDF measurements......................................................................................................... 331
Setting measure setup .......................................................................................................................................... 331
Measurement example ......................................................................................................................................... 332
Conducting CDMA OTA measurements ......................................................................................................................... 332
Channel scanner .................................................................................................................................................. 332
PN scanner........................................................................................................................................................... 334
Multipath profile .................................................................................................................................................... 335
Code domain power ............................................................................................................................................. 336
Route map ............................................................................................................................................................ 338

Using EV-DO Signal Analyzer ............................................................................................................ 342
Introduction ................................................................................................................................................................... 343
Display overview ........................................................................................................................................................... 343
Connecting a cable........................................................................................................................................................ 344
Direct connection .................................................................................................................................................. 344
Indirect connection ............................................................................................................................................... 344
Over the air (OTA) ................................................................................................................................................ 345
Selecting measurement mode ....................................................................................................................................... 346
Configuring test parameters .......................................................................................................................................... 346
Setting frequency.................................................................................................................................................. 346

Setting amplitude .................................................................................................................................................. 347
Setting average .................................................................................................................................................... 349
Setting sweep mode ............................................................................................................................................. 349
Setting trigger source............................................................................................................................................ 350
Setting external clock............................................................................................................................................ 350
Conducting spectrum measurements ............................................................................................................................ 351
Setting trace ......................................................................................................................................................... 351
Conducting RF measurements ...................................................................................................................................... 352
Channel power ..................................................................................................................................................... 352
Occupied bandwidth ............................................................................................................................................. 353
Spectrum emission mask (SEM) ........................................................................................................................... 354
ACPR ................................................................................................................................................................... 354
Multi-ACPR........................................................................................................................................................... 355
Spurious emissions .............................................................................................................................................. 356
Setting limit for RF tests........................................................................................................................................ 358
Conducting power vs. time measurements .................................................................................................................... 359
Power vs. time (idle slot) ....................................................................................................................................... 359
Power vs. time (active slot) ................................................................................................................................... 359
Setting limit for power vs. time tests ...................................................................................................................... 360
Conducting modulation measurements.......................................................................................................................... 361
Constellation......................................................................................................................................................... 361
Code domain power ............................................................................................................................................. 364
MAC Codogram .................................................................................................................................................... 366
RCSI..................................................................................................................................................................... 368
MAC CDP Table ................................................................................................................................................... 369
Setting limit for modulation tests ........................................................................................................................... 370
Performing auto measurements .................................................................................................................................... 371
Setting limit for auto measure ............................................................................................................................... 371
Setting measure setup .......................................................................................................................................... 371
Setting display ...................................................................................................................................................... 372
Performing power statistics CCDF measurements......................................................................................................... 373
Setting measure setup .......................................................................................................................................... 373
Measurement example ......................................................................................................................................... 373
Conducting EV-DO OTA measurements ........................................................................................................................ 374
Channel scanner .................................................................................................................................................. 374
PN scanner........................................................................................................................................................... 376
Multipath profile .................................................................................................................................................... 377
Code domain power ............................................................................................................................................. 378
Route map ............................................................................................................................................................ 380

Using TD-SCDMA Signal Analyzer ..................................................................................................... 383
Introduction ................................................................................................................................................................... 384
Display overview ........................................................................................................................................................... 385
Connecting a cable........................................................................................................................................................ 385
Direct connection .................................................................................................................................................. 385
Indirect connection ............................................................................................................................................... 386
Over the air (OTA) ................................................................................................................................................ 386
Selecting measurement mode ....................................................................................................................................... 387
Configuring test parameters .......................................................................................................................................... 387
Setting frequency.................................................................................................................................................. 387
Setting amplitude .................................................................................................................................................. 388
Setting average .................................................................................................................................................... 390
Setting sweep mode ............................................................................................................................................. 391
Setting trigger source............................................................................................................................................ 391
Setting external clock............................................................................................................................................ 391
Conducting spectrum measurements ............................................................................................................................ 392
Setting measure setup .......................................................................................................................................... 392
Setting trace ......................................................................................................................................................... 393
Conducting RF measurements ...................................................................................................................................... 394
Channel power ..................................................................................................................................................... 394
Occupied bandwidth ............................................................................................................................................. 395
Spectrum emission mask (SEM) ........................................................................................................................... 396
ACLR.................................................................................................................................................................... 397
Multi-ACLR ........................................................................................................................................................... 398
Spurious emissions .............................................................................................................................................. 399
Setting limit for RF tests........................................................................................................................................ 401

Conducting power vs. time measurements .................................................................................................................... 402
Power vs. time (slot) ............................................................................................................................................. 402
Power vs. time (frame).......................................................................................................................................... 403
Power vs. time (mask) .......................................................................................................................................... 405
Timogram ............................................................................................................................................................. 406
Setting limit for power vs. time tests ...................................................................................................................... 408
Conducting modulation measurements.......................................................................................................................... 408
Constellation......................................................................................................................................................... 408
Midamble power ................................................................................................................................................... 410
Code power .......................................................................................................................................................... 411
Code error ............................................................................................................................................................ 413
Setting limit for modulation tests ........................................................................................................................... 414
Performing auto measurements .................................................................................................................................... 414
Conducting TD-SCDMA OTA measurements ................................................................................................................. 416
Sync-DL ID scanner.............................................................................................................................................. 416
Sync-DL ID vs. Tau ............................................................................................................................................... 417
Sync-DL ID multipath ............................................................................................................................................ 418
Sync-DL ID analyzer ............................................................................................................................................. 419
Route map ............................................................................................................................................................ 420

Using Mobile WiMAX Signal Analyzer ................................................................................................ 423
Introduction ................................................................................................................................................................... 424
Display overview ........................................................................................................................................................... 424
Connecting a cable........................................................................................................................................................ 425
Direct connection .................................................................................................................................................. 425
Indirect connection ............................................................................................................................................... 425
Over the air (OTA) ................................................................................................................................................ 426
Selecting measurement mode ....................................................................................................................................... 427
Configuring test parameters .......................................................................................................................................... 427
Setting frequency.................................................................................................................................................. 427
Setting amplitude .................................................................................................................................................. 428
Setting average .................................................................................................................................................... 430
Setting sweep mode ............................................................................................................................................. 430
Setting trigger source............................................................................................................................................ 431
Setting external clock............................................................................................................................................ 431
Conducting spectrum measurements ............................................................................................................................ 432
Setting measure setup .......................................................................................................................................... 432
Setting trace ......................................................................................................................................................... 433
Conducting RF measurements ...................................................................................................................................... 434
Channel power ..................................................................................................................................................... 434
Occupied bandwidth ............................................................................................................................................. 435
Spectrum emission mask (SEM) ........................................................................................................................... 437
Spurious emissions .............................................................................................................................................. 438
Setting limit for RF tests........................................................................................................................................ 440
Conducting power vs. time (frame) measurements ........................................................................................................ 441
Setting measure setup .......................................................................................................................................... 441
Setting limit for power vs. time tests ...................................................................................................................... 442
Measurement example ......................................................................................................................................... 442
Conducting modulation measurements.......................................................................................................................... 443
Constellation......................................................................................................................................................... 443
Spectral flatness ................................................................................................................................................... 444
EVM vs. subcarrier ............................................................................................................................................... 446
EVM vs. symbol .................................................................................................................................................... 448
Setting limit for modulation tests ........................................................................................................................... 450
Performing auto measurements .................................................................................................................................... 451
Performing power statistics CCDF measurements......................................................................................................... 452
Setting measure setup .......................................................................................................................................... 453
Measurement example ......................................................................................................................................... 453
Conducting Mobile WiMAX OTA measurements ............................................................................................................ 453
Preamble scanner ................................................................................................................................................ 453
Multipath profile .................................................................................................................................................... 455
Preamble power trend .......................................................................................................................................... 456
Route map ............................................................................................................................................................ 458

Using Cable and Antenna Analyzer .................................................................................................... 461

Introduction ................................................................................................................................................................... 462
Display overview ........................................................................................................................................................... 462
Selecting measurement mode ....................................................................................................................................... 463
Configuring test parameters .......................................................................................................................................... 463
Setting frequency.................................................................................................................................................. 463
Setting distance .................................................................................................................................................... 464
Adjusting scale ..................................................................................................................................................... 465
Setting sweep mode ............................................................................................................................................. 465
Performing calibration.................................................................................................................................................... 465
1-port calibration ................................................................................................................................................... 466
2-port calibration ................................................................................................................................................... 467
Calibration status indicators .................................................................................................................................. 468
Connecting a cable........................................................................................................................................................ 469
Connecting a cable for reflection, DTF, 1-port phase, and Smith Chart measurements ......................................... 469
Connecting a cable for cable loss (1 port) measurements ..................................................................................... 470
Connecting a cable for 2-port vector measurements ............................................................................................. 470
Connecting a cable for 2-port scalar measurements ............................................................................................. 471
Performing reflection measurements ............................................................................................................................. 471
Making a measurement ........................................................................................................................................ 472
Measurement example ......................................................................................................................................... 473
Performing DTF measurements .................................................................................................................................... 473
Making a measurement ........................................................................................................................................ 473
Measurement example ......................................................................................................................................... 475
Performing reflection-DTF measurements ..................................................................................................................... 476
Making a measurement ........................................................................................................................................ 476
Measurement example ......................................................................................................................................... 476
Performing cable loss (1 port) measurements ............................................................................................................... 477
Making a measurement ........................................................................................................................................ 477
Measurement example ......................................................................................................................................... 478
Performing 1-port phase measurements........................................................................................................................ 479
Making a measurement ........................................................................................................................................ 479
Measurement example ......................................................................................................................................... 480
Performing Smith chart measurements.......................................................................................................................... 480
Making a measurement ........................................................................................................................................ 481
Performing 2-port vector measurements........................................................................................................................ 481
Making a measurement ........................................................................................................................................ 481
Measurement example ......................................................................................................................................... 482
Performing 2-port scalar measurements ........................................................................................................................ 483
Making a measurement ........................................................................................................................................ 483
Measurement example ......................................................................................................................................... 483
Analyzing measurements .............................................................................................................................................. 484
Setting trace and display ...................................................................................................................................... 484
Setting zoom zones .............................................................................................................................................. 484
Setting alternate sweep ........................................................................................................................................ 485
Setting limit for cable and antenna analyzer .......................................................................................................... 486

Using E1 Analyzer .............................................................................................................................. 487
Introduction ................................................................................................................................................................... 488
Display overview ........................................................................................................................................................... 488
Connecting a cable........................................................................................................................................................ 489
Out-of-service testing............................................................................................................................................ 489
In-service monitoring ............................................................................................................................................ 489
Monitoring transmission................................................................................................................................................. 490
Making a test ........................................................................................................................................................ 490
Measurement example ......................................................................................................................................... 491
Performing BERT testing ............................................................................................................................................... 491
Making a test ........................................................................................................................................................ 491
Measurement example ......................................................................................................................................... 493

Using T1 Analyzer .............................................................................................................................. 494
Introduction ................................................................................................................................................................... 495
Display overview ........................................................................................................................................................... 495
Connecting a cable........................................................................................................................................................ 496
Out-of-service testing............................................................................................................................................ 496
In-service monitoring ............................................................................................................................................ 496

Monitoring transmission................................................................................................................................................. 497
Making a test ........................................................................................................................................................ 497
Measurement example ......................................................................................................................................... 498
Performing BERT testing ............................................................................................................................................... 498
Making a test ........................................................................................................................................................ 498
Measurement example ......................................................................................................................................... 500
Performing RX signal testing ......................................................................................................................................... 500
Making a test ........................................................................................................................................................ 500
Measurement example ......................................................................................................................................... 501
Performing loop testing.................................................................................................................................................. 502
Making a test ........................................................................................................................................................ 502
Measurement example ......................................................................................................................................... 504

Using Channel Scanner ...................................................................................................................... 505
Introduction ................................................................................................................................................................... 506
Display overview ........................................................................................................................................................... 506
Connecting a cable........................................................................................................................................................ 506
Direct connection .................................................................................................................................................. 506
Indirect connection ............................................................................................................................................... 507
Over the air (OTA) ................................................................................................................................................ 507
Selecting measurement mode ....................................................................................................................................... 508
Configuring test parameters .......................................................................................................................................... 508
Setting frequency.................................................................................................................................................. 508
Setting amplitude .................................................................................................................................................. 508
Setting average .................................................................................................................................................... 510
Setting sweep mode ............................................................................................................................................. 510
Making channel scanner measurements ....................................................................................................................... 511
Setting channel ..................................................................................................................................................... 511
Measurement example ......................................................................................................................................... 511
Making frequency scanner measurements .................................................................................................................... 512
Setting frequency.................................................................................................................................................. 512
Measurement example ......................................................................................................................................... 513
Making custom scanner measurements ........................................................................................................................ 513
Setting channel/frequency .................................................................................................................................... 513
Measurement example ......................................................................................................................................... 515
Analyzing measurements .............................................................................................................................................. 515
Setting limit for channel scanner ........................................................................................................................... 515

Using Power Meter ............................................................................................................................. 518
Introduction ................................................................................................................................................................... 519
Display overview ........................................................................................................................................................... 519
Performing internal RF power measurements ................................................................................................................ 519
Connecting a cable ............................................................................................................................................... 520
Selecting measurement mode .............................................................................................................................. 521
Setting frequency.................................................................................................................................................. 521
Setting amplitude .................................................................................................................................................. 522
Setting sweep mode ............................................................................................................................................. 523
Making a measurement ........................................................................................................................................ 523
Measurement example ......................................................................................................................................... 524
Performing external RF power measurements ............................................................................................................... 524
Connecting a cable ............................................................................................................................................... 524
Selecting measurement mode .............................................................................................................................. 525
Setting frequency.................................................................................................................................................. 526
Setting amplitude .................................................................................................................................................. 526
Making a measurement ........................................................................................................................................ 526
Measurement example ......................................................................................................................................... 527
Performing optical power measurements ....................................................................................................................... 527
Connecting a cable ............................................................................................................................................... 527
Selecting measurement mode .............................................................................................................................. 528
Setting amplitude .................................................................................................................................................. 528
Making a measurement ........................................................................................................................................ 529
Measurement example ......................................................................................................................................... 529
Setting limit for power meter .......................................................................................................................................... 530

Performing Fiber Inspection ............................................................................................................... 531

Introduction ................................................................................................................................................................... 532
Display overview ........................................................................................................................................................... 532
Connecting a fiber microscope ...................................................................................................................................... 532
Selecting measurement mode ....................................................................................................................................... 533
Configuring test parameters .......................................................................................................................................... 533
Selecting profile and tip ........................................................................................................................................ 533
Setting preferences .............................................................................................................................................. 533
Performing fiber inspection ............................................................................................................................................ 534
Capturing fiber image ........................................................................................................................................... 534
Measurement example ......................................................................................................................................... 535
Testing a fiber ....................................................................................................................................................... 535
Measurement example ......................................................................................................................................... 536

Appendix ............................................................................................................................................. 537
Appendix A – Product general information ..................................................................................................................... 538
Appendix B – Cable list ................................................................................................................................................. 540
Appendix C – Band, frequency & channel standard ....................................................................................................... 541
Appendix D – VSWR-Return loss conversion table........................................................................................................ 544
Appendix E – Cyclic prefix table .................................................................................................................................... 545
Appendix F – Motorola CDMA/EV-DO LMF ................................................................................................................... 546
Using JD780A series LMF interface ...................................................................................................................... 546
Setting up for a LMF test ...................................................................................................................................... 546
Performing a LMF test .......................................................................................................................................... 547
Appendix G – Bluetooth connection ............................................................................................................................... 548
Installing and Setting up Bluetooth software ......................................................................................................... 548
Making Bluetooth connection ................................................................................................................................ 548
Setting up communication in application ............................................................................................................... 549
Turning Bluetooth mode on/off manually ............................................................................................................... 550
Appendix H – Device driver installation.......................................................................................................................... 551
Appendix I – Ordering information ................................................................................................................................. 552
JD785A Base Station Analyzer ............................................................................................................................. 552
JD786A RF Analyzer............................................................................................................................................. 553
JD788A Signal Analyzer ....................................................................................................................................... 554
JD780A Series Common Options ......................................................................................................................... 555
Appendix J – RoHS information ..................................................................................................................................... 557
Appendix K – On-screen keyboard ................................................................................................................................ 558
Adding or deleting letters ...................................................................................................................................... 558
Editing or adding a custom keyword ..................................................................................................................... 558
Appending a keyword ........................................................................................................................................... 559

1
About This Manual
Topics discussed in this chapter include the following:


Purpose and scope ....................................................................................................................18



Assumptions ..............................................................................................................................18



Safety and compliance information ...........................................................................................18



Conventions ...............................................................................................................................20



Technical assistance ..................................................................................................................21

JD780A Series Analyzers

Purpose and scope
The purpose of this manual is to help you successfully operate the JD780A series and use its features
and capabilities. This manual includes instructions that describe how to operate, set up, configure, and
use the JD780A series, consisting of JD785A Base Station Analyzer, JD786A RF Analyzer, and
JD788A Signal Analyzer.

Assumptions
This manual is intended for novice, intermediate, and experienced users who want to use the JD780A
series effectively and efficiently. We are assuming that you have basic operation experience and are
familiar with basic mobile communication concepts and terminology.

Safety and compliance information
Safety and compliance information for the instrument are provided upon your request.

Safety consideration
It is mandatory to permanently connect this product to the protective earth.
When powering this instrument externally, always use an AC power cable that includes an earth
(safety) ground connection, which is shipped with your instrument.
WARNING
Do not attempt to service this product yourself, as opening or removing covers may
expose you to dangerous voltage and other hazards. Refer all servicing to qualified JDSU
service personnel.
CAUTION
This equipment contains parts and assemblies sensitive to electrostatic discharge (ESD).
Use ESD precautionary procedures when touching, removing, or inserting ESD sensitive
parts and assemblies, or damage to components could result.
An electrostatic-sensitive device can only withstand voltage spikes of 10 to 100 volts. Any
discharge greater than this can damage or effectively destroy such a device while going
unnoticed by a technician. Common plastics (synthetic insulating materials), clothing, and
paper or cardboard are the most common source of static charges.

CAUTION
This instrument uses a Lithium Ion battery that, if not connected correctly, may lead to
explosion. In case the battery needs to be exchanged, it must be the same kind as or
compatible with the one shipped with your instrument.
The battery must not be disposed of in a landfill site or as municipal waste, and should be
disposed of according to your national regulations.

Battery
The battery pack that comes with the instrument is Lithium Ion and it may lead to explosion if not
connected correctly. In case the battery needs to be replaced, it must be one of the same kinds or
compatible ones. Disposal of the batteries must be done according to local safety and environmental
regulations.
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Safety guide


Do not expose the battery to high temperature such as fire, heat, direct sun, etc.



Do not connect the positive and negative terminals of the battery together with any metal
objects such as wires, paper clips, etc.



Do not expose the battery to any type of liquid such as rain, water and salt water, etc.



Do not disassemble or modify the battery.

Storage guide
Lithium Ion batteries continue to slowly discharge (self-discharge) when stored or not in use for a while.
In this case, you need to:


Remove the battery pack and store it separately from the product in a cool and dry location
without direct sun light on the pack or its carton box.



Store the battery at temperatures between 10 °C and 30 °C (50 °F and 86 °F) to minimize the
deactivation effect of the battery.



Storage at the temperatures above 30 °C or 86 °F reduces the battery storage life.



Charge at least once per 6 months to prevent leakage and deterioration in performance
caused by self-discharging.

Battery charge status indicator
You can find the indicator for battery charge status on the battery pack.
Table 1
Indicator

Battery charge status
Description
Voltage < 9.0 V, immediate charge required
Remaining Capacity Alarm, immediate charge required
1 to 19% Remaining, charge before storage
21 to 40% Remaining, charge before storage
41 to 60% Remaining, charge before storage
61 to 80% Remaining
81 to 100% Remaining

Electrostatic discharge precautions (ESD)
This instrument was manufactured in an ESD protected environment. Semiconductor devices used in
this product are susceptible to damage by static discharge. Depending on the magnitude of the
discharge, semiconductor devices may be damaged by direct contact or mere proximity of a static
charge. This may cause performance degradation, early failure, or immediate destruction. Use the
following guidelines to prevent ESD damage:


Before connecting a cable to this instrument terminal, short circuit the center of the cable with
an outside metal shield.
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Before removing a connected cable or getting in contact with the center pin, wear a wrist strap
with one MΩ resistor connected to the ground.



All equipment must be connected to the ground to avoid accumulation of static charges.

Using 12 V DC automotive adapter
When powering or charging this instrument with the 12 V DC Automotive Adapter, always verify that
the supply is rated for a minimum of 60 Watts @12 V DC and that the socket is clear of any dirt or
debris. If the adapter plug gets hot to touch during operation, discontinue the use immediately.

Conventions
This document uses typographical and symbols conventions as described in the following tables.
Table 2

Text formatting and other typographical conventions

Item

Text formatting/symbols used

Example(s)

Buttons or hard keys that
the user presses on a
physical device

Bold, all caps, default font

Press the ON button.
Press the MODE hard key.
Press the MARKER hard key.

Hot keys that the user
presses on a physical
device

Bold, all caps, italics, default font

Press the SYSTEM hot key.
Press the MEASURE hot key.

Soft keys or toggle keys
that the user presses on a
physical device to select
corresponding menus

Bold, default font

Press the Span soft key.
Press the Channel Power soft key.

Soft key option separators

Denoted by a vertical bar | that
means “or”, only one option can be
selected with a single press

Press the Zone [1|2|3] soft key.

File type

Courier New

In .tra file type.

Required arguments (text
variables in code)

Denoted by slanted brackets < >.

Enter <password>

Table 3

Symbol conventions
This symbol represents a general hazard. It may be associated with either a DANGER,
WARNING, or CAUTION message.
This symbol represents hazardous voltages. It may be associated with either a
DANGER, WARNING, or CAUTION message.

This symbol represents a risk of explosion. It may be associated with either a DANGER,
WARNING, or CAUTION message.

This symbol, located on the equipment, battery, or the packaging indicates that the
equipment or battery must not be disposed of in a landfill site or as municipal waste,
and should be disposed of according to your national regulations.
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Table 4

Safety definitions

DANGER

Indicates a potentially hazardous situation that, if not avoided, will result in death or
serious injury. It may be associated with either a general hazard, high voltage, or
risk of explosion symbol.

WARNING

Indicates a potentially hazardous situation that, if not avoided, could result in death
or serious injury. It may be associated with either a general hazard, high voltage, or
risk of explosion symbol.

CAUTION

Indicates a potentially hazardous situation that, if not avoided, could result in minor
or moderate injury and/or damage to equipment. It may be associated with either a
general hazard, high voltage, or risk of explosion symbol.
When applied to software actions, indicates a situation that, if not avoided, could
result in loss of data or a disruption of software operation.

Technical assistance
Contact information for technical assistance is listed in the following table. For the latest TAC
information, go to www.jdsu.com or contact your local sales office for assistance. Contact information
for regional sales headquarters is listed on the back cover of this manual.
Table 5

Technical assistance centers

Region

Phone Number

E-mail Address

Americas

1-855-ASK-JDSU (option #3)
(1-855-275-5378, option #3)

catvsupport@jdsu.com

Europe, Africa, and Mid-East

+49 (0) 7121 86 1345
(JDSU Germany)

hotline.europe@jdsu.com

Asia and the Pacific

China
Taiwan
India
Australia
New Zealand
Japan
Korea
Singapore
Malaysia
Thailand
Vietnam
Philippines
Indonesia

tac.apac@jdsu.com

400 122 6542
008 06651950
1800 103 5378
1800 095 127
0800 448 482
005 316 50533
007 986 517 490
1800 223 7070
1800 806584
1800 658177
12065180
1800 16510736
001 803657082

During off-hours, you can request assistance by doing one of the following: leave a voice mail
message at the Technical Assistance number, e-mail the North American Technical Assistance Center,
tac@jdsu.com, or submit your question using our online Technical Assistance Request form at
www.jdsu.com.
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This chapter provides a general description of the JD780A series. Topics discussed in this chapter
include the following:


About the JD780A series ...........................................................................................................23



Features and capabilities ...........................................................................................................23



Options ......................................................................................................................................24



Specifications.............................................................................................................................24
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About the JD780A series
JDSU wireless RF test solutions for the field
include base station analyzers, cable and antenna
analyzers, and signaling analyzers for the
installation and maintenance of modern wireless
communication systems. RF test is critical for
wireless operators facing challenges of signal
quality and signaling interference, and maintaining
quality high-bandwidth services.
The JD780A series addresses spectrum analysis,
interference analysis, and cable, antenna and
modulation analysis, covering current wideband technologies such as WiMAX and LTE.
Base station analyzer JD785A
The Base Station Analyzer contains all the features and capabilities required to perform field testing of
cell sites of all wireless technologies, from 2G to 4G.
RF analyzer JD786A
The RF Analyzer provides multi-purpose solution for the analysis of RF systems covering all physical
aspects of transmission, reception, and interference of RF systems up to 8 GHz.
Signal analyzer JD788A
The Signal Analyzer contains all the features and capabilities required to perform cell site field testing
for all wireless technologies from 2G to 4G.

Features and capabilities
The JD780A series is the optimal test solution for installation and maintenance of cellular base stations
and cell sites, running with external AC power or battery for the field.
The user interface has been specifically designed with customized menus and simple calibration
procedures, providing service providers with accurate and reliable measurement results.
Applicable Systems


cdmaOne/cdma2000



EV-DO



WCDMA/HSPA+



GSM/GPRS/EDGE



TD-SCDMA



WiMAX



LTE/LTE-Advanced (FDD/TDD)

JD780A Series Overview
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Key Features
Table 6

Key functions

Functionality

JD785A

JD786A

JD788A

Spectrum Analyzer







Cable and Antenna Analyzer





RF Power Meter







Optical Power Meter







Fiber Inspection







Signal Analyzers (optional)



E1/T1 Analyzers (optional)



Interference Analyzer (optional)







Channel Scanner (optional)







OTA Measurement (optional)







Options
This instrument is provided with various options/features that are available to be ordered. See
“Appendix I – Ordering information” on page 552 for more information.

Specifications
AC power
Input voltage is automatically selected within the instrument’s tolerable input line voltage from 100 to
240 VAC. This instrument does not have a separate line protection fuse.
Table 7

AC power requirements

Item

Specification

AC Power

100 to 240 V AC, 50-60 Hz

Power Consumption

37 W in operation; 49 W with battery charging

Physical specifications
Table 8 shows weight with standard configurations and the battery pack installed.
Table 8
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Physical specifications

Parameter

JD785A/JD786A

JD788A

Height

7.7” (195 mm)

7.7” (195 mm)

Width

11.6” (295 mm)

11.6” (295 mm)

Depth

3.2” (82 mm)

3.2” (82 mm)
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Getting Started
This chapter provides general guides of how to get started with your JD780A series instrument. Topics
discussed in this chapter are as follows:


Unpacking the JD780A series ...................................................................................................26



Exploring the JD780A series .....................................................................................................26



Installing battery pack ................................................................................................................30



Starting up the JD780A series ...................................................................................................31



Managing files............................................................................................................................31



Configuring system ....................................................................................................................35



Upgrading firmware ...................................................................................................................37



Managing licenses .....................................................................................................................39



Performing service diagnostic ...................................................................................................41



Using system administration......................................................................................................42



Running IP test ..........................................................................................................................43



Activating StrataSync ................................................................................................................44



Setting communication ..............................................................................................................45
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Unpacking the JD780A series
Unpack and inspect the shipping package thoroughly to ensure that nothing was damaged during the
shipment. Also, check that your delivered package includes all of your ordered items in the shipment. If
contents in the package are damaged or defective or if there are any missing items, keep the shipping
list and materials for carrier’s inspection and contact your nearest JDSU's authorized sales and service
office.
A basic test set of JD780A series would include the following items in the package. For more options,
see “Appendix I – Ordering information” on page 552.
Table 9

Items included in a basic test set shipment

Item

Quantity

JD780A series instrument (JD785A, JD786A, or JD788A)

1

AC/DC power adapter and power cord

1

1.5 meter cross LAN cable

1

1.8 meter USB A-to-B cable

1

> 1 G byte USB memory

1

Rechargeable Lithium Ion battery pack

1

12 V DC automotive adapter

1

Stylus Pen

1

User’s manual and application software CD

1

Exploring the JD780A series
Figure 1
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Front panel
The JD780A series analyzers have the same front panel look as like Figure 1, except for the bumpers
in different colors.
Power on/off button
Key

Description
POWER ON/OFF – You can turn your instrument on or off. Two LEDs indicate power
source and status. See “Starting up the JD780A series” on page 31.

Function hard keys
You can use these hard keys to activate specified functions as labeled on each key.
Key

Description
MODE – You can select an analyzer mode from all the standard and optional modes
available to your instrument.
FREQ/DIST – You can configure frequency or distance settings.
AMP/SCALE – You can configure amplitude and scale settings.
BW/AVG – You can configure bandwidth and average settings.
TRACE/DISPLAY – You can set up trace and display parameters.
MARKER – You can analyze measurements with markers.
PEAK SEARCH – You can set up peak search parameters.

Hot keys
When the user input field on the screen is inactive, you can use these hot keys to activate specific
functions instead of numbers. When you see the user input field activated or highlighted, press the
ESC hard key to use these hot keys.
Key

Description
MEASURE – You can select measurements available for your selected analyzer mode.
MEASURE SETUP – You can set measurement parameters available for your selected
measurement mode.
SAVE/LOAD – You can save or load your current screen, result, setup, or limit into or
from the internal memory or an external USB memory drive.
SWEEP – You can configure sweep parameters.
TRIGGER – You can select trigger options such as internal, external, and GPS.
SYSTEM – You can configure your system settings or view your current system
information.
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PRESET – You can use this key to return to a known state and make measurements.
HOLD – You can change the sweep mode: Continue or Single.
LIMIT – You can set limit settings such as display line, multi segment line, save limits,
recall limits, or test specification limits.
BACKLIGHT – You can turn the key backlight feature on or off.
HELP – You can have the online help screen on.

Soft keys
You can use these soft keys along the right side of the display to start a specific function associated
with each key, invoke other screen keys, or select a unit. The More screen menu indicates that there
are more than seven screen menus for the level. The small arrowhead symbol in the screen menu
indicates that there are screen menus under the screen menu.
Data entry and other keys
Key

Description
ROTARY KNOB WITH ENTER KEY – You can change a value with predefined
increments or move marker position. Rotating this knob clockwise increases value or
moves a marker to the right and rotating counter clockwise does vice versa. This knob
works as the ENTER hard key as well.
ARROW KEYS – You can increase or decrease value or move your selection up, down,
to the left, or to the right.

NUMERIC KEYS – You can manually enter a value for measurement parameters.

DEL – You can delete data entry. After pressing the ENTER key or selecting a unit soft
key, you cannot delete or remove data entered.
ENTER – You can save and confirm data entry.
ESC – You can cancel any input in the user input field or dismiss a pop-up window on the
screen.
PREV – You can go back to the previous menu without changing current setup.

Top panel
The JD785A and the JD786A analyzers have the same top panel view as Figure 2, except for the
E1/T1 inlet. The JD786A has the GPIO inlet instead.
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Figure 2

JD785A top panel view

Reflection/RF Out (Cable and Antenna Analyzer)
The Reflection/RF Out port of the Cable and Antenna Analyzer is a precise 50 Ω N-type female
connector that is used as the output signal port for the Cable and Antenna Analyzer mode.
CAUTION
Do not apply or connect power exceeding +25 dBm to this Reflection/RF Out port. If such
power is applied, it will degrade the product’s performance and can cause damage to the
product in worst case.

RF In (Cable and Antenna Analyzer)
The RF In port is a precise 50 Ω N-type female connector that is used as the input signal port for
insertion gain/loss measurements in the Cable and Antenna Analyzer mode.
CAUTION
The maximum power allowed to the RF In port is +25 dBm. If the input power exceeds
the limit, it may degrade the product performance or cause damage to the instrument in a
worst case. Do not connect any power feed exceeding 1 W directly to this port.

DC 18 V
The input power to this port shall be 18 V DC.
RF In (Spectrum Analyzer)
The RF In port is a precise 50 Ω N-type female connector that is used as the input signal port for
spectrum analysis, signal analysis, and RF power measurement.
CAUTION
The maximum power allowed to the RF In port is +25 dBm. If the input power exceeds
the limit, it may degrade the product performance or cause damage to the instrument in a
worst case. Do not connect any power feed exceeding 1 W directly to this port.

Audio jack
The audio jack is labeled with a headphones icon. Plugging in headphones or earphones turns the
speaker off.
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USB


CLIENT: This is a communication port that you can connect your instrument and your PC with
application software JDViewer or JDRemote. You must install driver software for the
instrument on to the computer. See “Appendix H – Device driver installation” on page 551 for
more information.



HOST: You can use this port to plug in an external USB memory to extend storage capacity or
to upgrade the instrument’s firmware. It supports most USB memory devices with 32-bit file
system. You can also use this port to connect an external power sensor, Bluetooth USB
adapter, or P5000i fiber microscope. See “Appendix G – Bluetooth connection” on page 548
on how to set up and use the Bluetooth connection.

LAN
You can use this Ethernet communication port to connect your instrument and your PC using the
application software JDViewer or Motorola WinLMF, if necessary. Two LEDs indicate data transfer
activity and link status.


ACTIVITY: The yellow LED is illuminated during data transfer.



LINK: The green LED is illuminated when there is a valid communication connection.

E1/T1 for JD785A
You can use this E1/T1 input port to detect an error or alarm from E1/T1 signal and to transmit test
pattern to E1/T1 transmission line connected through the provided RJ45 cable accessory.
GPIO for JD786A and JD788A
This General Purpose Input/Output (GPIO) port is factory use only.
External In


GPS: You can plug in a GPS antenna to this SMA type female connector in order to get
location information and highly accurate reference.



TRIGGER: You can use this SMA type female connector to receive PP2S clock or 10 ms
synchronization signals from an external timing reference.



REF: You can use this SMA type female connector to receive 10 MHz, 13 MHz, or 15 MHz
reference clock signals from an external frequency source.

Installing battery pack
You need to install the Lithium Ion battery pack provided with your instrument. Follow the instruction to
install or remove the battery pack as needed.
Procedure
To install the battery pack:

1. Loosen the latching screw of the battery cover by turning counter clockwise.
2. Slide out the battery cover to open.
3. Insert the battery pack with the connector terminal side up and push in until it stops.
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4. Slide in the battery cover to close.
5. Tighten the latching screw of the battery cover
by turning clockwise.
To remove the battery pack:

1. Loosen the latching screw of the battery cover
by turning counter clockwise.

2. Slide out the battery cover.
3. Hold the battery strap and pull it out.
CAUTION
The battery pack that came with your instrument is Lithium Ion and it may, if not
connected correctly, lead to explosion. In case you need to replace the battery, you must
use one of the same kinds or compatible ones. You must dispose a battery according to
your local safety and environmental regulations.
NOTE
It is recommended that you turn off the instrument to replace the battery. However, if you
do not want to interrupt the current test, you can leave the module turned on with the AC
power adapter plugged in.

Starting up the JD780A series
Use the power button to turn your JD780A series on or off. When external power is supplied via the
AC/DC adapter, the upper orange LED is illuminated.
Procedure
To turn on:

1. Press and hold the

POWER button for a few seconds until the lower green LED indicator is

illuminated.

2. Release the button and wait for a few seconds while booting up.
To turn off:

1. Press and hold the

POWER button for a few seconds until the lower green LED indicator

goes out.

2. Release the button.

Managing files
The JD780A series lets you save and load screen, result, setup, limit, logging data, or Fail events
depending on your selected measurement mode and option.
NOTE
If you see greyed-out menus as you change measurement modes, this indicates that the
menu(s) are not available to be used.

Using save
You can save your current screen, result, setup, and limit into the internal memory or your external
USB memory drive.
Getting Started
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Procedure

1. Press the SAVE/LOAD hot key. The Save/Load screen menu bar appears.
2. Press the Save soft key.
3. Select the save option, from the following choices:
To save

Select

File type

Current screen

Save Screen > Screen

.png

Measurement result in a report
format with comments

Save Screen > Report

.pdf

Measurement result

Save Result

.tra
.gom
.grr
.jdt

Measurement result (.csv)

Save Result as CSV Format

.csv

Setup and test configuration

Save Setup

.sta

Limit setting

Save Limit

.jml

Logging data

Save Logging Data

.grr
.gsr

Automatically screen or results
that falls outside the defined
limit settings (Failed event)

Save On Event

.png
.tra
.csv

The on-screen keyboard appears.
NOTE
Save Setup saves a test configuration only, not a measurement limit setting. You must
use Save Limit to save your limit settings.

4. Type the name of the file in the File Name field with or without using a keyword.
5. Optional.
–

To create or edit keywords, touch the Edit Keywords button, select your desired keyword
button in the upper screen, type a keyword, and then tap the Save button on the keyboard.
See “Editing or adding a custom keyword” on page 558 for more information.

–

To include a keyword in the file name, touch the Append Keywords button, select your
desired keyword, and then tap the Keyboard button. See “Appending a keyword” on page
559 for more information.

–

To change the file location in the internal memory or to your USB memory drive, tap the
Location button, select your desired file path using the touch screen or the rotary knob,
and then press the Apply soft key.

–

To create a folder, press the Create Folder soft key, type a directory name, and then press
the Apply soft key.

6. Press the Save soft key.
Saving fail events
Depending on the measurement mode, you can let the instrument automatically save measurement
screen or result that falls outside the defined limit settings or the Fail indicator is on. You can also set
to save the first event and hold the measurement or to save all the events continuously.

32

Getting Started

JD780A Series Analyzers

Procedure

1. Press the SAVE/LOAD hot key. The Save/Load screen menu bar appears.
2. Press the Save soft key.
3. Press the Save On Event soft key.
4. Press the Save Type soft key, and then select the save option: Screen, Result, or Result as
CSV Format.

5. Optional. Toggle the Save Then Stop soft key and select On in order to save the first event that
falls outside the limit(s) and to hold the measurement. Otherwise, leave this feature off to save
events continuously.

6. Press the Start soft key to start saving. The on-screen keyboard appears.
7. Type the name of the file in the File Name field with or without using a keyword.
8. Optional.
–

To create or edit keywords, touch the Edit Keywords button, select your desired keyword
button in the upper screen, type a keyword, and then tap the Save button on the keyboard.
See “Editing or adding a custom keyword” on page 558 for more information.

–

To include a keyword in the file name, touch the Append Keywords button, select your
desired keyword, and then tap the Keyboard button. See “Appending a keyword” on page
559 for more information.

–

To change the file location in the internal memory or to your USB memory drive, touch the
Location button, select your desired file path using the touch screen or the rotary knob,
and then press the Apply soft key.

–

To create a folder, press the Create Folder soft key, type a directory name, and then press
the Apply soft key.

9. Press the Done soft key.
The “Event Save” appears on the screen and the Start screen menu changes to Stop.

10. Press the Stop soft key to end the event saving.
Saving logging data
You can save logging data in the following measurement modes: Interference Analyzer, E1/T1
Analyzer, Signal Analyzer OTA, and Auto Measure.
Procedure

1. Press the SAVE/LOAD hot key. The Save/Load screen menu bar appears.
2. Press the Save soft key.
3. Press the Save Logging Data soft key. The on-screen keyboard appears.
4. Type the name of the file in the File Name field with or without using a keyword.
5. Optional.
–

To create or edit keywords, touch the Edit Keywords button, select your desired keyword
button in the upper screen, type a keyword, and then tap the Save button on the keyboard.
See “Editing or adding a custom keyword” on page 558 for more information.

–

To include a keyword in the file name, touch the Append Keywords button, select your
desired keyword, and then tap the Keyboard button. See “Appending a keyword” on page
559 for more information.

–

To create a folder, press the Create Folder soft key, type a directory name, and then press
the Apply soft key.

–

To change the file location in the internal memory or to your USB memory drive, touch the
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Location button, select your desired file path using the touch screen or the rotary knob,
and then press the Apply soft key.
NOTE
In is recommended that you use an external USB memory drive to save logging data in
the Auto Measure mode in order to have enough free space.

6. Optional only in the Auto Measure mode.
Toggle the Save Screen soft key and select All to save all the Auto Measure screens or Fail to
save only the ones with the Fail on.

7. Press the Save soft key to start logging.
The “Recording” appears on the screen.

8. Press the ESC hard key to stop logging data and complete saving.

Using load
You can load your saved screen, result, setup, and limit from the internal memory or your external
USB memory drive.
Procedure

1. Press the SAVE/LOAD hot key. The Save/Load screen menu bar appears.
2. Press the Load soft key. The Load screen menu bar appears.
3. Select the load option, from the following choices:
To load

Select

Saved screen or report

Load Screen

Measurement result

Load Result

Setup and test configuration

Load Setup

Limit setting

Load Limit

Logging data

Load Logging Data

Map file

Load Map

Scenario

Load Scenario

The file manager window appears.

4. Select the name of the file to be loaded from the internal memory or from your USB drive.
Information of your selected file appears in the File Information pane.

5. Press the Load soft key.

Using file manager
The File Manager lets you copy, cut, paste, and delete data files saved in the internal memory or in
your USB memory drive.
Procedure

1. Press the SAVE/LOAD hot key. The Save/Load screen menu bar appears.
2. Press the File Manager soft key. The file manager window appears.
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3. To copy, cut, and paste, complete the following steps:
a.

Select a file or folder by using the touch screen or the rotary knob.

b.

Select the Copy or Cut soft key.

c.

Select the location to which the file or folder to be pasted.

d.

Press the Paste soft key.

4. To delete, complete the following steps:
a.

Select a file or folder by using the touch screen or the rotary knob.

b.

Press the Delete soft key.
The confirmation dialog box appears.
Once the file or folder is deleted, you cannot recover it.

c.

Select OK to delete.

5. Press the Exit soft key or the ESC hard key to close the file manager window.

Configuring system
Setting frequency reference
You can improve measurement accuracy by setting frequency reference.
Procedure

1. Press the SYSTEM hot key.
2. Press the Freq Reference soft key.
3. Select the frequency reference option: Internal, External 10 MHz, External 13 MHz,
External 15 MHz, or GPS.

Setting date and time
You can set the instrument’ system clock to your region.
Procedure

1. Press the SYSTEM hot key.
2. Select System Configuration > Date/Time. The current time zone information box appears.
3. To change the standard time zone, complete the following steps:
a.

Press the Std Time Zone soft key.

b.

Select your time zone by using the rotary knob or arrow keys. You can also use the
Top/Bottom or Page Up/Down soft keys.

c.

Press the ENTER hard key to save your change. You can also press the rotary knob.

4. To change the date format, complete the following steps:
a.

Press the Date Format soft key.

b.

Select YYMMDD, MMDDYY, or DDMMYY as needed.

5. To set the date and time manually, complete the following steps:
a.

Select Year, Month, Day, Hour, or Minute soft key as needed.

b.

Enter a value by using numeric keys.
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c.

Press the Enter soft key to save your change.

6. Press the Apply screen key to save and exit.

Setting language
You can change the system language for the menus, messages, and information on screen.
Procedure

1. Press the SYSTEM hot key.
2. Select System Configuration > Language.
3. Select the language option from the choices available.

Setting power on
Procedure
To set the power-on option:

1. Press the SYSTEM hot key.
2. Press the Power On soft key.
3. Select the power-on option, from the following choices:
–

Last: Boots up with the last state of the instrument before power-off or shut-down.

–

Preset: Boots up with the default settings preset in the factory.

–

User: Boots up with the user-defined setup.
When the User is selected, the User Setup menu under System becomes activated.

4. Optional. To specify the user setup file, complete the following steps:
a.

Press the User Setup soft key.

b.

Select the name of the user setup file.

c.

Press the Done soft key.

NOTE
The Preset option returns the instrument settings to the factory preset. It is recommended
that you use this option when you experience badly misadjusted settings.

Changing display mode
You can change the instrument’s display mode as needed.
Procedure

1. Press the SYSTEM hot key.
2. Select System Configuration > Display Mode.
3. Select a display mode from the choices: Indoor, Outdoor, and Night.
4. The instrument optimizes screen colors to each choice.
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Setting sleep time
You can set the amount of time up to 255 minutes to let the instrument automatically turn the backlight
off and enter into power saving mode after no actions or data entries. Default setting is zero, which
indicates that the sleep mode is turned off and screen backlight is always on.
Procedure

1. Press the SYSTEM hot key.
2. Select System Configuration > Sleep Time.
3. Enter the amount of minutes by using the numeric keys. You can also use the rotary knob.
4. Press the Enter soft key.

Adjusting LCD brightness
You can adjust display brightness from one to ten as needed. The larger number you set, the brighter
the display becomes.
Procedure

1. Press the SYSTEM hot key.
2. Select System Configuration > LCD Brightness.
3. Enter a value by using the numeric keys. You can also use the rotary knob.
4. Press the Enter soft key.

Adjusting volume
You can turn the sound on or off or adjust the volume from one to ten as needed.
Procedure

1. Press the SYSTEM hot key.
2. Select the sound option, from the following choices:
–

To turn the sound or alarm off, toggle the Sound soft key and select Off.

–

To turn the sound or alarm on, toggle the Sound soft key and select On.

–

To adjust the volume, complete the following steps:
a.

Press the Sound soft key.

b.

Enter a value by using the numeric keys.

c.

Press the Enter soft key.

Upgrading firmware
It is recommended that you maintain your instrument up-to-date with its latest firmware in order to
achieve the instrument’s optimal performance.
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Checking installed firmware version
Procedure

1. Press the SYSTEM hot key.
2. Press the HW/FW Info soft key.
3. Find the installed version number in the Firmware field.
4. From a computer with Internet access, visit JDSU’s Software Updates website and check if your
installed firmware is the latest one. Do the steps 5-6 if you want to update your firmware with
using your USB memory drive.

5. Download a latest firmware file from the website to the root directory of your USB memory drive.
NOTE
It is recommended that you format your memory drive to have enough space to download
the file.

6. Unzip the download file into the root directory of your USB memory stick.
A firmware file (*.fw) and a firmware release note (*.pdf) are extracted.

Installing new firmware
To update your firmware, you can choose either way of using your USB memory drive or accessing the
FTP server over the network.
Upgrading from USB memory drive
Procedure

1. Power your instrument via the AC-DC adapter to prevent any severe damage to your instrument
caused by a power-off in the middle of the upgrade, which may require a repair in the factory.

2. Plug in the USB memory drive to the USB Host port of your instrument.
3. Press the SYSTEM hot key.
4. Select More (1/2) > Upgrade > USB.
The file manager window appears.

5. Highlight the firmware file (.fw) saved in the root directory of your USB drive.
6. Press the Select soft key.
The Update Firmware dialog box appears.

7. Press the OK button to start to install the new firmware.
The Upgrade Status bar appears.
The instrument reboots the system automatically and completes upgrading.
NOTE
Firmware upgrade will be done within 30 minutes or so in most cases, but depending on
the number of files to be reconfigured, it may take longer than that.

8. After the instrument restarted, check the installed firmware version and DSP versions in the
System settings. Refer to the firmware release note to find correct DSP version and compatible
application software versions.
WARNING
Do not remove the USB drive while upgrading the firmware.
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Upgrading from FTP server
Procedure

1. Power your instrument via the AC-DC adapter to prevent any severe damage to your instrument
caused by a power-off in the middle of the upgrade, which may require a repair in the factory.

2. Press the SYSTEM hot key.
3. Select More (1/2) > Upgrade > FTP Server.
The upgrade server dialog box appears.
NOTE
Older version of firmware does not have the FTP Server option. It is recommended that
you update your firmware with the USB option first.

4. Enter ftp2.jdsu.com in the server address field.
5. Enter your proxy server address in the proxy server field, if necessary.
Contact your system administrator for your proxy server information.

6. Tap the Check button to check if the installed firmware version is the latest one.
7. Do one of the following:
–

If you view the latest firmware version information, tap the Install button to continue
upgrading.

–

If the message “Your firmware is up to date.” is displayed, tap the Cancel button.
NOTE
Firmware upgrade will be done within 30 minutes or so in most cases, but depending on
the number of files to be reconfigured, it may take longer than that.

8. After the instrument restarted, check the installed firmware version and DSP versions in the
System settings. Refer to the firmware release note to find correct DSP version and compatible
application software versions.

Managing licenses
The License Manager lets you view installed options, install additional ones, and load evaluation
licenses.

Checking options
Procedure
To view the list of installed or installable options:

1. Press the SYSTEM hot key.
2. Select More (1/2) > License Manager. The License Manager screen menu bar appears.
3. Select the menu, from the following choices:
–

To view the installed options, select the Installed Options soft key.
The list of options appears. The “(T)” indicates temporary licenses.

–

To view the installable options, select the Installable Options soft key.

4. Press the PREV hard key to return to the previous screen.
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Installing options
Procedure
To install an option that you have purchased:

1. Press the SYSTEM hot key.
2. Select More (1/2) > License Manager.
The License Manager menu bar appears.

3. Select the Install an Option soft key. The Installable Options window appears.
4. Select the name of the option from the list by using the rotary knob.
5. Press the ENTER hard key. You can also press the rotary knob.
The License Code bar appears.

6. Type the number of the license to activate by using the numeric keys.
7. Press the ENTER hard key. You can also select the Enter soft key.

Loading temporary license
The temporary license that you received from JDSU is intended for your evaluation only and it expires
after its specified time limit.
Procedure
To load a temporary license that you have received for evaluation:

1. Press the SYSTEM hot key.
2. Select More (1/2) > License Manager.
The License Manager menu bar appears.

3. Select the Load Temp License soft key. The file manager window appears.
4. Select the name of the license file.
5. Press the Load soft key.
6. Optional. You can check the loaded license using the Installed Options menu.

Viewing OSS license
The JD780A series incorporates software that is covered by either the GNU General Public license or
GNU Lesser General Public License. Check the OSS license notification for more details.
Procedure
To view OSS license notification and distribution:

1. Press the SYSTEM hot key.
2. Select More (1/2) > License Manager.
The License Manager menu bar appears.

3. Select the OSS License soft key.
The Open Source Code Notification & Distribution screen appears.

4. Press the ESC hard key to return to your previous screen.
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Performing service diagnostic
The Service Diagnostic lets you view system log, perform self test, revert the instrument settings to its
factory settings, or perform touch alignment.

Viewing system log
Procedure

1. Press the SYSTEM hot key.
2. Select More (1/2) > Svc Diagnostic > System Logging.
3. Optional. Press the Save soft key to save the system log as a .log file type.
4. Press the PREV hard key to return to the previous screen.

Running self-test
You can run a self-test on your instrument boards and modules.
Procedure

1. Press the SYSTEM hot key.
2. Select More (1/2) > Svc Diagnostic > Self Test.
The on-screen instruction appears.

3. Connect a test cable between the Reflection/RF Out port for Cable and Antenna Analyzer and
the RF In port for Spectrum Analyzer.

4. Press the Start soft key.
The test result window appears.

5. Optional. Press the Save Screen soft key to save the self-test results.
6. Press the PREV hard key to return to the previous screen.

Performing factory reset
The Factory Reset is used only when you want to purge all the user settings and data stored in the
system and return to the instrument’s factory state.
Procedure

1. Press the SYSTEM hot key.
2. Select More (1/2) > Svc Diagnostic > Factory Reset.
The confirmation window appears.

3. Press the Yes soft key to continue. Otherwise, select No.
4. Press the PREV hard key to return to the previous menu.
NOTE
It is recommended that you copy your setup or result data to an external USB memory
drive so that you can restore them later.
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Re-aligning touch screen
When you consistently experience of the instrument responding improperly to your touch on the
screen, you may need to perform this touch-screen alignment.
Procedure

1. Press the SYSTEM hot key.
2. Select More (1/2) > Svc Diagnostic > Touch Alignment.
The white screen with a plus sign (+) in the upper-left corner appears.

3. Touch the plus sign and repeat until the previous screen is back on.

Using system administration
The Administration is used to disable editing limits, enable modifying online help, or change
administration password.

Logging in
You need to log in first to access the administration menus.
Procedure

1. Press the SYSTEM hot key.
2. Select More (1/2) > Administration. The password box appears.
3. Enter <password> by using the numeric keys.
Default password is “0000”. To change the password, see “Changing password” on page 42.

4. Press the Apply soft key.

Changing password
Procedure

1. Press the SYSTEM hot key.
2. Select More (1/2) > Administration, and then enter your password.
3. Press the Change Password soft key. The new password box appears.
4. Enter a new password up to eight digits by using the numeric keys.
5. Press the Apply soft key. The reconfirmation box appears.
6. Enter the new password again by using the numeric keys.
7. Press the Apply soft key to complete changing password.

Locking limit key
You can lock the LIMIT hot key and disable editing predefined limit settings to prevent any
unintentional changes, which could result in incorrect measurements.
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Procedure

1. Press the SYSTEM hot key.
2. Select More (1/2) > Administration, and then enter your password.
3. Toggle the Edit Limit soft key and select Disable to lock the LIMIT hot key or Enable to unlock
the key.
NOTE
Disabling the Edit Limit limits the access to the LIMIT hot key only. The Limit features
including displaying limit line(s) and Pass/Fail result function properly as predefined.

Modifying online help
The online help can be modified if needed.
Procedure

1. Press the SYSTEM hot key.
2. Select More (1/2) > Administration, and then enter your password.
3. Toggle the Modify Help soft key and select Enable to allow modifying the online help or Disable
to restrict any modification.

Running IP test
You can test an Internet Protocol (IP) configuration of the cell site’s backhaul.
Procedure

1. Press the SYSTEM hot key.
2. Select More (1/2) > Utility > IP Test.
3. Select the command option, from the following choices:
–

To display the route and measure transit delays of packets, toggle the Commands soft key
and select Traceroute.

–

To display the reachability and measure the round-trip time, toggle the Commands soft key
and select Ping.

4. To set the destination IP address to be tested, complete the following steps:
a.

Press the Destination IP soft key.

b.

Press the First Octal soft key.

c.

Enter a value, and then press the Enter soft key.

d.

Press the Second Octal soft key and repeat step c.

e.

Press the Third Octal soft key and repeat step c.

f.

Press the Fourth Octal soft key and repeat step c.

5. Press the Execute soft key and select Start to start testing.
Test result is displayed on the screen as the test is progressing.

6. Press the Execute soft key and select Stop to stop testing.
7. Optional. Press the Save soft key to save the test result as a .txt file type.
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Activating StrataSync
StrataSync is a cloud-based solution that provides asset, configuration, and test data management for
JDSU instruments. StrataSync manages and tracks test instruments, collects and analyzes results
from the entire network, and informs and trains the workforce.
The JD780A series is compatible with the JDSU StrataSync cloud. This optional capability allows you
to manage your instrument inventory ensuring you know where all your valuable equipment is and
which engineer is using it. In addition, it allows you to keep your instruments current through the
remote upgrade capability that ensures all instruments have the latest firmware. It also enables the
centralized distribution of configuration settings to ensure all your engineers use the same instrument
settings resulting in consistent measurements.
Once testing is completed, the trace files can be uploaded onto StrataSync for secure storage and
sharing. This sharing capability allows engineers who have a problem they cannot resolve to request
help from an expert who can analyze the trace file via StrataSync using applications such as JDViewer,
JDFileViewer, JDPowerMeter, etc. from anywhere without having to be at the instrument, helping
resolve problems even faster.

Establishing a connection to StrataSync
Procedure

1. Press the SYSTEM hot key.
2. Select More (1/2) > Utility > StrataSync.
The StrataSync setting window appears as shown in Figure 91.

3. Enter <server address> in the Server Address field for StrataSync.
The server address at the time of this document production is “stratasync.jdsu.com”, which
may change.
NOTE
JDSU provides you with the information required to access StrataSync at your
purchase of StrataSync, including the Server Address, Account ID, and Port
number. See “JD780A Series Common Options” on page 555 for more information
on available options.

4. Enter <account number> in the Account ID field.
5. Enter <technician number> in the Technician ID field.
6. To set the port number and proxy server address, complete the following steps:
a.

Tap the Detail Settings button.
The input dialog box appears.

b.

Enter <port number> in the Port field.

c.

Enter <proxy server address> in the Proxy Server address, if necessary.
Contact your system administrator for your proxy server information.

d.

Tap the Apply button to save and exit.

7. Tap the Start Sync button.
Once successfully synchronized, the text “Successfully synchronized with server” appears and
the StrataSync status icon changes accordingly.

8. Tap the Apply button to exit.
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Figure 3

StrataSync setting window

StrataSync status indicators
The StrataSync indication icons provide you with the connection and activity status.
Indicator

Description
Indicates that your instrument is idle to be connected and synchronized with the
StrataSync server.
Indicates that your instrument is acquiring an authentication, synchronizing with the
server, and sharing data.
Indicates that your instrument is synchronized successfully.
Indicates that your instrument failed to synchronize with the StrataSync server or
encountered an error.

Setting communication
JD780A series provides several methods for you to connect your instrument with application software
or other instruments and devices.

Configuring Ethernet
You can configure a network to connect your JD780A series and PC with JDViewer or JDRemote via
Ethernet.
Procedure

1. Press the SYSTEM hot key.
2. Select System Configuration > Ethernet Config.
The Ethernet Configuration box appears.

3. Select the IP addressing option, from the following choices:
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–

To enable automatic IP addressing, toggle the Mode soft key and select DHCP.

–

To manually assign fixed IP addresses, complete the following steps:
a.

Toggle the Mode soft key and select Static.

b.

Select Field > IP Address.

c.

Press the First Octal soft key.

d.

Enter a value, and then press the Enter soft key.

e.

Press the Second Octal soft key and repeat step d.

f.

Press the Third Octal soft key and repeat step d.

g.

Press the Fourth Octal soft key and repeat step d.

h.

Select Field > Subnet Mask and repeat steps c-g.

i.

Select Field > Gateway and repeat steps c-g.

4. Press the Apply soft key to complete the network configuration.
5. Press the ESC hard key to exit.

Setting for JDViewer and JDRemote
The App SW is set by default to make it easy to connect your instrument to JDViewer or JDRemote.
After using other remote interfaces such as SCPI, LMF, and USBTMC, it is recommended that you set
the LAN and USB settings back to App SW.
Procedure

1. Press the SYSTEM hot key.
2. Press the System Configuration soft key.
3. Press the Remote Interface soft key and then do the following:
–

Select the LAN soft key and then press the App SW soft key.

–

Select the USB soft key and then press the App SW soft key.

Setting USBTMC mode
The USB Test & Measurement Class (USBTMC) is a standard for programmatic control of USB-based
test instruments that defines protocols used to send and receive messages. If you want to use the
USBTMC protocol to communicate with the instrument remotely, you can turn this TMC Mode on.
Procedure

1. Press the SYSTEM hot key.
2. Select System Configuration > Remote Interface > USB.
3. Press the USBTMC soft key.
The confirmation dialog box appears.

4. Press the USBTMC soft key again to confirm the mode change and reboot the instrument.
NOTE
After using the USBTMC mode, you may want to set this setting back to App SW if you
use JDViewer mainly for remote controlling your JD780A series.
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Setting SCPI mode
You can use SCPI commands to control your JD780A series remotely.
Procedure

1. Press the SYSTEM hot key.
2. Select System Configuration > Remote Interface > LAN.
3. Press the SCPI soft key.
NOTE
After using the SCPI mode, you may want to set this setting back to App SW if you use
JDViewer or JDRemote mainly.

Configuring LMF setting
The Local Maintenance Facility (LMF) setting is used in order to perform TX Calibration and TX Audit
on Motorola's CDMA/EV-DO BTS in the RF Power Meter mode. See “Appendix F – Motorola
CDMA/EV-DO LMF” on page 546 for more information.

Enabling Bluetooth connection
You can also use the Bluetooth mode to enable communicate between your instrument and your
computer with application software such as JDRemote and JDViewer or to transfer files to a Bluetooth
storage device. See “Appendix G – Bluetooth connection” on page 548 for more information.
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Analyzing Measurement Results
This chapter provides instructions on how to use JD780A series’ capabilities for measurement analysis.
Topics discussed in this chapter are as follows:


Using marker .............................................................................................................................49



Using peak search .....................................................................................................................50
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Using marker
Marker
Marker is used to get the information about a specific trace. Six markers can be set on the display and
each marker can be used independently. The X and Y coordinates of the trace are displayed when the
marker is placed on any position of the trace. The position displaying the marker’s X and Y coordinates
may be slightly different for each measurement mode and refer to the description of each
measurement. There are three different marker types available: Normal, Delta, and Delta pair. Marker
position can be set manually by entering numeric values (frequency) when one of the marker types is
selected.


Select Marker: Selects an active marker whose position can be changed with the rotary knob
or the arrow keys. The assigned number of the active marker is displayed in the Select Marker
menu box and the active marker number is also displayed right next to the active marker on
the trace when the Marker View is set to On.



Marker View: Displays the selected marker on the screen or hides it. When the Marker View
is turned off and then on again in the same measurement mode, markers appear at the
previous positions. If a measurement mode is changed, markers are not restored to their
previous positions.



Normal: This Normal marker type provides the reading of a marker position on the trace along
with the marker number between one and six.



Delta: This Delta marker type is associated with a Normal marker. A Normal marker must be
set before a Delta marker is set. When the Delta marker is set, the position set by the Delta
marker becomes the reference position of the Normal marker and the marker’s X and Y values
displays the difference compared with the Delta marker.



Delta Pair: This Delta Pair marker type is associated with a Normal marker. A Normal marker
must be set before a Delta Pair marker is set. When the Delta Pair marker is set, the position
set by the Delta Pair marker becomes the reference position of the Normal marker and the
marker’s X and Y values displays the difference compared with the Delta Pair marker. The
reference position will be varied in accordance with trace change.



Marker All Off: Turns all the markers the screen off. When the Marker View is selected for
those markers, the instrument displays those markers back at the previous position. If a
measurement mode is changed, current settings are not restored.



Marker : Sets the X coordinate of the active marker as selected.
MarkerCenter: Sets the frequency of the active marker to the center frequency of
spectrum analyzer.
MarkerStart: Sets the frequency of the active marker to the start frequency of spectrum
analyzer.
MarkerStop: Sets the frequency of the active marker to the stop frequency of spectrum
analyzer.



Frequency Count: This Frequency Count is used when a highly accurate reading of the
frequency is needed for the active marker on the signal. The measurement sweeps get
significantly slower because the instrument runs the measurement of the signal peak with 1 Hz
resolution in background. Toggle this key between On and Off to enable or disable the
frequency count function for the selected marker.



Noise Marker: This Noise Marker is used to measure a noise adjacent to a signal by
averaging several data points to calculate the readout for the Noise Marker as if making a
measurement using a 1 Hz bandwidth. Toggle this key between On and Off to enable or
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disable the noise marker function for the selected active marker.
NOTE
Frequency Count and Noise Marker functions are used only in the Spectrum Analyzer
mode.

Using peak search
Peak search
Each time the Peak Search soft key is pressed, the active marker is positioned at the highest peak of
the trace.
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Peak Search: Moves the active marker to the highest peak of the trace.



Next Peak: Moves the active marker to the second highest peak of the trace.



Next Peak Right: Moves the active marker to the highest peak to the right of its current
position.



Next Peak Left: Moves the active marker to the highest peak to the left of its current position.



Min Search: Moves the active marker to the lowest peak of the trace.



Always Peak: When the Always Peak is set to On, the instrument moves the active marker
automatically to the highest peak of the trace every time the trace is refreshed.
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Using Spectrum Analyzer
This chapter provides instructions for using the Spectrum Analyzer function. Topics discussed in this
chapter are as follows:
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Introduction
The advantage of using the Spectrum Analyzer is easy to verify the presence of unwanted signals
such as spurious and harmonics, which are normally very hard to identify in time domain analysis.
Performance assurance in wireless communication systems includes the observation of the out-ofband signal characteristics in order to identify the presence of harmonic signals. Harmonic signals of a
carrier may interfere with other signals far out of the transmission band, or harmonic signals from other
transmitter may interfere with in band signals affecting the spectral integrity.
In these days when wide variety of wireless communication services are provided in frequency bands
assigned very closely to each other, it is critical to ensure that each communication service is carried
out within their assigned frequency band minimizing interference with adjacent frequency bands. The
Adjacent Channel Power Ratio (ACPR) characteristic of a power amplifier or other RF components is
an important factor in evaluating the system performance.
The JD780A series is the optimal solution to perform following measurements:


Spectrum Analysis
Spectrum



RF Analysis
Channel Power
Occupied Bandwidth
Spectrum Emission Mask
Adjacent Channel Power (ACP)
Multi-ACP
Spurious Emissions
AM/FM Audio Demodulation
Field Strength
Route Map
Dual Spectrum
PIM Detection (Single and Multiple Carriers)

Display overview
Figure 4 provides overview of each segment of the measurement screen.
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Figure 4

Spectrum measurement screen

Connecting a cable
There are two ways that you can make a connection of your instrument and the base station to be
tested: direct or indirect.
Procedure
To make a direct connection:

1. Connect the Spectrum Analyzer RF In port of the JD780A series and the PA output port of BTS
as shown in Figure 5.
To make an indirect connection:

1. Connect the Spectrum Analyzer RF In port of the JD780A series and the monitor (test) port of
BTS as shown in Figure 6.

Figure 5

Direct connection

JD785A/JD786A

JD788A
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Figure 6

Indirect connection

JD785A/JD786A

JD788A

CAUTION
The maximum power for the Spectrum Analyzer RF In port is +25 dBm (0.316 W). If the
input signal level to be measured is greater than +25 dBm, use a High Power
Attenuator to prevent damage when you directly connect the signal to the instrument or
connect the signal from the coupling port of a directional coupler.

Selecting measurement mode
Procedure

1. Press the MODE hard key.
2. Press the Spectrum Analyzer soft key. The Measure Off mode is selected by default.
3. To select a measurement mode, press the MEASURE hot key and then select the measurement
mode:

–

Channel Power

–

Occupied BW

–

Spectrum Emission Mask

–

Adjacent Channel Power

–

Multi-ACP

–

Spurious Emissions

–

AM/FM Audio Demod

–

Field Strength

–

Route Map

–

Dual Spectrum

–

PIM Detection > Single Carrier or Multiple Carrier

Configuring test parameters
Setting frequency
You need to set the frequency range to be measured either with the center frequency and span or with
the start and stop frequencies. You can also set the frequency with the channel number and span.
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Procedure
To set the center frequency and span:

1. Press the FREQ/DIST hard key.
2. Toggle the Unit soft key and select Freq.
3. Press the Center Frequency soft key.
4. Enter a value by using the numeric keys. You can also use the rotary knob or the arrow keys.
5. Select the unit: GHz, MHz, kHz, or Hz.
6. Press the Span soft key, and then do one of the following:
–

To set the span manually, select Span, enter a value, and then select the unit.

–

To set the span automatically, select Full Span, Zero Span, or Last Span as needed.
NOTE
The Zero Span option is available only in the Spectrum mode. If you have selected Zero
Span, select TRIGGER > Free Run, External, GPS, Video, or Display Position.

To set the start and stop frequencies:

1. Press the FREQ/DIST hard key.
2. Toggle the Unit soft key and select Freq.
3. Press the Start Frequency soft key.
4. Enter a value by using the numeric keys. You can also use the rotary knob or the arrow keys.
5. Select the unit: GHz, MHz, kHz, or Hz.
6. Press the Stop Frequency soft key.
7. Enter a value by using the numeric keys. You can also use the rotary knob or the arrow keys.
8. Select the unit: GHz, MHz, kHz, or Hz.
To set the channel number and span:

1. Press the FREQ/DIST hard key.
2. Toggle the Unit soft key and select Channel.
3. To select the standard channel, complete the following steps:
a.

Press the Channel Std soft key. The standard channel window appears.
See “Appendix C – Band, frequency & channel standard” on page 541 for more information.

b.

Select the band to be measured by using the rotary knob, the arrow keys, or the Page
Up/Page Down soft keys.

c.

Press the Select soft key or the rotary knob to confirm the selection.

4. Toggle the Link soft key to select the sweep direction and select Fwd for forward or Rev for
reverse.

5. To set the channel number, complete the following steps:
a.

Press the Channel Number soft key.

b.

Enter a value by using the numeric keys.

c.

Press the Enter soft key or ENTER hard key to complete the entry.
The instrument automatically displays the corresponding center frequency value for the
selected channel number.

6. To set the span, complete the following steps:
a.

Press the Span soft key.
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b.

Select the span option, from the following choices:

–

To set the span manually, select Span, enter a value, and then select the unit.

–

To set the span automatically, select Full Span, Zero Span, or Last Span as needed.

NOTE
The Zero Span option is available only in the Spectrum mode. If you have selected Zero
Span, select TRIGGER > Free Run, External, GPS, Video, or Display Position.
Optional. To define the amount of frequency increment for the rotary knob:

1. Press the Frequency Step soft key, if the Freq is selected.
2. Enter a value by using the numeric keys.
3. Press the unit: GHz, MHz, kHz, or Hz.
Optional. To define the amount of channel increment for the rotary knob:

1. Press the Channel Step soft key, if the Channel is selected.
2. Enter a value by using the numeric keys.
3. Press the Enter soft key.
NOTE
This setting is not used in the Spurious Emissions mode.

Setting amplitude
Reference level and attenuation
You can set the reference and attenuation levels automatically or manually to optimize the display of
the traces measured, as you desire.
Procedure
To automatically set the reference and attenuation level:

1. Press the AMP/SCALE hard key.
2. Press the Auto Scale soft key.
Each time you press this key, both of the Y-axis scale and input attenuation level change to be
optimized with some margin.
To set the reference or attenuation level manually:

1. Press the AMP/SCALE hard key.
2. To set the maximum reference level on the Y-axis manually, complete the following steps:
a.

Press the Reference Level soft key.

b.

Enter a value by using the numeric keys or the rotary knob with 10 dB increments.

c.

Press the dBm soft key or the ENTER hard key.

3. To set the attenuation option, select one from the following choices:
–

To set the input attenuator’s level automatically, select Attenuation > Auto.
NOTE
It is recommended that you set the Attenuation to Auto in most situations so that the
level of the input attenuator can be set automatically according to your input signal level.

–
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To set the input attenuation manually up to 55 dB to optimize S/N, complete the following
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steps:

–

a.

Select Attenuation > Manual.

b.

Press the Attenuation Value soft key to set the level.

c.

Enter a value between 0 and 55 in fives by using the numeric keys.

d.

Press the dB soft key or the ENTER hard key.

To couple the input attenuator’s level with your reference level setting, select Attenuation >
Couple.
As you increse the reference setting, the attenuation level also increases acoordingly.

Optional. To change the scale unit:

1. Select More (1/2) > Units.
2. Select the unit of the display scale: dBm, dBV, dBmV, dBµV, V, or W.
The scale unit on the screen changes accordingly.
NOTE
For the Field Strength mode, the units change to dBµV/m, dBmV/m, dBV/m, Volt/m,
Watt/m^2, and dBm/m^2.

Pre-amplifier
You can turn the internal pre-amplifier on to correct and compensate for the gain of the preamplifier so
that amplitude readings show the value at the input connector.
Procedure

1. Press the AMP/SCALE hard key.
2. Toggle the Preamp soft key and select On or Off as needed.
NOTE
You can turn the Preamp on when the input attenuation range is from 0 dB to 10 dB. If
the attenuation value is manually set to greater than 10 dB, the instrument will
automatically turn off the pre-amplifier to display low-level signal properly on the chart.

External offset
You can turn the External Offset on and manually set the external offset value. An offset consists of a
cable loss and a user offset and the measurement result shows the value reflecting both offset values.
When the external offset value is set at 40 dB in the Spectrum mode, the measurement result
compensates 40 dB at both the Spectrum Analyzer and Signal Analyzer modes
Procedure
To set the external offset:

1. Press the AMP/SCALE hard key.
2. Toggle the External Offset soft key and select On.
3. Enter a value by using the numeric keys.
4. Press the dB soft key to complete the entry.
To turn the external offset off:

1. Press the AMP/SCALE hard key.
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2. Toggle the External Offset soft key and select Off.
NOTE
This setting is not used in the Field Strength mode.

Scale per division
You can use the Scale/Div feature available for the spectrum measurement screen. It represents the
value of one division on the horizontal scale. The default setting is 10 dB per division and the
maximum value can be set up to 20 dB.
Procedure
To set the scale per division:

1. Press the AMP/SCALE hard key.
2. Select More (1/2) > Scale/Div.
3. Enter a value between 1 and 20 by using the numeric keys.
4. Press the dB soft key to complete the entry.

Setting bandwidth
You can manually set the Resolution Bandwidth (RBW), Video Bandwidth (VBW), and the proportional
VBW based on the designated RBW. Selecting Auto changes the value to correspond to your
frequency span setting for RBW and to the current RBW and VBW/RBW settings for VBW.
Procedure
To automatically set the RBW and VBW to your selected VBW/RBW ratio:

1. Press the BW/AVG hard key.
2. Press the VBW/RBW soft key to set the proportional VBW based on the designated RBW.
Table 9 shows the ratio example for 30 kHz RBW.

3. Select the ratio: 1, 0.3, 0.1, 0.03, 0.01, or 0.003.
4. Toggle the RBW soft key and select Auto.
5. Toggle the VBW soft key and select Auto.
The RBW or VBW value on the screen changes accordingly based on the span.
To manually set the RBW or VBW to your selected VBW/RBW ratio:

1. Press the BW/AVG hard key.
2. Press the RBW soft key.
3. Enter a value between 1 Hz to 3 MHz in 1-3 sequence by using the numeric keys.
4. Select the unit: MHz, kHz, or Hz.
The RBW setting automatically changes to Manual.

5. Press the VBW soft key.
6. Enter a value by using the numeric keys.
7. Select the unit: MHz, kHz, or Hz.
The VBW setting automatically changes to Manual.
The RBW or VBW value on the screen changes accordingly.
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NOTE
This setting is not used in the Spurious Emissions mode.

Table 10

VBW/RBW ratio example

RBW

Ratio (VBW/RBW)

VBW

30 kHz

1:1

30 kHz

1:0.3

10 kHz

1:0.1

3 kHz

1:0.03

1 kHz

1:0.01

300 Hz

1:0.003

100 Hz

Setting average
You can set the number of measurements to be averaged for the trace presentation. A maximum of
100 times of averaging can be set. When the averaging reaches to your setting, a new measurement
value replaces the measurement value in sequence from the earliest.
Procedure

1. Press the BW/AVG hard key.
2. Press the Average soft key.
3. Enter a value between 1 and 100 as needed by using the numeric keys.
4. Press the Enter soft key.

Setting sweep
The SWEEP hot key is used to set and control the sweep time, sweep mode, gated sweep settings,
and gated sweep on or off.
Sweep time
You can set the sweep time automatically or manually. Manual setting allows you to set the sweep time
beyond an automatic setting.
Procedure

1. Press the SWEEP hot key.
2. Select the sweep time option, from the following choices:
–

To automatically set, toggle the Sweep Time soft key and select Auto.

–

To manually set, complete the following steps:
a.

Press the Sweep Time soft key.

b.

Enter a value by using the numeric keys.

c.

Select the unit: Sec, mSec, or µSec.
The sweep time mode automatically changes to Manual.
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NOTE
This setting is not used in the Spurious Emissions mode.

Sweep mode
The default settings of the sweep mode are Continue and Normal to sweep continuously at a normal
speed for most on-going measurements. If you want to hold the measurement or get a single sweep,
you can change the sweep mode.
Procedure
To select the single sweep mode:

1. Press the SWEEP hot key.
2. Toggle the Sweep Mode soft key and select Single. You can also use the HOLD hot key.
The letter HOLD in red appears and the sweeping is paused.

3. Optional. Press the Sweep Once soft key to get a new measurement.
4. Optional. To speed up sweeping, press the Sweep Mode soft key and then select Fast.
NOTE
Selecting Sweep Mode > Fast may reduce the measurement accuracy, but it is useful to
identify the existence of interfering signals.
To return to the continuous sweep mode:

1. Toggle the Sweep Mode soft key and select Continue. You can also use the HOLD hot key.
The letter HOLD in red disappears and the sweeping resumes.
NOTE
This setting is not used in the in the Field Strength mode, the AM/FM Audio Demodulation
mode, and the Route Map mode.

Gated sweep
You can configure the gated sweep settings with an internal or external trigger source. If you select
Gated Sweep Settings, you can view the signal in time domain.
Procedure

1. Press the SWEEP hot key.
2. Press the Gated Sweep Settings soft key.
3. Optional. Adjust sweep time to allow enough time for a cycle by completing the following steps:
a.

Press the Zero Span Time soft key.

b.

Enter a value by using the numeric keys.

c.

Select the unit: Sec, mSec, or µSec.

4. Set the period, if using the internal trigger source, by doing one of the following:
–

–
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To select the preset period, complete the following steps:
a.

Toggle the Period soft key and select StdSignal.

b.

Press the StdSignal soft key, and then select the period: GSM (4.615 ms), WCDMA
(10 ms), LTE (10 ms), EV-DO (5 ms), TD-SCDMA (5 ms), or WiMAX (10 ms).

To manually set the period, complete the following steps:
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a.

Toggle the Period soft key and select Manual.

b.

Press the Period soft key to enter the amount of time.

c.

Enter a value by using the numeric keys.

d.

Select the unit: Sec, mSec, or µSec.

5. Press the TRIGGER hot key, and then do one of the following:
–

Select External for an external trigger source.

–

Select Video or Display Position for the internal trigger source.

6. Press the PREV hard key to continue setting the gated sweep.
7. Set the gate delay by completing the following steps:
a.

Press the Gate Delay soft key.

b.

Enter a value by using the numeric keys.

c.

Select the unit: Sec, mSec, or µSec.

8. Set the gate length by completing the following steps:
a.

Press the Gate Length soft key.

b.

Enter a value by using the numeric keys.

c.

Select the unit: Sec, mSec, or µSec.

9. Press the PREV hard key to enable gated sweeping.
10. Toggle the Gated Sweep soft key and select On.
NOTE
This setting is not used in the in the Spurious Emissions mode, the Field Strength mode,
and the Route Map mode.

Using RF source
You can turn the RF Source feature on to provide different power levels as like using a CW signal
generator.
Procedure

1. Press the MEASURE SETUP hot key.
2. Press the RF Source soft key.
3. Press the Frequency soft key to set the frequency of the RF source.
4. Enter a value, and then select the unit: GHz, MHz, kHz, or Hz.
5. Press the Power Level soft key.
6. Enter a value between -60 and 0, and then select the dBm soft key.
7. Toggle the RF Source soft key and select On.

Conducting spectrum measurements
If you have configured test parameters as described in the “Configuring test parameters” on page 54,
your measurement is displayed on the screen as like the following example, Figure 7.
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Figure 7

Spectrum measurement with spectrum analyzer

Setting trace
You can display up to six traces on the measurement chart simultaneously.
Procedure

1. Press the TRACE/DISPLAY hard key.
2. Press the Select Trace soft key, and then select the trace number: T1, T2, T3, T4, T5, or T6.
The legend shape of the selected trace changes from square to round to indicate that the trace is
the active one now.

3. Toggle the Trace View soft key and select On.
4. To clear, write or capture, or hide the trace(s), do one of the following:
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To

Select

Trace Legend

Clear current data and display with new
measurements

Clear Write

W

Display the input signal’s maximum response only

Max Hold

M

Display the input signal’s minimum response only

Min Hold

m

Capture the selected trace and compare traces

Capture

C

Load a saved trace

More (1/2) > Load

L

Hide the selected trace

Trace View > Off

F

Remove all the traces and initialize the trace
settings

More (1/2) > Trace
Clear All

NOTE
For the Max Hold and Min Hold, the active trace compares newly acquired data with the
trace shown on the screen and displays larger or smaller trace on the screen.

5. To select the detection option, press the More (1/2) > Detectors, and then do one of the
following:
To display

Select

Random noise better than the peak without missing signals

Normal

The highest value in each data point

Peak

The root mean squared average power across the spectrum

RMS

The lowest value in each data point

Negative Peak

The center value in each data point

Sample

6. Optional. Press the More (1/2) > Trace Info soft key, and then select the trace number to view
the trace’s parameter setting information stored at the time of the measurement or None to hide
the information display.

7. Optional. If you have the two traces T1 and T2, you can perform trace math. To view the power
difference between the traces, press the T1 – T2 -> T5 or T2 – T1 -> T6 soft key.
The result is overlaid on the screen along with the second Y-axis.
NOTE
To be able to load a trace, the trace to be overlaid must be saved in the same
measurement mode and frequency setting as the current measurement.

Setting limit
Procedure
To use the display line:

1. Press the LIMIT hot key.
2. Press the Display Line soft key for a reference line.
3. Enter a value, and then press the dBm unit soft key.
4. Toggle the Display Line soft key between On and Off to display and dismiss the reference line.
The straight line appears across the screen to be used as a visual reference only.
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To display the multiple segment line:

1. Press the LIMIT hot key.
2. Press the Multi Segment Line soft key for Pass/Fail indication.
3. Toggle the Limit soft key between Upper and Lower to select the one to be displayed.
4. Set the number of segments for the selected upper or lower limit line. You can set up to 50
segments.
a.

Press the # of Line soft key.

b.

Enter a value between 1 and 50 by using the numeric keys.

c.

Press the Enter soft key.

5. Press the Autoset soft key to let the instrument set the limit for each segment and display the
line.

6. Optional. To move the limit line, complete the following steps:
a.

Select Limit Up/Down or Limit Left/Right.

b.

Turn the rotary knob to move the line as desired. You can also manually enter a value.

7. Optional. To edit the segment properties, complete the following steps:
a.

Press the Edit Limit soft key.

b.

Press the Move soft key and then turn the rotary knob to select the segment to edit.

c.

Select the menu option, from the following choices:

–

To hide the line for the selected segment, toggle the Line soft key and select Off.

–

To add a new point, press the Add Point soft key.

–

To delete the selected point, press the Delete Point soft key.

–

To change the position, press the Frequency or Amplitude soft key, and then turn the
rotary knob to change the value as desired.

8. Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings.
See “Using save” on page 31 for more information.

Conducting RF measurements
Channel power
The Channel Power measurement is a common test used in the wireless industry to measure the total
transmitted power of a radio within a defined frequency channel. It acquires a number of points
representing the input signal in the time domain, transforms this information into the frequency domain
using Fast Fourier Transform (FFT), and then calculates the channel power. The effective resolution
bandwidth of the frequency domain trace is proportional to the number of points acquired for the FFT.
The channel power measurement identifies the total RF power, power spectral density, and Peak to
Average Ratio (PAR) of the signal within the channel bandwidth.
Setting measure setup
After configuring test parameters, you can set the measure setup to continue your measurement. The
measurement settings can be saved and recalled as a file. You can also use JDViewer, PC application
software to configure a measure setup, save as a file, and load the file on to the instrument.
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Procedure

1. Configure test parameters as described in the “Configuring test parameters” on page 54.
2. Press the MEASURE SETUP hot key.
3. Set the channel power measurement bandwidth to be measured:
a.

Press the Integrated BW soft key.

b.

Enter a bandwidth by using the numeric keys. You can also use the rotary knob.

c.

Select the unit: GHz, MHz, kHz, or Hz.

4. Set the frequency range over which the instrument will sweep:
a.

Press the Span soft key.

b.

Enter a span frequency value by using the numeric keys. You can also use the rotary knob.

c.

Select the unit: GHz, MHz, kHz, or Hz.

5. Set the number of measurements to be averaged:
a.

Press the Average soft key.

b.

Enter a value between 1 and 100.

c.

Press the Enter soft key.

Setting limit
Procedure

1. Press the LIMIT hot key.
2. Press the Channel Power soft key to set the limit parameters.
3. Toggle the Test Limits soft key between On and Off to enable or disable the Pass/Fail
indication.

4. Set the upper threshold:
a.

Press the High Limit soft key.

b.

Enter a value for the upper limit.

c.

Press the dBm unit soft key.

5. Set the lower threshold:
a.

Press the Low Limit soft key.

b.

Enter a value for the lower limit.

c.

Press the dBm unit soft key.

6. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available
for your measurement mode. See “Using save” on page 31 for more information.
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Measurement example
Figure 8

Channel power measurement with spectrum analyzer

Channel power measurement result shows channel power and spectrum density in a user specified
channel bandwidth. The peak to average ratio (PAR) is shown at the bottom of the screen as well. The
shaded area on the display indicates the channel bandwidth.

Occupied bandwidth
The Occupied Bandwidth measures the percentage of the transmitted power within a specified
bandwidth. The percentage is typically 99%.
Setting measure setup
After configuring test parameters, you can set the measure setup to continue your measurement. The
measurement settings can be saved and recalled as a file. You can also use JDViewer, PC application
software to configure a measure setup, save as a file, and load the file on to the instrument.
Procedure

1. Configure test parameters as described in the “Configuring test parameters” on page 54.
2. Press the MEASURE SETUP hot key.
3. Set the percentage of power within the bandwidth to be measured:
a.

Press the Occupied BW % Power soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Press the Enter soft key.

4. Set the frequency range over which the instrument will sweep:
a.

Press the Span soft key.

b.

Enter a span frequency value by using the numeric keys. You can also use the rotary knob.

c.

Select the unit: GHz, MHz, kHz, or Hz.

5. Set the number of measurements to be averaged:
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a.

Press the Average soft key.

b.

Enter a value between 1 and 100.

c.

Press the Enter soft key.

Setting limit
Procedure

1. Press the LIMIT hot key.
2. Press the Occupied BW soft key to set the limit parameters.
3. Toggle the Test Limits soft key between On and Off to enable or disable the Pass/Fail indication.
4. Set the upper threshold:
a.

Press the High Limit soft key.

b.

Enter a value for the upper limit.

c.

Select the unit: MHz, kHz, or Hz.

5. Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings.
See “Using save” on page 31 for more information.

Measurement example
The Occupied Bandwidth measurement shows both of power across the band and power bandwidth in
a user specified percentage to determine the amount of spectrum used by a modulated signal.
Occupied bandwidth is typically calculated as the bandwidth containing 99% of the transmitted power.
Figure 9

Occupied bandwidth measurement with spectrum analyzer

Spectrum emission mask (SEM)
The Spectrum Emission Mask (SEM) measurement is to identify and determine the power level of outof-band spurious emission outside the necessary channel bandwidth and modulated signal. It
measures the power ratio between in-band and adjacent channels. The JD780A series indicates either
Pass or Fail based on the specified limit of the signal.
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Setting measure setup
After configuring test parameters, you can set the measure setup to continue your measurement. The
measurement settings can be saved and recalled as a file. You can also use JDViewer, PC application
software to configure a measure setup, save as a file, and load the file on to the instrument.
Procedure

1. Configure test parameters as described in the “Configuring test parameters” on page 54.
2. Press the MEASURE SETUP hot key.
3. Set the main channel bandwidth to be measured:
a.

Press the Main Channel BW soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Select the unit: MHz, kHz, or Hz.

4. Set the frequency range over which the instrument will sweep:
a.

Press the Span soft key.

b.

Enter a span frequency value by using the numeric keys. You can also use the rotary knob.

c.

Select the unit: GHz, MHz, kHz, or Hz.

5. Set the number of measurements to be averaged:
a.

Press the Average soft key.

b.

Enter a value between 1 and 100.

c.

Press the Enter soft key.

6. To configure an offset, up to five, complete the following steps:
a.

Press the Offset/Limit soft key.
The Offset/Limit screen menu bar appears.

b.

Press the Offset soft key, and then select the number for the active offset to configure.

c.

Toggle the Offset soft key and select On to display or Off to hide the active offset.

d.

Press the Offset Frequency soft key to set the center frequency of the offset.

e.

Enter a value by using the numeric keys. You can also use the rotary knob.

f.

Select the unit: MHz, kHz, or Hz.

g.

Press the Measurement Bandwidth soft key to set the bandwidth for the selected offset.

h.

Enter a value by using the numeric keys. You can also use the rotary knob.

i.

Select the unit: MHz, kHz, or Hz.

j.

Toggle the Reference soft key between Relative and Absolute and select Relative or
Absolute depending on how to use the reference.

7. To define the selected offset’s limits for Pass/Fail indication, complete the following steps:
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a.

Press the Start Offset Limit soft key to set the threshold for the power difference between
the main channel bandwidth and the selected offset bandwidth on the left.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Select the dB soft key.

d.

Press the Stop Offset Limit soft key to set the threshold for the power difference between
the main channel bandwidth and the selected offset bandwidth on the right.

e.

Enter a value by using the numeric keys. You can also use the rotary knob.

f.

Select the dB soft key.
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Setting limit
Procedure

1. Press the LIMIT hot key.
2. Press the Spectrum Emission Mask soft key.
3. Toggle the Test Limits soft key between On and Off to enable or disable the Pass/Fail
indication.

4. Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings.
See “Using save” on page 31 for more information.

Measurement example
Figure 10

Spectrum emission mask measurement with spectrum analyzer

Adjacent channel power (ACP)
The Adjacent Channel Power (ACP) is the power contained in a specified frequency channel
bandwidth relative to the total carrier power. It may also be expressed as a ratio of power spectral
densities between the carrier and the specified offset frequency band.
Setting measure setup
After configuring test parameters, you can set the measure setup to continue your measurement. The
measurement settings can be saved and recalled as a file. You can also use JDViewer, PC application
software to configure a measure setup, save as a file, and load the file on to the instrument.
Procedure

1. Configure test parameters as described in the “Configuring test parameters” on page 54.
2. Press the MEASURE SETUP hot key.
3. Set the main channel bandwidth to be measured:
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a.

Press the Main Channel BW soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Select the unit: MHz, kHz, or Hz.

4. Set the frequency range over which the instrument will sweep:
a.

Press the Span soft key.

b.

Enter a span frequency value by using the numeric keys. You can also use the rotary knob.

c.

Select the unit: GHz, MHz, kHz, or Hz.

5. Set the number of measurements to be averaged:
a.

Press the Average soft key.

b.

Enter a value between 1 and 100.

c.

Press the Enter soft key.

6. To configure an offset, up to five, complete the following steps:
a.

Press the Offset/Limit soft key.
The Offset/Limit screen menu bar appears.

b.

Press the Offset soft key, and then select the number for the active offset to configure.

c.

Toggle the Offset soft key and select On to display or Off to hide the active offset.

d.

Press the Offset Frequency soft key to set the center frequency of the offset.

e.

Enter a value by using the numeric keys. You can also use the rotary knob.

f.

Select the unit: MHz, kHz, or Hz.

g.

Press the Integration Bandwidth soft key to set the bandwidth for the selected offset.

h.

Enter a value by using the numeric keys. You can also use the rotary knob.

i.

Select the unit: MHz, kHz, or Hz.

7. To define the selected offset’s limits for Pass/Fail indication, complete the following steps:
a.

Press the Lower soft key to set the threshold for the power difference between the main
channel bandwidth and the selected offset bandwidth on the left.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Select the dBc soft key.

d.

Press the Upper soft key to set the threshold for the power difference between the main
channel bandwidth and the selected offset bandwidth on the right.

e.

Enter a value by using the numeric keys. You can also use the rotary knob.

f.

Select the dBc soft key.

Setting limit
Procedure

1. Press the LIMIT hot key.
2. Press the ACP soft key.
3. Toggle the Test Limits soft key between On and Off to enable or disable the Pass/Fail
indication.

4. Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings.
See “Using save” on page 31 for more information.
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Measurement example
Figure 11

Adjacent channel power measurement with spectrum analyzer

Multi-ACP
The Multi-ACP measurement is used to do multi-channel ACP testing. It helps you to measure ACP in
multi-channel transmitting base station environment.
Setting measure setup
After configuring test parameters as described in “Configuring test parameters” on page 54, you can
set the measure setup to continue your measurement. The measurement settings can be saved and
recalled as a file. You can also use JDViewer, PC application software to configure a measure setup,
save as a file, and load the file on to the instrument.
Procedure

1. Press the MEASURE SETUP hot key.
2. Toggle the Unit soft key and select Freq or Channel.
–

–

For the frequency setting, complete the following steps:
a.

Press the Lowest Frequency soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Select the unit: GHz, MHz, kHz, or Hz.

d.

Press the Highest Frequency soft key.

e.

Enter a value by using the numeric keys. You can also use the rotary knob.

f.

Select the unit: GHz, MHz, kHz, or Hz.

For the channel setting, complete the following steps:
a.

Press the Channel Std soft key. The standard channel window appears.

b.

Select the band to be measured by using the rotary knob or the Page p/Page Down
soft keys.

c.

Press the Select soft key or the rotary knob to confirm the selection.
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d.

Toggle the Link soft key to select the sweep direction and select Fwd or Rev as
needed.

e.

Press the Lowest Channel soft key.

f.

Enter a value by using the numeric keys.

g.

Press the Enter soft key or ENTER hard key to complete the entry.
The instrument automatically displays the corresponding center frequency value for the
selected channel number.

h.

Press the Highest Channel soft key.

i.

Enter a value by using the numeric keys.

j.

Press the Enter soft key or ENTER hard key to complete the entry.
The instrument automatically displays the corresponding center frequency value for the
selected channel number.

3. To set up ACP setting, press the ACP Settings soft key and then complete the following steps:
a.

Press the Main Channel BW soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Select the unit: MHz, kHz, or Hz.

d.

Press the Span soft key to set the frequency range over which the instrument will sweep.

e.

Enter a span frequency value by using the numeric keys. You can also use the rotary knob.

f.

Select the unit: GHz, MHz, kHz, or Hz.

g.

Press the Average soft key to set the number of measurement to be averaged:

h.

Enter a value between 1 and 100.

i.

Press the Enter soft key.

4. To configure an offset, up to five, complete the following steps:
a.

Press the Offset/Limit soft key. The Offset/Limit screen menu bar appears.

b.

Press the Offset soft key, and then select the number for the active offset to configure.

c.

Toggle the Offset soft key and select On to display or Off to hide the active offset.

d.

Press the Offset Frequency soft key to set the offset frequency.

e.

Enter a value by using the numeric keys. You can also use the rotary knob.

f.

Select the unit: MHz, kHz, or Hz.

g.

Press the Integration Bandwidth soft key.

h.

Enter a value by using the numeric keys. You can also use the rotary knob.

i.

Select the unit: MHz, kHz, or Hz.

5. To define the selected offset’s limits for Pass/Fail indication, complete the following steps:
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a.

Press the Lower soft key to set the threshold for the power difference between the main
channel bandwidth and the selected offset bandwidth on the left.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Select the dBc soft key.

d.

Press the Upper soft key to set the threshold for the power difference between the main
channel bandwidth and the selected offset bandwidth on the right.

e.

Enter a value by using the numeric keys. You can also use the rotary knob.

f.

Select the dBc soft key.
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Setting limit
Procedure

1. Press the LIMIT hot key.
2. Press the Multi-ACP soft key.
3. Toggle the Test Limits soft key between On and Off to enable or disable the Pass/Fail indication.
4. Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings.
See “Using save” on page 31 for more information.

Measurement example
Figure 12

Multi-ACP measurement with spectrum analyzer

Spurious emissions
The Spurious Emissions measurement is to identify or determine the power level of in-band or out-ofband spurious emissions within the necessary channel bandwidth and modulated signal. The JD780A
series indicates either Pass or Fail based on the specified limit of the signal.
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 54, you
can set the measure setup to continue your measurement. The measurement settings can be saved
and recalled as a file. You can also use JDViewer, PC application software to configure a measure
setup, save as a file, and load the file on to the instrument.
Procedure

1. Press the MEASURE SETUP hot key.
2. To set up the range table, complete the following steps:
a.

Press the Range Table soft key.

b.

Press the Range soft key, and then enter the range number to add a new range or change
an existing one.
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c.

Press the Enter soft key.

d.

Press the Start Frequency soft key to set up the frequency range.

e.

Enter a value by using the numeric keys. You can also use the rotary knob.

f.

Select the unit: GHz, MHz, kHz, or Hz.

g.

Press the Stop Frequency soft key to set up the frequency range.

h.

Enter a value by using the numeric keys. You can also use the rotary knob.

i.

Select the unit: GHz, MHz, kHz, or Hz.

3. Toggle the Range soft key between On and Off to display or hide the selected range.
4. To set up the test limits for Pass/Fail indication, complete the following steps:
a.

Press the Start Limit soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Select the dBm soft key.

d.

Press the Stop Limit soft key.

e.

Enter a value by using the numeric keys. You can also use the rotary knob.

f.

Select the dBm soft key.

5. To set up the other parameters, complete the following steps:
a.

Select More (1/2) > Attenuation to set up the attenuation value.

b.

Enter a value in the multiple of five.

c.

Press the dB soft key or the ENTER hard key.

d.

Press the RBW soft key.

e.

Enter a value by using the numeric keys.

f.

Select the unit: GHz, MHz, kHz, or Hz.

g.

Press the VBW soft key.

h.

Enter a value by using the numeric keys.

i.

Select the unit: GHz, MHz, kHz, or Hz.

6. Toggle the Measure Type soft key between Examine and Full to select the measurement type.
NOTE
The Examine mode displays only the selected range while the Full mode lets the
instrument automatically changes the selected range from one another.

7. Set the number of measurements to be averaged:
a.

Press the Average soft key.

b.

Enter a value between 1 and 100.

c.

Press the Enter soft key.

Setting limit
Procedure

1. Press the LIMIT hot key.
2. Press the Spurious Emissions soft key.
3. Toggle the Test Limits soft key between On and Off to enable or disable the Pass/Fail indication.
4. Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings.
See “Using save” on page 31 for more information.
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Measurement example
Figure 13

Spurious emissions measurement with spectrum analyzer

AM/FM audio demodulation
The AM/FM Audio Demodulator operates using the power received from radio waves and it serves as
an alternative to identify interfering signals easily. The instrument sounds demodulated signals that
can be heard through the built-in speaker or plugged-in headphones. You can hear the sound and
identify interfering signals easily.
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 54, you
can set the measure setup to continue your measurement. The measurement settings can be saved
and recalled as a file. You can also use JDViewer, PC application software to configure a measure
setup, save as a file, and load the file on to the instrument.
Procedure

1. Press the MEASURE SETUP hot key.
2. Toggle the Audio Demod soft key between On and Off to turn the AM/FM audio demodulation
on and off.

3. Press the Demod at soft key, and then select the marker number for the frequency to be
demodulated.
NOTE
You must set the marker(s) first by using the MARKER hard key as the AM/FM
demodulator uses the marker position to demodulate. See “Using marker” on page 49 for
more information.

4. Press the Demod Mode soft key, and then select the demodulation mode: AM, FM and CW.
5. Press the Dwell Time soft key, and then turn the rotary knob to set the demodulation interval
between 1 and 20.

6. Press the Volume soft key, and then turn the rotary knob to set the speaker volume.
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7. Toggle the Auto Gain soft key between On and Off to enable or disable the automatic gain
feature to adjust the interval gain of the demodulator.

8. Optional. You can use the Save On Event soft key to let the instrument automatically save
measurement screen or result that falls outside the defined limit settings or the Fail indicator is
on. You can also set to save the first event and hold the measurement or to save all the events
continuously. See “Using save” on page 31 for more information.

Setting limit
You can show or hide the display line on the screen that is used as a visual reference only.
Procedure
To view the display line:

1. Press the LIMIT hot key.
2. Press the Display Line soft key.
3. Enter a value, and then press the dBm unit soft key.
4. Toggle the Display Line On/Off soft key and select On.
The straight line appears on the screen.
To dismiss the display line:

1. Press the LIMIT hot key.
2. Toggle the Display Line On/Off soft key and select Off.
You can use the multiple segment limit line to set up different limits for different frequency ranges for
Pass/Fail indication.
Procedure
To display the multiple segment line:

1. Press the LIMIT hot key.
2. Press the Multi Segment Line soft key.
3. Toggle the Limit soft key between Upper and Lower to select the one to be displayed.
4. Set the number of segments for the selected upper or lower limit line. You can set up to 50
segments.
a.

Press the # of Line soft key.

b.

Enter a value between 1 and 50 by using the numeric keys.

c.

Press the Enter soft key.

5. Press the Autoset soft key to let the instrument set the limit for each segment and display the
line.

6. Optional. To move the limit line, complete the following steps:
a.

Select Limit Up/Down or Limit Left/Right.

b.

Turn the rotary knob to move the line as desired. You can also manually enter a value.

7. Optional. To edit the segment properties, complete the following steps:
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a.

Press the Edit Limit soft key.

b.

Press the Move soft key and then turn the rotary knob to select the segment to edit.

c.

Select the menu option, from the following choices:
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–

To hide the line for the selected segment, toggle the Line soft key and select Off.

–

To add a new point, press the Add Point soft key.

–

To delete the selected point, press the Delete Point soft key.

–

To change the position, press the Frequency or Amplitude soft key, and then turn the
rotary knob to change the value as desired.

8. Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings.
See “Using save” on page 31 for more information.

Measurement example
Figure 14

AM/FM audio demodulation with spectrum analyzer

Field strength meter
The Field Strength Meter measures the field strength over the frequency range of a connected
antenna, which is known with its specific bandwidth and gain characteristics. A standard or userdefined antenna can be selected from the antenna list in the JD780A series.
Setting measure setup
Procedure

1. Connect an antenna to be used with your instrument.
2. Configure test parameters as described in the “Configuring test parameters” on page 54.
3. Press the MEASURE SETUP hot key, and then do one of the following:
–

To select the connected antenna from the list stored in the instrument:
a.

Press the Antenna List soft key to view the standard and custom antennas.
The antenna list window appears.

b.

Select an antenna to be used for the field strength measurement by using the rotary
knob, the arrow keys, or Page Up/Page Down soft keys.

c.

Press the Select soft key.
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NOTE
You can use the JDViewer to edit or define a custom antenna and add to this list.

–

To edit the properties of the connected antenna:
a.

Press the Antenna Start Frequency soft key.

b.

Enter a value by using the numeric keys, and then select the unit: GHz, MHz, kHz, or
Hz. You can also use the rotary knob.

c.

Press the Antenna Stop Frequency soft key.

d.

Enter a value by using the numeric keys, and then select the unit: GHz, MHz, kHz, or
Hz. You can also use the rotary knob.

e.

Press the Gain soft key to enter the gain information for the antenna.

f.

Enter a value by using the numeric keys, and then select the Enter soft key.

Setting limit
You can show or hide the display line on the screen that is used as a visual reference only.
Procedure
To view the display line:

1. Press the LIMIT hot key.
2. Press the Display Line soft key.
3. Enter a value, and then press the dBm unit soft key.
4. Toggle the Display Line On/Off soft key and select On.
The straight line appears on the screen.
To dismiss the display line:

1. Press the LIMIT hot key.
2. Toggle the Display Line On/Off soft key and select Off.
You can use the multiple segment limit line to set up different limits for different frequency ranges for
Pass/Fail indication.
Procedure
To display the multiple segment line:

1. Press the LIMIT hot key.
2. Press the Multi Segment Line soft key.
3. Toggle the Limit soft key between Upper and Lower to select the one to be displayed.
4. Set the number of segments for the selected upper or lower limit line. You can set up to 50
segments.
a.

Press the # of Line soft key.

b.

Enter a value between 1 and 50 by using the numeric keys.

c.

Press the Enter soft key.

5. Press the Autoset soft key to set and display the limit line for each segment automatically..
6. Optional. To move the limit line, complete the following steps:
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a.

Select Limit Up/Down or Limit Left/Right.

b.

Turn the rotary knob to move the line as desired. You can also manually enter a value.
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7. Optional. To edit the segment properties, complete the following steps:
a.

Press the Edit Limit soft key.

b.

Press the Move soft key and then turn the rotary knob to select the segment to edit.

c.

Select the menu option, from the following choices:

–

To hide the line for the selected segment, toggle the Line soft key and select Off.

–

To add a new point, press the Add Point soft key.

–

To delete the selected point, press the Delete Point soft key.

–

To change the position, press the Frequency or Amplitude soft key, and then turn the
rotary knob to change the value as desired.

8. Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings.
See “Using save” on page 31 for more information.

Measurement example
Figure 15

Field strength measurement with spectrum analyzer

Route map
The JD780A Series provides indoor and outdoor mapping function that allows a user to collect data of
points in an indoor or outdoor environment and track the received signals and coverage of RF
transmitters plotting real time directly on top of a loaded floor plan or a map.
Setting measure setup
Procedure

1. If required, connect a GPS receiver to your JD780A series for outdoor mapping.
Indoor mapping does not necessarily need a GPS antenna.

2. Configure test parameters as described in the “Configuring test parameters” on page 54.
3. To load your map file, complete the following steps:
a.

Plug in your USB drive that has a floor map or .mcf file type created in JDMapCreator.
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NOTE
The JDMapCreator converts and resizes any scanned floor plan or layout to fit onto your
instrument’s display. You must save your map files (.mcf) into the “SavedMap” folder of
your USB drive so that you can load them onto your instrument.
b.

Press SAVE/LOAD hot key, and then select Load > Load Map. See “Using load” on page
34 for more information.

4. Press the MEASURE SETUP hot key.
5. Press the Plot Point soft key, and then select the plot point option from the following choices:
–

To collect data/plot points automatically as you move around in a vehicle or outside, select
GPS and then toggle the Screen Mode soft key between Map and Full.
NOTE
With the Map setting, you can view only the collected points that can be seen within the
boundary of the loaded map. If a point is off the map, the instrument displays an arrow to
indicate the direction of the current location on the map and the distance from the center
to the location at the top of the screen.
With the Full setting, you can view all the collected points of the route without the loaded
map.

–

To collect data/plot points manually without a GPS antenna, select Position.

–

To collect data/plot points based on time, select Time.
You do not need a GPS antenna as you would usually use this option indoor.

6. Press the Plot Item soft key, and then select the measurement option: RSSI or ACP.
7. Optional. If ACP is selected, set the Main Channel BW and Offset/Limit :
a.

Press the Main Channel BW soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Select the unit: MHz, kHz, or Hz.

d.

Press the Offset/Limit soft key.

e.

Toggle the Offset soft key and select On to display or Off to hide the offset.

f.

Press the Integration Bandwidth soft key.

g.

Enter a value by using the numeric keys. You can also use the rotary knob.

h.

Select the unit: MHz, kHz, or Hz.

i.

Press the Offset Frequency soft key to set the offset frequency.

j.

Enter a value by using the numeric keys. You can also use the rotary knob.

k.

Select the unit: MHz, kHz, or Hz.

l.

Press the Offset Limit soft key to set the offset limit.

m. Enter a value by using the numeric keys. You can also use the rotary knob.
n.

Select the dB soft key.

8. Toggle the Plot soft key and select Start.
9. Touch directly on the screen or press the ENTER hard key to collect data and plot points on the
loaded map for the Position or Time setting.
NOTE
For the Position setting, you can change the direction of the route with screen touch or
the arrow keys and the distance with the rotary knob. For the Time setting, the instrument
interpolates points in between two enters on a straight dotted line. You can change the
direction of the route with the arrow keys and the distance with the rotary knob.

10. Toggle the Plot soft key and select Stop to stop plotting.
11. Press the SAVE/LOAD hot key to save the result. See “Using save” on page 31 for more
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information.
NOTE
The instrument does not automatically save the collected data. It is recommended that
you save the result. Otherwise, you will lose all the collected data.

Setting limit
You can set the thresholds for the four different color indicators.
Procedure

1. Press the LIMIT hot key.
2. Press the Excellent soft key to set its threshold.
3. Enter a value, and then press the dBm soft key. You can also use the rotary knob.
4. Press the Very Good soft key to set its threshold.
5. Enter a value, and then press the dBm soft key. You can also use the rotary knob.
6. Press the Good soft key to set its threshold.
7. Enter a value, and then press the dBm soft key. You can also use the rotary knob.
8. Press the Poor soft key to set its threshold.
9. Enter a value, and then press the dBm soft key. You can also use the rotary knob.
10. Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings.
See “Using save” on page 31 for more information.

Measurement example
Figure 16

Route map measurement screen with GPS

Dual spectrum
The Dual Spectrum feature lets you view two spectrum measurements, both the Uplink and Downlink
spectrum, simultaneously eliminating the need to swap between two screens back and forth.
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Setting measure setup
Procedure

1. Configure test parameters as described in the “Configuring test parameters” on page 54.
2. Press the MEASURE SETUP hot key.
3. Toggle the Active Window soft key between Top and Bottom to select the measurement
window to configure or work on.

Measurement example
Figure 17

Dual spectrum measurement with spectrum analyzer

PIM detection (single and multiple carriers)
The Passive Intermodulation (PIM) Detection allows you to detect Uplink PIM across the full spectrum
for any technology. When PIM is detected, the normal repair mode is to replace the offending cable
and what you need to do is replacing the whole cable irrespective of the location of the fault.
Setting measure setup
Procedure

1. Press the MEASURE SETUP hot key.
2. Connect cables as instructed on the screen.
3. Optional. To check any possibility of PIM existence in red color by calculation, complete the
following steps:
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a.

Press the Calculated PIM soft key.

b.

Press the Radio Band soft key for single carrier.
There are Radio 1 Band and Radio 2 Band soft keys for multiple carriers.

c.

Highlight a desired band and then press the Select soft key.

d.

Press the Return soft key.
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4. To set the uplink frequency to be measured, do one of the following:
–

–

To set the center frequency and span, complete the following steps:
a.

Toggle the Unit soft key and select Freq.

b.

Press the Uplink Center Frequency soft key.

c.

Enter a value by using the numeric keys. You can also use the rotary knob.

d.

Select the unit: GHz, MHz, kHz, or Hz.

e.

Press the Uplink Span soft key.

f.

Enter a value by using the numeric keys. You can also use the rotary knob.

g.

Select the unit: GHz, MHz, kHz, or Hz.

To set the channel number and span, complete the following steps:
a.

Toggle the Unit soft key and select Channel.

b.

Press the Channel Std soft key and select a desired band.

c.

Press the Channel Number soft key.

d.

Enter a value by using the numeric keys and then press the Enter soft key.
The instrument automatically displays the corresponding center frequency value for the
selected channel number.

e.

Press the Uplink Span soft key.

f.

Enter a value by using the numeric keys. You can also use the rotary knob.

g.

Select the unit: GHz, MHz, kHz, or Hz.

5. Press the Continue soft key and follow the instructions on the screen.
Measurement example
Figure 18

PIM detection for single carrier
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Figure 19

84

PIM detection for multiple carriers
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Using Interference Analyzer
This chapter provides instructions for using the Interference Analyzer function (option 011). Topics
discussed in this chapter are as follows:


Introduction ................................................................................................................................86



Display overview ........................................................................................................................86



Connecting a cable ....................................................................................................................87



Selecting measurement mode ...................................................................................................88



Configuring test parameters ......................................................................................................88



Conducting spectrum measurements ........................................................................................94



Conducting interference measurements ...................................................................................96



Setting limit for interference analyzer ......................................................................................103
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Introduction
Interference is becoming more prevalent in the wireless community with the increasing number of
transmitters coming on the air. Wireless service providers have traditionally used spectrum analyzers
to monitor service channels, frequencies, and adjacent spectrum and to locate sources of interference.
A spectrum analyzer can only show you an interfering signal and you require determining the source of
the interference. To solve interference problems, you must understand the RF environment, know
adjacent operating transmitters, and identify any new or unlicensed emitters.
Once a potential interfering signal is identified in the Spectrum Analyzer mode, you can monitor the
signal further in the Interference Analyzer mode. JD780A series provides two different methodologies
to identify and determine interference signals: Spectrogram and Received Signal Strength Indicator
(RSSI). Locating the source of interference signal can be done with geographical information received
from built-in GPS receiver.
The JD780A series is extremely effective for locating and identifying periodic or intermittent RF
interference. Interference signals derive from several kinds of licensed or unlicensed transmitters that
cause dropped calls and poor service quality.
The JD780A series provides following measurements for interference analysis:


Spectrum



Spectrogram (Single/Dual)



RSSI (Received Signal Strength Indicator)



Interference Finder



Spectrum Replayer

Display overview
Figure 20 provides descriptions for each segment of the measurement screen.
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Figure 20

Interference measurement screen

Connecting a cable
Procedure

1. Connect an Omni/directional RF antenna to the Spectrum Analyzer RF In port of the JD780A
series.

2. Connect a GPS antenna to the GPS port of the JD780A series.
Figure 21

Interference measurement connection

JD788A

JD785A/JD786A

CAUTION
If the input signal level to be measured is less than 0 dBm, set it to 0 dB attenuation or
turn on the preamp to have better dynamic range for the testing.
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Selecting measurement mode
Procedure

1. Press the MODE hard key.
2. Press the Interference Analyzer soft key. The Spectrum mode is selected by default.
3. To change the mode, press the MEASURE hot key and then select the measurement mode:
Spectrogram, Dual Spectrogram, RSSI, Interference Finder, or Spectrum Replayer.
NOTE
If the Dual Spectrogram is selected, you can select the left or right measurement pane
under MEASURE SETUP to configure measurement parameters for the selected
spectrogram.

Configuring test parameters
Setting frequency
You need to set the frequency range to be measured either with the center frequency and span or with
the start and stop frequencies. You can also set the frequency with the channel number and span.
Procedure
To set the center frequency and span:

1. Press the FREQ/DIST hard key.
2. Toggle the Unit soft key and select Freq.
3. Press the Center Frequency soft key.
4. Enter a value by using the numeric keys. You can also use the rotary knob or the arrow keys.
5. Select the unit: GHz, MHz, kHz, or Hz.
6. Press the Span soft key, and then do one of the following:
–

To set the span manually, select Span, enter a value, and then select the unit.

–

To set the span automatically, select Full Span, Zero Span, or Last Span as needed.
NOTE
The Zero Span option is available only in the Spectrum mode. If you have selected Zero
Span, select TRIGGER > Free Run, External, GPS, Video, or Display Position.

To set the start and stop frequencies:

1. Press the FREQ/DIST hard key.
2. Toggle the Unit soft key and select Freq.
3. Press the Start Frequency soft key.
4. Enter a value by using the numeric keys. You can also use the rotary knob or the arrow keys.
5. Select the unit: GHz, MHz, kHz, or Hz.
6. Press the Stop Frequency soft key.
7. Enter a value by using the numeric keys. You can also use the rotary knob or the arrow keys.
8. Select the unit: GHz, MHz, kHz, or Hz.
To set the channel number and span:
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1. Press the FREQ/DIST hard key.
2. Toggle the Unit soft key and select Channel.
3. To select the standard channel, complete the following steps:
a.

Press the Channel Std soft key. The standard channel window appears.
See “Appendix C – Band, frequency & channel standard” on page 541 for more information.

b.

Select the band to be measured by using the rotary knob, the arrow keys, or the Page
Up/Page Down soft keys.

c.

Press the Select soft key or the rotary knob to confirm the selection.

4. Toggle the Link soft key to select the sweep direction and select Fwd for forward or Rev for
reverse.

5. To set the channel number, complete the following steps:
a.

Press the Channel Number soft key.

b.

Enter a value by using the numeric keys.

c.

Press the Enter soft key or ENTER hard key to complete the entry.
The instrument automatically displays the corresponding center frequency value for the
selected channel number.

6. To set the span, complete the following steps:
a.

Press the Span soft key.

b.

Select the span option, from the following choices:

–

To set the span manually, select Span, enter a value, and then select the unit.

–

To set the span automatically, select Full Span, Zero Span, or Last Span as needed.

NOTE
The Zero Span option is available only in the Spectrum mode. If you have selected Zero
Span, select TRIGGER > Free Run, External, GPS, Video, or Display Position.
Optional. To define the amount of frequency increment for the rotary knob:

1. Press the Frequency Step soft key, if the Freq is selected.
2. Enter a value by using the numeric keys.
3. Press the unit: GHz, MHz, kHz, or Hz.
Optional. To define the amount of channel increment for the rotary knob:

1. Press the Channel Step soft key, if the Channel is selected.
2. Enter a value by using the numeric keys.
3. Press the Enter soft key.

Setting amplitude
Reference level and attenuation
You can set the reference and attenuation levels automatically or manually to optimize the display of
the traces measured, as you desire.
Procedure
To automatically set the reference and attenuation level:

1. Press the AMP/SCALE hard key.
2. Press the Auto Scale soft key.
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Each time you press this key, both of the Y-axis scale and input attenuation level change to be
optimized with some margin.
To set the reference or attenuation level manually:

1. Press the AMP/SCALE hard key.
2. To set the maximum reference value on the Y-axis manually, complete the following steps:
a.

Press the Reference Level soft key.

b.

Enter a value by using the numeric keys or the rotary knob with 10 dB increments.

c.

Press the dBm soft key or the ENTER hard key.

3. To set the attenuation option, select one from the following choices:
–

To set the input attenuator’s level automatically, select Attenuation > Auto.
NOTE
It is recommended that you set the Attenuation to Auto in most situations so that the
level of the input attenuator can be set automatically according to your input signal level.

–

–

To set the input attenuation manually up to 55 dB to optimize S/N, complete the following
steps:
a.

Select Attenuation > Manual.

b.

Press the Attenuation Value soft key to set the level.

c.

Enter a value between 0 and 55 in fives by using the numeric keys.

d.

Press the dB soft key or the ENTER hard key.

To couple the input attenuator’s level with your reference level setting, select Attenuation >
Couple.
As you increse the reference setting, the attenuation level also increases acoordingly.

Optional. To change the scale unit:

1. Select More (1/2) > Units.
2. Select the unit of the display scale: dBm, dBV, dBmV, dBµV, V, or W.
The scale unit on the screen changes accordingly.

Scale per division
You can use the Scale/Div feature available for the spectrum measurement screen. It represents the
value of one division on the horizontal scale. The default setting is 10 dB per division and the
maximum value can be set up to 20 dB.
Procedure
To set the scale per division:

1. Press the AMP/SCALE hard key.
2. Select More (1/2) > Scale/Div.
3. Enter a value between 1 and 20 by using the numeric keys.
4. Press the dB soft key to complete the entry.
Pre-amplifier
You can turn the internal pre-amplifier on to correct and compensate for the gain of the preamp so that
amplitude readings show the value at the input connector.
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Procedure

1. Press the AMP/SCALE hard key.
2. Toggle the Preamp soft key and select On or Off as needed.
NOTE
You can turn the Preamp on when the input attenuation range is from 0 dB to 10 dB. If
the attenuation value is manually set to greater than 10 dB, the instrument will
automatically turn off the pre-amplifier to display low-level signal properly on the chart.

External offset
You can turn the External Offset on and manually set the external offset value. An offset consists of a
cable loss and a user offset and the measurement result shows the value reflecting both offset values.
When the external offset value is set at 40 dB in the Spectrum mode, the measurement result
compensates 40 dB at both the Spectrum Analyzer and Signal Analyzer modes
Procedure
To set the external offset:

1. Press the AMP/SCALE hard key.
2. Toggle the External Offset soft key and select On.
3. Enter a value by using the numeric keys.
4. Press the dB soft key to complete the entry.
To turn the external offset off:

1. Press the AMP/SCALE hard key.
2. Toggle the External Offset soft key and select Off.

Setting bandwidth
VBW based on the designated RBW. Selecting Auto changes the value to correspond to your
frequency span setting for RBW and to the current RBW and VBW/RBW settings for VBW.
Procedure
To automatically set the RBW and VBW to your selected VBW/RBW ratio:

1. Press the BW/AVG hard key.
2. Press the VBW/RBW soft key to set the proportional VBW based on the designated RBW.
Table 9 shows the ratio example for 30 kHz RBW.

3. Select the ratio: 1, 0.3, 0.1, 0.03, 0.01, or 0.003.
4. Toggle the RBW soft key and select Auto.
5. Toggle the VBW soft key and select Auto.
The RBW or VBW value on the screen changes accordingly based on the span.
To manually set the RBW or VBW to your selected VBW/RBW ratio:

1. Press the BW/AVG hard key.
2. Press the RBW soft key.
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3. Enter a value between 1 Hz to 3 MHz in 1-3 sequence by using the numeric keys.
4. Select the unit: MHz, kHz, or Hz.
The RBW setting automatically changes to Manual.

5. Press the VBW soft key.
6. Enter a value by using the numeric keys.
7. Select the unit: MHz, kHz, or Hz.
The VBW setting automatically changes to Manual.
The RBW or VBW value on the screen changes accordingly.

Table 11

VBW/RBW ratio example

RBW

Ratio (VBW/RBW)

VBW

30 kHz

1:1

30 kHz

1:0.3

10 kHz

1:0.1

3 kHz

1:0.03

1 kHz

1:0.01

300 Hz

1:0.003

100 Hz

Setting average
You can set the number of measurements to be averaged for the trace presentation. A maximum of
100 times of averaging can be set. When the averaging reaches to your setting, a new measurement
value replaces the measurement value in sequence from the earliest.
Procedure

1. Press the BW/AVG hard key.
2. Press the Average soft key.
3. Enter a value between 1 and 100 as needed by using the numeric keys.
4. Press the Enter soft key.

Setting sweep
The SWEEP hot key is used to set and control the sweep time, sweep mode, gated sweep settings,
and gated sweep on or off.
Sweep time
You can set the sweep time automatically or manually. Manual setting allows you to set the sweep time
beyond an automatic setting.
Procedure

1. Press the SWEEP hot key.
2. Select the sweep time option, from the following choices:
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–

To automatically set, toggle the Sweep Time soft key and select Auto.

–

To manually set, complete the following steps:
a.

Press the Sweep Time soft key.

b.

Enter a value by using the numeric keys.

c.

Select the unit: Sec, mSec, or µSec.
The sweep time mode automatically changes to Manual.

Sweep mode
The default settings of the sweep mode are Continue and Normal to sweep continuously at a normal
speed for most on-going measurements. If you want to hold the measurement or get a single sweep,
you can change the sweep mode.
Procedure
To select the single sweep mode:

1. Press the SWEEP hot key.
2. Toggle the Sweep Mode soft key and select Single. You can also use the HOLD hot key.
The letter HOLD in red appears and the sweeping is paused.

3. Optional. Press the Sweep Once soft key to get a new measurement.
To return to the continuous sweep mode:

1. Toggle the Sweep Mode soft key and select Continue. You can also use the HOLD hot key.
The letter HOLD in red disappears and the sweeping resumes.
NOTE
Selecting Sweep Mode > Fast may reduce the measurement accuracy, but you can use
this fast sweep mode to identify the existence of interfering signals.

Gated sweep
You can configure the gated sweep settings with an internal or external trigger source. If you select
Gated Sweep Settings, you can view the signal in time domain.
Procedure

1. Press the SWEEP hot key.
2. Press the Gated Sweep Settings soft key.
3. Optional. Adjust sweep time to allow enough time for a cycle by completing the following steps:
a.

Press the Zero Span Time soft key.

b.

Enter a value by using the numeric keys.

c.

Select the unit: Sec, mSec, or µSec.

4. Set the period, if using the internal trigger source, by doing one of the following:
–

–

To select the preset period, complete the following steps:
a.

Toggle the Period soft key and select StdSignal.

b.

Press the StdSignal soft key, and then select the period: GSM (4.615 ms), WCDMA
(10 ms), LTE (10 ms), EV-DO (5 ms), TD-SCDMA (5 ms), or WiMAX (10 ms).

To manually set the period, complete the following steps:
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a.

Toggle the Period soft key and select Manual.

b.

Press the Period soft key to enter the amount of time.

c.

Enter a value by using the numeric keys.

d.

Select the unit: Sec, mSec, or µSec.

5. Press the TRIGGER hot key, and then do one of the following:
–

Select External for an external trigger source.

–

Select Video or Display Position for the internal trigger source.

6. Press the PREV hard key to continue setting the gated sweep.
7. Set the gate delay by completing the following steps:
a.

Press the Gate Delay soft key.

b.

Enter a value by using the numeric keys.

c.

Select the unit: Sec, mSec, or µSec.

8. Set the gate length by completing the following steps:
a.

Press the Gate Length soft key.

b.

Enter a value by using the numeric keys.

c.

Select the unit: Sec, mSec, or µSec.

9. Press the PREV hard key to enable gated sweeping.
10. Toggle the Gated Sweep soft key and select On.
NOTE
This setting is not used in the Spectrum Replayer mode.

Conducting spectrum measurements
The spectrum measurement with an audible indicator is especially useful for locating interferer sources
with a directional antenna.

Sound indicator
You can use the Sound Indicator to help you identify interfering signals by sounding an alarm.
Procedure

1. Configure test parameters as described in the “Configuring test parameters” on page 88.
2. Press the MEASURE SETUP hot key.
3. Press the Sound Indicator soft key.
4. Toggle the Sound soft key between On and Off to enable and disable the alarm sound.
5. Select the alarm reference option from the following choices:
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–

To set the active marker position as the alarm reference, toggle the Alarm Reference soft
key and select Marker.

–

To set the limit as the alarm reference, complete the following steps:
a.

Toggle the Alarm Reference soft key and select Line.
The Limit Line menu becomes activated to be set.

b.

Press the Limit Line soft key to define a threshold for the limit line.
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c.

Enter a value by using the numeric keys. You can also use the rotary knob.

d.

Press the dBm soft key.

6. Optional. To adjust the volume for alarm sound, press the Volume soft key and then turn the
rotary knob clockwise or counter clockwise.

7. Optional. You can save logging data automatically so that you can load the measurement data
and replay in the Spectrum Replayer mode. See “Using save” on page 31 for more information.

AM/FM audio demodulation
th

You can use the AM/FM Audio Demodulation to identify if the interfering signal is n harmonics of
AM/FM audio. The instrument sounds demodulated signals that you can hear through the speaker or
headphones.
Procedure

1. Configure test parameters as described in the “Configuring test parameters” on page 88.
2. Press the MEASURE SETUP hot key.
3. Toggle the Audio Demod soft key between On and Off to turn the AM/FM audio demodulation
on and off.

4. Press the Demod at soft key, and then select the marker number for the frequency to be
demodulated.
NOTE
You must set the marker(s) first by using the MARKER hard key as the AM/FM
demodulator uses the marker position to demodulate. See “Using marker” on page 49 for
more information.

5. Press the Demod Mode soft key, and then select the demodulation mode: AM, FM and CW.
6. Press the Dwell Time soft key, and then turn the rotary knob to set the demodulation interval
between 1 and 20.

7. Press the Volume soft key, and then turn the rotary knob to set the speaker volume.
8. Toggle the Auto Gain soft key between On and Off to enable or disable the automatic gain
feature to adjust the interval gain of the demodulator.

9. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available
for your measurement mode. See “Using save” on page 31 for more information.

Interference ID
The Interference ID automatically classifies interfering signals over a designated spectrum and
displays the list of possible signal types corresponding to the selected signal.
Procedure

1. Configure test parameters as described in the “Configuring test parameters” on page 88.
2. Press the MEASURE SETUP hot key.
3. Toggle the Interference ID soft key between On and Off to turn the Interference ID on and off.
4. To set the threshold level manually, complete the following steps:
a.

Press the Threshold soft key.

b.

Enter a value by using the numeric keys.
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c.

Press the dBm soft key.

5. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available
for your measurement mode. See “Using save” on page 31 for more information.
NOTE
You can use the LIMIT hot key to analyze your measurements with the display line, multisegment line, and channel limit. See “Setting limit for interference analyzer” on page 103
for more information.

Conducting interference measurements
Spectrogram
The Spectrogram is particularly useful when attempting to identify periodic or intermittent signals as it
captures spectrum activity over time and uses various colors to differentiate spectrum power levels.
When the directional antenna is used to receive the signal, you will see a change in the amplitude of
the tracked signal as you change the direction of the antenna and see a change in the Spectrogram
colors. The source of the signal is located in the direction that results in the highest signal strength.
Setting measure setup
Procedure

1. Configure test parameters as described in the “Configuring test parameters” on page 88.
2. Press the MEASURE SETUP hot key.
3. To set the amount of time between each trace measurement:
a.

Press the Time Interval soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Press the Sec soft key.

4. To set the time cursor on a specific trace position, complete the following steps:
a.

Toggle the Time Cursor soft key and select On.

b.

Turn the rotary knob to move the time cursor. You can also enter a value and then press the
Enter soft key.
NOTE
Enabling the time cursor puts the measurement on hold and you can make postprocessing analysis for each measurement over time using the time cursor.

5. To start a new measurement, press the Reset/Restart soft key.
6. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available
for your measurement mode. See “Using save” on page 31 for more information.

Measurement example
The spectrogram shows a vertical line on the chart when the marker is enabled on the screen.
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Figure 22

Interference measurement in spectrogram



The horizontal line or X-axis of the spectrogram is frequency.



The vertical line or Y-axis is time.



The color identification (Spectrogram) indicates power level of the tracked signal. As the signal
strength increases, the color on the spectrogram changes accordingly.

Figure 23

Interference measurement in spectrogram with gated sweep on

NOTE
You can use the LIMIT hot key to analyze your measurements with the display line, multisegment line, and channel limit. See “Setting limit for interference analyzer” on page 103
for more information.

Dual spectrogram
The Dual Spectrogram mode is useful to compare two spectrograms displayed simultaneously on the
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screen.
Setting measure setup
Procedure

1. Configure test parameters as described in the “Configuring test parameters” on page 88.
2. Press the MEASURE SETUP hot key.
3. Toggle the Active Window soft key and select Left or Right spectrogram to be set up.
4. To set the amount of time between each trace measurement:
a.

Press the Time Interval soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Press the Sec soft key.

5. To set the time cursor on a specific trace position, complete the following steps:
a.

Toggle the Time Cursor soft key and select On.

b.

Turn the rotary knob to move the time cursor. You can also enter a value and then press the
Enter soft key.
NOTE
Enabling the time cursor puts the measurement on hold and you can make postprocessing analysis for each measurement over time using the time cursor.

6. To start a new measurement, press the Reset/Restart soft key.
7. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available
for your measurement mode. See “Using save” on page 31 for more information.

Measurement example
Figure 24

Interference measurement in dual spectrogram view

RSSI
The Received Signal Strength Indicator (RSSI) is a multi-signal tracking metric that is particularly
useful for measuring power-level variations over time. The RSSI measurement lets you assign power
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limit line for audible alarms and increase alarm counters every time a signal exceeds a defined limit
line. For long-term analysis, the spectrogram and RSSI measurements can be automatically saved
into an external USB memory. Post-analysis can be performed with JDViewer application software.
Setting measure setup
Procedure

1. Configure test parameters as described in the “Configuring test parameters” on page 88.
2. Press the MEASURE SETUP hot key.
3. To set up the alarm parameters, complete the following steps:
a.

Press the Alarm soft key.

b.

Press the Alarm at soft key and select the marker number: M1 to M6 .

c.

Press the Limit Line soft key to set a threshold for the alarm.

d.

Enter a value by using the numeric keys. You can also use the rotary knob.

e.

Press the dBm soft key.

f.

Toggle the Alarm soft key between On and Off to turn the alarm feature on or off.

g.

Optional. Press the Volume soft key and adjust the volume.

4. To set up the AM/FM audio demodulation, complete the following steps:
a.

Press the AM/FM Audio Demod soft key.

b.

Toggle the Audio Demod soft key between On and Off to turn the AM/FM audio
demodulation on or off.

c.

Press the Demod at soft key, and then select the marker number for the frequency to be
demodulated.
NOTE
For the alarm and AM/FM audio demodulation, you must set the marker(s) first by using
the MARKER hard key as these features use the marker position to sound alarm or
demodulate. See “Using marker” on page 49 for more information.

d.

Press the Demod Mode soft key, and then select the demodulation mode: AM, FM and
CW.

e.

Press the Dwell Time soft key, and then turn the rotary knob to set the demodulation
interval between 1 and 20.

f.

Toggle the Auto Gain soft key between On and Off to enable or disable the automatic gain
feature to adjust the interval gain of the demodulator.

g.

Optional. Press the Volume soft key and adjust the volume.

5. To start a new measurement, press the Reset/Restart soft key.
6. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available
for your measurement mode. See “Using save” on page 31 for more information.
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Measurement example
Figure 25

Interference measurement in RSSI

NOTE
You can use the LIMIT hot key to analyze your measurements with the display line, multisegment line, and channel limit. See “Setting limit for interference analyzer” on page 103
for more information.

Interference finder
The Interference Finder is an automatic triangulation algorithm that uses GPS coordinates to locate
possible interference sources based on three measurements. The interference finder calculates
possible interference locations using its inscribed circle or circumscribed circle based on measured
intersection points. You can plot up to seven measurement points and select three that are more
representative for triangulation. JD780A series automatically logs measurement positions not to lose
them while changing measurement modes.
Setting measure setup
Procedure

1. Configure test parameters as described in the “Configuring test parameters” on page 88.
2. To load your map file, complete the following steps:
a.

Plug in your USB drive that has a map file in .mcf file type created in JDMapCreator.
NOTE
The JDMapCreator converts and resizes a map to fit onto your instrument’s display. You
must save your map files (.mcf) into the “SavedMap” folder of your USB drive so that
you can load them onto your instrument.

b.

Press SAVE/LOAD hot key, and then select Load > Load Map. See “Using load” on page
34 for more information.

3. Press the MEASURE SETUP hot key.
4. Press the Location Setup soft key.
5. Press the Location soft key.
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6. Press the Point 1 soft key, and then do one of the following option:
–

To automatically get the selected point’s positioning information with GPS locked, press the
Get GPS Position.
The instrument displays the latitude and logitude information of the signal received by a
Yagi antenna.

–

To manually determine positioning for the selected point, complete the following steps:
a.

Press the Latitude soft key, and then set the properties: North/South, Degree,
Minute, and Second.

b.

Press the Longitude soft key, and then set the properties: East/West, Degree,
Minute, and Second.

7. Press the Azimuth soft key to set an azimuth, and then do one of the following:
–

Without using a compass, turn the rotary knob to align the straight line on the loaded map
with the direction of the connected Yagi antenna.
The instrument calculates the azimuth and the angle appears on the screen.

–

Measure an azimuth by using a compass, enter the measured angle, and then press the
Enter soft key.

8. Optional. To save a defined position, press the Save Position soft key and then select one of the
soft keys to which you want to save the position information. You can use the Load Position soft
key to load any saved positions.

9. Press the Point 2 soft key, and then repeat steps 6-7.
10. Press the Point 3 soft key, and then repeat steps 6-7.
11. Press the Display Setup soft key.
12. Press the Display Mode soft key, and then select the display mode: Circum, Inscribed, or
Double.
NOTE
Change the display to different mode options and check possible location of the
interfering signal.
Circumscribed

Inscribed
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13. Toggle the Screen Mode soft key and select the display option: Map or Full.
–

Map: Displays points on the loaded map.

–

Full: Displays points without the map.

Measurement example
Figure 26

Interference finder measurement in map view

Spectrum Replayer
The Spectrum Replayer lets you retrieve and replay recorded spectrum analyzer traces in interference
analysis mode. These traces can be played back in the spectrogram or RSSI. You can configure the
limit line to create failure points when signals exceed it. The failure points are clearly displayed on the
trace timeline for quick access during playback.
Setting measure setup
Procedure

1. Press the MEASURE hot key.
2. Press the Spectrum Replayer soft key.
The file manager window appears.

3. Select a file to be loaded, and then press the Load soft key.
The Measure Setup screen menus appear.

4. Toggle the Replay Direction soft key between FWD and REV to change play direction to forward
or reverse.

5. Press the Replay Speed soft key, and then select the speed option: x1, x2, x3, and x4.
6. Press the Play soft key to start playing.
7. Press the Pause soft key to pause or stop playing data.
8. To move to a particular failure position directly and play from there, complete the following steps:
a.
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b.

Enter a value by using the numeric keys.

c.

Press the Enter soft key.

9. Optional. Toggle the Time Cursor soft key between On and Off to display or dismiss the time
cursor on the screen. This key becomes activated when you play logged data in the Spectrogram
mode.
NOTE
If you connected a USB drive, do not remove it while playing. Doing so may freeze the
USB port, which will require you to restart the instrument to get a USB drive recognized
again.

Setting display
You can select the display option.
Procedure

1. Press the TRACE/DISPLAY hard key.
2. Select the display option: Spectrum, Spectrogram, or RSSI.
NOTE
You can use the LIMIT hot key to analyze your measurements with the display line, multisegment line, and channel limit. See “Setting limit for interference analyzer” on page 103
for more information.

Setting limit for interference analyzer
Procedure
To use the display line:

1. Press the LIMIT hot key.
2. Press the Display Line soft key for a reference line.
3. Enter a value, and then press the dBm unit soft key.
4. Toggle the Display Line soft key between On and Off to display and dismiss the reference line.
The straight line appears across the screen to be used as a visual reference only.
To display the multiple segment line:

1. Press the LIMIT hot key.
2. Press the Multi Segment Line soft key for Pass/Fail indication.
3. Toggle the Limit soft key between Upper and Lower to select the one to be displayed.
4. Set the number of segments for the selected upper or lower limit line. You can set up to 50
segments.
a.

Press the # of Line soft key.

b.

Enter a value between 1 and 50 by using the numeric keys.

c.

Press the Enter soft key.

5. Press the Autoset soft key to let the instrument set the limit for each segment and display the
line.

6. Optional. To move the limit line, complete the following steps:
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a.

Select Limit Up/Down or Limit Left/Right.

b.

Turn the rotary knob to move the line as desired. You can also manually enter a value.

7. Optional. To edit the segment properties, complete the following steps:
a.

Press the Edit Limit soft key.

b.

Press the Move soft key and then turn the rotary knob to select the segment to edit.

c.

Select the menu option, from the following choices:

–

To hide the line for the selected segment, toggle the Line soft key and select Off.

–

To add a new point, press the Add Point soft key.

–

To delete the selected point, press the Delete Point soft key.

–

To change the position, press the Frequency or Amplitude soft key, and then turn the
rotary knob to change the value as desired.

To define the channel limit:

1. Press the LIMIT hot key.
2. Press the Channel Limit soft key.
3. To define the index table, complete the following steps:
a.

Toggle the Table soft key between On and Off to display and hide the channel index table
on the screen.

b.

Press the Index soft key.

c.

Enter an index number to be set between 1 and 10 by using the numeric keys.

d.

Press the Enter soft key.

e.

Press the Start Frequency or Center Frequency soft key depending on your prior
frequency setting.

f.

Enter a value by using the numeric keys. You can also use the rotary knob or the arrow
keys.

g.

Select the unit: GHz, MHz, kHz, or Hz.

h.

Press the Stop Frequency or Span Width soft key depending on your prior frequency
setting.

i.

Enter a value by using the numeric keys. You can also use the rotary knob or the arrow
keys.

j.

Select the unit: GHz, MHz, kHz, or Hz.

4. To set the limits for Pass/Fail indication, complete the following steps:
a.

Toggle the Limit soft key between On and Off to enable and disable the limit.

b.

Press the High Limit soft key.

c.

Enter a value by using the numeric keys. You can also use the rotary knob or the arrow
keys.

d.

Press the dBm soft key.

e.

Press the Low Limit soft key.

f.

Enter a value by using the numeric keys. You can also use the rotary knob or the arrow
keys.

g.

Press the dBm soft key.

5. Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings.
See “Using save” on page 31 for more information.
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Using GSM/GPRS/EDGE Signal Analyzer
This chapter provides instructions for using the GSM/GPRS/EDGE Signal Analyzer function (option
022) with GSM//GPRS/EDGE OTA Analyzer function (option 042). Topics discussed in this chapter are
as follows:
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Introduction
The Global System for Mobile Communications (GSM) is a digital cellular standard that uses Time
Division Multiple Access (TDMA) multiplexing scheme and Gaussian Minimum Shift Keying (GMSK)
modulation. The Enhanced Data Rates for GSM Evolution (EDGE) is an enhancement to GSM that
promises to deliver multimedia and other broadband applications. It uses TDMA and 3π/8 8PSK
(phase shift keying) modulation.
This instrument performs measurements using the methods and limits as defined in the 3GPP TS
51.021 Base Station System (BSS) equipment specification: Radio Aspects V8.9.0 (2003-06). The
Pass/Fail indictor helps you to determine base station performance easily.
This instrument provides the following measurement tools for GSM/GPRS/EDGE system:


Spectrum Analysis



RF Analysis
Channel Power
Occupied Bandwidth
Spectrum Emission Mask (SEM)
Spurious Emissions



Power vs. Time
Power vs. Time (Slot)
Power vs. Time (Frame)



Modulation Analysis
Constellation



Auto Measure



Over The Air (OTA)
Channel Scanner
Frequency Scanner
Multipath Profile
Modulation Analyzer

Display overview
Figure 27 provides descriptions for each segment of the measurement screen.
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Figure 27

GSM signal analyzer measurement screen

Connecting a cable
Direct connection
Procedure

1. Connect the Spectrum Analyzer RF In port of the JD780A series and the power amplifier output
port of BTS.

Figure 28

Direct connection

JD785A/JD786A

JD788A

Indirect connection
Procedure

1. Connect the Spectrum Analyzer RF In port of the JD780A series and the monitor (test) port of
BTS.
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Figure 29

Indirect connection

JD785A/JD786A

JD788A

CAUTION
The maximum power for the Spectrum Analyzer RF In port is +25 dBm (0.316 W). If the
input signal level to be measured is greater than +25 dBm, use a High Power
Attenuator to prevent damage when you directly connect the signal to the instrument or
connect the signal from the coupling port of a directional coupler.

Over the air (OTA)
Procedure

1. Connect an Omni/directional RF antenna to the Spectrum Analyzer RF In port of the JD780A
series.

2. Connect a GPS antenna to the GPS port of the JD780A series.
Figure 30

OTA connection

JD785A/JD786A

JD788A

CAUTION
If the input signal level to be measured is less than 0 dBm, set 0 dB attenuation or turn on
the preamp to have better dynamic range for the OTA testing.
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Selecting measurement mode
Procedure

1. Press the MODE hard key.
2. Press the Signal Analyzer soft key.
3. Press the GSM soft key. The Spectrum mode is set by default.
4. Press the MEASURE hot key, and then select the measurement mode option from the following
choices:

–

Spectrum

–

RF Analysis > Channel Power, Occupied BW, Spectrum Emission Mask, or
Spurious Emissions

–

Power vs Time > Power vs Time (Slot) or Power vs Time (Frame)

–

Constellation

–

Auto Measure

–

OTA > Channel Scanner, Frequency Scanner, Multipath Profile, or
Modulation Analyzer

Configuring test parameters
Setting frequency
You can set the frequency with either frequency or channel number. If a frequency to be set matches
to the frequency corresponding to the selected channel standard, the instrument calculates its channel
number and updates the screen with it automatically.
Procedure
To set the center frequency:

1. Press the FREQ/DIST hard key.
2. Toggle the Unit soft key and select Freq.
3. Press the Center Frequency soft key.
4. Enter a value by using the numeric keys. You can also use the rotary knob.
5. Select the unit: GHz, MHz, kHz, or Hz.
6. Optional. To define the amount of frequency increment for the rotary knob, complete the following
steps:
a.

Press the Frequency Step soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Press the unit: GHz, MHz, kHz, or Hz.

To set the channel number:

1. Press the FREQ/DIST hard key.
2. Toggle the Unit soft key and select Channel.
3. To select the standard channel, complete the following steps:
a.

Press the Channel Std soft key. The standard channel window appears.
See “Appendix C – Band, frequency & channel standard” on page 541 for more information.
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b.

Select the band to be measured by using the rotary knob, the arrow keys, or the Page
Up/Page Down soft keys.

c.

Press the Select soft key or the rotary knob to confirm the selection.

4. Press the Channel Number soft key.
5. Enter a value by using the numeric keys. You can also use the rotary knob.
6. Press the Enter soft key.
The instrument automatically displays the corresponding center frequency value for the selected
channel number.

7. Optional. To define the amount of channel increment for the rotary knob, complete the following
steps:
a.

Press the Channel Step soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Press the Enter soft key.

NOTE
This frequency setting is not used in the Spurious Emissions mode.

Setting amplitude
Reference level and attenuation
You can set the reference and attenuation levels automatically or manually to optimize the display of
the traces measured, as you desire.
Procedure
To automatically set the reference and attenuation level:

1. Press the AMP/SCALE hard key.
2. Press the Auto Scale soft key.
Each time you press this key, both of the Y-axis scale and input attenuation level change to be
optimized with some margin.
To set the reference or attenuation level manually:

1. Press the AMP/SCALE hard key.
2. To set the maximum reference value on the Y-axis manually, complete the following steps:
a.

Press the Reference Level soft key.

b.

Enter a value by using the numeric keys or the rotary knob with 10 dB increments.

c.

Press the dBm soft key or the ENTER hard key.

3. To set the attenuation option, select one from the following choices:
–

To set the input attenuator’s level automatically, select Attenuation > Auto.
NOTE
It is recommended that you set the Attenuation to Auto in most situations so that the
level of the input attenuator can be set automatically according to your input signal level.

–
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steps:
a.

Select Attenuation > Manual.

b.

Press the Attenuation Value soft key to set the level.

Using GSM/GPRS/EDGE Signal Analyzer

JD780A Series Analyzers

–

c.

Enter a value between 0 and 55 in fives by using the numeric keys.

d.

Press the dB soft key or the ENTER hard key.

To couple the input attenuator’s level with your reference level setting, select Attenuation >
Couple.
As you increse the reference setting, the attenuation level also increases acoordingly.

Optional. To change the scale unit:

1. Select More (1/2) > Units.
2. Select the unit of the display scale: dBm, dBV, dBmV, dBµV, V, or W.
The scale unit on the screen changes accordingly.
NOTE
This Units menu is available in the Spectrum and RF Analysis modes.

Scale per division
You can use the Scale/Div feature available for the spectrum and RF analysis. It represents the value
of one division on the horizontal scale. The default setting is 10 dB per division and the maximum
value can be set up to 20 dB.
Procedure
To set the scale per division:

1. Press the AMP/SCALE hard key.
2. Select More (1/2) > Scale/Div.
3. Enter a value between 1 and 20 by using the numeric keys.
4. Press the dB soft key to complete the entry.
Pre-amplifier
You can turn the internal pre-amplifier on to correct and compensate for the gain of the preamp so that
amplitude readings show the value at the input connector.
Procedure

1. Press the AMP/SCALE hard key.
2. Toggle the Preamp soft key and select On or Off as needed.
NOTE
You can turn the Preamp on when the input attenuation range is from 0 dB to 10 dB. If
the attenuation value is manually set to greater than 10 dB, the instrument will
automatically turn off the pre-amplifier to display low-level signal properly on the chart.

External offset
You can turn the External Offset on and manually set the external offset value. An offset consists of a
cable loss and a user offset and the measurement result shows the value reflecting both offset values.
When the external offset value is set at 40 dB in the Spectrum mode, the measurement result
compensates 40 dB at both the Spectrum Analyzer and Signal Analyzer modes
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Procedure
To set the external offset:

1. Press the AMP/SCALE hard key.
2. Toggle the External Offset soft key and select On.
3. Enter a value by using the numeric keys.
4. Press the dB soft key to complete the entry.
To turn the external offset off:

1. Press the AMP/SCALE hard key.
2. Toggle the External Offset soft key and select Off.

Setting average
You can set the number of measurements to be averaged for the trace presentation. A maximum of
100 times of averaging can be set. When the averaging reaches to your setting, a new measurement
value replaces the measurement value in sequence from the earliest.
Procedure

1. Press the BW/AVG hard key.
2. Press the Average soft key.
3. Enter a value between 1 and 100 as needed by using the numeric keys.
4. Press the Enter soft key.

Setting sweep mode
The default settings of the sweep mode are Continue and Normal to sweep continuously at a normal
speed for most on-going measurements. If you want to hold the measurement or get a single sweep,
you can change the sweep mode.
Procedure
To select the single sweep mode:

1. Press the SWEEP hot key.
2. Toggle the Sweep Mode soft key and select Single. You can also use the HOLD hot key.
The letter HOLD in red appears and the sweeping is paused.

3. Optional. Press the Sweep Once soft key to get a new measurement.
To return to the continuous sweep mode:

1. Toggle the Sweep Mode soft key and select Continue. You can also use the HOLD hot key.
The letter HOLD in red disappears and the sweeping resumes.

Setting trigger source
You can set the trigger source option for your measurements.
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Procedure

1. Press the TRIGGER hot key.
2. Select the trigger source option from the following choices:
To set the trigger level

Select

When using the RF burst (wideband) trigger

RF Burst

To free burst if there is a frequency burst signal

Internal FB

To training sequence code

RF Burst & TS

To external trigger reference

External

To the free trigger

Free

Conducting spectrum measurements
If you have configured test parameters as described in the “Configuring test parameters” on page 109,
your measurement result is displayed on the screen as like the following example, Figure 31.
Figure 31

Spectrum measurement screen with GSM signal analyzer

Setting measure setup
Procedure
Optional.

1. Press the MEASURE SETUP hot key.
2. Press the Miscellaneous soft key.
3. Press the Delay soft key to set the amount of delay in µs.
4. Enter a value by using the numeric keys. You can also use the rotary knob.
5. Press the µs soft key.
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NOTE
The Delay setting is used only when there is a time offset in the signals to be measured.

Setting trace
You can display up to six traces on the measurement chart simultaneously.
Procedure

1. Press the TRACE/DISPLAY hard key.
2. Press the Select Trace soft key, and then select the trace number: T1, T2, T3, T4, T5, or T6.
The legend shape of the selected trace changes from square to round to indicate that the trace is
the active one now.

3. Toggle the Trace View soft key and select On.
4. To clear, write or capture, or hide the trace(s), do one of the following:
To

Select

Trace Legend

Clear current data and display with new
measurements

Clear Write

W

Display the input signal’s maximum response only

Max Hold

M

Display the input signal’s minimum response only

Min Hold

m

Capture the selected trace and compare traces

Capture

C

Load a saved trace

More (1/2) > Load

L

Hide the selected trace

Trace View > Off

F

Remove all the traces and initialize the trace
settings

More (1/2) > Trace
Clear All

5. Optional. Press the More (1/2) > Trace Info soft key, and then select the trace number to view
the trace’s parameter setting information stored at the time of the measurement or None to hide
the information display.

6. Optional. If you have the two traces T1 and T2, you can perform trace math. To view the power
difference between the traces, press the T1 – T2 -> T5 or T2 – T1 -> T6 soft key.
The result is overlaid on the screen along with the second Y-axis.

Conducting RF measurements
Channel power
The Channel Power measures in-channel power for GSM/GPRS and EDGE systems, which use
dynamic power control to ensure that each link is maintained with minimum power. It gives two
fundamental benefits of keeping overall system interference to a minimum level and of maximizing
battery life in the case of mobile stations. It determines the power delivered to the antenna system on
the RF channel under test. The instrument acquires a GSM/GPRS or EDGE signal in the time domain.
The average power level above the threshold is then computed and displayed.
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 109, you
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can continue your measurement.
Procedure
Optional. To set the delay, complete the following steps:

1. Press the MEASURE SETUP hot key.
2. Press the Miscellaneous soft key.
3. Press the Delay soft key to set the amount of delay in µs.
4. Enter a value by using the numeric keys. You can also use the rotary knob.
5. Press the µs soft key.
NOTE
The Delay setting is used only when there is a time offset in the signals to be measured.

Measurement example
Figure 32

Channel power measurement with GSM signal analyzer

Channel power measurement result shows channel power and spectrum density in a user specified
channel bandwidth. The peak to average ratio (PAR) is shown at the bottom of the screen as well. The
shaded area on the display indicates the channel bandwidth.
NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 119 for more
information.

Occupied bandwidth
The Occupied Bandwidth measures the spectrum shape of the carrier. It is defined as the bandwidth,
which includes 99% of the transmitted power among total transmitted power.
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Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 109, you
can continue your measurement.
Procedure
Optional. To set the delay, complete the following steps:

1. Press the MEASURE SETUP hot key.
2. Press the Miscellaneous soft key.
3. Press the Delay soft key to set the amount of delay in µs.
4. Enter a value by using the numeric keys. You can also use the rotary knob.
5. Press the µs soft key.
NOTE
The Delay setting is used only when there is a time offset in the signals to be measured.

Measurement example
The Occupied Bandwidth measurement shows both of power across the band and power bandwidth in
a user specified percentage to determine the amount of spectrum used by a modulated signal.
Occupied bandwidth is typically calculated as the bandwidth containing 99% of the transmitted power.
Figure 33

Occupied bandwidth measurement with GSM signal analyzer

NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 119 for more
information.

Spectrum emission mask (SEM)
The Spectrum Emission Mask (SEM) measurement is to identify and determine the power level of outof-band spurious emission outside the necessary channel bandwidth and modulated signal. It
measures the power ratio between in-band and adjacent channels. The JD780A series indicates either
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Pass or Fail based on the specified limit of the signal.
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 109, you
can continue your measurement.
Procedure
Optional. To set the delay, complete the following steps:

1. Press the MEASURE SETUP hot key.
2. Press the Miscellaneous soft key.
3. Press the Delay soft key to set the amount of delay in µs.
4. Enter a value by using the numeric keys. You can also use the rotary knob.
5. Press the µs soft key.
NOTE
The Delay setting is used only when there is a time offset in the signals to be measured.

Measurement example
Figure 34

SEM measurement with GSM signal analyzer

NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 119 for more
information.

Spurious emissions
Out-of-band emissions are unwanted emissions immediately outside the channel bandwidth resulting
from the modulation process and non-linearity in the transmitter but excluding spurious emissions. The
Spurious Emissions measurement is to identify and determine the power level of out-of-band spurious
emission within the necessary channel bandwidth and modulated signal measured at the RF port of
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the Base Station.
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 109, you
can continue your measurement.
Procedure

1. Press the MEASURE SETUP hot key.
2. To set up the range table and frequency range, press the Range Table soft key and then
complete the following steps:
a.

Press the Range soft key, and then enter the range number to add a new range or change
an existing one.

b.

Press the Enter soft key.

c.

Press the Start Frequency soft key to set up the frequency range.

d.

Enter a value by using the numeric keys. You can also use the rotary knob.

e.

Select the unit: GHz, MHz, kHz, or Hz.

f.

Press the Stop Frequency soft key to set up the frequency range.

g.

Enter a value by using the numeric keys. You can also use the rotary knob.

h.

Select the unit: GHz, MHz, kHz, or Hz.

3. Toggle the Range soft key between On and Off to display or hide the selected range.
4. To set up the test limits for Pass/Fail indication, complete the following steps:
a.

Press the Start Limit soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Select the dBm soft key.

d.

Press the Stop Limit soft key.

e.

Enter a value by using the numeric keys. You can also use the rotary knob.

f.

Select the dBm soft key.

5. To set up the other parameters, complete the following steps:
a.

Select More (1/2) > Attenuation to set up the attenuation value.

b.

Enter a value in the multiple of five.

c.

Press the dB soft key or the ENTER hard key.

d.

Press the RBW soft key.

e.

Enter a value by using the numeric keys.

f.

Select the unit: GHz, MHz, kHz, or Hz.

g.

Press the VBW soft key.

h.

Enter a value by using the numeric keys.

i.

Select the unit: GHz, MHz, kHz, or Hz.

6. Press the PREV hard key.
7. Toggle the Measure Type soft key between Examine and Full to select the measurement type.
NOTE
The Examine mode displays only the selected range while the Full mode lets the
instrument automatically changes the selected range from one another.
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8. Set the number of measurements to be averaged:
a.

Press the Average soft key.

b.

Enter a value between 1 and 100.

c.

Press the Enter soft key.

Measurement example
Figure 35

Spurious emissions measurement with GSM signal analyzer

NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 119 for more
information.

Setting limit for RF tests
By default, test limits specified in the standard are set for you. You can change thresholds if you desire.
Procedure

1. Press the LIMIT hot key.
2. Press the RF Test Limits soft key.
3. Select the test item(s) and set the limit(s) depending on your selected measurement mode:
To set the limit for

Select

Set

Channel power

Channel Power

High Limit, Low Limit

Occupied bandwidth

Occupied BW

High Limit

Spectrum emission mask

Spectrum Emission Mask

(On/Off only)

ACLR

ACLR

(On/Off only)

Multi-ACLR

Multi-ACLR

(On/Off only)
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Spurious emissions

Spurious Emissions

(On/Off only)

4. Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit.
Toggle the Beep soft key between On and Off to enable or disable the beep sound.

5. Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings.
See “Using save” on page 31 for more information.

Conducting power vs. time measurements
The Power vs. Time measurement measures the mean transmission power during the useful part of
GSM bursts and verifies that the power ramp fits within the defined mask. It also lets you view the rise,
fall, and useful part of the GSM burst.
This measurement provides masks for both of Base Transceiver Station (BTS) and Mobile Station
(MS). The timing masks are referenced to the transition from the bit 13 to the bit 14 of the mid-amble
training sequence. For GMSK measurements, the 0 dB reference is determined by measuring the
mean transmitted power during the useful part of the burst.

Power vs. time (slot)
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 109, you
can continue your measurement. The measurement settings can be saved and recalled as a file.
Procedure

1. Press the MEASURE SETUP hot key.
2. Press the Detect Mode soft key, and then select the signal standard option: Auto, GSM, or
EDGE. Auto is set by default. The instrument applies a mask automatically based on the selected
mode.

3. Optional. To set the delay, complete the following steps:
a.

Press the Miscellaneous soft key.

b.

Press the Delay soft key to set the amount of delay in µs.

c.

Enter a value by using the numeric keys. You can also use the rotary knob.

d.

Press the µs soft key.

NOTE
The Delay setting is used only when there is a time offset in the signals to be measured.

Setting limit for burst power
Procedure

1. Press the LIMIT hot key.
2. Press the PvsT Test Limits soft key.
3. Press the Burst Power soft key to set the limit in the Power vs. Time (Slot) measurement.
4. Toggle the Test Limits soft key between On and Off to enable or disable the Pass/Fail
indication.
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5. Set the upper threshold:
a.

Press the High Limit soft key.

b.

Enter a value for the upper limit, and then press the dBm unit soft key.

6. Set the lower threshold:
a.

Press the Low Limit soft key.

b.

Enter a value for the lower limit, and then press the dBm unit soft key.

7. Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit.
Toggle the Beep soft key between On and Off to enable or disable the beep sound.

8. Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings.
See “Using save” on page 31 for more information.

Measurement example
Figure 36

Power vs. time (slot) measurement with GSM/EDGE signal analyzer
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Power vs. time (frame)
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 109, you
can continue your measurement. The measurement settings can be saved and recalled as a file.
Procedure

1. Press the MEASURE SETUP hot key.
2. Press the Detect Mode soft key, and then select the signal standard option: Auto, GSM, or
EDGE. Auto is set by default. The instrument applies a mask automatically based on the selected
mode.

3. Optional. To set the delay, complete the following steps:
a.

Press the Miscellaneous soft key.

b.

Press the Delay soft key to set the amount of delay in µs.

c.

Enter a value by using the numeric keys. You can also use the rotary knob.

d.

Press the µs soft key.

NOTE
The Delay setting is used only when there is a time offset in the signals to be measured.

Setting limit for frame average power
Procedure

1. Press the LIMIT hot key.
2. Press the PvsT Test Limits soft key.
3. Press the Frame Avg Power soft key to set the limit in the Power vs. Time (Frame)
measurement.

4. Toggle the Test Limits soft key between On and Off to enable or disable the Pass/Fail
indication.

5. Set the upper threshold:
a.

Press the High Limit soft key.

b.

Enter a value for the upper limit.

c.

Press the dBm unit soft key.

6. Set the lower threshold:
a.

Press the Low Limit soft key.

b.

Enter a value for the lower limit.

c.

Press the dBm unit soft key.

7. Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit.
Toggle the Beep soft key between On and Off to enable or disable the beep sound.

8. Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings.
See “Using save” on page 31 for more information.
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Measurement example
Figure 37

Power vs. time (frame) measurement with GSM signal analyzer

Conducting constellation measurements
The Constellation is used to observe some aspects of modulation accuracy and can reveal certain
fault mechanisms such as I/Q amplitude imbalance or quadrature imbalance. It displays constellation
diagram by modulation types.

Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 109, you
can continue your measurement. The measurement settings can be saved and recalled as a file.
Procedure

1. Press the MEASURE SETUP hot key.
2. Press the Detect Mode soft key, and then select the signal standard option: Auto, GSM, or
EDGE. Auto is set by default. The instrument applies a mask automatically based on the selected
mode.

3. Toggle the PSK Constellation soft key between On and Off to enable or disable the PSK
constellation observation.
NOTE
The PSK constellation must be turned on to analyze EDGE signals.

4. Optional. To set the delay, complete the following steps:
a.

Press the Miscellaneous soft key.

b.

Press the Delay soft key to set the amount of delay in µs.

c.

Enter a value by using the numeric keys. You can also use the rotary knob.

d.

Press the µs soft key.
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NOTE
The Delay setting is used only when there is a time offset in the signals to be measured.

Setting limit for constellation
Procedure

1. Press the LIMIT hot key.
2. Press the Modulation Test Limits soft key to set the limits in the Constellation measurement.
3. Select the test item(s) and set the limit(s) depending on your selected measurement mode:
To set the limit for

Select

Set

Frequency error

Frequency Error

High Limit, Low Limit

Phase error rms

Phase Error RMS

High Limit, Low Limit

Phase error peak

Phase Error Peak

High Limit, Low Limit

Error vector magnitude rms

EVM RMS

High Limit

Error vector magnitude peak

EVM Peak

High Limit

I/Q origin offset of the I and Q error
(magnitude squared) offset from the origin

IQ Origin Offset

High Limit

Carrier to interference (C/I) ratio

C/I

Low Limit

4. Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit.
Toggle the Beep soft key between On and Off to enable or disable the beep sound.

5. Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings.
See “Using save” on page 31 for more information.

Measurement example
Figure 38
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NOTE

Measurement items such as IQ Origin Offset, C/I, EVM RMS/Peak and EVM 95
are applicable only to EDGE signal measurements.

th

Performing auto measurements
The Auto Measure function of the JD780A series allows a complete signal profiling covering RF
characterization and modulation quality parameters of up to 10 different carriers, particularly useful on
an overlay architecture where base stations are transmitting in different frequencies.
The Auto Measure can be easily executed either by selecting a menu in the instrument or by running a
programmed scenario in the PC-based application so that the instrument automatically configure and
perform tests on every aspect of all the carriers.

Setting limit for auto measure
You can set test limits for test item(s) in the auto measurement.
Procedure

1. Press the LIMIT hot key.
2. Press the RF Test Limits soft key, and then enable test limits as desired.
3. Press the PvsT Test Limits soft key, and then enable test limits as desired.
4. Press the Modulation Test Limits soft key, and then enable test limits as desired.
5. Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit.
Toggle the Beep soft key between On and Off to enable or disable the beep sound.

6. Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings.
See “Using save” on page 31 for more information.

Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 109, you
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can continue your measurement. The measurement settings can be saved and recalled as a file. You
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load
the file on to the instrument.
Procedure

1. Press the MEASURE SETUP hot key.
2. Toggle the Configuration soft key and select the configuration option:
–

Current: to let the instrumnet use current frequency (single carrier) and determine pass or
fail based on the instrument’s limit settings in Auto Measure.

–

Scenario: to run a test with a programmed scenario in JDViewer.
The Scenario menu becomes activated.

3. To load a scenario, press the Scenario soft key, and then select a scenario file to load.
4. Toggle the Test Time soft key and select the test time option:
–

Now: to let the instrument run a test only once.

–

Schedule: to let the instrument repeat tests as defined in the Set Timing.
The Set Timing menu becomes activated.

5. To define a schedule for an auto measurement, complete the following steps:
a.

Press the Set Timing soft key.

b.

Press the Start Time (HH:MM) soft key.

c.

Enter the time in the HH:MM format, and then press the Enter soft key.

d.

Press the Stop Time (HH:MM) soft key.

e.

Enter the time in the HH:MM format, and then press the Enter soft key.

f.

Press the Time Interval soft key.

g.

Enter the amount of time in minutes, and then press the Enter soft key.

6. To set external offset, complete the following steps:
a.

Toggle the External Offset soft key and select On.

b.

Enter a value by using the numeric keys, and then press the dB soft key.

7. To save your settings and results, go to SAVE/LOAD > Save and then perform functions as you
desire. See “Using save” on page 31 for more information.

8. Press the Run Test soft key to start to run a test.
The Auto Measure Results window appears at the end of the test.

9. To stop running the test, press the Abort soft key.
10. To change the view on the screen during the test, press the Display and then select the view
option from the following choices:

–

Screen: You can view each measurement screen as the test progresses.

–

Results: You can view a measurement result table as the test progresses.

–

Settings: You can view a measurement setting table as the test progresses.

Setting display
After completion of the auto measurement, the screen menu changes to Trace/Display so that you can
view the results in different forms.
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Procedure

1. Toggle the Display soft key and select the display option:
–

Result: to view the result table. The Display Result menu becomes activated.

–

Settings: to view the measurement settings for the auto measurement.

2. Toggle the Display Result soft key and select the display result option:
–

Full: to view detailed measurement readings with the pass/fail indication.

–

Quick: to view only the Pass/Fail results.

3. To view the measurement results for a different carrier, press the View Carrier soft key and then
select the carrier number to view.

Conducting GSM OTA measurements
This Over-The-Air (OTA) measurement has channel scanner, frequency scanner, multipath profile, and
modulation analyzer screens. The GSM OTA has a function to display channel power and related
information up to 128 GSM down link signals. This channel scanner can quickly identifies improper
power levels that affect network performance. The transmitter performance can be made on a base
station from the convenience of your vehicle without taking the base station out of service. It helps you
to determine testing area's RF environmental condition with the multipath profile.

Channel scanner
Setting channel
Procedure

1. Press the FREQ/DIST hard key.
2. To select the standard channel, complete the following steps:
a.

Press the Channel Std soft key. The standard channel window appears.
See “Appendix C – Band, frequency & channel standard” on page 541 for more information.

b.

Select the band to be measured by using the rotary knob, the arrow keys, or the Page
Up/Page Down soft keys.

c.

Press the Select soft key or the rotary knob to confirm the selection.

3. To set the starting channel to be scanned, complete the following steps:
a.

Press the Channel Number soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Press the Enter soft key.

4. To set the amount of channel increment in scanning channels, complete the following steps:
a.

Press the Channel Step soft key.

b.

Enter a value by suing the numeric keys. You can also use the rotary knob.

c.

Press the Enter soft key.

5. To set the number of channels to be displayed, complete the following steps:
a.

Press the # of Channels soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Press the Enter soft key.
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Setting zoom position
You can set the starting channel for the Zoom In Window.
Procedure

1. Press the TRACE/DISPLAY hard key.
2. Press the Zoom Position soft key.
3. Enter a value by using the numeric keys. You can also use the rotary knob.
4. Press the Enter soft key.
Setting limit for OTA channel scanner
Procedure

1. Press the LIMIT hot key.
1. Press the Limit Line soft key to set a threshold for the limit line and Pass/Fail indication.
2. Enter a value, and then press the dBm unit soft key.
3. Toggle the Limit Line soft key between On and Off to display or dismiss the limit line.
4. Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit.
Toggle the Beep soft key between On and Off to enable or disable the beep sound.

5. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available
for your measurement mode. See “Using save” on page 31 for more information.

Measurement example
Figure 39

Channel scanner measurement with GSM OTA signal analyzer

Frequency scanner
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Setting frequency
Procedure

1. Press the FREQ/DIST hard key.
2. To set the starting frequency to be scanned, complete the following steps:
a.

Press the Start Frequency soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Select the unit: GHz, MHz, kHz, or Hz.

3. To set the amount of frequency increment in scanning frequencies, complete the following steps:
a.

Press the Frequency Step soft key.

b.

Enter a value by suing the numeric keys. You can also use the rotary knob.

c.

Select the unit: GHz, MHz, kHz, or Hz.

4. To set the number of frequencies to be displayed, complete the following steps:
a.

Press the # of Frequencies soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Press the Enter soft key.

Setting zoom position
You can set the starting channel for the Zoom Window.
Procedure

1. Press the TRACE/DISPLAY hard key.
2. Press the Zoom Position soft key.
3. Enter a value by using the numeric keys. You can also use the rotary knob.
4. Press the Enter soft key.
Setting limit for OTA frequency scanner
Procedure

1. Press the LIMIT hot key.
2. Press the Limit Line soft key to set a threshold for the limit line and Pass/Fail indication.
3. Enter a value, and then press the dBm unit soft key.
4. Toggle the Limit Line soft key between On and Off to display or dismiss the limit line.
5. Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit.
Toggle the Beep soft key between On and Off to enable or disable the beep sound.

6. Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings.
See “Using save” on page 31 for more information.
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Measurement example
Figure 40

Frequency scanner measurement with GSM OTA signal analyzer

Multipath profile
The Multipath Profile let you determine RF environmental conditions of testing area. The multipath
profile is the result of portions of the original broadcast signal arriving at the receiving antenna out of
phase. This can be caused by the signal being reflected off objects such as buildings, or being
refracted through the atmosphere differently from the main signal.
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 109, you
can continue your measurement. The measurement settings can be saved and recalled as a file.
Procedure

1. Press the MEASURE SETUP hot key.
2. Press the Detect Mode soft key, and then select the signal standard option: Auto, GSM, or
EDGE. Auto is set by default. The instrument applies a mask automatically based on the selected
mode.

3. Optional. To set the delay, complete the following steps:
a.

Press the Miscellaneous soft key.

b.

Press the Delay soft key to set the amount of delay in µs.

c.

Enter a value by using the numeric keys. You can also use the rotary knob.

d.

Press the µs soft key.

4. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available
for your measurement mode. See “Using save” on page 31 for more information.
NOTE
The Delay setting is used only when there is a time offset in the signals to be measured.
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Measurement example
Figure 41

Multipath profile measurement with GSM OTA signal analyzer

Modulation analyzer
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 109, you
can continue your measurement. The measurement settings can be saved and recalled as a file.
Procedure

1. Press the MEASURE SETUP hot key.
2. Press the Detect Mode soft key, and then select the signal standard option: Auto, GSM, or
EDGE. Auto is set by default. The instrument applies a mask automatically based on the selected
mode.

3. Optional. To set the delay, complete the following steps:
a.

Press the Miscellaneous soft key.

b.

Press the Delay soft key to set the amount of delay in µs.

c.

Enter a value by using the numeric keys. You can also use the rotary knob.

d.

Press the µs soft key.

4. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available
for your measurement mode. See “Using save” on page 31 for more information.
NOTE
The Delay setting is used only when there is a time offset in the signals to be measured.

Setting limit for modulation analyzer
Procedure

1. Press the LIMIT hot key.
2. Select the test item(s) and set the limit(s):
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To set the limit for

Select

Set

Frame average power

Frame Average Power

High Limit
Low Limit

Frequency error

Frequency Error

High Limit
Low Limit

Burst power

Burst Power

High Limit
Low Limit

ACLR

ACLR

(On/Off only)

Multi-ACLR

Multi-ACLR

(On/Off only)

Spurious emissions

Spurious Emissions

(On/Off only)

3. Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit.
Toggle the Beep soft key between On and Off to enable or disable the beep sound.

4. Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings.
See “Using save” on page 31 for more information.

Measurement example
Figure 42
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Using WCDMA/HSPA+ Signal Analyzer
This chapter provides instructions for using the WCDMA/HSPA+ Signal Analyzer function (option 023)
with the WCDMA/HSPA+ OTA Analyzer function (option 043). Topics discussed in this chapter are as
follows:
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Introduction
This WCDMA/HSPA+ Signal Analyzer can be used to test a WCDMA transmitter including
HSDPA/HSPA+ signals to check the base station’s compliance with following standards documentation.


3GPP TS 25.104 Base Station radio transmission and reception



3GPP TS 25.141 Base Station (BS) conformance test



3GPP TS 25.211 Physical channel and mapping of transport channels onto physical channels



3GPP TS 25.212 Multiplexing and channel coding



3GPP TS 25.213 Spreading and modulation

The instrument automatically makes standard defined measurements using the measurement
methods and limits as defined in the standards. Detailed measurement results allow you to analyze
WCDMA and HSPA+ system performance. You may alter the measurement parameters for specialized
analysis. Pass/Fail testing with standard defined or user defined upper and lower limits and the
Pass/Fail indictor help you to determine base station performance easily.
This instrument provides the following measurement tools for WCDMA/HSPA+ system:


Spectrum Analysis



RF Analysis
Channel Power
Occupied Bandwidth
Spectrum Emission Mask (SEM)
Adjacent Channel Leakage power Ratio (ACLR)
Multi-ACLR
Spurious Emissions



Modulation Analysis
Constellation
Code Domain Power
Relative Code Domain Error
Codogram
Received Code Strength Indicator (RCSI)
CDP Table



Auto Measure



Power Statistics CCDF



Over The Air (OTA)
Channel Scanner
Scramble Scanner
Multipath Profile
Code Domain Power
Route Map

Display overview
Figure 43 provides descriptions for each segment of the measurement screen.
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Figure 43

WCDMA/HSPA+ signal analyzer measurement screen

Connecting a cable
Direct connection
Procedure

1. Connect the Spectrum Analyzer RF In port of the JD780A series and the power amplifier output
port of BTS.

Figure 44

Direct connection

JD785A/JD786A

JD788A

Indirect connection
Procedure

1. Connect the Spectrum Analyzer RF In port of the JD780A series and the monitor (test) port of
BTS.
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Figure 45

Indirect connection

JD785A/JD786A

JD788A

CAUTION
The maximum power for the Spectrum Analyzer RF In port is +25 dBm (0.316 W). If the
input signal level to be measured is greater than +25 dBm, use a High Power
Attenuator to prevent damage when you directly connect the signal to the instrument or
connect the signal from the coupling port of a directional coupler.

Over the air (OTA)
Procedure

1. Connect an Omni/directional RF antenna to the Spectrum Analyzer RF In port of the JD780A
series.

2. Connect a GPS antenna to the GPS port of the JD780A series.
Figure 46

OTA connection

JD785A/JD786A

JD788A

CAUTION
If the input signal level to be measured is less than 0 dBm, set 0 dB attenuation or turn on
the preamp to have better dynamic range for the OTA testing.
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Selecting measurement mode
Procedure

1. Press the MODE hard key.
2. Press the Signal Analyzer soft key.
3. Press the WCDMA soft key. The Spectrum mode is set by default.
4. Press the MEASURE hot key, and then select the measurement mode option from the following
choices:

–

Spectrum

–

RF Analysis > Channel Power, Occupied BW, Spectrum Emission Mask, ACLR,
Multi-ACLR, or Spurious Emissions

–

Modulation > Constellation, Code Domain Power, Relative Code Domain Error,
Codogram, RCSI, or CDP Table

–

Auto Measure

–

Power Statistics CCDF

–

OTA > Channel Scanner, Scramble Scanner, Multipath Profile, Code Domain Power,
or Route Map

Configuring test parameters
Setting frequency
You can set the frequency with either frequency or channel number. If a frequency to be set matches
to the frequency corresponding to the selected channel standard, the instrument calculates its channel
number and updates the screen with it automatically.
Procedure
To set the center frequency:

1. Press the FREQ/DIST hard key.
2. Toggle the Unit soft key and select Freq.
3. Press the Center Frequency soft key.
4. Enter a value by using the numeric keys. You can also use the rotary knob.
5. Select the unit: GHz, MHz, kHz, or Hz.
6. Optional. To define the amount of frequency increment for the rotary knob, complete the following
steps:
a.

Press the Frequency Step soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Press the unit: GHz, MHz, kHz, or Hz.

To set the channel number:

1. Press the FREQ/DIST hard key.
2. Toggle the Unit soft key and select Channel.
3. To select the standard channel, complete the following steps:
a.

Press the Channel Std soft key. The standard channel window appears.
See “Appendix C – Band, frequency & channel standard” on page 541 for more information.
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b.

Select the band to be measured by using the rotary knob, the arrow keys, or the Page
Up/Page Down soft keys.

c.

Press the Select soft key or the rotary knob to confirm the selection.

4. Press the Channel Number soft key.
5. Enter a value by using the numeric keys. You can also use the rotary knob.
6. Press the Enter soft key.
The instrument automatically displays the corresponding center frequency value for the selected
channel number.

7. Optional. To define the amount of channel increment for the rotary knob, complete the following
steps:
a.

Press the Channel Step soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Press the Enter soft key.

NOTE
This frequency setting is not used in the Multi-ACLR and Spurious Emissions modes.

Setting amplitude
Reference level and attenuation
You can set the reference and attenuation levels automatically or manually to optimize the display of
the traces measured, as you desire.
Procedure
To automatically set the reference and attenuation level:

1. Press the AMP/SCALE hard key.
2. Press the Auto Scale soft key.
Each time you press this key, both of the Y-axis scale and input attenuation level change to be
optimized with some margin.
To set the reference or attenuation level manually:

1. Press the AMP/SCALE hard key.
2. To set the maximum reference value on the Y-axis manually, complete the following steps:
a.

Press the Reference Level soft key.

b.

Enter a value by using the numeric keys or the rotary knob with 10 dB increments.

c.

Press the dBm soft key or the ENTER hard key.
NOTE
In the measurements such as Code Domain Power, Codogram, and RCSI, you may
need to select the reference option between Relative and Absolute before setting the
reference level.

3. To set the attenuation option, select one from the following choices:
–

To set the input attenuator’s level automatically, select Attenuation > Auto.
NOTE
It is recommended that you set the Attenuation to Auto in most situations so that the
level of the input attenuator can be set automatically according to your input signal level.

–
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steps:

–

a.

Select Attenuation > Manual.

b.

Press the Attenuation Value soft key to set the level.

c.

Enter a value between 0 and 55 in fives by using the numeric keys.

d.

Press the dB soft key or the ENTER hard key.

To couple the input attenuator’s level with your reference level setting, select Attenuation >
Couple.
As you increse the reference setting, the attenuation level also increases acoordingly.

Optional. To change the scale unit:

1. Select More (1/2) > Units.
2. Select the unit of the display scale: dBm, dBV, dBmV, dBµV, V, or W.
The scale unit on the screen changes accordingly.
NOTE
This Units menu is available in the Spectrum and RF Analysis modes.

Scale per division
You can use the Scale/Div feature available for the spectrum and RF analysis. It represents the value
of one division on the horizontal scale. The default setting is 10 dB per division and the maximum
value can be set up to 20 dB.
Procedure
To set the scale per division:

1. Press the AMP/SCALE hard key.
2. Select More (1/2) > Scale/Div.
3. Enter a value between 1 and 20 by using the numeric keys.
4. Press the dB soft key to complete the entry.
Pre-amplifier
You can turn the internal pre-amplifier on to correct and compensate for the gain of the preamp so that
amplitude readings show the value at the input connector.
Procedure

1. Press the AMP/SCALE hard key.
2. Toggle the Preamp soft key and select On or Off as needed.
NOTE
You can turn the Preamp on when the input attenuation range is from 0 dB to 10 dB. If
the attenuation value is manually set to greater than 10 dB, the instrument will
automatically turn off the pre-amplifier to display low-level signal properly on the chart.

External offset
You can turn the External Offset on and manually set the external offset value. An offset consists of a
cable loss and a user offset and the measurement result shows the value reflecting both offset values.
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When the external offset value is set at 40 dB in the Spectrum mode, the measurement result
compensates 40 dB at both the Spectrum Analyzer and Signal Analyzer modes
Procedure
To set the external offset:

1. Press the AMP/SCALE hard key.
2. Toggle the External Offset soft key and select On.
3. Enter a value by using the numeric keys.
4. Press the dB soft key to complete the entry.
To turn the external offset off:

1. Press the AMP/SCALE hard key.
2. Toggle the External Offset soft key and select Off.

Setting average
You can set the number of measurements to be averaged for the trace presentation. A maximum of
100 times of averaging can be set. When the averaging reaches to your setting, a new measurement
value replaces the measurement value in sequence from the earliest.
Procedure

1. Press the BW/AVG hard key.
2. Press the Average soft key.
3. Enter a value between 1 and 100 as needed by using the numeric keys.
4. Press the Enter soft key.

Setting sweep mode
The default settings of the sweep mode are Continue and Normal to sweep continuously at a normal
speed for most on-going measurements. If you want to hold the measurement or get a single sweep,
you can change the sweep mode.
Procedure
To select the single sweep mode:

1. Press the SWEEP hot key.
2. Toggle the Sweep Mode soft key and select Single. You can also use the HOLD hot key.
The letter HOLD in red appears and the sweeping is paused.

3. Optional. Press the Sweep Once soft key to get a new measurement.
To return to the continuous sweep mode:

1. Toggle the Sweep Mode soft key and select Continue. You can also use the HOLD hot key.
The letter HOLD in red disappears and the sweeping resumes.

Setting trigger source
You can set the trigger source option for your measurements.
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Procedure

1. Press the TRIGGER hot key.
2. Select the trigger source option from the following choices: Internal, External, or GPS.

Setting external clock
To enhance the reliability of modulation analysis measurements the JD780A series must be
synchronized with a base station. When an external clock is not supplied, the instrument works with its
built-in internal high-accuracy time base and some measurement results may exhibit inaccurate values.
Therefore, it is highly recommended that you use the same reference clock as the signal source. You
can use the TRIGGER hot key to set the external clock.
Table 12

Standards of external clock operation

Clock

Type

Reference

External
Reference

Internal

Internal 10 MHz

External

External Ref Clock

Ext Ref (SMA)

Manual switching
(Input signal level >-3 dBm)

GPS

GPS Clock

GPS (SMA)

Automatic switching
(GPS signal received)

Internal

Internal Trigger

External

External Trigger

Trigger (SMA)

Manual switching

GPS

GPS

GPS (SMA)

Manual switching

Trigger

Figure 47

Port

Switching Standard
Default

Default

Connection ports for external reference clock

Procedure

1. Connect an external reference or a GPS antenna to the JD780A series.
2. Press the SYSTEM hot key.
3. Press the Freq Reference soft key, and then select the reference option: Internal, External 10
MHz, External 13 MHz, External 15 MHz, or GPS.
NOTE
When a GPS antenna is connected and locked, GPS coordinates (longitude and latitude)
are displayed on the screen and frequency reference is automatically set to GPS in the
System > Freq Reference.
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Table 13
Type

External reference indicators
Indicator

Description

Internal

(green)

The green INT icon indicates that the instrument uses the built-in
internal time base.

External

(green)

The green EXT icon indicates that an external reference is connected
and locked and that the instrument uses the same reference clock as
the signal source.

External

(red)

The red EXT icon indicates that an external reference is connect but not
locked.

GPS

(green)

The green GPS antenna icon indicates that a GPS antenna is
connected and locked.

GPS

(yellow)

The yellow GPS antenna icon indicates that a GPS antenna is
connected and locking is in progress.

GPS

(grey)

The grey GPS antenna icon indicates that a GPS antenna is not
connected, failed, or unable to be locked.

Conducting spectrum measurements
If you have configured test parameters as described in the “Configuring test parameters” on page 137,
your measurement result is displayed on the screen as like the following example, Figure 48.
Figure 48

Spectrum measurement screen with WCDMA signal analyzer

Setting trace
You can display up to six traces on the measurement chart simultaneously.
Procedure

1. Press the TRACE/DISPLAY hard key.
2. Press the Select Trace soft key, and then select the trace number: T1, T2, T3, T4, T5, or T6.
The legend shape of the selected trace changes from square to round to indicate that the trace is
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the active one now.

3. Toggle the Trace View soft key and select On.
4. To clear, write or capture, or hide the trace(s), do one of the following:
To

Select

Trace Legend

Clear current data and display with new
measurements

Clear Write

W

Display the input signal’s maximum response only

Max Hold

M

Display the input signal’s minimum response only

Min Hold

m

Capture the selected trace and compare traces

Capture

C

Load a saved trace

More (1/2) > Load

L

Hide the selected trace

Trace View > Off

F

Remove all the traces and initialize the trace
settings

More (1/2) > Trace
Clear All

5. To select the detection option, press the More (1/2) > Detectors, and then do one of the
following:
To display

Select

Random noise better than the peak without missing signals

Normal

The highest value in each data point

Peak

The root mean squared average power across the spectrum

RMS

The lowest value in each data point

Negative Peak

The center value in each data point

Sample

6. Optional. Press the More (1/2) > Trace Info soft key, and then select the trace number to view
the trace’s parameter setting information stored at the time of the measurement or None to hide
the information display.

7. Optional. If you have the two traces T1 and T2, you can perform trace math. To view the power
difference between the traces, press the T1 – T2 -> T5 or T2 – T1 -> T6 soft key.
The result is overlaid on the screen along with the second Y-axis.

Conducting RF measurements
Channel power
The Channel Power measurement is a common test used in the wireless industry to measure the total
transmitted power of a radio within a defined frequency channel. This procedure measures the total
power within the defined channel for WCDMA. This measurement is applied to design, characterize,
evaluate, and verify transmitters and their components or devices for base stations and mobile stations.
The channel power measurement identifies the channel power within a specified bandwidth (default is
5 MHz, as per the 3GPP WCDMA technical specifications) and the power spectral density (PSD) in
dBm/Hz.
After configuring test parameters as described in the “Configuring test parameters” on page 137, your
measurement result is displayed on the screen as like the following example, Figure 49.
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Figure 49

Channel power measurement with WCDMA/HSPA+ signal analyzer

NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 150 for more
information.

Occupied bandwidth
The 3GPP specifications require the occupied bandwidth (OBW) of a transmitted WCDMA signal to be
less than 5 MHz, where occupied bandwidth is defined as the bandwidth containing 99% of the total
channel power. In this measurement, the total power of the displayed span is measured. Then the
power is measured inward from the right and left extremes until 0.5% of the power is accounted for
each of the upper and lower part of the span and the calculated difference is the occupied bandwidth.
The spectrum shape of a WCDMA signal can give a useful qualitative insight into the transmitter’s
operation. Any distortion to the spectrum shape might be an indication of degradation of the
transmitter's performance.
After configuring test parameters as described in the “Configuring test parameters” on page 137, your
measurement result is displayed on the screen as like the following example, Figure 50.
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Figure 50

Occupied bandwidth measurement with WCDMA/HSPA+ signal analyzer

NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 150 for more
information.

Spectrum emission mask (SEM)
The Spectrum Emission Mask (SEM) measurement required by 3GPP specifications encompasses
different power limits and different measurement bandwidths (resolution bandwidths) at various
frequency offsets. It may be expressed as a ratio of power spectral densities between the carrier and
the specified offset frequency band. It provides useful figures-of-merit for the spectral re-growth and
emissions produced by components and circuit blocks, without the rigor of performing a full SEM
measurement.
The SEM measures spurious signal levels in up to five pairs of offset or region frequencies and relates
them to the carrier power.
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 137, you
can set the mask type according to the output power of the base station be tested. Your measurement
result is displayed on the screen as like the following example, Figure 51.
Procedure

1. Press the MEASURE SETUP hot key.
2. Press the Mask Type soft key.
3. Select the mask type option: – 31 dBm, 31 – 39 dBm, 39 – 43 dBm, or 49 dBm –.
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Figure 51

SEM measurement with WCDMA/HSPA+ signal analyzer

NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 150 for more
information.

ACLR
The Adjacent Channel Power Ratio (ACPR), designated by the 3GPP WCDMA specifications as the
Adjacent Channel Leakage power Ratio (ACLR), is the power contained in a specified frequency
channel bandwidth relative to the total carrier power. It may also be expressed as a ratio of power
spectral densities between the carrier and the specified offset frequency band.
After configuring test parameters as described in the “Configuring test parameters” on page 137, your
measurement result is displayed on the screen as like the following example, Figure 52.
Figure 52
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NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 150 for more
information.

Multi-ACLR
The Multi-ACLR measurement is used to perform multi-channel ACLR measurements with as many
channels as possible. It helps you to measure ACLR in multi-channel transmitting Base Station
environment.
Setting frequency for Multi-ACLR
You can set the frequency with either frequency or channel number.
Procedure

1. Press the MEASURE SETUP hot key.
2. To set the frequency, do one of the following:
–

–

To set the center frequency, complete the following steps:
a.

Toggle the Unit soft key and select Freq.

b.

Press the Lowest Frequency soft key to set the starting center frequency.

c.

Enter a value by using the numeric keys. You can also use the rotary knob.

d.

Select the unit: GHz, MHz, kHz, or Hz.

e.

Press the Highest Frequency soft key to set the stopping center frequency.

f.

Enter a value by using the numeric keys. You can also use the rotary knob.

g.

Select the unit: GHz, MHz, kHz, or Hz.

To set the channel number, complete the following steps:
a.

Toggle the Unit soft key and select Channel.

b.

To select the standard channel, press the Channel Std soft key and then select the
band to be measured.

c.

Press the Lowest Channel soft key to set the starting channel.

d.

Enter a value by using the numeric keys. You can also use the rotary knob.

e.

Press the Enter soft key.

f.

Press the Highest Channel soft key to set the stopping channel.

g.

Enter a value by using the numeric keys. You can also use the rotary knob.

h.

Press the Enter soft key.

After configuring test parameters, your measurement result is displayed on the screen as like the
following example, Figure 53.
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Figure 53

Multi-ACLR measurement with WCDMA/HSPA+ signal analyzer

NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 150 for more
information.

Spurious emissions
Out-of-band emissions are unwanted emissions immediately outside the channel bandwidth resulting
from the modulation process and non-linearity in the transmitter but excluding spurious emissions. The
Spurious Emissions measurement is to identify and determine the power level of out-of-band spurious
emission within the necessary channel bandwidth and modulated signal measured at the RF port of
the Base Station.
Setting measure setup
Procedure

1. Press the MEASURE SETUP hot key.
2. To set up the range table and frequency range, press the Range Table soft key and then
complete the following steps:
a.

Press the Range soft key, and then enter the range number to add a new range or change
an existing one.

b.

Press the Enter soft key.

c.

Press the Start Frequency soft key to set up the frequency range.

d.

Enter a value by using the numeric keys. You can also use the rotary knob.

e.

Select the unit: GHz, MHz, kHz, or Hz.

f.

Press the Stop Frequency soft key to set up the frequency range.

g.

Enter a value by using the numeric keys. You can also use the rotary knob.

h.

Select the unit: GHz, MHz, kHz, or Hz.

3. Toggle the Range soft key between On and Off to display or hide the selected range.
4. To set up the test limits for Pass/Fail indication, complete the following steps:
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a.

Press the Start Limit soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Select the dBm soft key.

d.

Press the Stop Limit soft key.

e.

Enter a value by using the numeric keys. You can also use the rotary knob.

f.

Select the dBm soft key.

5. To set up the other parameters, complete the following steps:
a.

Select More (1/2) > Attenuation to set up the attenuation value.

b.

Enter a value in the multiple of five.

c.

Press the dB soft key or the ENTER hard key.

d.

Press the RBW soft key.

e.

Enter a value by using the numeric keys.

f.

Select the unit: GHz, MHz, kHz, or Hz.

g.

Press the VBW soft key.

h.

Enter a value by using the numeric keys.

i.

Select the unit: GHz, MHz, kHz, or Hz.

6. Press the PREV hard key.
7. Toggle the Measure Type soft key between Examine and Full to select the measurement type.
NOTE
The Examine mode displays only the selected range while the Full mode lets the
instrument automatically changes the selected range from one another.

8. Set the number of measurements to be averaged:
a.

Press the Average soft key.

b.

Enter a value between 1 and 100.

c.

Press the Enter soft key.

After configuring test parameters as described in the “Configuring test parameters” on page 137, your
measurement result is displayed on the screen as like the following example, Figure 54.
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Figure 54

Spurious emissions measurement with WCDMA/HSPA+ signal analyzer

NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 150 for more
information.

Setting limit for RF tests
By default, test limits specified in the standard are set for you. You can change thresholds if you desire.
Procedure

1. Press the LIMIT hot key.
2. Press the RF Test Limits soft key.
3. Select the test item(s) and set the limit(s) depending on your selected measurement mode:
To set the limit for

Select

Set

Channel power

Channel Power

High Limit
Low Limit

Occupied bandwidth

Occupied BW

High Limit

Spectrum emission mask

Spectrum Emission Mask

(On/Off only)

ACLR

ACLR

(On/Off only)

Multi-ACLR

Multi-ACLR

(On/Off only)

Spurious emissions

Spurious Emissions

(On/Off only)

4. Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit.
Toggle the Beep soft key between On and Off to enable or disable the beep sound.

5. Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings.
See “Using save” on page 31 for more information.
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Conducting modulation measurements
Constellation
The Constellation is used to observe some aspects of modulation accuracy and can reveal certain
fault mechanisms such as I/Q amplitude imbalance or quadrature imbalance. It displays constellation
diagram by modulation types.
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 137, you
can continue your measurement. The measurement settings can be saved and recalled as a file.
Procedure

1. Press the MEASURE SETUP hot key.
2. To set the scramble code, complete the following steps:
a.

Toggle the Scramble soft key between Auto and Manual.

b.

Enter a value by using the numeric keys to set manually.

c.

Press the Enter soft key.

3. Press the Detect Mode soft key, and then select the signal standard option: WCDMA, HSDPA,
or HSPA+. HSDPA is set by default.

4. To set the threshold, complete the following steps:
a.

Press the Threshold soft key.

b.

Enter a value by using the numeric keys.

c.

Press the Enter soft key.

Measurement example
Figure 55

Constellation measurement with WCDMA/HSPA+ signal analyzer

NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 162 for
more information.

Using WCDMA/HSPA+ Signal Analyzer

151

JD780A Series Analyzers

Code domain power
The Code Domain Power (CDP) measures the distribution of power across the set of code channels,
normalized to the total power. It helps to verify that each code channel is operating at its proper level
and to identify problems throughout the transmitter design from coding to the RF section. System
imperfections such as amplifier non-linearity will present themselves as an undesired distribution of
power in the code domain.
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 137, you
can continue your measurement. The measurement settings can be saved and recalled as a file. You
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load
the file on to the instrument.
Procedure

1. Press the MEASURE SETUP hot key.
2. Optional. To set the scramble code, complete the following steps:
a.

Toggle the Scramble soft key between Auto and Manual.

b.

Enter a value by using the numeric keys to set manually.

c.

Press the Enter soft key.

3. Optional. Press the Detect Mode soft key, and then select the signal standard option: WCDMA,
HSDPA, or HSPA+. HSDPA is set by default.

4. To set the S-CCPCH information of the system to be tested, complete the following steps:
a.

Press the S-CCPCH soft key.

b.

Toggle the S-CCPCH soft key between On and Off to enable or disable the S-CCPCH.

c.

Press the Spread Factor soft key, and then select the spread factor option: 4, 8, 16, 32, 64,
128, or 256.

d.

Press the Spread Code soft key to set the spread code.

e.

Enter a value by using the numeric keys.

f.

Press the Enter soft key.

5. To set the PICH information of the system to be tested, complete the following steps:
a.

Press the PICH soft key.

b.

Toggle the PICH soft key between On and Off to enable or disable the PICH.

c.

Press the Spread Factor soft key, and then select the spread factor option: 4, 8, 16, 32, 64,
128, or 256.

d.

Press the Spread Code soft key to set the spread code.

e.

Enter a value by using the numeric keys.

f.

Press the Enter soft key.

6. Optional. To set the threshold, complete the following steps:

152

a.

Press the Threshold soft key.

b.

Enter a value by using the numeric keys.

c.

Press the Enter soft key.
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Measurement example
Figure 56

Code domain power measurement with WCDMA/HSPA+ signal analyzer

1) Full screen

2) Full screen with constellation
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3) Zoomed screen (Width 64)

4) Zoomed screen with constellation (Width 64)

NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 162 for
more information.

Setting display
You can view .your measurement results in a different view option.
Procedure

1. Press the TRACE/DISPLAY hard key.
2. Toggle the View soft key and select the display option:
–
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The Position and Width menus become activated.
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–

Full: to view the full measurement result.

3. To define the zoom start position and width, complete the following steps:
a.

Press the Position soft key.

b.

Enter a value of the position by using the numeric keys.

c.

Press the Enter soft key.

d.

Press the Width soft key, and then select the Walsh code option: 32, 64, 128, or 256.

4. Toggle the Constellation soft key between On and Off to enable or disable the constellation
chart on the Code Domain Power screen.

5. Toggle the Control Channel soft key and select the control channel mode option:
–

Normal: to view the relative ratio of each control channel vs. total power.

–

Delta: to view the relative ratio of each control channel vs. CPICH channel.

Relative code domain power
The Relative Code Domain Error (RCDE) measurement provides relative code domain error analysis
that is particularly required by HSPA+.
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 137, you
can continue your measurement. The measurement settings can be saved and recalled as a file. You
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load
the file on to the instrument.
Procedure

1. Press the MEASURE SETUP hot key.
2. Optional. To set the scramble code, complete the following steps:
a.

Toggle the Scramble soft key between Auto and Manual.

b.

Enter a value by using the numeric keys to set manually.

c.

Press the Enter soft key.

3. Optional. Press the Detect Mode soft key, and then select the signal standard option: WCDMA,
HSDPA, or HSPA+. HSDPA is set by default.
NOTE
It is recommended that you select HSPA+ for RCDE testing.

4. To set the S-CCPCH information of the system to be tested, complete the following steps:
a.

Press the S-CCPCH soft key.

b.

Toggle the S-CCPCH soft key between On and Off to enable or disable the S-CCPCH.

c.

Press the Spread Factor soft key, and then select the spread factor option: 4, 8, 16, 32, 64,
128, or 256.

d.

Press the Spread Code soft key to set the spread code.

e.

Enter a value by using the numeric keys.

f.

Press the Enter soft key.

5. To set the PICH information of the system to be tested, complete the following steps:
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a.

Press the PICH soft key.

b.

Toggle the PICH soft key between On and Off to enable or disable the PICH.

c.

Press the Spread Factor soft key, and then select the spread factor option: 4, 8, 16, 32, 64,
128, or 256.

d.

Press the Spread Code soft key to set the spread code.

e.

Enter a value by using the numeric keys.

f.

Press the Enter soft key.

6. Optional. To set the threshold, complete the following steps:
a.

Press the Threshold soft key.

b.

Enter a value by using the numeric keys.

c.

Press the Enter soft key.

7. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available
for your measurement mode. See “Using save” on page 31 for more information.

Measurement example
Figure 57

Relative code domain error with WCDMA/HSPA+ signal analyzer

NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 162 for
more information.

Setting display
You can view .your measurement results in a different view option.
Procedure

1. Press the TRACE/DISPLAY hard key.
2. Toggle the View soft key and select the display option:
–
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Zoom: to view the result in detail with zoom-in window.
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The Position and Width menus become activated.

–

Full: to view the full measurement result.

3. To define the zoom start position and width, complete the following steps:
a.

Press the Position soft key.

b.

Enter a value of the position by using the numeric keys.

c.

Press the Enter soft key.

d.

Press the Width soft key, and then select the Walsh code option: 32, 64, 128, or 256.

4. Toggle the Constellation soft key between On and Off to enable or disable the constellation
chart on the Code Domain Power screen.

5. Toggle the Control Channel soft key and select the control channel mode option:
–

Normal: to view the relative ratio of each control channel vs. total power.

–

Delta: to view the relative ratio of each control channel vs. CPICH channel.

Codogram
The Codogram displays how the code level is changing over time and makes it easier for you to view
traffic channels as they initiate and terminate and to track traffic channels call levels over time. The
Codogram measurements can be saved into an external USB memory so that a post-analysis can be
done with the application software JDViewer.
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 137, you
can continue your measurement. The measurement settings can be saved and recalled as a file. You
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load
the file on to the instrument.
Procedure

1. Press the MEASURE SETUP hot key.
2. Optional. To set the scramble code, complete the following steps:
a.

Toggle the Scramble soft key between Auto and Manual.

b.

Enter a value by using the numeric keys to set manually.

c.

Press the Enter soft key.

3. Optional. Press the Detect Mode soft key, and then select the signal standard option: WCDMA,
HSDPA, or HSPA+. HSDPA is set by default.

4. To set the S-CCPCH information of the system to be tested, complete the following steps:
a.

Press the S-CCPCH soft key.

b.

Toggle the S-CCPCH soft key between On and Off to enable or disable the S-CCPCH.

c.

Press the Spread Factor soft key, and then select the spread factor option: 4, 8, 16, 32, 64,
128, or 256.

d.

Press the Spread Code soft key to set the spread code.

e.

Enter a value by using the numeric keys.

f.

Press the Enter soft key.

5. To set the PICH information of the system to be tested, complete the following steps:
a.

Press the PICH soft key.
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b.

Toggle the PICH soft key between On and Off to enable or disable the PICH.

c.

Press the Spread Factor soft key, and then select the spread factor option: 4, 8, 16, 32, 64,
128, or 256.

d.

Press the Spread Code soft key to set the spread code.

e.

Enter a value by using the numeric keys.

f.

Press the Enter soft key.

6. Optional. To set the threshold, complete the following steps:
a.

Press the Threshold soft key.

b.

Enter a value by using the numeric keys.

c.

Press the Enter soft key.

7. To set the time interval, complete the following steps:
a.

Press the Time Interval soft key.

b.

Enter a value by using the numeric keys.

c.

Press the Enter soft key.

8. To place the time cursor to analyze your measurements, complete the following steps:
a.

Toggle the Time Cursor soft key between On and Off to enable or disable the time cursor.

b.

Enter a value by using the numeric keys.

c.

Press the Enter soft key.
NOTE
When the time cursor is enabled, the measurement is put on hold and information about
the time cursor is displayed.

9. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available
for your measurement mode. See “Using save” on page 31 for more information.

Measurement example
Figure 58
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Setting display
You can view .your measurement results in a different view option.
Procedure

1. Press the TRACE/DISPLAY hard key.
2. Toggle the View soft key and select the display option:
–

Zoom: to view the result in detail with zoom-in window.
The Position and Width menus become activated.

–

Full: to view the full measurement result.

3. To define the zoom start position and width, complete the following steps:
a.

Press the Position soft key.

b.

Enter a value of the position by using the numeric keys.

c.

Press the Enter soft key.

d.

Press the Width soft key, and then select the Walsh code option: 32, 64, 128, or 256.

RCSI
The Received Code Strength indicator (RCSI) is used to track the code channels such as CPICH, PCCPCH, S-CCPCH, PICH, P-SCH, and S-SCH. It is particularly useful to observe signal fluctuations of
the dedicated control channels over the time. The RCSI measurements can be saved into an external
USB memory so that a post-analysis can be done with the application software JDViewer.
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 137, you
can continue your measurement. The measurement settings can be saved and recalled as a file. You
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load
the file on to the instrument.
Procedure

1. Press the MEASURE SETUP hot key.
2. Optional. To set the scramble code, complete the following steps:
a.

Toggle the Scramble soft key between Auto and Manual.

b.

Enter a value by using the numeric keys to set manually.

c.

Press the Enter soft key.

3. Optional. Press the Detect Mode soft key, and then select the signal standard option: WCDMA,
HSDPA, or HSPA+. HSDPA is set by default.

4. To set the S-CCPCH information of the system to be tested, complete the following steps:
a.

Press the S-CCPCH soft key.

b.

Toggle the S-CCPCH soft key between On and Off to enable or disable the S-CCPCH.
Setting this on makes the S-CCPCH in the Alarm Code menu activated.

c.

Press the Spread Factor soft key, and then select the spread factor option: 4, 8, 16, 32, 64,
128, or 256.

d.

Press the Spread Code soft key to set the spread code.

e.

Enter a value by using the numeric keys.
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f.

Press the Enter soft key.

5. To set the PICH information of the system to be tested, complete the following steps:
a.

Press the PICH soft key.

b.

Toggle the PICH soft key between On and Off to enable or disable the PICH.
Setting this on makes the PICH in the Alarm Code menu activated.

c.

Press the Spread Factor soft key, and then select the spread factor option: 4, 8, 16, 32, 64,
128, or 256.

d.

Press the Spread Code soft key to set the spread code.

e.

Enter a value by using the numeric keys.

f.

Press the Enter soft key.

6. Optional. To set the threshold, complete the following steps:
a.

Press the Threshold soft key.

b.

Enter a value by using the numeric keys.

c.

Press the Enter soft key.

7. Press the Alarm Code soft key, and then select the alarm code option: None, CPICH, PCCPCH, S-CCPCH, PICH, P-SCH, or S-SCH.
NOTE
The alarm codes S-CCPCH and PICH become activated in case that you have enabled
the S-CCPCH and PICH respectively.

8. To set the alarm mask, complete the following steps:
a.

Press the Set Mask soft key.

b.

Enter a value by using the numeric keys.

c.

Press the Enter soft key.

9. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available
for your measurement mode. See “Using save” on page 31 for more information.

Measurement example
Figure 59
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Setting display
You can view .your measurement results in a different view option.
Procedure

1. Press the TRACE/DISPLAY hard key.
2. Toggle the View soft key and select the display option:
–

Zoom: to view the result in detail with zoom-in window.
The Position and Width menus become activated.

–

Full: to view the full measurement result.

3. To define the zoom start position and width, complete the following steps:
a.

Press the Position soft key.

b.

Enter a value of the position by using the numeric keys.

c.

Press the Enter soft key.

d.

Press the Width soft key, and then select the Walsh code option: 32, 64, 128, or 256.

CDP Table
The CDP Table is used to look at a numeric and textual description of all the active code channels in
the signal.
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 137, you
can continue your measurement. The measurement settings can be saved and recalled as a file. You
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load
the file on to the instrument.
Procedure

1. Press the MEASURE SETUP hot key.
2. Optional. To set the scramble code, complete the following steps:
a.

Toggle the Scramble soft key between Auto and Manual.

b.

Enter a value by using the numeric keys to set manually.

c.

Press the Enter soft key.

3. Optional. Press the Detect Mode soft key, and then select the signal standard option: WCDMA,
HSDPA, or HSPA+. HSDPA is set by default.

4. To set the S-CCPCH information of the system to be tested, complete the following steps:
a.

Press the S-CCPCH soft key.

b.

Toggle the S-CCPCH soft key between On and Off to enable or disable the S-CCPCH.

c.

Press the Spread Factor soft key, and then select the spread factor option: 4, 8, 16, 32, 64,
128, or 256.

d.

Press the Spread Code soft key to set the spread code.

e.

Enter a value by using the numeric keys.

f.

Press the Enter soft key.

5. To set the PICH information of the system to be tested, complete the following steps:
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a.

Press the PICH soft key.

b.

Toggle the PICH soft key between On and Off to enable or disable the PICH.

c.

Press the Spread Factor soft key, and then select the spread factor option: 4, 8, 16, 32, 64,
128, or 256.

d.

Press the Spread Code soft key to set the spread code.

e.

Enter a value by using the numeric keys.

f.

Press the Enter soft key.

6. Optional. To set the threshold, complete the following steps:
a.

Press the Threshold soft key.

b.

Enter a value by using the numeric keys.

c.

Press the Enter soft key.

Measurement example
Figure 60

CDP Table measurement with WCDMA/HSPA+ signal analyzer

Setting display
If the CDP table spans over to the next page(s), you can change pages up and down to view .your
measurement results.
Procedure

1. Press the TRACE/DISPLAY hard key.
2. Select Page Up or Page Down as needed.

Setting limit for modulation tests
Procedure

1. Press the LIMIT hot key.
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2. Press the Modulation Test Limits soft key to set the limits.
3. Select the test item(s) and set the limit(s) depending on your selected measurement mode:
To set the limit for

Select

Set

Frequency error

Frequency Error

High Limit
Low Limit

Error vector magnitude

EVM

High Limit

Peak code domain error

PCDE

High Limit

Carrier feed through

Carrier Feed Through

High Limit

Correlated power in coded channel

CPICH

High Limit [Abs|Rel]
Low Limit [Abs|Rel]

Highest level among inactive channels

Max Inactive

High Limit

Relative code domain error

RCDE

High Limit (QPSK)
High Limit (16 QAM)
High Limit (64 QAM)

4. Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit.
Toggle the Beep soft key between On and Off to enable or disable the beep sound.

5. Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings.
See “Using save” on page 31 for more information.
NOTE
The Carrier Feed Through is a result of the RF carrier signal feeding through the I/Q
modulator and riding on the output circuitry without being modulated.

Performing auto measurements
The Auto Measure function of the JD780A series allows a complete signal profiling covering RF
characterization and modulation quality parameters of up to 10 different carriers, particularly useful on
an overlay architecture where base stations are transmitting in different frequencies.
The Auto Measure can be easily executed either by selecting a menu in the instrument or by running a
programmed scenario in the PC-based application so that the instrument automatically configure and
perform tests on every aspect of all the carriers.

Setting limit for auto measure
You can set test limits for test item(s) in the auto measurement.
Procedure

1. Press the LIMIT hot key.
2. Press the RF Test Limits soft key, and then enable test limits as desired.
3. Press the Modulation Test Limits soft key, and then enable test limits as desired.
4. Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit.
Toggle the Beep soft key between On and Off to enable or disable the beep sound.

5. Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings.
See “Using save” on page 31 for more information.
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Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 137, you
can continue your measurement. The measurement settings can be saved and recalled as a file. You
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load
the file on to the instrument.
Procedure

1. Press the MEASURE SETUP hot key.
2. Toggle the Configuration soft key and select the configuration option:
–

Current: to let the instrumnet use current frequency (single carrier) and determine pass or
fail based on the instrument’s limit settings in Auto Measure.

–

Scenario: to run a test with a programmed scenario in JDViewer.
The Scenario menu becomes activated.

3. To load a scenario, press the Scenario soft key, and then select a scenario file to load.
4. Toggle the Test Time soft key and select the test time option:
–

Now: to let the instrument run a test only once.

–

Schedule: to let the instrument repeat tests as defined in the Set Timing.
The Set Timing menu becomes activated.

5. To define a schedule for an auto measurement, complete the following steps:
a.

Press the Set Timing soft key.

b.

Press the Start Time (HH:MM) soft key.

c.

Enter the time in the HH:MM format, and then press the Enter soft key.

d.

Press the Stop Time (HH:MM) soft key.

e.

Enter the time in the HH:MM format, and then press the Enter soft key.

f.

Press the Time Interval soft key.

g.

Enter the amount of time in minutes, and then press the Enter soft key.

6. To set external offset, complete the following steps:
a.

Toggle the External Offset soft key and select On.

b.

Enter a value by using the numeric keys, and then press the dB soft key.

6. To save your settings and results, go to SAVE/LOAD > Save and then perform functions as you
desire. See “Using save” on page 31 for more information.

7. Press the Run Test soft key to start to run a test.
The Auto Measure Results window appears at the end of the test.

8. To stop running the test, press the Abort soft key.
9. To change the view on the screen during the test, press the Display and then select the view
option from the following choices:

–

Screen: You can view each measurement screen as the test progresses.

–

Results: You can view a measurement result table as the test progresses.

–

Settings: You can view a measurement setting table as the test progresses.

Setting display
After completion of the auto measurement, the screen menu changes to Trace/Display so that you can
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view the results in different forms.
Procedure

1. Toggle the Display soft key and select the display option:
–

Result: to view the result table.
The Display Result menu becomes activated.

–

Settings: to view the measurement settings for the auto measurement.

2. Toggle the Display Result soft key and select the display result option:
–

Full: to view detailed measurement readings with the pass/fail indication.

–

Quick: to view only the Pass/Fail results.

3. To view the measurement results for a different carrier, press the View Carrier soft key and then
select the carrier number to view.

Performing power statistics CCDF measurement
The Power Statistics Complementary Cumulative Distribution Function (CCDF) measurement
characterizes the power statistics of the input signal. It provides PAR (Peak to Average power Ratio)
versus different probabilities.

Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 137, you
can continue your measurement. The measurement settings can be saved and recalled as a file. You
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load
the file on to the instrument.
Procedure

1. Press the MEASURE SETUP hot key.
2. Press the CCDF Length soft key to set the length of the CCDF.
3. Enter a value between 1 and 100 by using the numeric keys. You can also use the rotary knob.
4. Press the Enter soft key.
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Measurement example
Figure 61

CCDF measurement with WCDMA/HSPA+ signal analyzer

Conducting WCDMA/HSPA+ OTA measurements
This Over The Air (OTA) measurement has channel scanner, scramble scanner, multipath profile, code
domain power, and route map screens. Scramble scanner displays six scrambling codes and powers
to inform neighbor cells existence and its power. The multipath profile graph helps you to determine
testing area's RF environmental condition. The code domain power shows not only modulation
performance metric but also amplifier capacity and code utilization metric. The amplifier capacity (code
utilization) measurement is an estimate of the amount of power amplifier capacity (code utilization) that
is being used expressed in percent of maximum.

Channel scanner
Setting channel/frequency
Procedure
To set the channels to be scanned:

1. Press the FREQ/DIST hard key.
2. Toggle the Unit soft key and select Channel.
3. Press the Index soft key, and then enter an index number by turning the rotary knob or using the
numeric keys.

4. To select the standard channel, complete the following steps:
a.

Press the Channel Std soft key. The standard channel window appears.
See “Appendix C – Band, frequency & channel standard” on page 541 for more information.

b.

Select the band to be measured by using the rotary knob, the arrow keys, or the Page
Up/Page Down soft keys.

c.

Press the Select soft key or the rotary knob to confirm the selection.

5. To set the channel number for the selected index, complete the following steps:
a.
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Press the Channel Number soft key.

Using WCDMA/HSPA+ Signal Analyzer

JD780A Series Analyzers

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Press the Enter soft key.

The instrument displays a corresponding center frequency for the channel number.

6. To set the integration bandwidth for the selected index, complete the following steps:
a.

Press the Integration Bandwidth soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Select the unit: GHz, MHz, kHz, or Hz.

7. To add more channels to be scanned, repeat steps 3-6.
8. Press the ESC hard key to dismiss the channel list window and view the scanning result.
To set the frequencies to be scanned:

1. Press the FREQ/DIST hard key.
2. Toggle the Unit soft key and select Freq.
3. Press the Index soft key, and then enter an index number by turning the rotary knob or using the
numeric keys.

4. To set the center frequency for the selected index, complete the following steps:
a.

Press the Center Frequency soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Select the unit: GHz, MHz, kHz, or Hz.

5. To set the integration bandwidth for the selected index, complete the following steps:
a.

Press the Integration Bandwidth soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Select the unit: GHz, MHz, kHz, or Hz.

6. To add more channels to be scanned, repeat steps 3-5.
7. Press the ESC hard key to dismiss the channel list window and view the scanning result.
Setting limit for OTA channel scanner
Procedure

1. Press the LIMIT hot key.
2. Press the Limit Line soft key to set a threshold for the limit line and Pass/Fail indication.
3. Enter a value, and then press the dBm unit soft key.
4. Toggle the Limit Line soft key between On and Off to display or dismiss the limit line.
5. Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit.
Toggle the Beep soft key between On and Off to enable or disable the beep sound.

6. Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings.
See “Using save” on page 31 for more information.
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Measurement example
Figure 62

Channel scanner measurement with WCDMA/HSPA+ OTA signal analyzer

Scramble scanner
The WCDMA/HSPA+ mobile receives signals from multiple base stations that all of these signals share
the same spectrum and are present at the same time. Each base station has a unique scrambling code
assigned to the particular base station and it differentiates its signal from other base stations in the area.
Measurement example
Figure 63

Scramble scanner measurement with WCDMA/HSPA+ OTA signal analyzer

Multipath profile
The Multipath Profile enables you to determine RF environmental conditions of testing area. It
indicates the amount of power of the dominant pilot signal that is dispersed outside the main
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correlation peak due to multipath echoes that are expressed in dB. This value should be very small
ideally.
The multipath profile is the result of portions of the original broadcast signal arriving at the receiving
antenna out of phase. This can be caused by the signal being reflected off objects such as buildings,
or being refracted through the atmosphere differently from the main signal.
Measurement example
Figure 64

Multipath profile measurement with WCDMA/HSPA+ OTA signal analyzer

Code domain power
Channels with high correlation factors are determined to be active channels and are indicated as such
on the display. Once the channels are decoded, the analyzer determines the power of each channel
relative to the total signal power.
This measurement helps to verify that each code channel is operating at its proper level and helps to
identify problems throughout the transmitter design from the coding to the RF section. System
imperfections, such as the non-linearity of amplifiers, will present themselves as an undesired
distribution of power in the code domain.
Setting measure setup
After configuring test parameters, you can set the measure setup to continue your measurement. The
measurement settings can be saved and recalled as a file. You can also use JDViewer, PC application
software to configure a measure setup, save as a file, and load the file on to the instrument.
Procedure

1. Press the MEASURE SETUP hot key.
2. To set the scramble code, complete the following steps:
a.

Toggle the Scramble soft key between Auto and Manual.

b.

Enter a value by using the numeric keys to set manually.
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c.

Press the Enter soft key.

3. Press the Detect Mode soft key, and then select the signal standard option: WCDMA, HSDPA,
or HSPA+. HSDPA is set by default.

4. To set the threshold, complete the following steps:
a.

Press the Threshold soft key.

b.

Enter a value by using the numeric keys.

c.

Press the Enter soft key.

5. To set the S-CCPCH information of the system to be tested, complete the following steps:
a.

Press the S-CCPCH soft key.

b.

Toggle the S-CCPCH soft key between On and Off to enable or disable the S-CCPCH.

c.

Press the Spread Factor soft key, and then select the spread factor option: 4, 8, 16, 32, 64,
128, or 256.

d.

Press the Spread Code soft key to set the spread code.

e.

Enter a value by using the numeric keys.

f.

Press the Enter soft key.

6. To set the PICH information of the system to be tested, complete the following steps:
a.

Press the PICH soft key.

b.

Toggle the PICH soft key between On and Off to enable or disable the PICH.

c.

Press the Spread Factor soft key, and then select the spread factor option: 4, 8, 16, 32, 64,
128, or 256.

d.

Press the Spread Code soft key to set the spread code.

e.

Enter a value by using the numeric keys.

f.

Press the Enter soft key.

7. To set the maximum amplifier power, complete the following steps:
a.

Press the Max Amplifier Power soft key.

b.

Enter a value by using the numeric keys.

c.

Press the dBm soft key.

8. To set the CPICH power, complete the following steps:
a.

Press the More (1/2) soft key.

b.

Press the CPICH soft key.

c.

Enter a value by using the numeric keys.

d.

Press the dBm soft key.

9. To set the threshold for CPICH dominance, complete the following steps:
a.

Press the CPICH Dominance > soft key.

b.

Enter a value by using the numeric keys.

c.

Press the Enter soft key.
NOTE
Recommended value is 10. Color of the CPICH Dominance indicator on the screen
bases on this setting.

10. To set the threshold for multipath power, complete the following steps:

170

a.

Press the Multipath Power < soft key.

b.

Enter a value by using the numeric keys.

c.

Press the Enter soft key.
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NOTE
Recommended value is one. Color of the multipath power indicator on the screen bases
on this setting.

11. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available
for your measurement mode. See “Using save” on page 31 for more information.

Measurement example
Figure 65

Code domain power measurement with WCDMA/HSPA+ OTA signal analyzer

NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication.

Route map
The JD780A Series provides indoor and outdoor mapping function that allows a user to collect data of
points in an indoor or outdoor environment and track the received signals and coverage of RF
transmitters plotting real time directly on top of a loaded floor plan or a map.
Setting measure setup
Procedure

1. If required, connect a GPS receiver to your JD780A series for outdoor mapping.
Indoor mapping does not necessarily need a GPS antenna.

2. Configure test parameters as described in the “Configuring test parameters” on page 137.
3. To load your map file, complete the following steps:
a.

Plug in your USB drive that has a floor map or .mcf file type created in JDMapCreator.
NOTE
The JDMapCreator converts and resizes any scanned floor plan or layout to fit onto your
instrument’s display. You must save your map files (.mcf) into the “SavedMap” folder of
your USB drive so that you can load them onto your instrument.
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b.

Press SAVE/LOAD hot key, and then select Load > Load Map.
See “Using load” on page 34 for more information.

4. Press the MEASURE SETUP hot key.
5. Press the Plot Point soft key, and then select the plot point option from the following choices:
–

To collect data/plot points automatically as you move around in a vehicle or outside, press
the GPS soft key and then toggle the Screen Mode soft key between Map and Full.
NOTE
With the Map setting, you can view only the collected points that can be seen within the
boundary of the loaded map. If a point is off the map, the instrument displays an arrow to
indicate the direction of the current location on the map and the distance from the center
to the location at the top of the screen.
With the Full setting, you can view all the collected points of the route without the loaded
map.

–

To collect data/plot points manually without a GPS antenna in an indoor environment, press
the Position soft key.

6. Press the Plot Item soft key, and then select the measurement option: CPICH Power or Ec/Io.
7. Toggle the Plot soft key and select Start.
8. Touch directly on the screen or press the ENTER hard key to collect data and plot points on the
loaded map for the Position setting.
NOTE
For the Position setting, you can change the direction of the route with the arrow keys
and the distance with the rotary knob.

9. Toggle the Plot soft key and select Stop to stop plotting.
10. Press the SAVE/LOAD hot key to save the result.
See “Using save” on page 31 for more information.
NOTE
The instrument does not automatically save the collected data. It is recommended that
you save the result. Otherwise, you will lose all the collected data.

Setting limit
You can set the thresholds for the four different color indicators for CPICH power or Ec/Io.
Procedure

1. Press the LIMIT hot key.
2. To set the limits for CPICH power if you have selected CPICH as for the plot item, complete the
following steps:
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a.

Press the CPICH Power soft key.

b.

Press the Excellent soft key to set its threshold.

c.

Enter a value, and then press the dBm soft key. You can also use the rotary knob.

d.

Press the Very Good soft key to set its threshold.

e.

Enter a value, and then press the dBm soft key. You can also use the rotary knob.

f.

Press the Good soft key to set its threshold.

g.

Enter a value, and then press the dBm soft key. You can also use the rotary knob.

h.

Press the Fair soft key to set its threshold.
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i.

Enter a value, and then press the dBm soft key. You can also use the rotary knob.

j.

Press the Poor soft key to set its threshold.

k.

Enter a value, and then press the dBm soft key. You can also use the rotary knob.

3. To set the limits for Ec/Io if you have selected as for the plot item , complete the following steps:
a.

Press the Ec/Io soft key.

b.

Press the Good soft key to set its threshold.

c.

Enter a value, and then press the Enter soft key. You can also use the rotary knob.

d.

Press the Fair soft key to set its threshold.

e.

Enter a value, and then press the Enter soft key. You can also use the rotary knob.

f.

Press the Poor soft key to set its threshold.

g.

Enter a value, and then press the Enter soft key. You can also use the rotary knob.

4. Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings.
See “Using save” on page 31 for more information.

Measurement example
Figure 66

Route map measurement with WCDMA/HSPA+ OTA signal analyzer

1) CPICH Power
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2) CPICH Ec/Io
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Using LTE - FDD Signal Analyzer
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Introduction
The LTE (Long-Term Evolution) Signal Analyzer of the JD780A series performs power and spectrum
measurements as well as modulation analysis to test the proper transmitter performance of FDD LTE
systems. It performs conformance testing according to the following standards providing a simple
Pass/Fail indication on each test.


3GPP TS 36.104. Evolved Universal Terrestrial Radio Access (E-UTRA); Base Station (BS)
Radio Transmission and Reception



3GPP TS 36.141. Evolved Universal Terrestrial Radio Access (E-UTRA); Base Station (BS)
Conformance Testing



3GPP TS 36.211. Evolved Universal Terrestrial Radio Access (E-UTRA); Physical Channels
and Modulation



3GPP TS 36.212. Evolved Universal Terrestrial Radio Access (E-UTRA); Multiplexing and
Channel Coding



3GPP TS 36.213 V8.2.0. Evolved Universal Terrestrial Radio Access (E-UTRA); Physical
Layer Procedures

This instrument provides the following measurement tools for FDD LTE system:


Spectrum Analysis



RF Analysis
-

Channel Power

-

Occupied Bandwidth

-

Spectrum Emission Mask

-

Adjacent Channel Leakage power Ratio (ACLR)

-

Multi-ACLR

-

Spurious Emissions



Power vs. Time (Frame)



Modulation Analysis
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-

Constellation

-

Data Channel

-

Control Channel

-

Subframe

-

Frame

-

Time Alignment Error

-

Data Allocation Map

Auto Measure:
-

Conformance Test

-

Maintenance Test

-

Signal Performance Test

-

DAS Test
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Power Statistics CCDF



Carrier Aggregation



Over The Air (OTA)
-

Channel Scanner

-

ID Scanner

-

Multipath Profile

-

Control Channel

-

Datagram

-

Route Map

Display overview
Figure 67 provides descriptions for each segment of the measurement screen.
Figure 67

LTE - FDD signal analyzer measurement screen

Connecting a cable
Direct connection
Procedure

1. Connect the Spectrum Analyzer RF In port of the JD780A series and the Power amplifier output
port of BTS.

Using LTE - FDD Signal Analyzer

177

JD780A Series Analyzers

Figure 68

Direct connection

JD785A/JD786A

JD788A

Indirect connection
Procedure

1. Connect the Spectrum Analyzer RF In port of the JD780A series and the monitor (test) port of
BTS.

Figure 69

Indirect connection

JD785A/JD786A

JD788A

CAUTION
The maximum power for the Spectrum Analyzer RF In port is +25 dBm (0.316 W). If the
input signal level to be measured is greater than +25 dBm, use a High Power
Attenuator to prevent damage when you directly connect the signal to the instrument or
connect the signal from the coupling port of a directional coupler.

Over the air (OTA)
Procedure

1. Connect an Omni/directional RF antenna to the Spectrum Analyzer RF In port of the JD780A
series.

2. Connect a GPS antenna to the GPS port of the JD780A series.
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Figure 70

OTA connection

JD785A/JD786A

JD788A

CAUTION
If the input signal level to be measured is less than 0 dBm, set 0 dB attenuation or turn on
the preamp to have better dynamic range for the OTA testing.

Selecting measurement mode
Procedure

1. Press the MODE hard key.
2. Press the Signal Analyzer soft key.
3. Press the LTE - FDD soft key. The Spectrum mode is set by default.
4. Press the MEASURE hot key, and then select the measurement mode option from the following
choices:

–

Spectrum

–

RF Analysis > Channel Power, Occupied BW, Spectrum Emission Mask, ACLR,
Multi-ACLR, or Spurious Emissions

–

Power vs Time (Frame)

–

Modulation Analysis > Constellation, Data Channel, Control Channel, Subframe, Frame,
Time Alignement Error, or Data Allocation Map

–

Auto Measure > Conformance Test, Maintenance Test, Signal Perfomance, or DAS Test

–

Power Statistics CCDF

–

More (1/2) > Carrier Aggregation

–

More (1/2) > OTA > Channel Scanner, ID Scanner, Multipath Profile, Control Channel,
Datagram, or Route Map
NOTE
The Carrier Aggregation soft key is activated if the license for the option 030 LTEAdvanced FDD is installed.
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Configuring test parameters
Setting frequency
You can set the frequency with either frequency or channel number. If a frequency to be set matches
to the frequency corresponding to the selected channel standard, the instrument calculates its channel
number and updates the screen with it automatically.
Procedure
To set the center frequency:

1. Press the FREQ/DIST hard key.
2. Toggle the Unit soft key and select Freq.
3. Press the Center Frequency soft key.
4. Enter a value by using the numeric keys. You can also use the rotary knob.
5. Select the unit: GHz, MHz, kHz, or Hz.
6. Optional. To define the amount of frequency increment for the rotary knob, complete the following
steps:
a.

Press the Frequency Step soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Press the unit: GHz, MHz, kHz, or Hz.

To set the channel number:

1. Press the FREQ/DIST hard key.
2. Toggle the Unit soft key and select Channel.
NOTE
Selecting Channel sets the standard channel to Band Global automatically so that you
can set the Channel Number without choosing a standard channel band from the list.

3. Press the Channel Number soft key.
4. Enter a value by using the numeric keys. You can also use the rotary knob.
5. Press the Enter soft key.
The instrument automatically displays the corresponding center frequency value for the selected
channel number.

6. Optional. To define the amount of channel increment for the rotary knob, complete the following
steps:
a.

Press the Channel Step soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Press the Enter soft key.

NOTE
This frequency setting is not used in the Multi-ACLR and Spurious Emissions modes.

Setting amplitude
Reference level and attenuation
You can set the reference and attenuation levels automatically or manually to optimize the display of
the traces measured, as you desire.
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Procedure
To automatically set the reference and attenuation level:

1. Press the AMP/SCALE hard key.
2. Press the Auto Scale soft key.
Each time you press this key, both of the Y-axis scale and input attenuation level change to be
optimized with some margin.
To set the reference or attenuation level manually:

1. Press the AMP/SCALE hard key.
2. To set the maximum reference value on the Y-axis manually, complete the following steps:
a.

Press the Reference Level soft key.

b.

Enter a value by using the numeric keys or the rotary knob with 10 dB increments.

c.

Press the dBm soft key or the ENTER hard key.
NOTE
In the measurements such as Control Channel, Subframe, and Frame, you may need
to select the reference option between Relative and Absolute before setting the
reference level.

3. To set the attenuation option, select one from the following choices:
–

To set the input attenuator’s level automatically, select Attenuation > Auto.
NOTE
It is recommended that you set the Attenuation to Auto in most situations so that the
level of the input attenuator can be set automatically according to your input signal level.

–

–

To set the input attenuation manually up to 55 dB to optimize S/N, complete the following
steps:
a.

Select Attenuation > Manual.

b.

Press the Attenuation Value soft key to set the level.

c.

Enter a value between 0 and 55 in fives by using the numeric keys.

d.

Press the dB soft key or the ENTER hard key.

To couple the input attenuator’s level with your reference level setting, select Attenuation >
Couple. As you increse the reference setting, the attenuation level also increases
acoordingly.

Optional. To change the scale unit:

1. Select More (1/2) > Units.
2. Select the unit of the display scale: dBm, dBV, dBmV, dBµV, V, or W.
The scale unit on the screen changes accordingly.
NOTE
This Units menu is available in the Spectrum and RF Analysis modes.

Scale per division
You can use the Scale/Div feature available for the spectrum and RF analysis. It represents the value
of one division on the horizontal scale. The default setting is 10 dB per division and the maximum
value can be set up to 20 dB.
Procedure
To set the scale per division:

Using LTE - FDD Signal Analyzer

181

JD780A Series Analyzers

1. Press the AMP/SCALE hard key.
2. Select More (1/2) > Scale/Div.
3. Enter a value between 1 and 20 by using the numeric keys.
4. Press the dB soft key to complete the entry.
Pre-amplifier
You can turn the internal pre-amplifier on to correct and compensate for the gain of the preamp so that
amplitude readings show the value at the input connector.
Procedure

1. Press the AMP/SCALE hard key.
2. Toggle the Preamp soft key and select On or Off as needed.
NOTE
You can turn the Preamp on when the input attenuation range is from 0 dB to 10 dB. If
the attenuation value is manually set to greater than 10 dB, the instrument will
automatically turn off the pre-amplifier to display low-level signal properly on the chart.

External offset
You can turn the External Offset on and manually set the external offset value. An offset consists of a
cable loss and a user offset and the measurement result shows the value reflecting both offset values.
When the external offset value is set at 40 dB in the Spectrum mode, the measurement result
compensates 40 dB at both the Spectrum Analyzer and Signal Analyzer modes
Procedure
To set the external offset:

1. Press the AMP/SCALE hard key.
2. Toggle the External Offset soft key and select On.
3. Enter a value by using the numeric keys.
4. Press the dB soft key to complete the entry.
To turn the external offset off:

1. Press the AMP/SCALE hard key.
2. Toggle the External Offset soft key and select Off.

Setting average
You can set the number of measurements to be averaged for the trace presentation. A maximum of
100 times of averaging can be set. When the averaging reaches to your setting, a new measurement
value replaces the measurement value in sequence from the earliest.
Procedure

1. Press the BW/AVG hard key.
2. Press the Average soft key.
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3. Enter a value between 1 and 100 as needed by using the numeric keys.
4. Press the Enter soft key.

Setting sweep mode
The default settings of the sweep mode are Continue and Normal to sweep continuously at a normal
speed for most on-going measurements. If you want to hold the measurement or get a single sweep,
you can change the sweep mode.
Procedure
To select the single sweep mode:

1. Press the SWEEP hot key.
2. Toggle the Sweep Mode soft key and select Single. You can also use the HOLD hot key.
The letter HOLD in red appears and the sweeping is paused.

3. Optional. Press the Sweep Once soft key to get a new measurement.
To return to the continuous sweep mode:

1. Toggle the Sweep Mode soft key and select Continue. You can also use the HOLD hot key.
The letter HOLD in red disappears and the sweeping resumes.

Setting trigger source
You can set the trigger source option for your measurements.
Procedure

1. Press the TRIGGER hot key.
2. Select the trigger source option from the following choices: Internal, External, or GPS.

Setting external clock
To enhance the reliability of modulation analysis measurements the JD780A series must be
synchronized with a base station. When an external clock is not supplied, the instrument works with its
built-in internal high-accuracy time base and some measurement results may exhibit inaccurate values.
Therefore, it is highly recommended that you use the same reference clock as the signal source. You
can use the TRIGGER hot key to set the external clock.
Figure 71

Connection ports for external reference clock
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Procedure

1. Connect an external reference or a GPS antenna to the JD780A series.
2. Press the SYSTEM hot key.
3. Press the Freq Reference soft key, and then select the reference option: Internal, External 10
MHz, External 13 MHz, External 15 MHz, or GPS.

Table 14

External reference indicators

Type

Indicator

Description

Internal

(green)

The green INT icon indicates that the instrument uses the built-in
internal time base.

External

(green)

The green EXT icon indicates that an external reference is connected
and locked and that the instrument uses the same reference clock as
the signal source.

External

(red)

The red EXT icon indicates that an external reference is connect but not
locked.

GPS

(green)

The green GPS antenna icon indicates that a GPS antenna is
connected and locked.

GPS

(yellow)

The yellow GPS antenna icon indicates that a GPS antenna is
connected and locking is in progress.

GPS

(grey)

The grey GPS antenna icon indicates that a GPS antenna is not
connected, failed, or unable to be locked.

Conducting spectrum measurements
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 179, you
can continue your measurement.
Procedure

1. Press the MEASURE SETUP hot key.
2. Press the Bandwidth soft key.
3. Select the nominal channel bandwidth to be measured, from the following choices:
–

1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, and 20 MHz

Your measurement result is displayed on the screen as like the following example, Figure 72.
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Figure 72

Spectrum measurement screen with LTE - FDD signal analyzer

Setting trace
You can display up to six traces on the measurement chart simultaneously.
Procedure

1. Press the TRACE/DISPLAY hard key.
2. Press the Select Trace soft key, and then select the trace number: T1, T2, T3, T4, T5, or T6.
The legend shape of the selected trace changes from square to round to indicate that the trace is
the active one now.

3. Toggle the Trace View soft key and select On.
4. To clear, write or capture, or hide the trace(s), do one of the following:
To

Select

Trace Legend

Clear current data and display with new
measurements

Clear Write

W

Display the input signal’s maximum response only

Max Hold

M

Display the input signal’s minimum response only

Min Hold

m

Capture the selected trace and compare traces

Capture

C

Load a saved trace

More (1/2) > Load

L

Hide the selected trace

Trace View > Off

F

Remove all the traces and initialize the trace
settings

More (1/2) > Trace
Clear All

5. Optional. Press the More (1/2) > Trace Info soft key, and then select the trace number to view
the trace’s parameter setting information stored at the time of the measurement or None to hide
the information display.

6. Optional. If you have the two traces T1 and T2, you can perform trace math. To view the power
difference between the traces, press the T1 – T2 -> T5 or T2 – T1 -> T6 soft key.
The result is overlaid on the screen along with the second Y-axis.
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Conducting RF measurements
Channel power
The Channel Power measurement is a common test used in the wireless industry to measure the total
transmitted power of a radio within a defined frequency channel. It acquires a number of points
representing the input signal in the time domain, transforms this information into the frequency domain
using Fast Fourier Transform (FFT), and then calculates the channel power. The effective resolution
bandwidth of the frequency domain trace is proportional to the number of points acquired for the FFT.
The channel power measurement identifies the total RF power and power spectral density (PSD) of
the signal in the LTE channel bandwidth.
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 179, you
can continue your measurement.
Procedure

1. Press the MEASURE SETUP hot key.
2. Press the Bandwidth soft key.
3. Select the nominal channel bandwidth to be measured, from the following choices:
–

1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, and 20 MHz

Measurement example
Figure 73

Channel power measurement with LTE - FDD signal analyzer

NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 193 for more
information.
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Occupied bandwidth
The Occupied Bandwidth measures the spectrum shape of the carrier. It is defined as the bandwidth,
which includes 99% of the transmitted power among total transmitted power.
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 179, you
can continue your measurement.
Procedure

1. Press the MEASURE SETUP hot key.
2. Press the Bandwidth soft key.
3. Select the nominal channel bandwidth to be measured, from the following choices:
–

1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, and 20 MHz

Measurement example
Figure 74

Occupied bandwidth measurement with LTE - FDD signal analyzer

NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 193 for more
information.

Spectrum emission mask (SEM)
The Spectrum Emission Mask (SEM) measurement required by 3GPP specifications encompasses
different power limits and different measurement bandwidths (resolution bandwidths) at various
frequency offsets. It may be expressed as a ratio of power spectral densities between the carrier and
the specified offset frequency band. It provides useful figures-of-merit for the spectral re-growth and
emissions produced by components and circuit blocks, without the rigor of performing a full SEM
measurement.
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The SEM measures spurious signal levels in up to five pairs of offset or region frequencies and relates
them to the carrier power.
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 179, you
can continue your measurement.
Procedure

1. Press the MEASURE SETUP hot key.
2. To set the nominal channel bandwidth to be measured, complete the following steps:
a.

Press the Bandwidth soft key.

b.

Select the bandwidth option: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, or 20 MHz.

3. To select the mask type, complete the following steps:
a.

Press the Mask Type soft key.

b.

Select the mask type option, from the following choices:

–

Wide Area BS Category A

–

Wide Area BS Category B

–

Local Area BS

–

Home BS

Measurement example
Figure 75

SEM measurement with LTE - FDD signal analyzer

NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 193 for more
information.
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ACLR
The Adjacent Channel Leakage power Ratio (ACLR) measures the amount of interference or power in
an adjacent frequency channel according to the standards.
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 179, you
can continue your measurement.
Procedure

1. Press the MEASURE SETUP hot key.
2. Press the Bandwidth soft key.
3. Select the nominal channel bandwidth to be measured, from the following choices:
–

1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, and 20 MHz

Measurement example
Figure 76

ACLR measurement with LTE - FDD signal analyzer

NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 193 for more
information.

Multi-ACLR
The Multi-ACLR measurement is used to perform multi-channel ACLR measurements with as many
channels as possible. It helps you to measure ACLR in multi-channel transmitting Base Station
environment.
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 179, you
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can continue your measurement.
Procedure

1. Press the MEASURE SETUP hot key.
2. To set the nominal channel bandwidth to be measured, complete the following steps:
a.

Press the Bandwidth soft key.

b.

Select the bandwidth option: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, or 20 MHz.

3. To set the frequency, do one of the following:
–

–

To set the center frequency, complete the following steps:
a.

Toggle the Unit soft key and select Freq.

b.

Press the Lowest Frequency soft key to set the starting center frequency.

c.

Enter a value by using the numeric keys. You can also use the rotary knob.

d.

Select the unit: GHz, MHz, kHz, or Hz.

e.

Press the Highest Frequency soft key to set the stopping center frequency.

f.

Enter a value by using the numeric keys. You can also use the rotary knob.

g.

Select the unit: GHz, MHz, kHz, or Hz.

To set the channel number, complete the following steps:
a.

Toggle the Unit soft key and select Channel.

NOTE
Selecting Channel sets the standard channel to Band Global automatically so that you
can set the Channel Number without choosing a standard channel band from the list.
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b.

Press the Lowest Channel soft key to set the starting channel.

c.

Enter a value by using the numeric keys. You can also use the rotary knob.

d.

Press the Enter soft key.

e.

Press the Highest Channel soft key to set the stopping channel.

f.

Enter a value by using the numeric keys. You can also use the rotary knob.

g.

Press the Enter soft key.
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Measurement example
Figure 77

Multi-ACLR measurement with LTE - FDD signal analyzer

NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 193 for more
information.

Spurious emissions
Out-of-band emissions are unwanted emissions immediately outside the channel bandwidth resulting
from the modulation process and non-linearity in the transmitter but excluding spurious emissions. The
Spurious Emissions measurement is to identify and determine the power level of out-of-band spurious
emission within the necessary channel bandwidth and modulated signal measured at the RF port of
the Base Station.
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 179, you
can continue your measurement.
Procedure

1. Press the MEASURE SETUP hot key.
2. To set up the range table and frequency range, press the Range Table soft key and then
complete the following steps:
a.

Press the Range soft key, and then enter the range number to add a new range or change
an existing one.

b.

Press the Enter soft key.

c.

Press the Start Frequency soft key to set up the frequency range.

d.

Enter a value by using the numeric keys. You can also use the rotary knob.

e.

Select the unit: GHz, MHz, kHz, or Hz.

f.

Press the Stop Frequency soft key to set up the frequency range.
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g.

Enter a value by using the numeric keys. You can also use the rotary knob.

h.

Select the unit: GHz, MHz, kHz, or Hz.

3. Toggle the Range soft key between On and Off to display or hide the selected range.
4. To set up the test limits for Pass/Fail indication, complete the following steps:
a.

Press the Start Limit soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Select the dBm soft key.

d.

Press the Stop Limit soft key.

e.

Enter a value by using the numeric keys. You can also use the rotary knob.

f.

Select the dBm soft key.

5. To set up the other parameters, complete the following steps:
a.

Select More (1/2) > Attenuation to set up the attenuation value.

b.

Enter a value in the multiple of five.

c.

Press the dB soft key or the ENTER hard key.

d.

Press the RBW soft key.

e.

Enter a value by using the numeric keys.

f.

Select the unit: GHz, MHz, kHz, or Hz.

g.

Press the VBW soft key.

h.

Enter a value by using the numeric keys.

i.

Select the unit: GHz, MHz, kHz, or Hz.

6. Press the PREV hard key.
7. Toggle the Measure Type soft key between Examine and Full to select the measurement type.
NOTE
The Examine mode displays only the selected range while the Full mode lets the
instrument automatically changes the selected range from one another.

8. Set the number of measurements to be averaged:
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a.

Press the Average soft key.

b.

Enter a value between 1 and 100.

c.

Press the Enter soft key.
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Measurement example
Figure 78

Spurious emissions measurement with LTE - FDD signal analyzer

NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 193 for more
information.

Setting limit for RF tests
By default, test limits specified in the standard are set for you. You can change thresholds if you desire.
Procedure

1. Press the LIMIT hot key.
2. Press the RF Test Limits soft key.
3. Select the test item(s) and set the limit(s) depending on your selected measurement mode:
To set the limit for

Select

Set

Channel power

Channel Power

High Limit
Low Limit

Occupied bandwidth

Occupied BW

High Limit

Spectrum emission mask

Spectrum Emission Mask

(On/Off only)

ACLR

ACLR

(On/Off only)

Multi-ACLR

Multi-ACLR

(On/Off only)

Spurious emissions

Spurious Emissions

(On/Off only)

4. Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit.
Toggle the Beep soft key between On and Off to enable or disable the beep sound.

5. Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings.
See “Using save” on page 31 for more information.
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Conducting power vs. time (frame) measurements
The Power vs. Time (Frame) measures the modulation envelope in the time domain, showing the
power of each time slot in an LTE signal.

Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 179, you
can continue your measurement. The measurement settings can be saved and recalled as a file.
Procedure

1. Press the MEASURE SETUP hot key.
2. To set the nominal channel bandwidth to be measured, complete the following steps:
a.

Press the Bandwidth soft key.

b.

Select the bandwidth option: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, or 20 MHz.

3. To select the subframe number to be measured, complete the following steps:
a.

Press the Subframe No soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Press the Enter soft key.

4. Toggle the Cell ID soft key and select Auto or Manual as desired:
–

Auto: to let the instrument detect the Cell ID for the LTE signal automatically.

–

Manual: to set a specific Cell ID for the LTE signal manually in order to speed up the
synchronization with a BTS.

5. Optional. Press the Miscellaneous soft key, and then do the following(s) as needed:
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–

To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4.
This MIMO (Multiple Input Multiple Output) setting is activated only if the option 030 LTEAdvanced FDD is installed with a license number. If not, the instrument sets this option to
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO
channels.

–

To assign a antenna port number automatically or manually, press the Antenna Port soft
key and select the option: Auto, 0, 1, 2, and 3. If the option 030 LTE-Advanced FDD is not
installed or if the MIMO is set to 2x2, the antenna ports 2 and 3 are disabled.

–

To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or
Extended. See “Appendix E – Cyclic prefix table” on page 545 for OFDM parameter details
by different bandwidth.
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Measurement example
Figure 79

Power vs. time (frame) measurement with LTE – FDD signal analyzer

Conducting modulation measurements
Constellation
The Constellation is used to observe some aspects of modulation accuracy and can reveal certain
fault mechanisms such as I/Q amplitude imbalance or quadrature imbalance. It displays constellation
diagram by modulation types.
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 179, you
can continue your measurement. The measurement settings can be saved and recalled as a file.
Procedure

1. Press the MEASURE SETUP hot key.
2. To set the nominal channel bandwidth to be measured, complete the following steps:
a.

Press the Bandwidth soft key.

b.

Select the bandwidth option: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, or 20 MHz.

3. To select the subframe number to be measured, complete the following steps:
a.

Press the Subframe No soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.
NOTE
For MBMS testing, this subframe number must be neither 0 nor 5 as these subframes 0
and 5 are not available for MBMS and it must be set to the MBMS transmitted channel’s
subframe number.

c.

Press the Enter soft key.

4. Optional. Toggle the Cell ID soft key and select Auto or Manual as desired:
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–

Auto: to let the instrument detect the Cell ID for the LTE signal automatically.

–

Manual: to set a specific Cell ID for the LTE signal manually in order to speed up the
synchronization with a BTS.

5. Optional. Toggle the CFI soft key and select Auto or Manual as desired:
–

Auto: to let the instrument set the number of OFDM symbols used for transmitting PDCCHs
in a subframe.

–

Manual: to set the number of OFDM symbols manually. The set of OFDM symbols that can
be used for PDCCH in a subframe is given by 0, 2, 3 or 4 in 1.4 MHz bandwidth and 1, 2, or
3 in other bandwidths.

6. Optional. Press the PHICH Ng soft key, and then select the option for the number of PHICH
groups (Ng): 1/6, 1/2, 1, 2, E-1/6, E-1/2, E-1, or E-2.

7. Optional. Press the Miscellaneous soft key, and then do the following(s) as needed:
–

To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4.
This MIMO (Multiple Input Multiple Output) setting is activated only if the option 030 LTEAdvanced FDD is installed with a license number. If not, the instrument sets this option to
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO
channels.

–

To assign a antenna port number automatically or manually, press the Antenna Port soft
key and select the option: Auto, 0, 1, 2, and 3. If the option 030 LTE-Advanced FDD is not
installed or if the MIMO is set to 2x2, the antenna ports 2 and 3 are disabled.

–

To turn the Multimedia Broadcast Multicast Service (MBMS) feature on or off, toggle the
MBMS soft key and select On or Off. For proper MBMS testing, you need to set the
Subframe No with the same PMCH subframe number. If this setting is on, either PMCH or
PDSCH appears on the screen depending on the detected channel.

–

To set the Multicast Broadcast Single Frequency Network (MBSFN) detection automatically
or manually for MBMS testing, toggle the MBSFN soft key and select Auto or Manual. An
automatically detected or manually entered MBSFN ID appears on the screen.

–

To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or
Extended. See “Appendix E – Cyclic prefix table” on page 545 for OFDM parameter details
by different bandwidth.

–

Press the PDSCH Modulation Type soft key, and then select the modulation type option:
Auto, QPSK, 16 QAM, 64 QAM, E-TM3.3, E-TM3.2, E-TM3.1, E-TM2, E-TM1.2, and ETM1.1. If two or more modulation types are used in a frame, select Auto. If the PDSCH
uses the same modulation type in a frame or in a subframe, select a specific modulation
type to get more accurate EVM.

–

To set the threshold for PDSCH, complete the following steps:

–
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a.

Press the PDSCH Threshold soft key.

b.

Enter a value by using the numeric keys.

c.

Press the dB soft key.

Toggle the PDSCH Precoding soft key between On and Off to enable or disable the
PDSCH precoding.
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Measurement example
Figure 80

Constellation measurement with LTE - FDD signal analyzer

Figure 81

Constellation measurement with LTE - FDD signal analyzer (MBMS On)

NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 213 for
more information.

Data channel
The Data Channel measures the constellation for the specified resource block as well as the
modulation accuracy of each PDSCH at the specified subframe.
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 179, you
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can continue your measurement. The measurement settings can be saved and recalled as a file.
Procedure

1. Press the MEASURE SETUP hot key.
2. To set the nominal channel bandwidth to be measured, complete the following steps:
a.

Press the Bandwidth soft key.

b.

Select the bandwidth option: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, or 20 MHz.

3. To select the subframe number to be measured, complete the following steps:
a.

Press the Subframe No soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.
NOTE
For MBMS testing, this subframe number must be neither 0 nor 5 as these subframes 0
and 5 are not available for MBMS and it must be set to the MBMS transmitted channel’s
subframe number.

c.

Press the Enter soft key.

4. Optional. Toggle the Cell ID soft key and select Auto or Manual as desired:
–

Auto: to let the instrument detect the Cell ID for the LTE signal automatically.

–

Manual: to set a specific Cell ID for the LTE signal manually in order to speed up the
synchronization with a BTS.

5. Optional. Toggle the CFI soft key and select Auto or Manual as desired:
–

Auto: to let the instrument set the number of OFDM symbols used for transmitting PDCCHs
in a subframe.

–

Manual: to set the number of OFDM symbols manually. The set of OFDM symbols that can
be used for PDCCH in a subframe is given by 0, 2, 3 or 4 in 1.4 MHz bandwidth and 1, 2, or
3 in other bandwidths.

6. Optional. Press the PHICH Ng soft key, and then select the option for the number of PHICH
groups (Ng): 1/6, 1/2, 1, 2, E-1/6, E-1/2, E-1, or E-2.

7. Toggle the Event Hold soft key between On and Off to enable or disable the event hold feature.
When enabled, the display line for the PDSCH threshold appears.
When an event occurs, the measurement is put on hold until you press the HOLD hot key.

8. Optional. Press the Miscellaneous soft key, and then do the following(s) as needed:
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–

To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4.
This MIMO (Multiple Input Multiple Output) setting is activated only if the option 030 LTEAdvanced FDD is installed with a license number. If not, the instrument sets this option to
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO
channels.

–

To assign a antenna port number automatically or manually, press the Antenna Port soft
key and select the option: Auto, 0, 1, 2, and 3. If the option 030 LTE-Advanced FDD is not
installed or if the MIMO is set to 2x2, the antenna ports 2 and 3 are disabled.

–

To turn the Multimedia Broadcast Multicast Service (MBMS) feature on or off, toggle the
MBMS soft key and select On or Off. For proper MBMS testing, you need to set the
Subframe No with the same PMCH subframe number. If this setting is on, either PMCH or
PDSCH appears on the screen depending on the detected channel.

–

To set the Multicast Broadcast Single Frequency Network (MBSFN) detection automatically
or manually for MBMS testing, toggle the MBSFN soft key and select Auto or Manual. An
automatically detected or manually entered MBSFN ID appears on the screen.

–

To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or
Extended. See “Appendix E – Cyclic prefix table” on page 545 for OFDM parameter details
by different bandwidth.
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–

Press the PDSCH Modulation Type soft key, and then select the modulation type option:
Auto, QPSK, 16 QAM, 64 QAM, E-TM3.3, E-TM3.2, E-TM3.1, E-TM2, E-TM1.2, and ETM1.1. If two or more modulation types are used in a frame, select Auto. If the PDSCH
uses the same modulation type in a frame or in a subframe, select a specific modulation
type to get more accurate EVM.

–

To set the threshold for PDSCH, complete the following steps:

–

a.

Press the PDSCH Threshold soft key.

a.

Enter a value by using the numeric keys, and then press the dB soft key.

Toggle the PDSCH Precoding soft key between On and Off to enable or disable the
PDSCH precoding.

Measurement example
Figure 82

Data channel measurement with LTE - FDD signal analyzer

Figure 83

Data channel measurement with LTE - FDD signal analyzer (MBMS On)
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NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 213 for
more information.

Using marker
You can use the MARKER hard key to place a marker on a resource block and display the IQ diagram
for the selected resource block.
Procedure

1. Press the MARKER hard key.
2. Press the RB Number soft key to select the resource block to be marked.
3. Enter the resource block number by using the numeric keys.
4. Press the Enter soft key.
The marker appears on the selected resource block.

5. Toggle the Marker View soft key between On and Off to display or dismiss the result of the
selected resource block.

Control channel
The Control Channel measures the constellation for the specified control channel as well as
modulation accuracy of the control channel at the specified subframe.
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 179, you
can continue your measurement. The measurement settings can be saved and recalled as a file.
Procedure

1. Press the MEASURE SETUP hot key.
2. To set the nominal channel bandwidth to be measured, complete the following steps:
a.

Press the Bandwidth soft key.

b.

Select the bandwidth option: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, or 20 MHz.

3. To select the subframe number to be measured, complete the following steps:
a.

Press the Subframe No soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.
NOTE
For MBMS testing, this subframe number must be neither 0 nor 5 as these subframes 0
and 5 are not available for MBMS and it must be set to the MBMS transmitted channel’s
subframe number.

c.

Press the Enter soft key.

4. Optional. Toggle the Cell ID soft key and select Auto or Manual as desired:
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–

Auto: to let the instrument detect the Cell ID for the LTE signal automatically.

–

Manual: to set a specific Cell ID for the LTE signal manually in order to speed up the
synchronization with a BTS.
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5. Optional. Toggle the CFI soft key and select Auto or Manual as desired:
–

Auto: to let the instrument set the number of OFDM symbols used for transmitting PDCCHs
in a subframe.

–

Manual: to set the number of OFDM symbols manually. The set of OFDM symbols that can
be used for PDCCH in a subframe is given by 0, 2, 3 or 4 in 1.4 MHz bandwidth and 1, 2, or
3 in other bandwidths.

6. Optional. Press the PHICH Ng soft key, and then select the option for the number of PHICH
groups (Ng): 1/6, 1/2, 1, 2, E-1/6, E-1/2, E-1, or E-2.

7. Toggle the EVM Detection Mode soft key and select Single or Combine as desired:
–

Single: Testing on one single antenna connected to your JD780A series with a cable.

–

Combine: Testing on multiple antennas connected to your JD780A series with a 2x1 or 4x1
combiner or an antenna.

8. Optional. Press the Miscellaneous soft key, and then do the following(s) as needed:
–

To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4.
This MIMO (Multiple Input Multiple Output) setting is activated only if the option 030 LTEAdvanced FDD is installed with a license number. If not, the instrument sets this option to
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO
channels.

–

To assign a antenna port number automatically or manually, press the Antenna Port soft
key and select the option: Auto, 0, 1, 2, and 3. If the option 030 LTE-Advanced FDD is not
installed or if the MIMO is set to 2x2, the antenna ports 2 and 3 are disabled.

–

To turn the Multimedia Broadcast Multicast Service (MBMS) feature on or off, toggle the
MBMS soft key and select On or Off. For proper MBMS testing, you need to set the
Subframe No with the same PMCH subframe number. If this setting is on, the
measurement item “MBSFN RS” appears in the result table.

–

To set the Multicast Broadcast Single Frequency Network (MBSFN) detection automatically
or manually for MBMS testing, toggle the MBSFN soft key and select Auto or Manual. An
automatically detected or manually entered MBSFN ID appears on the screen.

–

To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or
Extended. See “Appendix E – Cyclic prefix table” on page 545 for OFDM parameter details
by different bandwidth.

–

To set the threshold for PDCCH, complete the following steps:

–

a.

Press the PDCCH Threshold soft key.

b.

Enter a value by using the numeric keys.

c.

Press the dB soft key.

Toggle the PDCCH Mode soft key and select REG to calculate EVM based on Resource
Element Group or Avg to calculate EVM after adding up all the PDCCH signals from one
subframe.
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Measurement example
Figure 84

Control channel measurement with LTE - FDD signal analyzer

Figure 85

Control channel measurement with LTE - FDD signal analyzer (MBMS On)

NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 213 for
more information.

Using marker
You can use the MARKER hard key to place a marker on a control channel and display the IQ
diagram for the selected channel.
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Procedure

1. Press the MARKER hard key.
2. Press the Channel soft key to select the channel to be displayed in the IQ diagram.
The channel P-SS is selected by default.

3. Turn the rotary knob to move the highlight from one to another in the channel summary table.
4. Toggle the Marker View soft key between On and Off to display or dismiss the result of the
selected channel.

Subframe
The Subframe measures the modulation accuracy of all the data and control channels at the specified
subframe (1 ms).
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 179, you
can continue your measurement. The measurement settings can be saved and recalled as a file.
Procedure

1. Press the MEASURE SETUP hot key.
2. To set the nominal channel bandwidth to be measured, complete the following steps:
a.

Press the Bandwidth soft key.

b.

Select the bandwidth option: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, or 20 MHz.

3. To select the subframe number to be measured, complete the following steps:
a.

Press the Subframe No soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.
NOTE
For MBMS testing, this subframe number must be neither 0 nor 5 as these subframes 0
and 5 are not available for MBMS and it must be set to the MBMS transmitted channel’s
subframe number.

c.

Press the Enter soft key.

4. Optional. Toggle the Cell ID soft key and select Auto or Manual as desired:
–

Auto: to let the instrument detect the Cell ID for the LTE signal automatically.

–

Manual: to set a specific Cell ID for the LTE signal manually in order to speed up the
synchronization with a BTS.

5. Optional. Toggle the CFI soft key and select Auto or Manual as desired:
–

Auto: to let the instrument set the number of OFDM symbols used for transmitting PDCCHs
in a subframe.

–

Manual: to set the number of OFDM symbols manually. The set of OFDM symbols that can
be used for PDCCH in a subframe is given by 0, 2, 3 or 4 in 1.4 MHz bandwidth and 1, 2, or
3 in other bandwidths.

6. Optional. Press the PHICH Ng soft key, and then select the option for the number of PHICH
groups (Ng): 1/6, 1/2, 1, 2, E-1/6, E-1/2, E-1, or E-2.

7. Toggle the EVM Detection Mode soft key and select Single or Combine as desired:
–

Single: Testing on one single antenna connected to your JD780A series with a cable.
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–

Combine: Testing on multiple antennas connected to your JD780A series with a 2x1 or 4x1
combiner or an antenna.

8. Optional. Press the Miscellaneous soft key, and then do the following(s) as needed:
–

To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4.
This MIMO (Multiple Input Multiple Output) setting is activated only if the option 030 LTEAdvanced FDD is installed with a license number. If not, the instrument sets this option to
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO
channels.

–

To assign a antenna port number automatically or manually, press the Antenna Port soft
key and select the option: Auto, 0, 1, 2, and 3. If the option 030 LTE-Advanced FDD is not
installed or if the MIMO is set to 2x2, the antenna ports 2 and 3 are disabled.

–

To turn the Multimedia Broadcast Multicast Service (MBMS) feature on or off, toggle the
MBMS soft key and select On or Off. For proper MBMS testing, you need to set the
Subframe No with the same PMCH subframe number. If this setting is on, the
measurement item “MBSFN RS” appears in the result table and either PMCH or PDSCH
appears as well depending on the detected channel.

–

To set the Multicast Broadcast Single Frequency Network (MBSFN) detection automatically
or manually for MBMS testing, toggle the MBSFN soft key and select Auto or Manual. An
automatically detected or manually entered MBSFN ID appears on the screen.

–

To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or
Extended. See “Appendix E – Cyclic prefix table” on page 545 for OFDM parameter details
by different bandwidth.

–

Press the PDSCH Modulation Type soft key, and then select the modulation type option:
Auto, QPSK, 16 QAM, 64 QAM, E-TM3.3, E-TM3.2, E-TM3.1, E-TM2, E-TM1.2, and ETM1.1. If two or more modulation types are used in a frame, select Auto. If the PDSCH
uses the same modulation type in a frame or in a subframe, select a specific modulation
type to get more accurate EVM.

–

To set the threshold for PDSCH, complete the following steps:

–
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a.

Press the PDSCH Threshold soft key.

b.

Enter a value by using the numeric keys.

c.

Press the dB soft key.

To set the threshold for PDCCH, complete the following steps:
a.

Press the PDCCH Threshold soft key.

b.

Enter a value by using the numeric keys.

c.

Press the dB soft key.

–

Toggle the PDCCH Mode soft key and select REG to calculate EVM based on Resource
Element Group or Avg to calculate EVM after adding up all the PDCCH signals from one
subframe.

–

Toggle the PDSCH Precoding soft key between On and Off to enable or disable the
PDSCH precoding.
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Measurement example
Figure 86

Subframe measurement with LTE - FDD signal analyzer

1) Regular view

2) Chart view
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Figure 87

Subframe measurement with LTE - FDD signal analyzer (MBMS On)

NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 213 for
more information.

Setting display
You can use the TRACE/DISPLAY hard key to view the RE and RS power at the symbol.
Procedure

1. Press the TRACE/DISPLAY hard key.
2. Toggle the Chart soft key between On and Off to display or dismiss the chart.
If this setting is on, the MARKER hard key is activated.

Using marker
If you turn the Chart view on, you can use the MARKER hard key to place the marker at a specific
symbol.
Procedure

1. Press the MARKER hard key.
2. Toggle the Marker View soft key between On and Off to display or dismiss the marker on the
chart.

3. Press the Symbol soft key to select the symbol number, to which the marker is placed.
4. Enter a value by using the numeric keys.
5. Press the Enter soft key.

Frame
The Frame measures the modulation accuracy of all the data and control channels at the frame (10
ms).
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Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 179, you
can continue your measurement. The measurement settings can be saved and recalled as a file.
Procedure

1. Press the MEASURE SETUP hot key.
2. To set the nominal channel bandwidth to be measured, complete the following steps:
a.

Press the Bandwidth soft key.

b.

Select the bandwidth option: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, or 20 MHz.

3. Optional. Toggle the Cell ID soft key and select Auto or Manual as desired:
–

Auto: to let the instrument detect the Cell ID for the LTE signal automatically.

–

Manual: to set a specific Cell ID for the LTE signal manually in order to speed up the
synchronization with a BTS.

4. Optional. Toggle the CFI soft key and select Auto or Manual as desired:
–

Auto: to let the instrument set the number of OFDM symbols used for transmitting PDCCHs
in a subframe.

–

Manual: to set the number of OFDM symbols manually. The set of OFDM symbols that can
be used for PDCCH in a subframe is given by 0, 2, 3 or 4 in 1.4 MHz bandwidth and 1, 2, or
3 in other bandwidths.

5. Optional. Press the PHICH Ng soft key, and then select the option for the number of PHICH
groups (Ng): 1/6, 1/2, 1, 2, E-1/6, E-1/2, E-1, or E-2.

6. Toggle the EVM Detection Mode soft key and select Single or Combine as desired:
–

Single: Testing on one single antenna connected to your JD780A series with a cable.

–

Combine: Testing on multiple antennas connected to your JD780A series with a 2x1 or 4x1
combiner or an antenna.

7. Optional. Press the Miscellaneous soft key, and then do the following(s) as needed:
–

To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4.
This MIMO (Multiple Input Multiple Output) setting is activated only if the option 030 LTEAdvanced FDD is installed with a license number. If not, the instrument sets this option to
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO
channels.

–

To assign a antenna port number automatically or manually, press the Antenna Port soft
key and select the option: Auto, 0, 1, 2, and 3. If the option 030 LTE-Advanced FDD is not
installed or if the MIMO is set to 2x2, the antenna ports 2 and 3 are disabled.

–

To turn the Multimedia Broadcast Multicast Service (MBMS) feature on or off, toggle the
MBMS soft key and select On or Off. If this setting is on, the measurement items MBSFN
RS, PMCH QPSK, PMCH 16 QAM, and PMCH 64 QAM appear in the result table.

–

To set the Multicast Broadcast Single Frequency Network (MBSFN) detection automatically
or manually for MBMS testing, toggle the MBSFN soft key and select Auto or Manual. An
automatically detected or manually entered MBSFN ID appears on the screen.

–

To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or
Extended. See “Appendix E – Cyclic prefix table” on page 545 for OFDM parameter details
by different bandwidth.

–

Press the PDSCH Modulation Type soft key, and then select the modulation type option:
Auto, QPSK, 16 QAM, 64 QAM, E-TM3.3, E-TM3.2, E-TM3.1, E-TM2, E-TM1.2, and ETM1.1. If two or more modulation types are used in a frame, select Auto. If the PDSCH
uses the same modulation type in a frame or in a subframe, select a specific modulation
type to get more accurate EVM.
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–

–

To set the threshold for PDSCH, complete the following steps:
a.

Press the PDSCH Threshold soft key.

b.

Enter a value by using the numeric keys.

c.

Press the dB soft key.

To set the threshold for PDCCH, complete the following steps:
a.

Press the PDCCH Threshold soft key.

b.

Enter a value by using the numeric keys.

c.

Press the dB soft key.

–

Toggle the PDCCH Mode soft key and select REG to calculate EVM based on Resource
Element Group or Avg to calculate EVM after adding up all the PDCCH signals from one
subframe.

–

Toggle the PDSCH Precoding soft key between On and Off to enable or disable the
PDSCH precoding.

Measurement example
Figure 88
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Frame measurement with LTE - FDD signal analyzer
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Figure 89

Frame measurement with LTE - FDD signal analyzer (MBMS On)

NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 213 for
more information.

Time alignment error
In eNode B supporting Tx Diversity transmission, signals are transmitted from two or more antennas.
These signals shall be aligned. The time alignment error in Tx diversity is specified as the delay
between the signals from two antennas at the antenna ports.
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 179, you
can continue your measurement. The measurement settings can be saved and recalled as a file.
Procedure

1. Press the MEASURE SETUP hot key.
2. To set the nominal channel bandwidth to be measured, complete the following steps:
a.

Press the Bandwidth soft key.

b.

Select the bandwidth option: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, or 20 MHz.

3. Optional. Toggle the Cell ID soft key and select Auto or Manual as desired:
–

Auto: to let the instrument detect the Cell ID for the LTE signal automatically.

–

Manual: to set a specific Cell ID for the LTE signal manually in order to speed up the
synchronization with a BTS.

4. Optional. Press the Miscellaneous soft key, and then do the following(s) as needed:
–

To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4.
This MIMO (Multiple Input Multiple Output) setting is activated only if the option 030 LTEAdvanced FDD is installed with a license number. If not, the instrument sets this option to
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO
channels.
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–

To assign a antenna port number automatically or manually, press the Antenna Port soft
key and select the option: Auto, 0, 1, 2, and 3. If the option 030 LTE-Advanced FDD is not
installed or if the MIMO is set to 2x2, the antenna ports 2 and 3 are disabled.

–

To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or
Extended. See “Appendix E – Cyclic prefix table” on page 545 for OFDM parameter details
by different bandwidth.

Measurement example
Figure 90

Time alignment error measurement with LTE - FDD signal analyzer

NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 213 for
more information.

Data allocation map
The Data Allocation Map function represents data allocation as a frame.
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 179, you
can continue your measurement. The measurement settings can be saved and recalled as a file. You
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load
the file on to the instrument.
Procedure

1. Press the MEASURE SETUP hot key.
2. To set the nominal channel bandwidth to be measured, complete the following steps:
a.

Press the Bandwidth soft key.

b.

Select the bandwidth option: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, or 20 MHz.

3. To select the subframe number to be measured, complete the following steps:
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a.

Press the Subframe No soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.
NOTE
For MBMS testing, this subframe number must be neither 0 nor 5 as these subframes 0
and 5 are not available for MBMS and it must be set to the MBMS transmitted channel’s
subframe number.

c.

Press the Enter soft key.

4. To set the threshold for PDSCH, complete the following steps:
a.

Press the PDSCH Threshold soft key.

b.

Enter a value by using the numeric keys.

c.

Press the dB soft key.

5. Optional. Toggle the Cell ID soft key and select Auto or Manual as desired:
–

Auto: to let the instrument detect the Cell ID for the LTE signal automatically.

–

Manual: to set a specific Cell ID for the LTE signal manually in order to speed up the
synchronization with a BTS.

6. Optional. Press the Miscellaneous soft key, and then do the following(s) as needed:
–

To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4.
This MIMO (Multiple Input Multiple Output) setting is activated only if the option 030 LTEAdvanced FDD is installed with a license number. If not, the instrument sets this option to
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO
channels.

–

To assign a antenna port number automatically or manually, press the Antenna Port soft
key and select the option: Auto, 0, 1, 2, and 3. If the option 030 LTE-Advanced FDD is not
installed or if the MIMO is set to 2x2, the antenna ports 2 and 3 are disabled.

–

To turn the Multimedia Broadcast Multicast Service (MBMS) feature on or off, toggle the
MBMS soft key and select On or Off. For proper MBMS testing, you need to set the
Subframe No with the same PMCH subframe number. If this setting is on, either PMCH or
PDSCH appears on the screen depending on the detected channel.

–

To set the Multicast Broadcast Single Frequency Network (MBSFN) detection automatically
or manually for MBMS testing, toggle the MBSFN soft key and select Auto or Manual. An
automatically detected or manually entered MBSFN ID appears on the screen.

–

To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or
Extended. See “Appendix E – Cyclic prefix table” on page 545 for OFDM parameter details
by different bandwidth.
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Measurement example
Figure 91

Data allocation map measurement with LTE - FDD signal analyzer

Figure 92

Data allocation map measurement with LTE - FDD signal analyzer (MBMS On)

NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 213 for
more information.

Using marker
You can use the MARKER hard key to place the marker at a specific resource block and subframe.
Procedure

1. Press the MARKER hard key.
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2. Toggle the Marker View soft key between On and Off to display or dismiss the marker on the
chart.

3. To select the resource block number, complete the following steps:
a.

Press the RB Number soft key.

b.

Enter the resource block number to select by using the numeric keys. You can also use the
rotary knob to move the marker side by side.

c.

Press the Enter soft key.

4. To select the subframe block number, complete the following steps:
a.

Press the Subframe No soft key.

b.

Enter the subframe number to select by using the numeric keys. You can also use the
rotary knob to move the marker up and down.

c.

Press the Enter soft key.

Setting limit for modulation tests
Procedure

1. Press the LIMIT hot key.
2. Press the Modulation Test Limits soft key to set the limits.
3. Select the test item(s) and set the limit(s) depending on your selected measurement mode:
To set the limit for

Select

Set

Frequency error

Frequency Error

High Limit
Low Limit

PDSCH error vector
magnitude if MBMS is off

EVM > PDSCH EVM

High Limit (QPSK)
High Limit (16 QAM)
High Limit (64 QAM)

PMCH error vector magnitude
if MBMS is on and a PMCH is
detected

EVM > PMCH EVM

High Limit (QPSK)
High Limit (16 QAM)
High Limit (64 QAM)

RMS for data error vector
magnitude

EVM > Data EVM RMS

High Limit

Peak for data error vector
magnitude

EVM> Data EVM Peak

High Limit

RS error vector magnitude

EVM > RS EVM

High Limit

P-SS error vector magnitude

EVM > P-SS EVM

High Limit

S-SS error vector magnitude

EVM > S-SS EVM

High Limit

Downlink RS power

Power > DL RS Power

High Limit
Low Limit

P-SS power

Power > P-SS Power

High Limit
Low Limit

S-SS power

Power > S-SS Power

High Limit
Low Limit

PBCH power

Power > PBCH Power

High Limit
Low Limit
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Subframe power

Power > Subframe Power

High Limit
Low Limit

OFDM symbol power

Power > OFDM Symbol Power

High Limit
Low Limit

Frame average power

Power > Frame Avg Power

High Limit
Low Limit

Time alignment error for MIMO

Time Alignment Error > MIMO

High Limit

Time alignment error for
aggregation of component
carriers (intra-band
contiguous, intra-band noncontiguous, and inter-band)

Time Alignment Error > Carrier
Aggregation

Intra Cont
Intra Non-cont
Inter Band

Time error

Time Error

High Limit
Low Limit

I-Q origin offset

IQ Origin Offset

High Limit

4. Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit.
Toggle the Beep soft key between On and Off to enable or disable the beep sound.

5. Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings.
See “Using save” on page 31 for more information.

Performing auto measurements
Conformance test
The Conformance Test is to test if eNode-B meets some specified standards that have been
developed for verification. Its test procedure and test setups have been developed by 3GPP. Test
results can be saved as a .csv file type.
Setting limit for conformance test
You can set test limits for test item(s) in the auto measurement. Turning the test limit on for a test item
makes the test item included in the conformance test.
Procedure

1. Press the LIMIT hot key.
2. To set the limit for BTS output power, complete the following steps:
a.

Press the BTS Output Power soft key.

b.

Toggle the Test Limits soft key between On and Off to enable or disable the limit.

c.

Press the High Limit soft key.

d.

Enter a value for the upper limit.

e.

Press the dBm unit soft key.

f.

Press the Low Limit soft key.

g.

Enter a value for the lower limit.

h.

Press the dBm unit soft key.

3. To set the limit for total power dynamic, complete the following steps:
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a.

Press the Total Power Dynamic soft key.

b.

Toggle the Test Limits soft key between On and Off to enable or disable the limit.

c.

Press the Low Limit soft key.

d.

Enter a value for the lower limit.

e.

Press the dBm unit soft key.

4. To verify signal quality, press the Signal Quality soft key, and then do the following as needed:
To set the limit for

Select

Set

Frequency error

Frequency Error >
Test Limits [E-TM2|ETM3.1|E-TM3.2|ETM3.3]

High Limit
Low Limit

Error vector magnitude

EVM > Test Limits [ETM2|E-TM3.1|ETM3.2|E-TM3.3]

High Limit (QPSK)
High Limit (16 QAM)
High Limit (64 QAM)

Time alignment error

Time Alignment Error

High Limit

RS power

RS Power

High Limit
Low Limit

5. To verify unwanted emissions, press the Unwanted Emissions soft key, and then do the
following as needed:
To set the limit for

Select

Set

Occupied bandwidth

Occupied BW

High Limit

Adjacent channel power ratio

ACLR

Spectrum emission mask

SEM

Mask Type

Spurious emissions

Spurious Emissions

Range Table

6. Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit.
Toggle the Beep soft key between On and Off to enable or disable the beep sound.

7. Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings.
See “Using save” on page 31 for more information.

Setting measure setup
After setting frequency as described in the “Configuring test parameters” on page 179, you can
continue your measurement.
Procedure

1. Press the MEASURE SETUP hot key.
2. Press the Bandwidth soft key.
3. Select the nominal channel bandwidth to be measured, from the following choices:
–

1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, and 20 MHz

4. Press the Sector soft key, and then select the sector option: Alpha, Beta, or Gamma.
5. To set external offset, complete the following steps:
a.

Toggle the External Offset soft key and select On.
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b.

Enter a value by using the numeric keys.

c.

Press the dB soft key.

6. To save your settings and results, go to SAVE/LOAD > Save and then perform functions as you
desire. See “Using save” on page 31 for more information.

7. Press the Run Test soft key to start to run a test.
The Auto Measure Results window appears at the end of the test.

8. When prompted on the screen, connect the cable from the Spectrum Analyzer RF In port of the
instrument either to Antenna Port 0 or Antenna Port 1 of the eNode-B, and then change the TM
mode on the eNode-B side.

9. Press the Continue soft key to continue testing.
10. Repeat the steps 8-9 until completion of the test.
A conformance test report appears at the end of the test.

11. Optional. To stop running the test, press the Abort soft key.

Maintenance test
The Auto Measure function of the JD780A series allows a complete signal profiling covering RF
characterization and modulation quality parameters of up to 20 different carriers, particularly useful on
an overlay architecture where base stations are transmitting in different frequencies.
Following settings are required only when you run the Auto Measure Maintenance Test on the
instrument using “Current” configuration setting. Additional settings are not required when you run Auto
Measure using a scenario generated in the PC application software, JDViewer.
Setting limit for maintenance test
You can set test limits for test item(s) in the auto measurement.
Procedure

1. Press the LIMIT hot key.
2. Press the RF Test Limits soft key, and then enable test limits as desired.
3. Press the Modulation Test Limits soft key, and then enable test limits as desired.
4. Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit.
Toggle the Beep soft key between On and Off to enable or disable the beep sound.

5. Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings.
See “Using save” on page 31 for more information.
NOTE
You can use the Allowed % Change soft key for each test item to compare two
measurement values displayed in the result table. This requires setting the Display mode
to Compare in advance.

Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 179, you
can continue your measurement. The measurement settings can be saved and recalled as a file. You
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load
the file on to the instrument.
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Procedure

1. Press the MEASURE SETUP hot key.
2. Toggle the Configuration soft key and select the configuration option:
–

Current: to let the instrumnet use current frequency (single carrier) and determine pass or
fail based on the instrument’s limit settings in Auto Measure.

–

Scenario: to run a test with a programmed scenario in JDViewer.
The Scenario menu becomes activated.

3. To load a scenario, press the Scenario soft key, and then select a scenario file to load.
4. Toggle the Test Time soft key and select the test time option:
–

Now: to let the instrument run a test only once.

–

Schedule: to let the instrument repeat tests as defined in the Set Timing.
The Set Timing menu becomes activated.

5. To define a schedule for an auto measurement, complete the following steps:
a.

Press the Set Timing soft key.

b.

Press the Start Time (HH:MM) soft key.

c.

Enter the time in the HH:MM format, and then press the Enter soft key.

d.

Press the Stop Time (HH:MM) soft key.

e.

Enter the time in the HH:MM format, and then press the Enter soft key.

f.

Press the Time Interval soft key.

g.

Enter the amount of time in minutes, and then press the Enter soft key.

–
6. Press the Settings soft key, and then set the following as needed:
a.

Press the Bandwidth soft key, and then select the nominal channel bandwidth to be
measured, from the following choices:

–
b.

1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, and 20 MHz

Toggle the Cell ID soft key and select Auto or Manual as desired:

–

Auto: to let the instrument detect the Cell ID for the LTE signal automatically.

–

Manual: to set a specific Cell ID for the LTE signal manually in order to speed up the
synchronization with a BTS.

c.

Press the MIMO soft key, and then select the antenna number option: 2x2 or 4x4.
This MIMO (Multiple Input Multiple Output) setting is activated only if the option 030 LTEAdvanced FDD is installed with a license number. If not, the instrument sets this option to
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO
channels.

d.

Press the Antenna Port soft key, and then select the option: Auto, 0, 1, 2, or 3.
If the option 030 LTE-Advanced FDD is not installed or if the MIMO is set to 2x2, the
antenna ports 2 and 3 are disabled.

e.

Toggle the External Offset soft key and select On.

f.

Enter a value by using the numeric keys, and then press the dB soft key.

g.

To turn the Multimedia Broadcast Multicast Service (MBMS) feature on or off, toggle the
MBMS soft key and select On or Off. For proper MBMS testing, you need to set the
Subframe No with the same PMCH subframe number.

h.

To set the Multicast Broadcast Single Frequency Network (MBSFN) detection automatically
or manually for MBMS testing, toggle the MBSFN soft key and select Auto or Manual. An
automatically detected or manually entered MBSFN ID appears on the screen.

7. To save your settings and results, go to SAVE/LOAD > Save and then perform functions as you
desire. See “Using save” on page 31 for more information.

Using LTE - FDD Signal Analyzer

217

JD780A Series Analyzers

8. Press the Run Test soft key to start to run a test.
The Auto Measure Results window appears at the end of the test.

9. To stop running the test, press the Abort soft key.
10. To change the view on the screen during the test, press the Display and then select the view
option from the following choices:

–

Screen: You can view each measurement screen as the test progresses.

–

Results: You can view a measurement result table as the test progresses.

–

Settings: You can view a measurement setting table as the test progresses.

Setting display
After completion of the auto measurement, the screen menu changes to Trace/Display so that you can
view the results in different forms.
Procedure

1. Toggle the Display soft key and select the display option:
–

Result: to view the result table.
The Display Result menu becomes activated.

–

Settings: to view the measurement settings for the auto measurement.

2. Toggle the Display Result soft key and select the display result option:
–

Full: to view detailed measurement readings with the pass/fail indication.

–

Quick: to view only the Pass/Fail results.

–

Compare: to compare two measurement values for each test time with the Allowed %
Change setting on. You can view results vs. factory-defined or user-defined references.

3. To view the measurement results for a different carrier, press the View Carrier soft key and then
select the carrier number to view.

4. Press the Replace Reference soft key to replace existing reference values for comparison with
new measurement data.

5. Press the Load From soft key to select the location from which references file to be loaded.

Signal performance test
Unlike the other auto measurement tests, the Signal Performance Test runs measurements
continuously.
Setting limit for signal performance test
You can set test limits for test item(s) in the auto measurement.
Procedure

1. Press the LIMIT hot key.
2. Press the RF Test Limits > Channel Power soft key, and then set the limits for the channel
power. Other RF test items are not used in the signal performance test.

3. Press the Modulation Test Limits soft key, and then enable test limits as desired.
4. Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit.
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Toggle the Beep soft key between On and Off to enable or disable the beep sound.

5. Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings.
See “Using save” on page 31 for more information.

Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 179, you
can continue your measurement. The measurement settings can be saved and recalled as a file. You
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load
the file on to the instrument.
Procedure

1. Press the MEASURE SETUP hot key.
2. Toggle the Cell ID soft key and select Auto or Manual as desired:
–

Auto: to let the instrument detect the Cell ID for the LTE signal automatically.

–

Manual: to set a specific Cell ID for the LTE signal manually in order to speed up the
synchronization with a BTS.

3. Press the MIMO soft key, and then select the antenna number option: 2x2 or 4x4.
This MIMO (Multiple Input Multiple Output) setting is activated only if the option 030 LTEAdvanced FDD is installed with a license number. If not, the instrument sets this option to 2x2 by
default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO channels.

4. Press the Antenna Port soft key, and then select the option: Auto, 0, 1, 2, or 3.
If the option 030 LTE-Advanced FDD is not installed or if the MIMO is set to 2x2, the antenna
ports 2 and 3 are disabled.

5. Press the Bandwidth soft key, and then select the nominal channel bandwidth to be measured,
from the following choices:

–

1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, and 20 MHz

6. Toggle the RF Profile soft key between On and Off to turn on or off the RF profiling such as
channel power and subframe frequency error.

7. Toggle the Modulation Profile soft key between On and Off to turn on or off the modulation
profiling such as P-SS, S-SS, Data - QPSK, Data – 16 QAM, and Data – 64 QAM.

8. Toggle the MIMO Profile soft key between On and Off to turn on or off the MIMO profiling such
as TX1 - RS0, TX2 - RS1, and time alignment error.

9. Toggle the External Offset soft key and select On to set the external offset value.
10. To save your settings and results, go to SAVE/LOAD > Save and then perform functions as you
desire. See “Using save” on page 31 for more information.

DAS test
The Distributed Antenna System (DAS) testing enables you to check the degradation of performance
in the signal transmission from a radio band to antennas distributed from it. You can save
measurement values at both the radio band and antennas and then compare results with percentage
of changes. You can also save test results in the .csv file format for ease of analysis.
Setting measure setup
Procedure

1. Press the MEASURE SETUP hot key.
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2. Press the Settings soft key and then set the following;
a.

Press the Bandwidth soft key and then select the nominal channel bandwidth to be
measured from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, and 20 MHz:

b.

Press the MIMO soft key, and then select the antenna number option: 2x2 or 4x4.
This MIMO (Multiple Input Multiple Output) setting is activated only if the option 030 LTEAdvanced FDD is installed with a license number. If not, the instrument sets this option to
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO
channels.

c.

Toggle the Cell ID soft key and select Auto or Manual as desired:

–

Auto: to let the instrument detect the Cell ID for the LTE signal automatically.

–

Manual: to set a specific Cell ID for the LTE signal manually in order to speed up the
synchronization with a BTS.

d.

Press the Antenna Port soft key, and then select the option: Auto, 0, 1, 2, or 3.
If the option 030 LTE-Advanced FDD is not installed or if the MIMO is set to 2x2, the
antenna ports 2 and 3 are disabled.

e.

Toggle the External Offset soft key and select On to set the external offset value.

f.

To turn the Multimedia Broadcast Multicast Service (MBMS) feature on or off, toggle the
MBMS soft key and select On or Off.

g.

To set the Multicast Broadcast Single Frequency Network (MBSFN) detection automatically
or manually for MBMS testing, toggle the MBSFN soft key and select Auto or Manual. An
automatically detected or manually entered MBSFN ID appears on the screen.

3. To save your settings, go to SAVE/LOAD > Save > Save Setup and then perform functions as
you desire. See “Using save” on page 31 for more information.

4. Press the Continue soft key to do the reference test first or press the Skip Reference Test soft
key if you already saved test results from the radio band under test.

5. Press the FREQ/DIST hard key and then set the frequency to be measured. See “Setting
frequency” on page 243 for more information.

6. Press the PREV hard key.
7. Press the Limit soft key and then set the limits and allowed percentage change for each test
item. See “Maintenance test” on page 280 for more information on setting limits.

8. Keep pressing the PREV hard key until you see the Run Test soft key.
9. Press the Run Test soft key.
The instrument runs specified tests to gather reference measurement values. The measurement
table appears when the reference test is done.

10. Press the Continue soft key to run the testing on an antenna (Ant 1).
11. Optional. To change the settings such as External Offset, press the Settings and then change
the settings as needed.

12. Press the Continue soft key.
The instrument runs the testing on Ant 1. The Ant 1 tab appears with the updated result table
when the test is done.

13. To run the testing on the next antenna (Ant 2), press the Run Test soft key and then repeat the
steps 11-12. You can do the testing on up to 10 distributed antennas for one radio band.

14. To view test results for each antenna, press the Select Antenna soft key and then select the
antenna tab number to display on the screen.

15. Optional. Press the Delete Test soft key to delete the selected antenna tab.
16. Optional. Press the Retest Reference soft key to obtain reference measurement values again.
17. Optional. To save your measurement results, go to SAVE/LOAD > Save and then perform
functions as you desire. See “Using save” on page 31 for more information.
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Measurement Example
Figure 93

DAS measurement with LTE - FDD signal analyzer

Performing power statistics CCDF measurements
The Power Statistics Complementary Cumulative Distribution Function (CCDF) measurement
characterizes the power statistics of the input signal. It provides PAR (Peak to Average power Ratio)
versus different probabilities.

Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 179, you
can continue your measurement. The measurement settings can be saved and recalled as a file. You
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load
the file on to the instrument.
Procedure

1. Press the MEASURE SETUP hot key.
2. Press the CCDF Length soft key to set the length of the CCDF.
3. Enter a value between 1 and 100 by using the numeric keys. You can also use the rotary knob.
4. Press the Enter soft key.
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Measurement example
Figure 94

CCDF measurement with LTE - FDD signal analyzer

Performing carrier aggregation measurements
Carrier aggregation enables a maximum of five multiple LTE carriers to be used together in order to
provide high data rate required for LTE-Advanced. Component carriers to be aggregated can be intraband contiguous, intra-band non-contiguous, or inter-band. The JD780A series provides carrier
aggregation measurements supporting for all the different modes with carrier aggregation bands
added to the channel standard. This functionality is activated if the license for the option 030 LTEAdvanced FDD is installed.

Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 179, you
can continue your measurement. The measurement settings can be saved and recalled as a file. You
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load
the file on to the instrument.
Procedure

1. Press the MEASURE SETUP hot key.
2. To configure parameters for up to 5 component carriers, complete the following steps:
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a.

Press the CA Configuration soft key.
The component carrier configuration window appears.

b.

Press the CA Range soft key.

c.

Enter the number of the component carrier to be set between 1 and 5.

d.

Press the Enter soft key.

e.

Toggle the Turn On soft key and then select On to set parameters and view the results for
the selected component carrier on the screen or Off to turn it off.

f.

Set the following parameters as needed:

Using LTE - FDD Signal Analyzer

JD780A Series Analyzers

–
g.

Center Frequency, Channel, Bandwidth, Cell ID, CFI, PHICH Ng, Antenna Port,
MBMS On/Off, Cyclic Prefix, and PDSCH Modulation Type

To set more component carriers, repeat the steps c-f.

3. Press the MEASURE SETUP hot key again
4. Toggle the EVM Detection Mode soft key and select Single or Combine as desired:
–

Single: Testing on one single antenna connected to your JD780A series with a cable.

–

Combine: Testing on multiple antennas connected to your JD780A series with a 2x1 or 4x1
combiner or an antenna.

5. To select the subframe number to be measured, do one of the following:
–

If the EVM Detection Mode is set to Single, press the Subframe No soft key and then set
the subframe number.
NOTE
For MBMS testing, this subframe number must be neither 0 nor 5 as these subframes 0
and 5 are not available for MBMS and it must be set to the MBMS transmitted channel’s
subframe number.

–

If the EVM Detection Mode is set to Combine, toggle the Subframe No soft key and then
select 0 or 5.

6. To set the threshold for PDSCH, complete the following steps:
a.

Press the PDSCH Threshold soft key.

b.

Enter a value by using the numeric keys.

c.

Press the dB soft key.

7. Toggle the PDSCH Precoding soft key between On and Off to enable or disable the PDSCH
precoding.

8. To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4.
This MIMO (Multiple Input Multiple Output) setting is activated only if the option 030 LTEAdvanced FDD is installed with a license number. If not, the instrument sets this option to 2x2 by
default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO channels.

Setting display
You can use the TRACE/DISPLAY hard key to select modulation analysis or spectrum analysis.
Procedure

1. Press the TRACE/DISPLAY hard key.
2. Toggle the Display soft key and select MA for modulation analysis or SA for spectrum analysis.
The screen changes according to the selected option.
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Measurement example
Figure 95

Carrier aggregation measurement with LTE - FDD signal analyzer (MA)

Figure 96

Carrier aggregation measurement with LTE - FDD signal analyzer (SA)

NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 213 for
more information.

Using marker
You can use the MARKER hard key to place the marker at a specific channel.
Procedure

1. Press the MARKER hard key.
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2. Toggle the IQ Diagram soft key between On and Off to display or dismiss data on the IQ
diagram for each component carrier.

3. Press the Channel soft key to select the channel to be displayed on the IQ diagram.
4. Use the rotary knob to move and select an item under EVM.

Conducting LTE - FDD OTA measurements
The FDD LTE Over The Air (OTA) measurement has Channel Scanner, ID Scanner, Multipath Profile,
Datagram, and Control Channel screens. The ID Scanner displays key parameters such as RSRP,
RSRQ, RS-SINR, and S-SS RSSI. The Multipath Profile enables you to determine RF environmental
conditions of testing area. The OTA Control Channel provides summary of all control channels
including RS power variation over time.

Channel scanner
The Channel Scanner is a radio receiver that can automatically tune or scan two or more discrete
frequencies and multi-channels, indicating when it finds a signal on one of them and then continuing
scanning when that frequency goes silent.
Setting channel/frequency
Procedure
To set the channels to be scanned:

1. Press the FREQ/DIST hard key.
2. Toggle the Unit soft key and select Channel.
3. Press the Index soft key, and then enter an index number between one and six by turning the
rotary knob or using the numeric keys.

4. To select the standard channel, complete the following steps:
a.

Press the Channel Std soft key. The standard channel window appears.
See “Appendix C – Band, frequency & channel standard” on page 541 for more information.

b.

Select the band to be measured by using the rotary knob, the arrow keys, or the Page
Up/Page Down soft keys.

c.

Press the Select soft key or the rotary knob to confirm the selection.

5. To set the channel number for the selected index, complete the following steps:
a.

Press the Channel Number soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Press the Enter soft key.

The instrument displays a corresponding center frequency for the channel number.

6. To set the integration bandwidth for the selected index, complete the following steps:
a.

Press the Integration Bandwidth soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Select the unit: GHz, MHz, kHz, or Hz.

7. To add more channels to be scanned, repeat steps 3-6.
8. Press the ESC hard key to dismiss the channel list window and view the scanning result.
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To set the frequencies to be scanned:

1. Press the FREQ/DIST hard key.
2. Toggle the Unit soft key and select Freq.
3. Press the Index soft key, and then enter an index number between one and six by turning the
rotary knob or using the numeric keys.

4. To set the center frequency for the selected index, complete the following steps:
a.

Press the Center Frequency soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Select the unit: GHz, MHz, kHz, or Hz.

5. To set the integration bandwidth for the selected index, complete the following steps:
a.

Press the Integration Bandwidth soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Select the unit: GHz, MHz, kHz, or Hz.

6. To add more channels to be scanned, repeat steps 3-5.
7. Press the ESC hard key to dismiss the channel list window and view the scanning result.
Setting number of antenna ports
Procedure

1. Press the MEASURE SETUP hot key.
2. Toggle the MIMO soft key and select 2x2 or 4x4.
This MIMO (Multiple Input Multiple Output) setting is activated only if the option 030 LTEAdvanced FDD is installed with a license number. If not, the instrument sets this option to 2x2 by
default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO channels.

Measurement example
Figure 97
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ID scanner
The LTE mobile receives signals from multiple base stations that all of these signals share the same
spectrum and are present at the same time. Each base station has unique scrambling code assigned
to the particular base station and it differentiates its signal from other base stations in the area.
The ID Scanner shows key parameters such as RSRP (Reference Signal Received Power) and RSRQ
(Reference Signal Received Quality) that predict the downlink coverage quickly.


RSRPs from entire cells help to rank between the different cells as input for handover and cell
reselection decisions.



RSRQ provides additional information when RSRP is not sufficient to make a reliable
handover or cell reselection decision.

All of the parameters for OTA ID scanner can be plotted on map data such as Google Maps and
Google Earth by using JDViewer.
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 179, you
can continue your measurement.
Procedure

1. Press the MEASURE SETUP hot key.
2. To set the nominal channel bandwidth to be measured, complete the following steps:
a.

Press the Bandwidth soft key.

b.

Select the bandwidth option: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, or 20 MHz.

3. Optional. Press the Miscellaneous soft key, and then do the following(s) as needed:
–

To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4.
This MIMO (Multiple Input Multiple Output) setting is activated only if the option 030 LTEAdvanced FDD is installed with a license number. If not, the instrument sets this option to
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO
channels.

–

To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or
Extended. See “Appendix E – Cyclic prefix table” on page 545 for OFDM parameter details
by different bandwidth.

4. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available
for your measurement mode. See “Using save” on page 31 for more information.
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Measurement example
Figure 98

ID scanner measurement with LTE - FDD OTA signal analyzer

Multipath profile
The Multipath Profile enables you to determine RF environmental conditions of testing area. It
indicates the amount of power of the dominant pilot signal that is dispersed outside the main
correlation peak due to multipath echoes that are expressed in dB. This value should be very small
ideally.
The multipath profile is the result of portions of the original broadcast signal arriving at the receiving
antenna out of phase. This can be caused by the signal being reflected off objects such as buildings,
or being refracted through the atmosphere differently from the main signal.
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 179, you
can continue your measurement.
Procedure

1. Press the MEASURE SETUP hot key.
2. To set the nominal channel bandwidth to be measured, complete the following steps:
a.

Press the Bandwidth soft key.

b.

Select the bandwidth option: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, or 20 MHz.

3. Toggle the Display soft key and select RS or Sync.
The RS Window soft key becomes activated if RS is selected.

4. Press the RS Window soft key, if RS is selected, and then select the RS window option: 2 µs,
4 µs, or 8 µs.

5. Optional. Press the Miscellaneous soft key, and then do the following(s) as needed:
–
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To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4.
This MIMO (Multiple Input Multiple Output) setting is activated only if the option 030 LTEAdvanced FDD is installed with a license number. If not, the instrument sets this option to
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2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO
channels.

–

To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or
Extended. See “Appendix E – Cyclic prefix table” on page 545 for OFDM parameter details
by different bandwidth.

6. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available
for your measurement mode. See “Using save” on page 31 for more information.

Measurement example
Figure 99

Multipath profile measurement with LTE - FDD OTA signal analyzer

Control channel
DL RS power is the resource element power of Downlink Reference Symbol. The absolute DL RS
power is indicated on the BCH. The absolute accuracy is defined as the maximum deviation between
the DL RS power indicated on the BCH and the DL RS power at the BS antenna connector.
The OTA Control Channel provides summary of all control channels including RS power trend over
time. GPS coordinates (latitude and longitude) will be displayed on the screen if a GPS antenna is
connected and locked to the GPS satellites.
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 179, you
can continue your measurement. The measurement settings can be saved and recalled as a file. You
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load
the file on to the instrument.
Procedure

1. Press the MEASURE SETUP hot key.
2. To set the nominal channel bandwidth to be measured, complete the following steps:
a.

Press the Bandwidth soft key.
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b.

Select the bandwidth option: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, or 20 MHz.

3. To select the subframe number to be measured, complete the following steps:
a.

Press the Subframe No soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.
NOTE
For MBMS testing, this subframe number must be neither 0 nor 5 as these subframes 0
and 5 are not available for MBMS and it must be set to the MBMS transmitted channel’s
subframe number.

c.

Press the Enter soft key.

4. Optional. Toggle the Cell ID soft key and select Auto or Manual as desired:
–

Auto: to let the instrument detect the Cell ID for the LTE signal automatically.

–

Manual: to set a specific Cell ID for the LTE signal manually in order to speed up the
synchronization with a BTS.

5. Optional. Press the Miscellaneous soft key, and then do the following(s) as needed:
–

To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4.
This MIMO (Multiple Input Multiple Output) setting is activated only if the option 030 LTEAdvanced FDD is installed with a license number. If not, the instrument sets this option to
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO
channels.

–

To assign a antenna port number automatically or manually, press the Antenna Port soft
key and select the option: Auto, 0, 1, 2, and 3. If the option 030 LTE-Advanced FDD is not
installed or if the MIMO is set to 2x2, the antenna ports 2 and 3 are disabled.

–

To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or
Extended. See “Appendix E – Cyclic prefix table” on page 545 for OFDM parameter details
by different bandwidth.

–

To turn the Multimedia Broadcast Multicast Service (MBMS) feature on or off, toggle the
MBMS soft key and select On or Off. For proper MBMS testing, you need to set the
Subframe No with the same PMCH subframe number. If this setting is on, the
measurement item “MBSFN RS” appears in the result table.

–

To set the Multicast Broadcast Single Frequency Network (MBSFN) detection automatically
or manually for MBMS testing, toggle the MBSFN soft key and select Auto or Manual. An
automatically detected or manually entered MBSFN ID appears on the screen.

6. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available
for your measurement mode. See “Using save” on page 31 for more information.

Setting limit for OTA control channel
Procedure

1. Press the LIMIT hot key.
2. Select the test item(s) and set the limit(s) as needed:
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To set the limit for

Select

Set

P-SS error vector magnitude

P-SS EVM

High Limit

S-SS error vector magnitude

S-SS EVM

High Limit

RS error vector magnitude

RS EVM > RS0 EVM
RS EVM > RS1 EVM
RS EVM > RS2 EVM
RS EVM > RS3 EVM

High Limit
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Frequency error

Frequency Error

High Limit
Low Limit

Time error

Time Error

High Limit
Low Limit

Time alignment error

Time Alignment Error

High Limit

3. Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings.
See “Using save” on page 31 for more information.

Setting display
You can use the TRACE/DISPLAY hard key to select the display option.
Procedure

1. Press the TRACE/DISPLAY hard key.
2. Toggle the Display soft key and select Power or EVM.
The screen changes according to the selected option.

Measurement example
Figure 100 Control channel measurement with LTE - FDD OTA signal analyzer

Datagram
The OTA Datagram is a time-varying spectral representation that shows how the power of a signal
varies with time. The power allocated to the specific resource block will be represented with an
amplitude axis (in dBm) and the waterfall diagram will show the trend of past resource block power
over certain period. Using a marker function facilitates analysis of accumulated resource block power
for data utilization.
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 179, you
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can continue your measurement. The measurement settings can be saved and recalled as a file. You
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load
the file on to the instrument.
Procedure

1. Press the MEASURE SETUP hot key.
2. To set the nominal channel bandwidth to be measured, complete the following steps:
a.

Press the Bandwidth soft key.

b.

Select the bandwidth option: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, or 20 MHz.

3. To select the subframe number to be measured, complete the following steps:
a.

Press the Subframe No soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Press the Enter soft key.

4. Optional. Toggle the Cell ID soft key and select Auto or Manual as desired:
–

Auto: to let the instrument detect the Cell ID for the LTE signal automatically.

–

Manual: to set a specific Cell ID for the LTE signal manually in order to speed up the
synchronization with a BTS.

5. Optional. To set the threshold for PDSCH, complete the following steps:
a.

Press the PDSCH Threshold soft key.

b.

Enter a value by using the numeric keys.

c.

Press the dB soft key.

6. To set the time cursor at a specific position, complete the following steps:
a.

Toggle the Time Cursor soft key and select On.

b.

Turn the rotary knob to move the time cursor. You can also enter a value and then press the
Enter soft key.
NOTE
Enabling the time cursor puts the measurement on hold and you can make postprocessing analysis for each measurement over time using the time cursor.

7. To start a new measurement, press the Reset/Restart soft key.
8. Optional. Press the Miscellaneous soft key, and then do the following(s) as needed:
–

To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4.
This MIMO (Multiple Input Multiple Output) setting is activated only if the option 030 LTEAdvanced FDD is installed with a license number. If not, the instrument sets this option to
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO
channels.

–

To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or
Extended. See “Appendix E – Cyclic prefix table” on page 545 for OFDM parameter details
by different bandwidth.

9. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available
for your measurement mode. See “Using save” on page 31 for more information.
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Measurement example
Figure 101 Datagram measurement with LTE - FDD signal analyzer

Route map
The JD780A Series provides indoor and outdoor mapping function that allows a user to collect data of
points in an indoor or outdoor environment and track the received signals and coverage of RF
transmitters plotting real time directly on top of a loaded floor plan or a map.
Setting measure setup
Procedure

1. If required, connect a GPS receiver to your JD780A series for outdoor mapping.
Indoor mapping does not necessarily need a GPS antenna.

2. Configure test parameters as described in the “Configuring test parameters” on page 179.
3. To load your map file, complete the following steps:
a.

Plug in your USB drive that has a floor map or .mcf file type created in JDMapCreator.
NOTE
The JDMapCreator converts and resizes any scanned floor plan or layout to fit onto your
instrument’s display. You must save your map files (.mcf) into the “SavedMap” folder of
your USB drive so that you can load them onto your instrument.

b.

Press SAVE/LOAD hot key, and then select Load > Load Map.
See “Using load” on page 34 for more information.

4. Press the MEASURE SETUP hot key.
5. Press the Plot Point soft key, and then select the plot point option from the following choices:
–

To collect data/plot points automatically as you move around in a vehicle or outside, press
the GPS soft key and then toggle the Screen Mode soft key between Map and Full.
NOTE
With the Map setting, you can view only the collected points that can be seen within the
boundary of the loaded map. If a point is off the map, the instrument displays an arrow to
indicate the direction of the current location on the map and the distance from the center
to the location at the top of the screen.

Using LTE - FDD Signal Analyzer

233

JD780A Series Analyzers

With the Full setting, you can view all the collected points of the route without the loaded
map.

–

To collect data/plot points manually without a GPS antenna in an indoor environment, press
the Position soft key.

6. Press the Plot Item soft key, and then select the measurement option: RSRP, RSRQ, RS-SINR,
S-SS RSSI, P-SS Power, S-SS Power, or S-SS Ec/Io.
NOTE
The instrument collects the strongest Cell ID’s data to plot points.

7. Press the Bandwidth soft key to set the nominal channel bandwidth to be measured, and then
select the bandwidth option: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, or 20 MHz.

8. Toggle the Plot soft key and select Start to start plotting.
9. Touch directly on the screen or press the ENTER hard key to collect data and plot points on the
loaded map for the Position setting.
NOTE
For the Position setting, you can change the direction of the route with the arrow keys
and the distance with the rotary knob.

10. Toggle the Plot soft key and select Stop to stop plotting.
11. Press the SAVE/LOAD hot key to save the result.
See “Using save” on page 31 for more information.
NOTE
The instrument does not automatically save the collected data. It is recommended that
you save the result. Otherwise, you will lose all the collected data.

Setting limit for route map
You can set the thresholds for each test item.
Procedure

1. Press the LIMIT hot key.
2. Select the plot items and set the limits as needed:
To set the limit for

Select

Set

RSRP

RSRP

Excellent, Very Good, Good, Fair, Poor (dBm)

RSRQ

RSRQ

Good, Fair, Poor (dB)

RS-SINR

RS-SINR

Good, Fair, Poor (dB)

S-SS RSSI

S-SS RSSI

Excellent, Very Good, Good, Fair, Poor (dBm)

P-SS Power

P-SS Power

Excellent, Very Good, Good, Fair, Poor (dBm)

S-SS Power

S-SS Power

Excellent, Very Good, Good, Fair, Poor (dBm)

S-SS Ec/Io

S-SS Ec/Io

Good, Fair, Poor (dB)

3. Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings.
See “Using save” on page 31 for more information.
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Measurement example
Figure 102 Route map measurement with LTE - FDD OTA signal analyzer
1) RSRP

2) RSRQ
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3) RS-SINR

4) S-SS RSSI

5) P-SS Power
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6) S-SS Power

7) S-SS Ec/Io
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Using LTE - TDD Signal Analyzer
This chapter provides instructions for using the LTE - TDD Signal Analyzer (option 029) and LTEAdvanced TDD Analyzer (option 031) with the LTE - TDD OTA Analyzer (option 049). Topics discussed
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Introduction
The LTE (Long-Term Evolution) Signal Analyzer of the JD780A series performs power and spectrum
measurements as well as modulation analysis to test the proper transmitter performance of TDD LTE
systems. It performs conformance testing according to the following standards providing a simple
Pass/Fail indication on each test.


3GPP TS 36.104. Evolved Universal Terrestrial Radio Access (E-UTRA); Base Station (BS)
Radio Transmission and Reception



3GPP TS 36.141. Evolved Universal Terrestrial Radio Access (E-UTRA); Base Station (BS)
Conformance Testing



3GPP TS 36.211. Evolved Universal Terrestrial Radio Access (E-UTRA); Physical Channels
and Modulation



3GPP TS 36.212. Evolved Universal Terrestrial Radio Access (E-UTRA); Multiplexing and
Channel Coding



3GPP TS 36.213 V8.2.0. Evolved Universal Terrestrial Radio Access (E-UTRA); Physical
Layer Procedures

This instrument provides the following measurement tools for TDD LTE system:


Spectrum Analysis



RF Analysis
-

Channel Power

-

Occupied Bandwidth

-

Spectrum Emission Mask

-

Adjacent Channel Leakage power Ratio (ACLR)

-

Multi-ACLR

-

Spurious Emissions



Power vs. Time: Slot and Frame



Modulation Analysis



-

Constellation

-

Data Channel

-

Control Channel

-

Subframe

-

Time Alignment Error

-

Data Allocation Map

Auto Measure
-

Conformance Test

-

Maintenance Test

-

Signal Performance Test

-

DAS Test



Power Statistics CCDF



Carrier Aggregation
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Over The Air (OTA)
-

Channel Scanner

-

ID Scanner

-

Multipath Profile

-

Control Channel

-

Datagram

-

Route Map

Display overview
Figure 103 provides descriptions for each segment of the measurement screen.
Figure 103 LTE - TDD signal analyzer measurement screen

Connecting a cable
Direct connection
Procedure

1. Connect the Spectrum Analyzer RF In port of the JD780A series and the Power amplifier output
port of BTS.
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Figure 104 Direct connection

JD785A/JD786A

JD788A

Indirect connection
Procedure

1. Connect the Spectrum Analyzer RF In port of the JD780A series and the monitor (test) port of
BTS.

Figure 105 Indirect connection

JD785A/JD786A

JD788A

CAUTION
The maximum power for the Spectrum Analyzer RF In port is +25 dBm (0.316 W). If the
input signal level to be measured is greater than +25 dBm, use a High Power
Attenuator to prevent damage when you directly connect the signal to the instrument or
connect the signal from the coupling port of a directional coupler.

Over the air (OTA)
Procedure

1. Connect an Omni/directional RF antenna to the Spectrum Analyzer RF In port of the JD780A
series.

2. Connect a GPS antenna to the GPS port of the JD780A series.
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Figure 106 OTA connection

JD785A/JD786A

JD788A

CAUTION
If the input signal level to be measured is less than 0 dBm, set 0 dB attenuation or turn on
the preamp to have better dynamic range for the OTA testing.

Selecting measurement mode
Procedure

1. Press the MODE hard key.
2. Press the Signal Analyzer soft key.
3. Press the LTE - TDD soft key. The Spectrum mode is set by default.
4. Press the MEASURE hot key, and then select the measurement mode option from the following
choices:

–

Spectrum

–

RF Analysis > Channel Power, Occupied BW, Spectrum Emission Mask, ACLR,
Multi-ACLR, or Spurious Emissions

–

Power vs Time > Power vs Time (Slot) or Power vs Time (Frame)

–

Modulation Analysis > Constellation, Data Channel, Control Channel, Subframe,
Time Alignement Error, or Data Allocation Map

–

Auto Measure > Conformance Test, Maintenance Test, Signal Perfomance, or DAS Test

–

Power Statistics CCDF

–

More (1/2) > Carrier Aggregation

–

More (1/2) > OTA > Channel Scanner, ID Scanner, Multipath Profile, Control Channel,
Datagram,
or Route Map
NOTE
The Carrier Aggregation soft key is activated if the license for the option 031 LTEAdvanced TDD is installed.
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Configuring test parameters
Setting frequency
You can set the frequency with either frequency or channel number. If a frequency to be set matches
to the frequency corresponding to the selected channel standard, the instrument calculates its channel
number and updates the screen with it automatically.
Procedure
To set the center frequency:

1. Press the FREQ/DIST hard key.
2. Toggle the Unit soft key and select Freq.
3. Press the Center Frequency soft key.
4. Enter a value by using the numeric keys. You can also use the rotary knob.
5. Select the unit: GHz, MHz, kHz, or Hz.
6. Optional. To define the amount of frequency increment for the rotary knob, complete the following
steps:
a.

Press the Frequency Step soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Press the unit: GHz, MHz, kHz, or Hz.

To set the channel number:

1. Press the FREQ/DIST hard key.
2. Toggle the Unit soft key and select Channel.
NOTE
Selecting Channel sets the standard channel to Band Global automatically so that you
can set the Channel Number without choosing a standard channel band from the list.

3. Press the Channel Number soft key.
4. Enter a value by using the numeric keys. You can also use the rotary knob.
5. Press the Enter soft key.
The instrument automatically displays the corresponding center frequency value for the selected
channel number.

6. Optional. To define the amount of channel increment for the rotary knob, complete the following
steps:
a.

Press the Channel Step soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Press the Enter soft key.

NOTE
This frequency setting is not used in the Multi-ACLR and Spurious Emissions modes.

Setting amplitude
Reference level and attenuation
You can set the reference and attenuation levels automatically or manually to optimize the display of
the traces measured, as you desire.
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Procedure
To automatically set the reference and attenuation level:

1. Press the AMP/SCALE hard key.
2. Press the Auto Scale soft key.
Each time you press this key, both of the Y-axis scale and input attenuation level change to be
optimized with some margin.
To set the reference or attenuation level manually:

1. Press the AMP/SCALE hard key.
2. To set the maximum reference value on the Y-axis manually, complete the following steps:
a.

Press the Reference Level soft key.

b.

Enter a value by using the numeric keys or the rotary knob with 10 dB increments.

c.

Press the dBm soft key or the ENTER hard key.
NOTE
In the measurements such as Control Channel, and Subframe, you may need to select
the reference option between Relative and Absolute before setting the reference level.

3. To set the attenuation option, select one from the following choices:
–

To set the input attenuator’s level automatically, select Attenuation > Auto.
NOTE
It is recommended that you set the Attenuation to Auto in most situations so that the
level of the input attenuator can be set automatically according to your input signal level.

–

–

To set the input attenuation manually up to 55 dB to optimize S/N, complete the following
steps:
a.

Select Attenuation > Manual.

b.

Press the Attenuation Value soft key to set the level.

c.

Enter a value between 0 and 55 in fives by using the numeric keys.

d.

Press the dB soft key or the ENTER hard key.

To couple the input attenuator’s level with your reference level setting, select Attenuation >
Couple.
As you increse the reference setting, the attenuation level also increases acoordingly.

Optional. To change the scale unit:

1. Select More (1/2) > Units.
2. Select the unit of the display scale: dBm, dBV, dBmV, dBµV, V, or W.
The scale unit on the screen changes accordingly.
NOTE
This Units menu is available in the Spectrum and RF Analysis modes.

Scale per division
You can use the Scale/Div feature available for the spectrum and RF analysis. It represents the value
of one division on the horizontal scale. The default setting is 10 dB per division and the maximum
value can be set up to 20 dB.
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Procedure
To set the scale per division:

1. Press the AMP/SCALE hard key.
2. Select More (1/2) > Scale/Div.
3. Enter a value between 1 and 20 by using the numeric keys.
4. Press the dB soft key to complete the entry.
Pre-amplifier
You can turn the internal pre-amplifier on to correct and compensate for the gain of the preamp so that
amplitude readings show the value at the input connector.
Procedure

1. Press the AMP/SCALE hard key.
2. Toggle the Preamp soft key and select On or Off as needed.
NOTE
You can turn the Preamp on when the input attenuation range is from 0 dB to 10 dB. If
the attenuation value is manually set to greater than 10 dB, the instrument will
automatically turn off the pre-amplifier to display low-level signal properly on the chart.

External offset
You can turn the External Offset on and manually set the external offset value. An offset consists of a
cable loss and a user offset and the measurement result shows the value reflecting both offset values.
When the external offset value is set at 40 dB in the Spectrum mode, the measurement result
compensates 40 dB at both the Spectrum Analyzer and Signal Analyzer modes
Procedure
To set the external offset:

1. Press the AMP/SCALE hard key.
2. Toggle the External Offset soft key and select On.
3. Enter a value by using the numeric keys.
4. Press the dB soft key to complete the entry.
To turn the external offset off:

1. Press the AMP/SCALE hard key.
2. Toggle the External Offset soft key and select Off.

Setting average
You can set the number of measurements to be averaged for the trace presentation. A maximum of
100 times of averaging can be set. When the averaging reaches to your setting, a new measurement
value replaces the measurement value in sequence from the earliest.
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Procedure

1. Press the BW/AVG hard key.
2. Press the Average soft key.
3. Enter a value between 1 and 100 as needed by using the numeric keys.
4. Press the Enter soft key.

Setting sweep mode
The default settings of the sweep mode are Continue and Normal to sweep continuously at a normal
speed for most on-going measurements. If you want to hold the measurement or get a single sweep,
you can change the sweep mode.
Procedure
To select the single sweep mode:

1. Press the SWEEP hot key.
2. Toggle the Sweep Mode soft key and select Single. You can also use the HOLD hot key.
The letter HOLD in red appears and the sweeping is paused.

3. Optional. Press the Sweep Once soft key to get a new measurement.
To return to the continuous sweep mode:

1. Toggle the Sweep Mode soft key and select Continue. You can also use the HOLD hot key.
The letter HOLD in red disappears and the sweeping resumes.

Setting trigger source
You can set the trigger source option for your measurements.
Procedure

1. Press the TRIGGER hot key.
2. Select the trigger source option from the following choices: Internal, External, or GPS.

Setting external clock
To enhance the reliability of modulation analysis measurements the JD780A series must be
synchronized with a base station. When an external clock is not supplied, the instrument works with its
built-in internal high-accuracy time base and some measurement results may exhibit inaccurate values.
Therefore, it is highly recommended that you use the same reference clock as the signal source. You
can use the TRIGGER hot key to set the external clock.
Figure 107 Connection ports for external reference clock
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Procedure

1. Connect an external reference or a GPS antenna to the JD780A series.
2. Press the SYSTEM hot key.
3. Press the Freq Reference soft key, and then select the reference option: Internal, External 10
MHz, External 13 MHz, External 15 MHz, or GPS.

Table 15

External reference indicators

Type

Indicator

Description

Internal

(green)

The green INT icon indicates that the instrument uses the built-in
internal time base.

External

(green)

The green EXT icon indicates that an external reference is connected
and locked and that the instrument uses the same reference clock as
the signal source.

External

(red)

The red EXT icon indicates that an external reference is connect but not
locked.

GPS

(green)

The green GPS antenna icon indicates that a GPS antenna is
connected and locked.

GPS

(yellow)

The yellow GPS antenna icon indicates that a GPS antenna is
connected and locking is in progress.

GPS

(grey)

The grey GPS antenna icon indicates that a GPS antenna is not
connected, failed, or unable to be locked.

Conducting spectrum measurements
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 242, you
can continue your measurement.
Procedure

1. Press the MEASURE SETUP hot key.
2. To set the nominal channel bandwidth to be measured, complete the following steps:
a.

Press the Bandwidth soft key.

b.

Select the bandwidth option: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, or 20 MHz.

3. To select the subframe number to be measured, complete the following steps:
a.

Press the Subframe No soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Press the Enter soft key.

4. Toggle the Cell ID soft key and select Auto or Manual as desired:
–

Auto: to let the instrument detect the Cell ID for the LTE signal automatically.

–

Manual: to set a specific Cell ID for the LTE signal manually in order to speed up the
synchronization with a BTS.

Your measurement result is displayed on the screen as like the following example, Figure 108.
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Figure 108 Spectrum measurement screen with LTE - TDD signal analyzer

Setting trace
You can display up to six traces on the measurement chart simultaneously.
Procedure

1. Press the TRACE/DISPLAY hard key.
2. Press the Select Trace soft key, and then select the trace number: T1, T2, T3, T4, T5, or T6.
The legend shape of the selected trace changes from square to round to indicate that the trace is
the active one now.

3. Toggle the Trace View soft key and select On.
4. To clear, write or capture, or hide the trace(s), do one of the following:
To

Select

Trace Legend

Clear current data and display with new
measurements

Clear Write

W

Display the input signal’s maximum response only

Max Hold

M

Display the input signal’s minimum response only

Min Hold

m

Capture the selected trace and compare traces

Capture

C

Load a saved trace

More (1/2) > Load

L

Hide the selected trace

Trace View > Off

F

Remove all the traces and initialize the trace settings

More (1/2) >
Trace Clear All

5. Optional. Press the More (1/2) > Trace Info soft key, and then select the trace number to view
the trace’s parameter setting information stored at the time of the measurement or None to hide
the information display.

6. Optional. If you have the two traces T1 and T2, you can perform trace math. To view the power
difference between the traces, press the T1 – T2 -> T5 or T2 – T1 -> T6 soft key.
The result is overlaid on the screen along with the second Y-axis.
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Conducting RF measurements
Channel power
The Channel Power measurement is a common test used in the wireless industry to measure the total
transmitted power of a radio within a defined frequency channel. It acquires a number of points
representing the input signal in the time domain, transforms this information into the frequency domain
using Fast Fourier Transform (FFT), and then calculates the channel power. The effective resolution
bandwidth of the frequency domain trace is proportional to the number of points acquired for the FFT.
The channel power measurement identifies the total RF power and power spectral density (PSD) of
the signal in the LTE channel bandwidth.
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 242, you
can continue your measurement.
Procedure

1. Press the MEASURE SETUP hot key.
2. To set the nominal channel bandwidth to be measured, complete the following steps:
a.

Press the Bandwidth soft key.

b.

Select the bandwidth option: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, or 20 MHz.

3. To select the subframe number to be measured, complete the following steps:
a.

Press the Subframe No soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Press the Enter soft key.

4. Toggle the Cell ID soft key and select Auto or Manual as desired:
–

Auto: to let the instrument detect the Cell ID for the LTE signal automatically.

–

Manual: to set a specific Cell ID for the LTE signal manually in order to speed up the
synchronization with a BTS.
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Measurement example
Figure 109 Channel power measurement with LTE - TDD signal analyzer

NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 257 for more
information.

Occupied bandwidth
The Occupied Bandwidth measures the spectrum shape of the carrier. It is defined as the bandwidth,
which includes 99% of the transmitted power among total transmitted power.
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 242, you
can continue your measurement.
Procedure

1. Press the MEASURE SETUP hot key.
2. To set the nominal channel bandwidth to be measured, complete the following steps:
a.

Press the Bandwidth soft key.

b.

Select the bandwidth option: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, or 20 MHz.

3. To select the subframe number to be measured, complete the following steps:
a.

Press the Subframe No soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Press the Enter soft key.

4. Toggle the Cell ID soft key and select Auto or Manual as desired:
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–

Auto: to let the instrument detect the Cell ID for the LTE signal automatically.

–

Manual: to set a specific Cell ID for the LTE signal manually in order to speed up the
synchronization with a BTS.
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Measurement example
Figure 110 Occupied bandwidth measurement with LTE - TDD signal analyzer

NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 257 for more
information.

Spectrum emission mask (SEM)
The Spectrum Emission Mask (SEM) measurement required by 3GPP specifications encompasses
different power limits and different measurement bandwidths (resolution bandwidths) at various
frequency offsets. It may be expressed as a ratio of power spectral densities between the carrier and
the specified offset frequency band. It provides useful figures-of-merit for the spectral re-growth and
emissions produced by components and circuit blocks, without the rigor of performing a full SEM
measurement.
The SEM measures spurious signal levels in up to five pairs of offset or region frequencies and relates
them to the carrier power.
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 242, you
can continue your measurement.
Procedure

1. Press the MEASURE SETUP hot key.
2. To set the nominal channel bandwidth to be measured, complete the following steps:
a.

Press the Bandwidth soft key.

b.

Select the bandwidth option: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, or 20 MHz.

3. To select the mask type, complete the following steps:
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a.

Press the Mask Type soft key.

b.

Select the mask type option, from the following choices:

–

Wide Area BS Category A

–

Wide Area BS Category B

–

Local Area BS

–

Home BS

4. To select the subframe number to be measured, complete the following steps:
a.

Press the Subframe No soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Press the Enter soft key.

5. Toggle the Cell ID soft key and select Auto or Manual as desired:
–

Auto: to let the instrument detect the Cell ID for the LTE signal automatically.

–

Manual: to set a specific Cell ID for the LTE signal manually in order to speed up the
synchronization with a BTS.

Measurement example
Figure 111 SEM measurement with LTE - TDD signal analyzer

NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 257 for more
information.

ACLR
The Adjacent Channel Leakage power Ratio (ACLR) measures the amount of interference or power in
an adjacent frequency channel according to the standards.
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 242, you
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can continue your measurement.
Procedure

1. Press the MEASURE SETUP hot key.
2. To set the nominal channel bandwidth to be measured, complete the following steps:
a.

Press the Bandwidth soft key.

b.

Select the bandwidth option: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, or 20 MHz.

3. To select the subframe number to be measured, complete the following steps:
a.

Press the Subframe No soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Press the Enter soft key.

4. Toggle the Cell ID soft key and select Auto or Manual as desired:
–

Auto: to let the instrument detect the Cell ID for the LTE signal automatically.

–

Manual: to set a specific Cell ID for the LTE signal manually in order to speed up the
synchronization with a BTS.

Measurement example
Figure 112 ACLR measurement with LTE - TDD signal analyzer

NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 257 for more
information.

Multi-ACLR
The Multi-ACLR measurement is used to perform multi-channel ACLR measurements with as many
channels as possible. It helps you to measure ACLR in multi-channel transmitting Base Station
environment.
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Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 242, you
can continue your measurement.
Procedure

1. Press the MEASURE SETUP hot key.
2. To set the nominal channel bandwidth to be measured, complete the following steps:
a.

Press the Bandwidth soft key.

b.

Select the bandwidth option: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, or 20 MHz.

3. To set the frequency, do one of the following:
–

–

To set the center frequency, complete the following steps:
a.

Toggle the Unit soft key and select Freq.

b.

Press the Lowest Frequency soft key to set the starting center frequency.

c.

Enter a value by using the numeric keys. You can also use the rotary knob.

d.

Select the unit: GHz, MHz, kHz, or Hz.

e.

Press the Highest Frequency soft key to set the stopping center frequency.

f.

Enter a value by using the numeric keys. You can also use the rotary knob.

g.

Select the unit: GHz, MHz, kHz, or Hz.

To set the channel number, complete the following steps:
a.

Toggle the Unit soft key and select Channel.

NOTE
Selecting Channel sets the standard channel to Band Global automatically so that you
can set the Channel Number without choosing a standard channel band from the list.

254

b.

Press the Lowest Channel soft key to set the starting channel.

c.

Enter a value by using the numeric keys. You can also use the rotary knob.

d.

Press the Enter soft key.

e.

Press the Highest Channel soft key to set the stopping channel.

f.

Enter a value by using the numeric keys. You can also use the rotary knob.

g.

Press the Enter soft key.

Using LTE – TDD Signal Analyzer

JD780A Series Analyzers

Measurement example
Figure 113 Multi-ACLR measurement with LTE - TDD signal analyzer

NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 257 for more
information.

Spurious emissions
Out-of-band emissions are unwanted emissions immediately outside the channel bandwidth resulting
from the modulation process and non-linearity in the transmitter but excluding spurious emissions. The
Spurious Emissions measurement is to identify and determine the power level of out-of-band spurious
emission within the necessary channel bandwidth and modulated signal measured at the RF port of
the Base Station.
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 242, you
can continue your measurement.
Procedure

1. Press the MEASURE SETUP hot key.
2. To set up the range table and frequency range, press the Range Table soft key and then
complete the following steps:
a.

Press the Range soft key, and then enter the range number to add a new range or change
an existing one.

b.

Press the Enter soft key.

c.

Press the Start Frequency soft key to set up the frequency range.

d.

Enter a value by using the numeric keys. You can also use the rotary knob.

e.

Select the unit: GHz, MHz, kHz, or Hz.

f.

Press the Stop Frequency soft key to set up the frequency range.
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g.

Enter a value by using the numeric keys. You can also use the rotary knob.

h.

Select the unit: GHz, MHz, kHz, or Hz.

3. Toggle the Range soft key between On and Off to display or hide the selected range.
4. To set up the test limits for Pass/Fail indication, complete the following steps:
a.

Press the Start Limit soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Select the dBm soft key.

d.

Press the Stop Limit soft key.

e.

Enter a value by using the numeric keys. You can also use the rotary knob.

f.

Select the dBm soft key.

5. To set up the other parameters, complete the following steps:
a.

Select More (1/2) > Attenuation to set up the attenuation value.

b.

Enter a value in the multiple of five.

c.

Press the dB soft key or the ENTER hard key.

d.

Press the RBW soft key.

e.

Enter a value by using the numeric keys.

f.

Select the unit: GHz, MHz, kHz, or Hz.

g.

Press the VBW soft key.

h.

Enter a value by using the numeric keys.

i.

Select the unit: GHz, MHz, kHz, or Hz.

6. Press the PREV hard key.
7. Toggle the Measure Type soft key between Examine and Full to select the measurement type.
NOTE
The Examine mode displays only the selected range while the Full mode lets the
instrument automatically changes the selected range from one another.

8. Set the number of measurements to be averaged:
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a.

Press the Average soft key.

b.

Enter a value between 1 and 100.

c.

Press the Enter soft key.
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Measurement example
Figure 114 Spurious emissions measurement with LTE - TDD signal analyzer

NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 257 for more
information.

Setting limit for RF tests
By default, test limits specified in the standard are set for you. You can change thresholds if you desire.
Procedure

1. Press the LIMIT hot key.
2. Press the RF Test Limits soft key.
3. Select the test item(s) and set the limit(s) depending on your selected measurement mode:
To set the limit for

Select

Set

Channel power

Channel Power

High Limit
Low Limit

Occupied bandwidth

Occupied BW

High Limit

Spectrum emission mask

Spectrum Emission Mask

(On/Off only)

ACLR

ACLR

(On/Off only)

Multi-ACLR

Multi-ACLR

(On/Off only)

Spurious emissions

Spurious Emissions

(On/Off only)

4. Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit.
Toggle the Beep soft key between On and Off to enable or disable the beep sound.

5. Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings.
See “Using save” on page 31 for more information.
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Conducting power vs. time measurements
The Power vs. Time measurement measures the modulation envelope in the time domain, showing the
signal rise and fall shape of LTE signal and the power of each time slot in an LTE signal.

Power vs. time (slot)
The Power vs. Time (Slot) in LTE - TDD Signal Analyzer measures the modulation envelope in the
time domain, showing the signal rise and fall shape of LTE signal.
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 242, you
can continue your measurement. The measurement settings can be saved and recalled as a file.
Procedure

1. Press the MEASURE SETUP hot key.
2. To set the nominal channel bandwidth to be measured, complete the following steps:
a.

Press the Bandwidth soft key.

b.

Select the bandwidth option: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, or 20 MHz.

3. To select the slot number to be measured, complete the following steps:
a.

Press the Slot No soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Press the Enter soft key.

4. Toggle the Cell ID soft key and select Auto or Manual as desired:
–

Auto: to let the instrument detect the Cell ID for the LTE signal automatically.

–

Manual: to set a specific Cell ID for the LTE signal manually in order to speed up the
synchronization with a BTS.

5. Optional. Press the Miscellaneous soft key, and then do the following(s) as needed:
–

To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4.
This MIMO (Multiple Input Multiple Output) setting is activated only if the option 031 LTEAdvanced TDD is installed with a license number. If not, the instrument sets this option to
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO
channels.

–

To assign a antenna port number automatically or manually, press the Antenna Port soft
key and select the option: Auto, 0, 1, 2, and 3. If the option 031 LTE-Advanced TDD is not
installed or if the MIMO is set to 2x2, the antenna ports 2 and 3 are disabled.

–

To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or
Extended. See “Appendix E – Cyclic prefix table” on page 545 for OFDM parameter details
by different bandwidth.

–

To set the delay, complete the following steps:
a.

Press the Delay soft key to set the amount of delay in µs.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Press the µs soft key.

NOTE
The Delay setting is used only when there is a time offset in the signals to be measured.
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Setting limit for power vs. time tests
Procedure

1. Press the LIMIT hot key.
2. Press the PvsT Test Limits soft key.
3. Select the test item(s) and set the limit(s):
To set the limit for

Select

Set

Slot average power

Slot Avg Power

High Limit,
Low Limit

Off power

Off Power

High Limit

Transition period

Transition Period

High Limit

4. Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit.
Toggle the Beep soft key between On and Off to enable or disable the beep sound.

5. Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings.
See “Using save” on page 31 for more information.

Measurement example
Figure 115 Power vs. time (slot) measurement with LTE – TDD signal analyzer
1)

Off to on
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2)

On to off

Power vs. time (frame)
The Power vs. Time (Frame) measures the modulation envelope in the time domain, showing the
power of each time slot in an LTE signal.
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 242, you
can continue your measurement. The measurement settings can be saved and recalled as a file.
Procedure

1. Press the MEASURE SETUP hot key.
2. To set the nominal channel bandwidth to be measured, complete the following steps:
a.

Press the Bandwidth soft key.

b.

Select the bandwidth option: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, or 20 MHz.

3. To select the subframe number to be measured, complete the following steps:
a.

Press the Subframe No soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Press the Enter soft key.

4. Toggle the Cell ID soft key and select Auto or Manual as desired:
–

Auto: to let the instrument detect the Cell ID for the LTE signal automatically.

–

Manual: to set a specific Cell ID for the LTE signal manually in order to speed up the
synchronization with a BTS.

5. Optional. Press the Miscellaneous soft key, and then do the following(s) as needed:
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–

To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4.
This MIMO (Multiple Input Multiple Output) setting is activated only if the option 031 LTEAdvanced TDD is installed with a license number. If not, the instrument sets this option to
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO
channels.

–

To assign a antenna port number automatically or manually, press the Antenna Port soft
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key and select the option: Auto, 0, 1, 2, and 3. If the option 031 LTE-Advanced TDD is not
installed or if the MIMO is set to 2x2, the antenna ports 2 and 3 are disabled.

–

To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or
Extended. See “Appendix E – Cyclic prefix table” on page 545 for OFDM parameter details
by different bandwidth.

–

To set the delay, complete the following steps:
a.

Press the Delay soft key to set the amount of delay in µs.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Press the µs soft key.

NOTE
The Delay setting is used only when there is a time offset in the signals to be measured.

Measurement example
Figure 116 Power vs. time (frame) measurement with LTE – TDD signal analyzer

Conducting modulation measurements
Constellation
The Constellation is used to observe some aspects of modulation accuracy and can reveal certain
fault mechanisms such as I/Q amplitude imbalance or quadrature imbalance. It displays constellation
diagram by modulation types.
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 242, you
can continue your measurement. The measurement settings can be saved and recalled as a file. You
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load
the file on to the instrument.
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Procedure

1. Press the MEASURE SETUP hot key.
2. To set the nominal channel bandwidth to be measured, complete the following steps:
a.

Press the Bandwidth soft key.

b.

Select the bandwidth option: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, or 20 MHz.

3. To select the subframe number to be measured, complete the following steps:
a.

Press the Subframe No soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.
NOTE
For MBMS testing, this subframe number must be neither 0 nor 5 as these subframes 0
and 5 are not available for MBMS and it must be set to the MBMS transmitted channel’s
subframe number.

c.

Press the Enter soft key.

4. Optional. Toggle the Cell ID soft key and select Auto or Manual as desired:
–

Auto: to let the instrument detect the Cell ID for the LTE signal automatically.

–

Manual: to set a specific Cell ID for the LTE signal manually in order to speed up the
synchronization with a BTS.

5. Optional. Toggle the CFI soft key and select Auto or Manual as desired:
–

Auto: to let the instrument set the number of OFDM symbols used for transmitting PDCCHs
in a subframe.

–

Manual: to set the number of OFDM symbols manually. The set of OFDM symbols that can
be used for PDCCH in a subframe is given by 0, 2, 3 or 4 in 1.4 MHz bandwidth and 1, 2, or
3 in other bandwidths.

6. Optional. Press the PHICH Ng soft key, and then select the option for the number of PHICH
groups (Ng): 1/6, 1/2, 1, 2, E-1/6, E-1/2, E-1, or E-2.

7. Press the Uplink-Downlink Configuration soft key, and then select the number of
uplink/downlink between one and six.

8. Optional. Press the Miscellaneous soft key, and then do the following(s) as needed:
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–

To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4.
This MIMO (Multiple Input Multiple Output) setting is activated only if the option 031 LTEAdvanced TDD is installed with a license number. If not, the instrument sets this option to
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO
channels.

–

To assign a antenna port number automatically or manually, press the Antenna Port soft
key and select the option: Auto, 0, 1, 2, and 3. If the option 031 LTE-Advanced TDD is not
installed or if the MIMO is set to 2x2, the antenna ports 2 and 3 are disabled.

–

To turn the Multimedia Broadcast Multicast Service (MBMS) feature on or off, toggle the
MBMS soft key and select On or Off. For proper MBMS testing, you need to set the
Subframe No with the same PMCH subframe number. If this setting is on, either PMCH or
PDSCH appears on the screen depending on the detected channel.

–

To set the Multicast Broadcast Single Frequency Network (MBSFN) detection automatically
or manually for MBMS testing, toggle the MBSFN soft key and select Auto or Manual. An
automatically detected or manually entered MBSFN ID appears on the screen.

–

To set the delay, complete the following steps:
a.

Press the Delay soft key to set the amount of delay in µs.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Press the µs soft key.
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NOTE
The Delay setting is used only when there is a time offset in the signals to be measured.

–

To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or
Extended. See “Appendix E – Cyclic prefix table” on page 545 for OFDM parameter details
by different bandwidth.

–

Press the PDSCH Modulation Type soft key, and then select the modulation type option:
Auto, QPSK, 16 QAM, 64 QAM, E-TM3.3, E-TM3.2, E-TM3.1, E-TM2, E-TM1.2, and ETM1.1. If two or more modulation types are used in a frame, select Auto. If the PDSCH
uses the same modulation type in a frame or in a subframe, select a specific modulation
type to get more accurate EVM.

–

To set the threshold for PDSCH, complete the following steps:

–

a.

Press the PDSCH Threshold soft key.

b.

Enter a value by using the numeric keys.

c.

Press the dB soft key.

Toggle the PDSCH Precoding soft key between On and Off to enable or disable the
PDSCH precoding.

Measurement example
Figure 117 Constellation measurement with LTE - TDD signal analyzer

Using LTE – TDD Signal Analyzer

263

JD780A Series Analyzers

Figure 118 Constellation measurement with LTE - TDD signal analyzer (MBMS On)

NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 277 for
more information.

Data channel
The Data Channel measures the constellation for the specified resource block as well as the
modulation accuracy of each PDSCH at the specified subframe.
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 242, you
can continue your measurement. The measurement settings can be saved and recalled as a file. You
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load
the file on to the instrument.
Procedure

1. Press the MEASURE SETUP hot key.
2. To set the nominal channel bandwidth to be measured, complete the following steps:
a.

Press the Bandwidth soft key.

b.

Select the bandwidth option: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, or 20 MHz.

3. To select the subframe number to be measured, complete the following steps:
a.

Press the Subframe No soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.
NOTE
For MBMS testing, this subframe number must be neither 0 nor 5 as these subframes 0
and 5 are not available for MBMS and it must be set to the MBMS transmitted channel’s
subframe number.

c.
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Press the Enter soft key.
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4. Optional. Toggle the Cell ID soft key and select Auto or Manual as desired:
–

Auto: to let the instrument detect the Cell ID for the LTE signal automatically.

–

Manual: to set a specific Cell ID for the LTE signal manually in order to speed up the
synchronization with a BTS.

5. Optional. Toggle the CFI soft key and select Auto or Manual as desired:
–

Auto: to let the instrument set the number of OFDM symbols used for transmitting PDCCHs
in a subframe.

–

Manual: to set the number of OFDM symbols manually. The set of OFDM symbols that can
be used for PDCCH in a subframe is given by 0, 2, 3 or 4 in 1.4 MHz bandwidth and 1, 2, or
3 in other bandwidths.

6. Optional. Press the PHICH Ng soft key, and then select the option for the number of PHICH
groups (Ng): 1/6, 1/2, 1, 2, E-1/6, E-1/2, E-1, or E-2.

7. Toggle the Event Hold soft key between On and Off to enable or disable the event hold feature.
When enabled, the display line for the PDSCH threshold appears.
When an event occurs, the measurement is put on hold until you press the HOLD hot key.
NOTE
You can view detailed current resource block on the I-Q diagram, particularly in a
dynamic field environment.

8. Press the More (1/2) > Uplink-Downlink Configuration soft key, and then select the number of
uplink/downlink between one and six.

9. Optional. Press the More (1/2) > Miscellaneous soft key, and then do the following(s) as
needed:

–

To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4.
This MIMO (Multiple Input Multiple Output) setting is activated only if the option 031 LTEAdvanced TDD is installed with a license number. If not, the instrument sets this option to
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO
channels.

–

To assign a antenna port number automatically or manually, press the Antenna Port soft
key and select the option: Auto, 0, 1, 2, and 3. If the option 031 LTE-Advanced TDD is not
installed or if the MIMO is set to 2x2, the antenna ports 2 and 3 are disabled.

–

To turn the Multimedia Broadcast Multicast Service (MBMS) feature on or off, toggle the
MBMS soft key and select On or Off. For proper MBMS testing, you need to set the
Subframe No with the same PMCH subframe number. If this setting is on, either PMCH or
PDSCH appears on the screen depending on the detected channel.

–

To set the Multicast Broadcast Single Frequency Network (MBSFN) detection automatically
or manually for MBMS testing, toggle the MBSFN soft key and select Auto or Manual. An
automatically detected or manually entered MBSFN ID appears on the screen.

–

To set the delay, complete the following steps:
a.

Press the Delay soft key to set the amount of delay in µs.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Press the µs soft key.

NOTE
The Delay setting is used only when there is a time offset in the signals to be measured.

–

To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or
Extended. See “Appendix E – Cyclic prefix table” on page 545 for OFDM parameter details
by different bandwidth.

–

Press the PDSCH Modulation Type soft key, and then select the modulation type option:
Auto, QPSK, 16 QAM, 64 QAM, E-TM3.3, E-TM3.2, E-TM3.1, E-TM2, E-TM1.2, and ETM1.1. If two or more modulation types are used in a frame, select Auto. If the PDSCH
uses the same modulation type in a frame or in a subframe, select a specific modulation
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type to get more accurate EVM.

–

–

To set the threshold for PDSCH, complete the following steps:
a.

Press the PDSCH Threshold soft key.

b.

Enter a value by using the numeric keys.

c.

Press the dB soft key.

Toggle the PDSCH Precoding soft key between On and Off to enable or disable the
PDSCH precoding.

Measurement example
Figure 119 Data channel measurement with LTE - TDD signal analyzer

Figure 120 Data channel measurement with LTE - TDD signal analyzer (MBMS On)
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NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 277 for
more information.

Using marker
You can use the MARKER hard key to place a marker on a resource block and display the IQ diagram
for the selected resource block.
Procedure

1. Press the MARKER hard key.
2. Press the RB Number soft key to select the resource block to be marked.
3. Enter the resource block number by using the numeric keys.
4. Press the Enter soft key.
The marker appears on the selected resource block.

5. Toggle the Marker View soft key between On and Off to display or dismiss the result of the
selected resource block.

Control channel
The Control Channel measures the constellation for the specified control channel as well as
modulation accuracy of the control channel at the specified subframe.
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 242, you
can continue your measurement. The measurement settings can be saved and recalled as a file. You
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load
the file on to the instrument.
Procedure

1. Press the MEASURE SETUP hot key.
2. To set the nominal channel bandwidth to be measured, complete the following steps:
a.

Press the Bandwidth soft key.

b.

Select the bandwidth option: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, or 20 MHz.

3. To select the subframe number to be measured, complete the following steps:
a.

Press the Subframe No soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.
NOTE
For MBMS testing, this subframe number must be neither 0 nor 5 as these subframes 0
and 5 are not available for MBMS and it must be set to the MBMS transmitted channel’s
subframe number.

c.

Press the Enter soft key.

4. Optional. Toggle the Cell ID soft key and select Auto or Manual as desired:
–

Auto: to let the instrument detect the Cell ID for the LTE signal automatically.
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–

Manual: to set a specific Cell ID for the LTE signal manually in order to speed up the
synchronization with a BTS.

5. Optional. Toggle the CFI soft key and select Auto or Manual as desired:
–

Auto: to let the instrument set the number of OFDM symbols used for transmitting PDCCHs
in a subframe.

–

Manual: to set the number of OFDM symbols manually. The set of OFDM symbols that can
be used for PDCCH in a subframe is given by 0, 2, 3 or 4 in 1.4 MHz bandwidth and 1, 2, or
3 in other bandwidths.

6. Optional. Press the PHICH Ng soft key, and then select the option for the number of PHICH
groups (Ng): 1/6, 1/2, 1, 2, E-1/6, E-1/2, E-1, or E-2.

7. Toggle the EVM Detection Mode soft key and select Single or Combine as desired:
–

Single: Testing on one single antenna connected to your JD780A series with a cable.

–

Combine: Testing on multiple antennas connected to your JD780A series with a 2x1 or 4x1
combiner or an antenna.

8. Press the Uplink-Downlink Configuration soft key, and then select the number of
uplink/downlink between one and six.

9. Optional. Press the Miscellaneous soft key, and then do the following(s) as needed:
–

To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4.
This MIMO (Multiple Input Multiple Output) setting is activated only if the option 031 LTEAdvanced TDD is installed with a license number. If not, the instrument sets this option to
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO
channels.

–

To assign a antenna port number automatically or manually, press the Antenna Port soft
key and select the option: Auto, 0, 1, 2, and 3. If the option 031 LTE-Advanced TDD is not
installed or if the MIMO is set to 2x2, the antenna ports 2 and 3 are disabled.

–

To turn the Multimedia Broadcast Multicast Service (MBMS) feature on or off, toggle the
MBMS soft key and select On or Off. For proper MBMS testing, you need to set the
Subframe No with the same PMCH subframe number. If this setting is on, the
measurement item “MBSFN RS” appears in the result table.

–

To set the Multicast Broadcast Single Frequency Network (MBSFN) detection automatically
or manually for MBMS testing, toggle the MBSFN soft key and select Auto or Manual. An
automatically detected or manually entered MBSFN ID appears on the screen.

–

To set the delay, complete the following steps:
a.

Press the Delay soft key to set the amount of delay in µs.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Press the µs soft key.

NOTE
The Delay setting is used only when there is a time offset in the signals to be measured.

–

To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or
Extended. See “Appendix E – Cyclic prefix table” on page 545 for OFDM parameter details
by different bandwidth.

–

To set the threshold for PDCCH, complete the following steps:

–
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a.

Press the PDCCH Threshold soft key.

b.

Enter a value by using the numeric keys.

c.

Press the dB soft key.

Toggle the PDCCH Mode soft key and select REG to calculate EVM based on Resource
Element Group or Avg to calculate EVM after adding up all the PDCCH signals from one
subframe.
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Measurement example
Figure 121 Control channel measurement with LTE - TDD signal analyzer

Figure 122 Control channel measurement with LTE - TDD signal analyzer (MBMS On)

NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 277 for
more information.

Using marker
You can use the MARKER hard key to place a marker on a resource block and display the IQ diagram
for the selected resource block.
Procedure

1. Press the MARKER hard key.
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2. Press the Channel soft key to select the channel to be displayed in the IQ diagram.
The channel P-SS is selected by default.

3. Turn the rotary knob to move the highlight from one to another in the channel summary table.
4. Toggle the Marker View soft key between On and Off to display or dismiss the result of the
selected channel.

Subframe
The Subframe measures the modulation accuracy of all the data and control channels at the specified
subframe (1 ms).
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 242, you
can continue your measurement. The measurement settings can be saved and recalled as a file. You
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load
the file on to the instrument.
Procedure

1. Press the MEASURE SETUP hot key.
2. To set the nominal channel bandwidth to be measured, complete the following steps:
a.

Press the Bandwidth soft key.

b.

Select the bandwidth option: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, or 20 MHz.

3. To select the subframe number to be measured, complete the following steps:
a.

Press the Subframe No soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.
NOTE
For MBMS testing, this subframe number must be neither 0 nor 5 as these subframes 0
and 5 are not available for MBMS and it must be set to the MBMS transmitted channel’s
subframe number.

c.

Press the Enter soft key.

4. Optional. Toggle the Cell ID soft key and select Auto or Manual as desired:
–

Auto: to let the instrument detect the Cell ID for the LTE signal automatically.

–

Manual: to set a specific Cell ID for the LTE signal manually in order to speed up the
synchronization with a BTS.

5. Optional. Toggle the CFI soft key and select Auto or Manual as desired:
–

Auto: to let the instrument set the number of OFDM symbols used for transmitting PDCCHs
in a subframe.

–

Manual: to set the number of OFDM symbols manually. The set of OFDM symbols that can
be used for PDCCH in a subframe is given by 0, 2, 3 or 4 in 1.4 MHz bandwidth and 1, 2, or
3 in other bandwidths.

6. Optional. Press the PHICH Ng soft key, and then select the option for the number of PHICH
groups (Ng): 1/6, 1/2, 1, 2, E-1/6, E-1/2, E-1, or E-2.

7. Toggle the EVM Detection Mode soft key and select Single or Combine as desired:
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–

Single: Testing on one single antenna connected to your JD780A series with a cable.

–

Combine: Testing on multiple antennas connected to your JD780A series with a 2x1 or 4x1
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combiner or an antenna.

8. Press the Uplink-Downlink Configuration soft key, and then select the number of
uplink/downlink between one and six.

9. Optional. Press the Miscellaneous soft key, and then do the following(s) as needed:
–

To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4.
This MIMO (Multiple Input Multiple Output) setting is activated only if the option 031 LTEAdvanced TDD is installed with a license number. If not, the instrument sets this option to
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO
channels.

–

To assign a antenna port number automatically or manually, press the Antenna Port soft
key and select the option: Auto, 0, 1, 2, and 3. If the option 031 LTE-Advanced TDD is not
installed or if the MIMO is set to 2x2, the antenna ports 2 and 3 are disabled.

–

To turn the Multimedia Broadcast Multicast Service (MBMS) feature on or off, toggle the
MBMS soft key and select On or Off. For proper MBMS testing, you need to set the
Subframe No with the same PMCH subframe number. If this setting is on, the
measurement item “MBSFN RS” appears in the result table and either PMCH or PDSCH
appears as well depending on the detected channel.

–

To set the Multicast Broadcast Single Frequency Network (MBSFN) detection automatically
or manually for MBMS testing, toggle the MBSFN soft key and select Auto or Manual. An
automatically detected or manually entered MBSFN ID appears on the screen.

–

To set the delay, complete the following steps:
a.

Press the Delay soft key to set the amount of delay in µs.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Press the µs soft key.

NOTE
The Delay setting is used only when there is a time offset in the signals to be measured.

–

To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or
Extended. See “Appendix E – Cyclic prefix table” on page 545 for OFDM parameter details
by different bandwidth.

–

Press the PDSCH Modulation Type soft key, and then select the modulation type option:
Auto, QPSK, 16 QAM, 64 QAM, E-TM3.3, E-TM3.2, E-TM3.1, E-TM2, E-TM1.2, and ETM1.1. If two or more modulation types are used in a frame, select Auto. If the PDSCH
uses the same modulation type in a frame or in a subframe, select a specific modulation
type to get more accurate EVM.

–

To set the threshold for PDSCH, complete the following steps:

–

a.

Press the PDSCH Threshold soft key.

b.

Enter a value by using the numeric keys.

c.

Press the dB soft key.

To set the threshold for PDCCH, complete the following steps:
a.

Press the PDCCH Threshold soft key.

b.

Enter a value by using the numeric keys.

c.

Press the dB soft key.

–

Toggle the PDCCH Mode soft key and select REG to calculate EVM based on Resource
Element Group or Avg to calculate EVM after adding up all the PDCCH signals from one
subframe.

–

Toggle the PDSCH Precoding soft key between On and Off to enable or disable the
PDSCH precoding.
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Measurement example
Figure 123 Subframe measurement with LTE - TDD signal analyzer
1) Regular view

2) Chart view
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Figure 124 Subframe measurement with LTE - TDD signal analyzer (MBMS On)

NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 277 for
more information.

Setting display
You can use the TRACE/DISPLAY hard key to view your measurement result with the chart.
Procedure

1. Press the TRACE/DISPLAY hard key.
2. Toggle the Chart soft key between On and Off to display or dismiss the chart. If this setting is on,
the MARKER hard key is activated.

Using marker
If you turn the Chart view on, you can use the MARKER hard key to place the marker at a specific
symbol.
Procedure

1. Press the MARKER hard key.
2. Toggle the Marker View soft key between On and Off to display or dismiss the marker on the
chart.

3. Press the Symbol soft key to select the symbol number, to which the marker is placed.
4. Enter a value by using the numeric keys.
5. Press the Enter soft key.

Time alignment error
In eNode B supporting Tx Diversity transmission, signals are transmitted from two or more antennas.
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These signals shall be aligned. The time alignment error in Tx diversity is specified as the delay
between the signals from two antennas at the antenna ports.
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 242, you
can continue your measurement. The measurement settings can be saved and recalled as a file. You
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load
the file on to the instrument.
Procedure

1. Press the MEASURE SETUP hot key.
2. To set the nominal channel bandwidth to be measured, complete the following steps:
a.

Press the Bandwidth soft key.

b.

Select the bandwidth option: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, or 20 MHz.

3. Optional. Toggle the Cell ID soft key and select Auto or Manual as desired:
–

Auto: to let the instrument detect the Cell ID for the LTE signal automatically.

–

Manual: to set a specific Cell ID for the LTE signal manually in order to speed up the
synchronization with a BTS.

4. Optional. Press the Miscellaneous soft key, and then do the following(s) as needed:
–

To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4.
This MIMO (Multiple Input Multiple Output) setting is activated only if the option 031 LTEAdvanced TDD is installed with a license number. If not, the instrument sets this option to
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO
channels.

–

To assign a antenna port number automatically or manually, press the Antenna Port soft
key and select the option: Auto, 0, 1, 2, and 3. If the option 031 LTE-Advanced TDD is not
installed or if the MIMO is set to 2x2, the antenna ports 2 and 3 are disabled.

–

To set the delay, complete the following steps:
a.

Press the Delay soft key to set the amount of delay in µs.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Press the µs soft key.

NOTE
The Delay setting is used only when there is a time offset in the signals to be measured.

–
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To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or
Extended. See “Appendix E – Cyclic prefix table” on page 545 for OFDM parameter details
by different bandwidth.
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Measurement example
Figure 125 Time alignment error measurement with LTE - TDD signal analyzer

NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 277 for
more information.

Data allocation map
The Data Allocation Map function represents data allocation as a mapping.
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 242, you
can continue your measurement. The measurement settings can be saved and recalled as a file. You
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load
the file on to the instrument.
Procedure

1. Press the MEASURE SETUP hot key.
2. To set the nominal channel bandwidth to be measured, complete the following steps:
a.

Press the Bandwidth soft key.

b.

Select the bandwidth option: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, or 20 MHz.

3. To select the subframe number to be measured, complete the following steps:
a.

Press the Subframe No soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.
NOTE
For MBMS testing, this subframe number must be neither 0 nor 5 as these subframes 0
and 5 are not available for MBMS and it must be set to the MBMS transmitted channel’s
subframe number.

c.

Press the Enter soft key.
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4. To set the threshold for PDSCH, complete the following steps:
a.

Press the PDSCH Threshold soft key.

b.

Enter a value by using the numeric keys.

c.

Press the dB soft key.

5. Optional. Toggle the Cell ID soft key and select Auto or Manual as desired:
–

Auto: to let the instrument detect the Cell ID for the LTE signal automatically.

–

Manual: to set a specific Cell ID for the LTE signal manually in order to speed up the
synchronization with a BTS.

6. Optional. Press the Miscellaneous soft key, and then do the following(s) as needed:
–

To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4.
This MIMO (Multiple Input Multiple Output) setting is activated only if the option 031 LTEAdvanced TDD is installed with a license number. If not, the instrument sets this option to
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO
channels.

–

To assign a antenna port number automatically or manually, press the Antenna Port soft
key and select the option: Auto, 0, 1, 2, and 3. If the option 031 LTE-Advanced TDD is not
installed or if the MIMO is set to 2x2, the antenna ports 2 and 3 are disabled.

–

To turn the Multimedia Broadcast Multicast Service (MBMS) feature on or off, toggle the
MBMS soft key and select On or Off. For proper MBMS testing, you need to set the
Subframe No with the same PMCH subframe number. If this setting is on, either PMCH or
PDSCH appears on the screen depending on the detected channel.

–

To set the Multicast Broadcast Single Frequency Network (MBSFN) detection automatically
or manually for MBMS testing, toggle the MBSFN soft key and select Auto or Manual. An
automatically detected or manually entered MBSFN ID appears on the screen.

–

To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or
Extended. See “Appendix E – Cyclic prefix table” on page 545 for OFDM parameter details
by different bandwidth.

Measurement example
Figure 126 Data allocation map measurement with LTE - TDD signal analyzer
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Figure 127 Data allocation map measurement with LTE - TDD signal analyzer (MBMS On)

NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 277 for
more information.

Using marker
You can use the MARKER hard key to place the marker at a specific resource block and subframe.
Procedure

1. Press the MARKER hard key.
2. Toggle the Marker View soft key between On and Off to display or dismiss the marker on the
chart.

3. To select the resource block number, complete the following steps:
a.

Press the RB Number soft key.

b.

Enter the resource block number to select by using the numeric keys. You can also use the
rotary knob to move the marker side by side.

c.

Press the Enter soft key.

4. To select the subframe block number, complete the following steps:
a.

Press the Subframe No soft key.

b.

Enter the subframe number to select by using the numeric keys. You can also use the
rotary knob to move the marker up and down.

c.

Press the Enter soft key.

Setting limit for modulation tests
Procedure

1. Press the LIMIT hot key.
2. Press the Modulation Test Limits soft key to set the limits.
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3. Select the test item(s) and set the limit(s) depending on your selected measurement mode:
To set the limit for

Select

Set

Frequency error

Frequency Error

High Limit
Low Limit

PDSCH error vector
magnitude if MBMS is off

EVM > PDSCH EVM

High Limit (QPSK)
High Limit (16 QAM)
High Limit (64 QAM)

PMCH error vector magnitude
if MBMS is on and a PMCH is
detected

EVM > PMCH EVM

High Limit (QPSK)
High Limit (16 QAM)
High Limit (64 QAM)

RMS for data error vector
magnitude

EVM > Data EVM RMS

High Limit

Peak for data error vector
magnitude

EVM> Data EVM Peak

High Limit

RS error vector magnitude

EVM > RS EVM

High Limit

P-SS error vector magnitude

EVM > P-SS EVM

High Limit

S-SS error vector magnitude

EVM > S-SS EVM

High Limit

Downlink RS power

Power > DL RS Power

High Limit
Low Limit

P-SS power

Power > P-SS Power

High Limit
Low Limit

S-SS power

Power > S-SS Power

High Limit
Low Limit

PBCH power

Power > PBCH Power

High Limit
Low Limit

Subframe power

Power > Subframe Power

High Limit
Low Limit

OFDM symbol power

Power > OFDM Symbol Power

High Limit
Low Limit

Time alignment error for
MIMO

Time Alignment Error > MIMO

High Limit

Time alignment error for
aggregation of component
carriers (intra-band
contiguous, intra-band noncontiguous, and inter-band)

Time Alignment Error > Carrier
Aggregation

Intra Cont
Intra Non-cont
Inter Band

Time error

Time Error

High Limit
Low Limit

I-Q origin offset

IQ Origin Offset

High Limit

4. Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit.
Toggle the Beep soft key between On and Off to enable or disable the beep sound.

5. Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings.
See “Using save” on page 31 for more information.
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Performing auto measurements
Conformance test
The Conformance Test is to test if eNode-B meets some specified standards that have been
developed for verification. Its test procedure and test setups have been developed by 3GPP. Test
results can be saved as a .csv file type.
Setting limit for conformance test
You can set test limits for test item(s) in the auto measurement. Turning the test limit on for a test item
makes the test item included in the conformance test.
Procedure

1. Press the LIMIT hot key.
2. To set the limit for BTS output power, complete the following steps:
a.

Press the BTS Output Power soft key.

b.

Toggle the Test Limits soft key between On and Off to enable or disable the limit.

c.

Press the High Limit soft key.

d.

Enter a value for the upper limit.

e.

Press the dBm unit soft key.

f.

Press the Low Limit soft key.

g.

Enter a value for the lower limit.

h.

Press the dBm unit soft key.

3. To set the limit for total power dynamic, complete the following steps:
a.

Press the Total Power Dynamic soft key.

b.

Toggle the Test Limits soft key between On and Off to enable or disable the limit.

c.

Press the Low Limit soft key.

d.

Enter a value for the lower limit.

e.

Press the dBm unit soft key.

4. To set the limit for on/off power, press the On/Off Power soft key, and then do the following as
needed:
To set the limit for

Select

Set

Off power

Off Power

High Limit

Transition period

Transition Period

High Limit

5. To verify signal quality, press the Signal Quality soft key, and then do the following as needed:
To set the limit for

Select

Set

Frequency error

Frequency Error

High Limit
Low Limit

Error vector magnitude

EVM

High Limit (QPSK)
High Limit (16 QAM)
High Limit (64 QAM)

Time alignment error

Time Alignment Error

High Limit
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RS power

RS Power

High Limit
Low Limit

6. To verify unwanted emissions, press the Unwanted Emissions soft key, and then do the
following as needed:
To set the limit for

Select

Set

Occupied bandwidth

Occupied BW

High Limit

Adjacent channel power ratio

ACLR

Spectrum emission mask

SEM

Mask Type

Spurious emissions

Spurious Emissions

Range Table

7. Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit.
Toggle the Beep soft key between On and Off to enable or disable the beep sound.

8. Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings.
See “Using save” on page 31 for more information.

Setting measure setup
After setting frequency as described in the “Configuring test parameters” on page 242, you can
continue your measurement.
Procedure

1. Press the MEASURE SETUP hot key.
2. Press the Bandwidth soft key.
3. Select the nominal channel bandwidth to be measured, from the following choices:
–

1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, and 20 MHz

4. Press the Sector soft key, and then select the sector option: Alpha, Beta, or Gamma.
5. To set external offset, complete the following steps:
a.

Toggle the External Offset soft key and select On.

b.

Enter a value by using the numeric keys.

c.

Press the dB soft key.

6. To save your settings and results, go to SAVE/LOAD > Save and then perform functions as you
desire. See “Using save” on page 31 for more information.

7. Press the Run Test soft key to start to run a test.
The Auto Measure Results window appears at the end of the test.

8. When prompted on the screen, connect the cable from the Spectrum Analyzer RF In port of the
instrument either to Antenna Port 0 or Antenna Port 1 of the eNode-B, and then change the TM
mode on the eNode-B side.

9. Press the Continue soft key to continue testing.
10. Repeat the steps 8-9 until completion of the test.
A conformance test report appears at the end of the test.

11. Optional. To stop running the test, press the Abort soft key.

Maintenance test
The Auto Measure function of the JD780A series allows a complete signal profiling covering RF
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characterization and modulation quality parameters of up to 20 different carriers, particularly useful on
an overlay architecture where base stations are transmitting in different frequencies.
Following settings are required only when you run the Auto Measure Maintenance Test on the
instrument using “Current” configuration setting. Additional settings are not required when you run Auto
Measure using a scenario generated in the PC application software, JDViewer.
Setting limit for maintenance test
You can set test limits for test item(s) in the auto measurement.
Procedure

1. Press the LIMIT hot key.
2. Press the RF Test Limits soft key, and then enable test limits as desired.
3. Press the PvsT Test Limits soft key, and then enable test limits as desired.
4. Press the Modulation Test Limits soft key, and then enable test limits as desired.
5. Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit.
Toggle the Beep soft key between On and Off to enable or disable the beep sound.

6. Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings.
See “Using save” on page 31 for more information.
NOTE
You can use the Allowed % Change soft key for each test item to compare two
measurement values displayed in the result table. This requires setting the Display mode
to Compare in advance.

Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 242, you
can continue your measurement. The measurement settings can be saved and recalled as a file. You
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load
the file on to the instrument.
Procedure

1. Press the MEASURE SETUP hot key.
2. Toggle the Configuration soft key and select the configuration option:
–

Current: to let the instrumnet use current frequency (single carrier) and determine pass or
fail based on the instrument’s limit settings in Auto Measure.

–

Scenario: to run a test with a programmed scenario in JDViewer.
The Scenario menu becomes activated.

3. To load a scenario, press the Scenario soft key, and then select a scenario file to load.
4. Toggle the Test Time soft key and select the test time option:
–

Now: to let the instrument run a test only once.

–

Schedule: to let the instrument repeat tests as defined in the Set Timing.
The Set Timing menu becomes activated.

5. To define a schedule for an auto measurement, complete the following steps:
a.

Press the Set Timing soft key.
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b.

Press the Start Time (HH:MM) soft key.

c.

Enter the time in the HH:MM format, and then press the Enter soft key.

d.

Press the Stop Time (HH:MM) soft key.

e.

Enter the time in the HH:MM format, and then press the Enter soft key.

f.

Press the Time Interval soft key.

g.

Enter the amount of time in minutes, and then press the Enter soft key.

7. Press the Settings soft key, and then set the following:
a.

Press the Bandwidth soft key, and then select the nominal channel bandwidth to be
measured, from the following choices:

–
b.

1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, and 20 MHz

Toggle the Cell ID soft key and select Auto or Manual as desired:

–

Auto: to let the instrument detect the Cell ID for the LTE signal automatically.

–

Manual: to set a specific Cell ID for the LTE signal manually in order to speed up the
synchronization with a BTS.

c.

Press the MIMO soft key, and then select the antenna number option: 2x2 or 4x4.
This MIMO (Multiple Input Multiple Output) setting is activated only if the option 031 LTEAdvanced TDD is installed with a license number. If not, the instrument sets this option to
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO
channels.

d.

Press the Antenna Port soft key, and then select the option: Auto, 0, 1, 2, or 3.
If the option 031 LTE-Advanced TDD is not installed or if the MIMO is set to 2x2, the
antenna ports 2 and 3 are disabled.

e.

Toggle the External Offset soft key and select On.

f.

Enter a value by using the numeric keys, and then press the dB soft key.

g.

To turn the Multimedia Broadcast Multicast Service (MBMS) feature on or off, toggle the
MBMS soft key and select On or Off. For proper MBMS testing, you need to set the
Subframe No with the same PMCH subframe number.

h.

To set the Multicast Broadcast Single Frequency Network (MBSFN) detection automatically
or manually for MBMS testing, toggle the MBSFN soft key and select Auto or Manual. An
automatically detected or manually entered MBSFN ID appears on the screen.

8. To save your settings and results, go to SAVE/LOAD > Save and then perform functions as you
desire. See “Using save” on page 31 for more information.

9. Press the Run Test soft key to start to run a test.
The Auto Measure Results window appears at the end of the test.

10. To stop running the test, press the Abort soft key.
11. To change the view on the screen during the test, press the Display and then select the view
option from the following choices:

–

Screen: You can view each measurement screen as the test progresses.

–

Results: You can view a measurement result table as the test progresses.

–

Settings: You can view a measurement setting table as the test progresses.

Setting display
After completion of the auto measurement, the screen menu changes to Trace/Display so that you can
view the results in different forms.
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Procedure

1. Toggle the Display soft key and select the display option:
–

Result: to view the result table. The Display Result menu becomes activated.

–

Settings: to view the measurement settings for the auto measurement.

2. Toggle the Display Result soft key and select the display result option:
–

Full: to view detailed measurement readings with the pass/fail indication.

–

Quick: to view only the Pass/Fail results.

–

Compare: to compare two measurement values for each test time with the Allowed %
Change setting on. You can view results vs. factory-defined or user-defined references.

3. To view the measurement results for a different carrier, press the View Carrier soft key and then
select the carrier number to view.

4. Press the Replace Reference soft key to replace existing reference values for comparison with
new measurement data.

5. Press the Load From soft key to select the location from which references file to be loaded.

Signal performance test
Unlike the other auto measurement tests, the Signal Performance Test runs measurements
continuously.
Setting limit for signal performance test
You can set test limits for test item(s) in the auto measurement.
Procedure

1. Press the LIMIT hot key.
2. Press the RF Test Limits > Channel Power soft key, and then set the limits for the channel
power. Other RF test items are not used in the signal performance test.

3. Press the Modulation Test Limits soft key, and then enable test limits as desired.
4. Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit.
Toggle the Beep soft key between On and Off to enable or disable the beep sound.

5. Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings.
See “Using save” on page 31 for more information.

Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 242, you
can continue your measurement. The measurement settings can be saved and recalled as a file. You
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load
the file on to the instrument.
Procedure

1. Press the MEASURE SETUP hot key.
2. Toggle the Cell ID soft key and select Auto or Manual as desired:
–

Auto: to let the instrument detect the Cell ID for the LTE signal automatically.
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–

Manual: to set a specific Cell ID for the LTE signal manually in order to speed up the
synchronization with a BTS.

3. Press the MIMO soft key, and then select the antenna number option: 2x2 or 4x4.
This MIMO (Multiple Input Multiple Output) setting is activated only if the option 031 LTEAdvanced TDD is installed with a license number. If not, the instrument sets this option to 2x2 by
default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO channels.

4. Press the Antenna Port soft key, and then select the option: Auto, 0, 1, 2, or 3.
If the option 031 LTE-Advanced TDD is not installed or if the MIMO is set to 2x2, the antenna
ports 2 and 3 are disabled.

5. Press the Bandwidth soft key, and then select the nominal channel bandwidth to be measured,
from the following choices:

–

1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, and 20 MHz

6. Toggle the RF Profile soft key between On and Off to turn on or off the RF profiling such as
channel power and subframe frequency error.

7. Toggle the Modulation Profile soft key between On and Off to turn on or off the modulation
profiling such as P-SS, S-SS, Data - QPSK, Data – 16 QAM, and Data – 64 QAM.

8. Toggle the MIMO Profile soft key between On and Off to turn on or off the MIMO profiling such
as TX1 - RS0, TX2 - RS1, and time alignment error.

9. Toggle the External Offset soft key and select On to set the external offset value.
10. To save your settings and results, go to SAVE/LOAD > Save and then perform functions as you
desire. See “Using save” on page 31 for more information.

DAS test
The Distributed Antenna System (DAS) testing enables you to check the degradation of performance
in the signal transmission from a radio band to antennas distributed from it. You can save
measurement values at both the radio band and antennas and then compare results with percentage
of changes. You can also save test results in the .csv file format for ease of analysis.
Setting measure setup
Procedure

1. Press the MEASURE SETUP hot key.
2. Press the Settings soft key and then set the following;
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a.

Press the Bandwidth soft key and then select the nominal channel bandwidth to be
measured from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, and 20 MHz:

b.

Press the MIMO soft key, and then select the antenna number option: 2x2 or 4x4.
This MIMO (Multiple Input Multiple Output) setting is activated only if the option 031 LTEAdvanced TDD is installed with a license number. If not, the instrument sets this option to
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO
channels.

c.

Toggle the Cell ID soft key and select Auto or Manual as desired:

–

Auto: to let the instrument detect the Cell ID for the LTE signal automatically.

–

Manual: to set a specific Cell ID for the LTE signal manually in order to speed up the
synchronization with a BTS.

d.

Press the Antenna Port soft key, and then select the option: Auto, 0, 1, 2, or 3.
If the option 031 LTE-Advanced TDD is not installed or if the MIMO is set to 2x2, the
antenna ports 2 and 3 are disabled.

e.

Toggle the External Offset soft key and select On to set the external offset value.
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f.

To turn the Multimedia Broadcast Multicast Service (MBMS) feature on or off, toggle the
MBMS soft key and select On or Off.

g.

To set the Multicast Broadcast Single Frequency Network (MBSFN) detection automatically
or manually for MBMS testing, toggle the MBSFN soft key and select Auto or Manual. An
automatically detected or manually entered MBSFN ID appears on the screen.

3. To save your settings, go to SAVE/LOAD > Save > Save Setup and then perform functions as
you desire. See “Using save” on page 31 for more information.

4. Press the Continue soft key to do the reference test first or press the Skip Reference Test soft
key if you already saved test results from the radio band under test.

5. Press the FREQ/DIST hard key and then set the frequency to be measured. See “Setting
frequency” on page 243 for more information.

6. Press the PREV hard key.
7. Press the Limit soft key and then set the limits and allowed percentage change for each test
item. See “Maintenance test” on page 280 for more information on setting limits.

8. Keep pressing the PREV hard key until you see the Run Test soft key.
9. Press the Run Test soft key.
The instrument runs specified tests to gather reference measurement values. The measurement
table appears when the reference test is done.

10. Press the Continue soft key to run the testing on an antenna (Ant 1).
11. Optional. To change the settings such as External Offset, press the Settings and then change
the settings as needed.

12. Press the Continue soft key.
The instrument runs the testing on Ant 1. The Ant 1 tab appears with the updated result table
when the test is done.

13. To run the testing on the next antenna (Ant 2), press the Run Test soft key and then repeat the
steps 11-12. You can do the testing on up to 10 distributed antennas for one radio band.

14. To view test results for each antenna, press the Select Antenna soft key and then select the
antenna tab number to display on the screen.

15. Optional. Press the Delete Test soft key to delete the selected antenna tab.
16. Optional. Press the Retest Reference soft key to obtain reference measurement values again.
17. Optional. To save your measurement results, go to SAVE/LOAD > Save and then perform
functions as you desire. See “Using save” on page 31 for more information.
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Measurement example
Figure 128 DAS measurement with LTE - TDD signal analyzer

Performing power statistics CCDF measurements
The Power Statistics Complementary Cumulative Distribution Function (CCDF) measurement
characterizes the power statistics of the input signal. It provides PAR (Peak to Average power Ratio)
versus different probabilities.

Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 242, you
can continue your measurement. The measurement settings can be saved and recalled as a file. You
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load
the file on to the instrument.
Procedure

1. Press the MEASURE SETUP hot key.
2. Press the CCDF Length soft key to set the length of the CCDF.
3. Enter a value between 1 and 100 by using the numeric keys. You can also use the rotary knob.
4. Press the Enter soft key.
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Measurement example
Figure 129 CCDF measurement with LTE - TDD signal analyzer

Performing carrier aggregation measurements
Carrier aggregation enables a maximum of five multiple LTE carriers to be used together in order to
provide high data rate required for LTE-Advanced. Component carriers to be aggregated can be intraband contiguous, intra-band non-contiguous, or inter-band. The JD780A series provides carrier
aggregation measurements supporting for all the different modes with carrier aggregation bands
added to the channel standard. This functionality is activated if the license for the option 031 LTEAdvanced TDD is installed.

Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 242, you
can continue your measurement. The measurement settings can be saved and recalled as a file. You
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load
the file on to the instrument.
Procedure

1. Press the MEASURE SETUP hot key.
2. To configure parameters for up to 5 component carriers, complete the following steps:
a.

Press the CA Configuration soft key.
The component carrier configuration window appears.

b.

Press the CA Range soft key.

c.

Enter the number of the component carrier to be set between 1 and 5.

d.

Press the Enter soft key.

e.

Toggle the Turn On soft key and then select On to set parameters and view the results for
the selected component carrier on the screen or Off to turn it off.

f.

Set the following parameters as needed:
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–
g.

Center Frequency, Channel, Bandwidth, Cell ID, CFI, PHICH Ng, Antenna Port,
MBMS On/Off, Cyclic Prefix, and PDSCH Modulation Type

To set more component carriers, repeat the steps c-f.

3. Press the MEASURE SETUP hot key again.
4. Toggle the EVM Detection Mode soft key and select Single or Combine as desired:
–

Single: Testing on one single antenna connected to your JD780A series with a cable.

–

Combine: Testing on multiple antennas connected to your JD780A series with a 2x1 or 4x1
combiner or an antenna.

5. To select the subframe number to be measured, do one of the following:
–

If the EVM Detection Mode is set to Single, press the Subframe No soft key and then set
the subframe number.
NOTE
For MBMS testing, this subframe number must be neither 0 nor 5 as these subframes 0
and 5 are not available for MBMS and it must be set to the MBMS transmitted channel’s
subframe number.

–

If the EVM Detection Mode is set to Combine, toggle the Subframe No soft key and then
select 0 or 5.

6. To set the threshold for PDSCH, complete the following steps:
a.

Press the PDSCH Threshold soft key.

b.

Enter a value by using the numeric keys.

c.

Press the dB soft key.

7. Toggle the PDSCH Precoding soft key between On and Off to enable or disable the PDSCH
precoding.

8. To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4.
This MIMO (Multiple Input Multiple Output) setting is activated only if the option 031 LTEAdvanced TDD is installed with a license number. If not, the instrument sets this option to 2x2 by
default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO channels.

Setting display
You can use the TRACE/DISPLAY hard key to select modulation analysis or spectrum analysis.
Procedure

1. Press the TRACE/DISPLAY hard key.
2. Toggle the Display soft key and select MA for modulation analysis or SA for spectrum analysis.
The screen changes according to the selected option.

288

Using LTE – TDD Signal Analyzer

JD780A Series Analyzers

Measurement example
Figure 130 Carrier aggregation measurement with LTE - TDD signal analyzer (MA)

Figure 131 Carrier aggregation measurement with LTE - TDD signal analyzer (SA)

NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 277 for
more information.

Using marker
You can use the MARKER hard key to place the marker at a specific channel.
Procedure

1. Press the MARKER hard key.
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2. Toggle the Marker View soft key between On and Off to display or dismiss the marker.
3. Press the Channel soft key to select the channel to be displayed on the IQ diagram.
4. Use the rotary knob to move and select an item under EVM.

Conducting LTE - TDD OTA measurements
The TDD LTE Over The Air (OTA) measurement has Channel Scanner, ID Scanner, Multipath Profile,
Datagram, and Control Channel screens. The ID Scanner displays key parameters such as RSRP,
RSRQ, RS-SINR, and S-SS RSSI. The Multipath Profile enables you to determine RF environmental
conditions of testing area. The OTA Control Channel provides summary of all control channels
including RS power variation over time.

Channel scanner
The Channel Scanner is a radio receiver that can automatically tune or scan two or more discrete
frequencies and multi-channels, indicating when it finds a signal on one of them and then continuing
scanning when that frequency goes silent.
Setting channel/frequency
Procedure
To set the channels to be scanned:

1. Press the FREQ/DIST hard key.
2. Toggle the Unit soft key and select Channel.
3. Press the Index soft key, and then enter an index number between one and six by turning the
rotary knob or using the numeric keys.

4. To select the standard channel, complete the following steps:
d.

Press the Channel Std soft key. The standard channel window appears.
See “Appendix C – Band, frequency & channel standard” on page 541 for more information.

e.

Select the band to be measured by using the rotary knob, the arrow keys, or the Page
Up/Page Down soft keys.

f.

Press the Select soft key or the rotary knob to confirm the selection.

5. To set the channel number for the selected index, complete the following steps:
a.

Press the Channel Number soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Press the Enter soft key.

The instrument displays a corresponding center frequency for the channel number.

6. To set the integration bandwidth for the selected index, complete the following steps:
a.

Press the Integration Bandwidth soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Select the unit: GHz, MHz, kHz, or Hz.

7. To add more channels to be scanned, repeat steps 3-6.
8. Press the ESC hard key to dismiss the channel list window and view the scanning result.
To set the frequencies to be scanned:
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1. Press the FREQ/DIST hard key.
2. Toggle the Unit soft key and select Freq.
3. Press the Index soft key, and then enter an index number between one and six by turning the
rotary knob or using the numeric keys.

4. To set the center frequency for the selected index, complete the following steps:
a.

Press the Center Frequency soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Select the unit: GHz, MHz, kHz, or Hz.

5. To set the integration bandwidth for the selected index, complete the following steps:
a.

Press the Integration Bandwidth soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Select the unit: GHz, MHz, kHz, or Hz.

6. To add more channels to be scanned, repeat steps 3-5.
7. Press the ESC hard key to dismiss the channel list window and view the scanning result.
Setting number of antenna ports
Procedure

1. Press the MEASURE SETUP hot key.
2. Toggle the MIMO soft key and select 2x2 or 4x4.
This MIMO (Multiple Input Multiple Output) setting is activated only if the option 031 LTEAdvanced TDD is installed with a license number. If not, the instrument sets this option to 2x2 by
default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO channels.

Measurement example
Figure 132 Channel scanner measurement with LTE - TDD OTA signal analyzer
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ID scanner
The LTE mobile receives signals from multiple base stations that all of these signals share the same
spectrum and are present at the same time. Each base station has unique scrambling code assigned
to the particular base station and it differentiates its signal from other base stations in the area.
The ID Scanner shows key parameters such as RSRP (Reference Signal Received Power) and RSRQ
(Reference Signal Received Quality) that predict the downlink coverage quickly.


RSRPs from entire cells help to rank between the different cells as input for handover and cell
reselection decisions.



RSRQ provides additional information when RSRP is not sufficient to make a reliable
handover or cell reselection decision.

All of the parameters for OTA ID scanner can be plotted on map data such as Google Maps and
Google Earth by using JDViewer.
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 242, you
can continue your measurement.
Procedure

1. Press the MEASURE SETUP hot key.
2. To set the nominal channel bandwidth to be measured, complete the following steps:
a.

Press the Bandwidth soft key.

b.

Select the bandwidth option: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, or 20 MHz.

3. Optional. Press the Miscellaneous soft key, and then do the following(s) as needed:
–

To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4.
This MIMO (Multiple Input Multiple Output) setting is activated only if the option 031 LTEAdvanced TDD is installed with a license number. If not, the instrument sets this option to
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO
channels.

–

To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or
Extended. See “Appendix E – Cyclic prefix table” on page 545 for OFDM parameter details
by different bandwidth.

4. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available
for your measurement mode. See “Using save” on page 31 for more information.
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Measurement example
Figure 133 ID scanner measurement with LTE - TDD OTA signal analyzer

Multipath profile
The Multipath Profile enables you to determine RF environmental conditions of testing area. It
indicates the amount of power of the dominant pilot signal that is dispersed outside the main
correlation peak due to multipath echoes that are expressed in dB. This value should be very small
ideally.
The multipath profile is the result of portions of the original broadcast signal arriving at the receiving
antenna out of phase. This can be caused by the signal being reflected off objects such as buildings,
or being refracted through the atmosphere differently from the main signal.
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 242, you
can continue your measurement.
Procedure

1. Press the MEASURE SETUP hot key.
2. To set the nominal channel bandwidth to be measured, complete the following steps:
a.

Press the Bandwidth soft key.

b.

Select the bandwidth option: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, or 20 MHz.

3. Toggle the Display soft key and select RS or Sync.
The RS Window soft key becomes activated if RS is selected.

4. Press the RS Window soft key, if RS is selected, and then select the RS window option: 2 µs,
4 µs, or 8 µs.

5. Optional. Press the Miscellaneous soft key, and then do the following(s) as needed:
–

To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4.
This MIMO (Multiple Input Multiple Output) setting is activated only if the option 031 LTEAdvanced TDD is installed with a license number. If not, the instrument sets this option to
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO
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channels.

–

To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or
Extended. See “Appendix E – Cyclic prefix table” on page 545 for OFDM parameter details
by different bandwidth.

6. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available
for your measurement mode. See “Using save” on page 31 for more information.

Measurement example
Figure 134 Multipath profile measurement with LTE - TDD OTA signal analyzer

Control channel
DL RS power is the resource element power of Downlink Reference Symbol. The absolute DL RS
power is indicated on the BCH. The absolute accuracy is defined as the maximum deviation between
the DL RS power indicated on the BCH and the DL RS power at the BS antenna connector.
The OTA Control Channel provides summary of all control channels including RS power trend over
time. GPS coordinates (latitude and longitude) will be displayed on the screen if a GPS antenna is
connected and locked to the GPS satellites.
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 242, you
can continue your measurement. The measurement settings can be saved and recalled as a file. You
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load
the file on to the instrument.
Procedure

1. Press the MEASURE SETUP hot key.
2. To set the nominal channel bandwidth to be measured, complete the following steps:
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a.

Press the Bandwidth soft key.

b.

Select the bandwidth option: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, or 20 MHz.
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3. To select the subframe number to be measured, complete the following steps:
a.

Press the Subframe No soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.
NOTE
For MBMS testing, this subframe number must be neither 0 nor 5 as these subframes 0
and 5 are not available for MBMS and it must be set to the MBMS transmitted channel’s
subframe number.

c.

Press the Enter soft key.

4. Toggle the Cell ID soft key and select Auto or Manual as desired:
–

Auto: to let the instrument detect the Cell ID for the LTE signal automatically.

–

Manual: to set a specific Cell ID for the LTE signal manually in order to speed up the
synchronization with a BTS.

5. Optional. Press the Miscellaneous soft key, and then do the following(s) as needed:
–

To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4.
This MIMO (Multiple Input Multiple Output) setting is activated only if the option 031 LTEAdvanced TDD is installed with a license number. If not, the instrument sets this option to
2x2 by default. A 2x1 or 4x1 RF combiner is also required to test on MIMO channels.

–

To assign a antenna port number automatically or manually, press the Antenna Port soft
key and select the option: Auto, 0, 1, 2, and 3. If the option 031 LTE-Advanced TDD is not
installed or if the MIMO is set to 2x2, the antenna ports 2 and 3 are disabled.

–

To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or
Extended. See “Appendix E – Cyclic prefix table” on page 545 for OFDM parameter details
by different bandwidth.

–

To turn the Multimedia Broadcast Multicast Service (MBMS) feature on or off, toggle the
MBMS soft key and select On or Off. For proper MBMS testing, you need to set the
Subframe No with the same PMCH subframe number. If this setting is on, the
measurement item “MBSFN RS” appears in the result table.

–

To set the Multicast Broadcast Single Frequency Network (MBSFN) detection automatically
or manually for MBMS testing, toggle the MBSFN soft key and select Auto or Manual. An
automatically detected or manually entered MBSFN ID appears on the screen.

6. Go to SAVE/LOAD > Save, and then select the save option from the choices available for your
measurement mode. See “Using save” on page 31 for more information.

Setting limit for OTA control channel
Procedure

1. Press the LIMIT hot key.
2. Select the test item(s) and set the limit(s) as needed:
To set the limit for

Select

Set

P-SS error vector magnitude

P-SS EVM

High Limit

S-SS error vector magnitude

S-SS EVM

High Limit

RS error vector magnitude

RS EVM > RS0 EVM
RS EVM > RS1 EVM
RS EVM > RS2 EVM
RS EVM > RS3 EVM

High Limit

Frequency error

Frequency Error

High Limit
Low Limit
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Time error

Time Error

High Limit
Low Limit

Time alignment error

Time Alignment Error

High Limit

3. Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings.
See “Using save” on page 31 for more information.

Setting display
You can use the TRACE/DISPLAY hard key to select the display option.
Procedure

1. Press the TRACE/DISPLAY hard key.
2. Toggle the Display soft key and select Power or EVM.
The screen changes according to the selected option.

Measurement example
Figure 135 Control channel measurement with LTE - TDD OTA signal analyzer

Datagram
The OTA Datagram is a time-varying spectral representation that shows how the power of a signal
varies with time. The power allocated to the specific resource block will be represented with an
amplitude axis (in dBm) and the waterfall diagram will show the trend of past resource block power
over certain period. Using a marker function facilitates analysis of accumulated resource block power
for data utilization.
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 242, you
can continue your measurement. The measurement settings can be saved and recalled as a file. You
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load
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the file on to the instrument.
Procedure

1. Press the MEASURE SETUP hot key.
2. To set the nominal channel bandwidth to be measured, complete the following steps:
a.

Press the Bandwidth soft key.

b.

Select the bandwidth option: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, or 20 MHz.

3. To select the subframe number to be measured, complete the following steps:
a.

Press the Subframe No soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Press the Enter soft key.

4. Optional. Toggle the Cell ID soft key and select Auto or Manual as desired:
–

Auto: to let the instrument detect the Cell ID for the LTE signal automatically.

–

Manual: to set a specific Cell ID for the LTE signal manually in order to speed up the
synchronization with a BTS.

5. Optional. To set the threshold for PDSCH, complete the following steps:
a.

Press the PDSCH Threshold soft key.

b.

Enter a value by using the numeric keys.

c.

Press the dB soft key.

6. To set the time cursor at a specific position, complete the following steps:
a.

Toggle the Time Cursor soft key and select On.

b.

Turn the rotary knob to move the time cursor. You can also enter a value and then press the
Enter soft key.
NOTE
Enabling the time cursor puts the measurement on hold and you can make postprocessing analysis for each measurement over time using the time cursor.

7. To start a new measurement, press the Reset/Restart soft key.
8. Optional. Press the Miscellaneous soft key, and then do the following(s) as needed:
–

To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4.
This MIMO (Multiple Input Multiple Output) setting is activated only if the option 031 LTEAdvanced TDD is installed with a license number. If not, the instrument sets this option to
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO
channels.

–

To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or
Extended. See “Appendix E – Cyclic prefix table” on page 545 for OFDM parameter details
by different bandwidth.

9. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available
for your measurement mode. See “Using save” on page 31 for more information.
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Measurement example
Figure 136 Datagram measurement with LTE - TDD signal analyzer

Route map
The JD780A Series provides indoor and outdoor mapping function that allows a user to collect data of
points in an indoor or outdoor environment and track the received signals and coverage of RF
transmitters plotting real time directly on top of a loaded floor plan or a map.
Setting measure setup
Procedure

1. If required, connect a GPS receiver to your JD780A series for outdoor mapping.
Indoor mapping does not necessarily need a GPS antenna.

2. Configure test parameters as described in the “Configuring test parameters” on page 242.
3. To load your map file, complete the following steps:
a.

Plug in your USB drive that has a floor map or .mcf file type created in JDMapCreator.
NOTE
The JDMapCreator converts and resizes any scanned floor plan or layout to fit onto your
instrument’s display. You must save your map files (.mcf) into the “SavedMap” folder of
your USB drive so that you can load them onto your instrument.

b.

Press SAVE/LOAD hot key, and then select Load > Load Map.
See “Using load” on page 34 for more information.

4. Press the MEASURE SETUP hot key.
5. Press the Plot Point soft key, and then select the plot point option from the following choices:
–

To collect data/plot points automatically as you move around in a vehicle or outside, press
the GPS soft key and then toggle the Screen Mode soft key between Map and Full.
NOTE
With the Map setting, you can view only the collected points that can be seen within the
boundary of the loaded map. If a point is off the map, the instrument displays an arrow to
indicate the direction of the current location on the map and the distance from the center
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to the location at the top of the screen.
With the Full setting, you can view all the collected points of the route without the loaded
map.

–

To collect data/plot points manually without a GPS antenna in an indoor environment, press
the Position soft key.

6. Press the Plot Item soft key, and then select the measurement option: RSRP, RSRQ, RS-SINR,
S-SS RSSI, P-SS Power, S-SS Power, or S-SS Ec/Io.
NOTE
The instrument collects the strongest Cell ID’s data to plot points.

7. Press the Bandwidth soft key to set the nominal channel bandwidth to be measured, and then
select the bandwidth option: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, or 20 MHz.

8. Toggle the Plot soft key and select Start to start plotting.
9. Touch directly on the screen or press the ENTER hard key to collect data and plot points on the
loaded map for the Position setting.
NOTE
For the Position setting, you can change the direction of the route with the arrow keys
and the distance with the rotary knob.

10. Toggle the Plot soft key and select Stop to stop plotting.
11. Press the SAVE/LOAD hot key to save the result.
See “Using save” on page 31 for more information.
NOTE
The instrument does not automatically save the collected data. It is recommended that
you save the result. Otherwise, you will lose all the collected data.

Setting limit for route map
You can set the thresholds for each test item.
Procedure

1. Press the LIMIT hot key.
2. Select the plot items and set the limits as needed:
To set the limit for

Select

Set

RSRP

RSRP

Excellent, Very Good, Good, Fair, Poor (dBm)

RSRQ

RSRQ

Good, Fair, Poor (dB)

RS-SINR

RS-SINR

Good, Fair, Poor (dB)

S-SS RSSI

S-SS RSSI

Excellent, Very Good, Good, Fair, Poor (dBm)

P-SS Power

P-SS Power

Excellent, Very Good, Good, Fair, Poor (dBm)

S-SS Power

S-SS Power

Excellent, Very Good, Good, Fair, Poor (dBm)

S-SS Ec/Io

S-SS Ec/Io

Good, Fair, Poor (dB)

3. Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings.
See “Using save” on page 31 for more information.
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Measurement example
Figure 137 Route map measurement with LTE - TDD OTA signal analyzer
1) RSRP

2) RSRQ
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3) RS-SINR

4) S-SS RSSI

5) P-SS Power
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6) S-SS Power

7) S-SS Ec/Io
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Using CDMA Signal Analyzer
This chapter provides instructions for using the CDMA Signal Analyzer function (option 020) with the
CDMA OTA Analyzer function (option 040). Topics discussed in this chapter are as follows:
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Introduction
This CDMA Signal Analyzer can be used to test a CDMA transmitter including cdmaOne and
cdma2000 signals to check the base station’s compliance with following standards documentation.


3GPP2 C.S0002 Physical Layer Standard for cdma2000 Spread Spectrum Systems



3GPP2 C.S0010 Recommended Minimum Performance Standards for cdma2000 Spread
Spectrum Base Station

This instrument automatically makes standard defined measurements using the measurement
methods and limits as defined in the standards. Detailed measurement results allow you to analyze
cdmaOne and cdma2000 system performance.


cdmaOne uses dual BPSK (Binary Phase-Shifting Key) for the forward link and OQPSK
(Offset Quadrature Phase Shift Keying) for the reverse link.



cdma2000 uses QPSK (Quadrature Phase Shift Keying) modulation for the forward link and
QPSK modulation with HPSK spreading for the reverse link. Both forward and reverse links
may have several channels, and individual characteristics for each channel. The chip rate
depends on the mode selected.

You may alter the measurement parameters for specialized analysis. Pass/Fail testing with standard
defined or user defined upper and lower limits and the Pass/Fail indictor help you to determine base
station performance easily.
This instrument provides the following measurement tools for CDMA system:


Spectrum Analysis



RF Analysis
Channel Power
Occupied Bandwidth
Spectrum Emission Mask (SEM)
Adjacent Channel Power Ratio (ACPR)
Multi-ACPR
Spurious Emissions



Modulation Analysis
Constellation
Code Domain Power
Codogram
Received Code Strength Indicator (RCSI)
CDP Table



Auto Measure



Power Statistics CCDF



Over The Air (OTA)
Channel Scanner
PN Scanner
Multipath Profile
Code Domain Power
Route Map
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Display overview
Figure 138 provides descriptions for each segment of the measurement screen.
Figure 138 CDMA signal analyzer measurement screen

Connecting a cable
Direct connection
Procedure

1. Connect the Spectrum Analyzer RF In port of the JD780A series and the Power amplifier output
port of BTS.

Figure 139 Direct connection

JD785A/JD786A

JD788A

Using CDMA Signal Analyzer

305

JD780A Series Analyzers

Indirect connection
Procedure

1. Connect the Spectrum Analyzer RF In port of the JD780A series and the monitor (test) port of
BTS.

Figure 140 Indirect connection

JD785A/JD786A

JD788A

CAUTION
The maximum power for the Spectrum Analyzer RF In port is +25 dBm (0.316 W). If the
input signal level to be measured is greater than +25 dBm, use a High Power
Attenuator to prevent damage when you directly connect the signal to the instrument or
connect the signal from the coupling port of a directional coupler.
NOTE
For accurate PN Offset and Time Offset measurements with the CDMA Signal Analyzer
function, a PP2S should be connected to the External Trigger. Without a GPS connection,
measurement results could be invalid numbers.

Over the air (OTA)
Procedure

1. Connect an Omni/directional RF antenna to the Spectrum Analyzer RF In port of the JD780A
series.

2. Connect a GPS antenna to the GPS port of the JD780A series.
CAUTION
If the input signal level to be measured is less than 0 dBm, set 0 dB attenuation or turn on
the preamp to have better dynamic range for the OTA testing.
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Figure 141 OTA connection

JD785A/JD786A

JD788A

Selecting measurement mode
Procedure

1. Press the MODE hard key.
2. Press the Signal Analyzer soft key.
3. Press the CDMA soft key. The Spectrum mode is set by default.
4. Press the MEASURE hot key, and then select the measurement mode option from the following
choices:

–

Spectrum

–

RF Analysis > Channel Power, Occupied BW, Spectrum Emission Mask, ACPR,
Multi-ACPR, or Spurious Emissions

–

Modulation > Constellation, Code Domain Power, Codogram, RCSI, or CDP Table

–

Auto Measure

–

Power Statistics CCDF

–

OTA > Channel Scanner, PN Scanner, Multipath Profile, Code Domain Power,
or Route Map

Configuring test parameters
Setting frequency
You can set the frequency with either frequency or channel number. If a frequency to be set matches
to the frequency corresponding to the selected channel standard, the instrument calculates its channel
number and updates the screen with it automatically.
Procedure
To set the center frequency:

1. Press the FREQ/DIST hard key.
2. Toggle the Unit soft key and select Freq.
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3. Press the Center Frequency soft key.
4. Enter a value by using the numeric keys. You can also use the rotary knob.
5. Select the unit: GHz, MHz, kHz, or Hz.
6. Optional. To define the amount of frequency increment for the rotary knob, complete the following
steps:
a.

Press the Frequency Step soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Press the unit: GHz, MHz, kHz, or Hz.

To set the channel number:

1. Press the FREQ/DIST hard key.
2. Toggle the Unit soft key and select Channel.
3. To select the standard channel, complete the following steps:
a.

Press the Channel Std soft key. The standard channel window appears.
See “Appendix C – Band, frequency & channel standard”” on page 541 for more
information.

b.

Select the band to be measured by using the rotary knob, the arrow keys, or the Page
Up/Page Down soft keys.

c.

Press the Select soft key or the rotary knob to confirm the selection.

4. Press the Channel Number soft key.
5. Enter a value by using the numeric keys. You can also use the rotary knob.
6. Press the Enter soft key.
The instrument automatically displays the corresponding center frequency value for the selected
channel number.

7. Optional. To define the amount of channel increment for the rotary knob, complete the following
steps:
a.

Press the Channel Step soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Press the Enter soft key.

NOTE
This frequency setting is not used in the Multi-ACLR and Spurious Emissions modes.

Setting amplitude
Reference level and attenuation
You can set the reference and attenuation levels automatically or manually to optimize the display of
the traces measured, as you desire.
Procedure
To automatically set the reference and attenuation level:

1. Press the AMP/SCALE hard key.
2. Press the Auto Scale soft key.
Each time you press this key, both of the Y-axis scale and input attenuation level change to be
optimized with some margin.
To set the reference or attenuation level manually:
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1. Press the AMP/SCALE hard key.
2. To set the maximum reference value on the Y-axis manually, complete the following steps:
a.

Press the Reference Level soft key.

b.

Enter a value by using the numeric keys or the rotary knob with 10 dB increments.

c.

Press the dBm soft key or the ENTER hard key.
NOTE
In the measurements such as Code Domain Power, Codogram, and RCSI, you may
need to select the reference option between Relative and Absolute before setting the
reference level.

3. To set the attenuation option, select one from the following choices:
–

To set the input attenuator’s level automatically, select Attenuation > Auto.
NOTE
It is recommended that you set the Attenuation to Auto in most situations so that the
level of the input attenuator can be set automatically according to your input signal level.

–

–

To set the input attenuation manually up to 55 dB to optimize S/N, complete the following
steps:
a.

Select Attenuation > Manual.

b.

Press the Attenuation Value soft key to set the level.

c.

Enter a value between 0 and 55 in fives by using the numeric keys.

d.

Press the dB soft key or the ENTER hard key.

To couple the input attenuator’s level with your reference level setting, select Attenuation >
Couple.
As you increse the reference setting, the attenuation level also increases acoordingly.

Optional. To change the scale unit:

1. Select More (1/2) > Units.
2. Select the unit of the display scale: dBm, dBV, dBmV, dBµV, V, or W.
The scale unit on the screen changes accordingly.
NOTE
This Units menu is available in the Spectrum and RF Analysis modes.

Scale per division
You can use the Scale/Div feature available for the spectrum and RF analysis. It represents the value
of one division on the horizontal scale. The default setting is 10 dB per division and the maximum
value can be set up to 20 dB.
Procedure
To set the scale per division:

1. Press the AMP/SCALE hard key.
2. Select More (1/2) > Scale/Div.
3. Enter a value between 1 and 20 by using the numeric keys.
4. Press the dB soft key to complete the entry.
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Pre-amplifier
You can turn the internal pre-amplifier on to correct and compensate for the gain of the preamp so that
amplitude readings show the value at the input connector.
Procedure

1. Press the AMP/SCALE hard key.
2. Toggle the Preamp soft key and select On or Off as needed.
NOTE
You can turn the Preamp on when the input attenuation range is from 0 dB to 10 dB. If
the attenuation value is manually set to greater than 10 dB, the instrument will
automatically turn off the pre-amplifier to display low-level signal properly on the chart.

External offset
You can turn the External Offset on and manually set the external offset value. An offset consists of a
cable loss and a user offset and the measurement result shows the value reflecting both offset values.
When the external offset value is set at 40 dB in the Spectrum mode, the measurement result
compensates 40 dB at both the Spectrum Analyzer and Signal Analyzer modes
Procedure
To set the external offset:

1. Press the AMP/SCALE hard key.
2. Toggle the External Offset soft key and select On.
3. Enter a value by using the numeric keys.
4. Press the dB soft key to complete the entry.
To turn the external offset off:

1. Press the AMP/SCALE hard key.
2. Toggle the External Offset soft key and select Off.

Setting average
You can set the number of measurements to be averaged for the trace presentation. A maximum of
100 times of averaging can be set. When the averaging reaches to your setting, a new measurement
value replaces the measurement value in sequence from the earliest.
Procedure

1. Press the BW/AVG hard key.
2. Press the Average soft key.
3. Enter a value between 1 and 100 as needed by using the numeric keys.
4. Press the Enter soft key.

Setting sweep mode
The default settings of the sweep mode are Continue and Normal to sweep continuously at a normal
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speed for most on-going measurements. If you want to hold the measurement or get a single sweep,
you can change the sweep mode.
Procedure
To select the single sweep mode:

1. Press the SWEEP hot key.
2. Toggle the Sweep Mode soft key and select Single. You can also use the HOLD hot key.
The letter HOLD in red appears and the sweeping is paused.

3. Optional. Press the Sweep Once soft key to get a new measurement.
To return to the continuous sweep mode:

1. Toggle the Sweep Mode soft key and select Continue. You can also use the HOLD hot key.
The letter HOLD in red disappears and the sweeping resumes.

Setting trigger source
You can set the trigger source option for your measurements. Connecting an external trigger is
necessary for accurate modulation measurements on CDMA systems.
Procedure

1. Press the TRIGGER hot key.
2. Select the trigger source option from the following choices: Internal, External, or GPS.

Setting external clock
To enhance the reliability of modulation analysis measurements the JD780A series must be
synchronized with a base station. When an external clock is not supplied, the instrument works with its
built-in internal high-accuracy time base and some measurement results may exhibit inaccurate values.
Therefore, it is highly recommended that you use the same reference clock as the signal source. You
can use the TRIGGER hot key to set the external clock.
Table 16

Standards of external clock operation

Clock

Type

Reference

External Reference

Internal

Internal 10 MHz

External

External Ref Clock

Ext Ref (SMA)

Manual switching
(Input signal level >-3 dBm)

GPS

GPS Clock

GPS (SMA)

Automatic switching
(GPS signal received)

Internal

Internal Trigger

External

External Trigger

Trigger (SMA)

Manual switching

GPS

GPS

GPS (SMA)

Manual switching

Trigger

Port

Switching Standard
Default

Default
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Figure 142 Connection ports for external reference clock

Procedure

1. Connect an external reference or a GPS antenna to the JD780A series.
2. Press the SYSTEM hot key.
3. Press the Freq Reference soft key, and then select the reference option: Internal, External 10
MHz, External 13 MHz, External 15 MHz, or GPS.
NOTE
When a GPS antenna is connected and locked, GPS coordinates (longitude and latitude)
are displayed on the screen and frequency reference is automatically set to GPS in the
System > Freq Reference.

Table 17
Type

External reference indicators
Indicator

Description

Internal

(green)

The green INT icon indicates that the instrument uses the built-in
internal time base.

External

(green)

The green EXT icon indicates that an external reference is connected
and locked and that the instrument uses the same reference clock as
the signal source.

External

(red)

The red EXT icon indicates that an external reference is connect but not
locked.

GPS

(green)

The green GPS antenna icon indicates that a GPS antenna is
connected and locked.

GPS

(yellow)

The yellow GPS antenna icon indicates that a GPS antenna is
connected and locking is in progress.

GPS

(grey)

The grey GPS antenna icon indicates that a GPS antenna is not
connected, failed, or unable to be locked.

Conducting spectrum measurements
If you have configured test parameters as described in the “Configuring test parameters” on page 307,
your measurement result is displayed on the screen as like the following example, Figure 143.
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Figure 143 Spectrum measurement screen with CDMA signal analyzer

Setting trace
You can display up to six traces on the measurement chart simultaneously.
Procedure

1. Press the TRACE/DISPLAY hard key.
2. Press the Select Trace soft key, and then select the trace number: T1, T2, T3, T4, T5, or T6.
The legend shape of the selected trace changes from square to round to indicate that the trace is
the active one now.

3. Toggle the Trace View soft key and select On.
4. To clear, write or capture, or hide the trace(s), do one of the following:
To

Select

Trace Legend

Clear current data and display with new
measurements

Clear Write

W

Display the input signal’s maximum response only

Max Hold

M

Display the input signal’s minimum response only

Min Hold

m

Capture the selected trace and compare traces

Capture

C

Load a saved trace

More (1/2) > Load

L

Hide the selected trace

Trace View > Off

F

Remove all the traces and initialize the trace
settings

More (1/2) > Trace
Clear All

5. To select the detection option, press the More (1/2) > Detectors, and then do one of the
following:
To display

Select

Random noise better than the peak without missing signals

Normal
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The highest value in each data point

Peak

The root mean squared average power across the spectrum

RMS

The lowest value in each data point

Negative Peak

The center value in each data point

Sample

6. Optional. Press the More (1/2) > Trace Info soft key, and then select the trace number to view
the trace’s parameter setting information stored at the time of the measurement or None to hide
the information display.

7. Optional. If you have the two traces T1 and T2, you can perform trace math. To view the power
difference between the traces, press the T1 – T2 -> T5 or T2 – T1 -> T6 soft key.
The result is overlaid on the screen along with the second Y-axis.

Conducting RF measurements
Channel power
The Channel Power measurement is a common test used in the wireless industry to measure the total
transmitted power of a radio within a defined frequency channel. It acquires a number of points
representing the input signal in the time domain, transforms this information into the frequency domain
using Fast Fourier Transform (FFT), and then calculates the channel power. The effective resolution
bandwidth of the frequency domain trace is proportional to the number of points acquired for the FFT.
The channel power measurement identifies the total RF power, power spectral density (PSD) and peak
to average ratio (PAR) of the signal within the channel bandwidth (1.23 MHz for cdmaOne).
After configuring test parameters as described in the “Configuring test parameters” on page 307, your
measurement result is displayed on the screen as like the following example, Figure 144.
Figure 144 Channel power measurement with CDMA signal analyzer

NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 320 for more
information.
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Occupied bandwidth
The Occupied Bandwidth measures the spectrum shape of the carrier. It is defined as the bandwidth,
which includes 99% of the transmitted power among total transmitted power.
After configuring test parameters as described in the “Configuring test parameters” on page 307, your
measurement result is displayed on the screen as like the following example, Figure 145.
Figure 145 Occupied bandwidth measurement with CDMA signal analyzer

NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 320 for more
information.

Spectrum emission mask (SEM)
The Spectrum Emission Mask (SEM) measurement required by 3GPP2 specifications encompasses
different power limits and different measurement bandwidths (resolution bandwidths) at various
frequency offsets. It may be expressed as a ratio of power spectral densities between the carrier and
the specified offset frequency band. It provides useful figures-of-merit for the spectral re-growth and
emissions produced by components and circuit blocks, without the rigor of performing a full SEM
measurement.
The SEM measures spurious signal levels in up to five pairs of offset or region frequencies and relates
them to the carrier power.
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 307, your
measurement result is displayed on the screen as like the following example, Figure 146.
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Figure 146 SEM measurement with CDMA signal analyzer

NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 320 for more
information.

ACPR
The Adjacent Channel Power Ratio (ACPR) is defined as the ratio of the average power in the
adjacent frequency channel (or offset) to the average power in the transmitted frequency channel. It
may be expressed as the ratio of the integrated signal power in the adjacent channel to the integrated
signal power in the main channel.
After configuring test parameters as described in the “Configuring test parameters” on page 307, your
measurement result is displayed on the screen as like the following example, Figure 147.
Figure 147 ACPR measurement with CDMA signal analyzer
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NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 320 for more
information.

Multi-ACPR
The Multi-ACPR measurement is used to perform multi-channel ACPR measurements with as many
channels as possible. It helps you to measure ACPR in multi-channel transmitting base station
environment.
Setting frequency for Multi-ACPR
You can set the frequency with either frequency or channel number.
Procedure

1. Press the MEASURE SETUP hot key.
2. To set the frequency, do one of the following:
–

–

To set the center frequency, complete the following steps:
a.

Toggle the Unit soft key and select Freq.

b.

Press the Lowest Frequency soft key to set the starting center frequency.

c.

Enter a value by using the numeric keys. You can also use the rotary knob.

d.

Select the unit: GHz, MHz, kHz, or Hz.

e.

Press the Highest Frequency soft key to set the stopping center frequency.

f.

Enter a value by using the numeric keys. You can also use the rotary knob.

g.

Select the unit: GHz, MHz, kHz, or Hz.

To set the channel number, complete the following steps:
a.

Toggle the Unit soft key and select Channel.

b.

To select the standard channel, press the Channel Std soft key and then select the
band to be measured.

c.

Press the Lowest Channel soft key to set the starting channel.

d.

Enter a value by using the numeric keys. You can also use the rotary knob.

e.

Press the Enter soft key.

f.

Press the Highest Channel soft key to set the stopping channel.

g.

Enter a value by using the numeric keys. You can also use the rotary knob.

h.

Press the Enter soft key.

After configuring test parameters, your measurement result is displayed on the screen as like the
following example, Figure 148.

Using CDMA Signal Analyzer

317

JD780A Series Analyzers

Figure 148 Multi-ACPR measurement with CDMA signal analyzer

NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 320 for more
information.

Spurious emissions
Out-of-band emissions are unwanted emissions immediately outside the channel bandwidth resulting
from the modulation process and non-linearity in the transmitter but excluding spurious emissions. The
Spurious Emissions measurement is to identify and determine the power level of out-of-band spurious
emission within the necessary channel bandwidth and modulated signal measured at the RF port of
the Base Station.
Setting measure setup
Procedure

1. Press the MEASURE SETUP hot key.
2. To set up the range table and frequency range, press the Range Table soft key and then
complete the following steps:
a.

Press the Range soft key, and then enter the range number to add a new range or change
an existing one.

b.

Press the Enter soft key.

c.

Press the Start Frequency soft key to set up the frequency range.

d.

Enter a value by using the numeric keys. You can also use the rotary knob.

e.

Select the unit: GHz, MHz, kHz, or Hz.

f.

Press the Stop Frequency soft key to set up the frequency range.

g.

Enter a value by using the numeric keys. You can also use the rotary knob.

h.

Select the unit: GHz, MHz, kHz, or Hz.

3. Toggle the Range soft key between On and Off to display or hide the selected range.
4. To set up the test limits for Pass/Fail indication, complete the following steps:
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a.

Press the Start Limit soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Select the dBm soft key.

d.

Press the Stop Limit soft key.

e.

Enter a value by using the numeric keys. You can also use the rotary knob.

f.

Select the dBm soft key.

5. To set up the other parameters, complete the following steps:
a.

Select More (1/2) > Attenuation to set up the attenuation value.

b.

Enter a value in the multiple of five.

c.

Press the dB soft key or the ENTER hard key.

d.

Press the RBW soft key.

e.

Enter a value by using the numeric keys.

f.

Select the unit: GHz, MHz, kHz, or Hz.

g.

Press the VBW soft key.

h.

Enter a value by using the numeric keys.

i.

Select the unit: GHz, MHz, kHz, or Hz.

6. Press the PREV hard key.
7. Toggle the Measure Type soft key between Examine and Full to select the measurement type.
NOTE
The Examine mode displays only the selected range while the Full mode lets the
instrument automatically changes the selected range from one another.

8. Set the number of measurements to be averaged:
a.

Press the Average soft key.

b.

Enter a value between 1 and 100.

c.

Press the Enter soft key.

After configuring test parameters as described in the “Configuring test parameters” on page 307, your
measurement result is displayed on the screen as like the following example, Figure 149.
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Figure 149 Spurious emissions measurement with CDMA signal analyzer

NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 320 for more
information.

Setting limit for RF tests
By default, test limits specified in the standard are set for you. You can change thresholds if you desire.
Procedure

1. Press the LIMIT hot key.
2. Press the RF Test Limits soft key.
3. Select the test item(s) and set the limit(s) depending on your selected measurement mode:
To set the limit for

Select

Set

Channel power

Channel Power

High Limit
Low Limit

Occupied bandwidth

Occupied BW

High Limit

Spectrum emission mask

Spectrum Emission Mask

(On/Off only)

ACPR

ACPR

(On/Off only)

Multi-ACPR

Multi-ACPR

(On/Off only)

Spurious emissions

Spurious Emissions

(On/Off only)

4. Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit.
Toggle the Beep soft key between On and Off to enable or disable the beep sound.

5. Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings.
See “Using save” on page 31 for more information.

320

Using CDMA Signal Analyzer

JD780A Series Analyzers

Conducting modulation measurements
In order to make accurate measurements of time offset and PN, you must connect an external trigger
before making a modulation measurement.

Constellation
The Constellation is used to observe some aspects of modulation accuracy and can reveal certain
fault mechanisms such as I/Q amplitude imbalance or quadrature imbalance. It displays constellation
diagram by modulation types.
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 307, you
can continue your measurement. The measurement settings can be saved and recalled as a file. You
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load
the file on to the instrument.
Procedure

1. Press the MEASURE SETUP hot key.
2. To set the Pseudo-Noise (PN) offset, complete the following steps:
a.

Toggle the PN Offset soft key between Auto and Manual.

b.

Enter a value by using the numeric keys to set manually.

c.

Press the Enter soft key.

3. To set the incremental step for the PN offset, complete the following steps:
a.

Press the PN Increment soft key.

b.

Enter a value by using the numeric keys.

c.

Press the Enter soft key.

4. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available
for your measurement mode. See “Using save” on page 31 for more information.
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Measurement example
Figure 150 Constellation measurement with CDMA signal analyzer

NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 328 for
more information.

Code domain power
The Code Domain Power (CDP) measures the distribution of power across the set of code channels,
normalized to the total power. It helps to verify that each code channel is operating at its proper level
and to identify problems throughout the transmitter design from coding to the RF section. System
imperfections such as amplifier non-linearity will present themselves as an undesired distribution of
power in the code domain.
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 307, you
can continue your measurement. The measurement settings can be saved and recalled as a file. You
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load
the file on to the instrument.
Procedure

1. Press the MEASURE SETUP hot key.
2. To set the Pseudo-Noise (PN) offset, complete the following steps:
a.

Toggle the PN Offset soft key between Auto and Manual.

b.

Enter a value by using the numeric keys to set manually.

c.

Press the Enter soft key.

3. To set the incremental step for the PN offset, complete the following steps:
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a.

Press the PN Increment soft key.

b.

Enter a value by using the numeric keys.
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c.

Press the Enter soft key.

4. To set the threshold between Auto and Manual, complete the following steps:
a.

Press the Threshold soft key. Its default setting is -27 dB.

b.

Enter a value between -50 and zero by using the numeric keys to change the value in the
Manual mode.

c.

Press the Enter soft key.

5. Toggle the Q-Paging soft key between On and Off to enable or disable the quick page channel
that indicates the power of Quick Page Walsh code 80.

6. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available
for your measurement mode. See “Using save” on page 31 for more information.

Measurement example
Figure 151 Code domain power measurement with CDMA signal analyzer

NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 328 for
more information.

Setting display
You can view .your measurement results in a different view option.
Procedure

1. Press the TRACE/DISPLAY hard key.
2. Press the Code Order soft key, and then select the code order option from the following choices:
–

Hadamard: To assign the number based on Walsh code order and display the measured
code power according to the assigned number in sequence.

–

Bit Reverse: Code number in binary bit is reversed relative to the Hadamard method.

3. Toggle the Base Code Length soft key and select the base Walsh code number: 64 or 128.
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Codogram
The Codogram displays how the code level is changing over time and makes it easier for you to view
traffic channels as they initiate and terminate and to track traffic channels call levels over time. The
Codogram measurements can be saved into an external USB memory so that a post-analysis can be
done with the application software JDViewer.
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 307, you
can continue your measurement. The measurement settings can be saved and recalled as a file. You
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load
the file on to the instrument.
Procedure

1. Press the MEASURE SETUP hot key.
2. To set the Pseudo-Noise (PN) offset, complete the following steps:
a.

Toggle the PN Offset soft key between Auto and Manual.

b.

Enter a value by using the numeric keys to set manually.

c.

Press the Enter soft key.

3. To set the incremental step for the PN offset, complete the following steps:
a.

Press the PN Increment soft key.

b.

Enter a value by using the numeric keys.

c.

Press the Enter soft key.

4. To set the threshold between Auto and Manual, complete the following steps:
a.

Press the More (1/2) > Threshold soft key. Its default setting is -27 dB.

b.

Enter a value between -50 and zero by using the numeric keys to change the value in the
Manual mode.

c.

Press the Enter soft key.

5. Toggle the More (1/2) > Q-Paging soft key between On and Off to enable or disable the quick
page channel that indicates the power of Quick Page Walsh code 80.

6. To set the time interval, complete the following steps:
a.

Press the Time Interval soft key.

b.

Enter a value by using the numeric keys.

c.

Press the Enter soft key.

7. To place the time cursor to analyze your measurements, complete the following steps:
a.

Toggle the Time Cursor soft key between On and Off to enable or disable the time cursor.

b.

Enter a value by using the numeric keys.

c.

Press the Enter soft key.
NOTE
When the time cursor is enabled, the measurement is put on hold and information about
the time cursor is displayed.

8. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available
for your measurement mode. See “Using save” on page 31 for more information.
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Measurement example
Figure 152 Codogram in full view with CDMA signal analyzer

Setting display
You can view .your measurement results in a different view option.
Procedure

1. Press the TRACE/DISPLAY hard key.
2. Press the Code Order soft key, and then select the code order option from the following choices:
–

Hadamard: To assign the number based on Walsh code order and display the measured
code power according to the assigned number in sequence.

–

Bit Reverse: Code number in binary bit is reversed relative to the Hadamard method.

3. Toggle the Base Code Length soft key and select the base Walsh code number: 64 or 128.

RCSI
The Received Code Strength Indicator (RCSI) is used to track the power variation of cdmaOne or
cdma2000 control channels such as Pilot, Paging, Sync, and Q-Paging over time. The RCSI
measurements can be saved into an external USB memory so that a post-analysis can be done with
the application software JDViewer.
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 307, you
can continue your measurement. The measurement settings can be saved and recalled as a file. You
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load
the file on to the instrument.
Procedure

1. Press the MEASURE SETUP hot key.
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2. To set the Pseudo-Noise (PN) offset, complete the following steps:
a.

Toggle the PN Offset soft key between Auto and Manual.

b.

Enter a value by using the numeric keys to set manually.

c.

Press the Enter soft key.

3. To set the incremental step for the PN offset, complete the following steps:
a.

Press the PN Increment soft key.

b.

Enter a value by using the numeric keys.

c.

Press the Enter soft key.

4. To set the threshold between Auto and Manual, complete the following steps:
a.

Press the Threshold soft key. Its default setting is -27 dB.

b.

Enter a value between -50 and zero by using the numeric keys to change the value in the
Manual mode.

c.

Press the Enter soft key.

5. Toggle the Q-Paging soft key between On and Off to enable or disable the quick page channel
that indicates the power of Quick Page Walsh code 80.

6. Press the Alarm Code soft key, and then select the alarm code option: None, Pilot, Page, Sync,
or Quick Page.

7. To set the alarm mask, complete the following steps:
a.

Press the Set Mask soft key.

b.

Enter a value by using the numeric keys.

c.

Press the [dB|dBm] soft key.

8. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available
for your measurement mode. See “Using save” on page 31 for more information.

Measurement example
Figure 153 RCSI measurement with CDMA signal analyzer

Setting display
You can view .your measurement results in a different view option.
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Procedure

1. Press the TRACE/DISPLAY hard key.
2. Press the Code Order soft key, and then select the code order option from the following choices:
–

Hadamard: To assign the number based on Walsh code order and display the measured
code power according to the assigned number in sequence.

–

Bit Reverse: Code number in binary bit is reversed relative to the Hadamard method.

3. Toggle the Base Code Length soft key and select the base Walsh code number: 64 or 128.

CDP Table
The CDP Table is used to look at a numeric and textual description of all the active code channels in
the signal.
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 307, you
can continue your measurement. The measurement settings can be saved and recalled as a file. You
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load
the file on to the instrument.
Procedure

1. Press the MEASURE SETUP hot key.
2. To set the Pseudo-Noise (PN) offset, complete the following steps:
a.

Toggle the PN Offset soft key between Auto and Manual.

b.

Enter a value by using the numeric keys to set manually.

c.

Press the Enter soft key.

3. To set the incremental step for the PN offset, complete the following steps:
a.

Press the PN Increment soft key.

b.

Enter a value by using the numeric keys.

c.

Press the Enter soft key.

4. To set the threshold between Auto and Manual, complete the following steps:
a.

Press the Threshold soft key. Its default setting is -27 dB.

b.

Enter a value between -50 and zero by using the numeric keys to change the value in the
Manual mode.

c.

Press the Enter soft key.

5. Toggle the Q-Paging soft key between On and Off to enable or disable the quick page channel
that indicates the power of Quick Page Walsh code 80.
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Measurement example
Figure 154 CDP Table measurement with CDMA signal analyzer

Setting display
If the CDP table spans over to the next page(s), you can change pages up and down to view .your
measurement results.
Procedure

1. Press the TRACE/DISPLAY hard key.
2. Press the Code Order soft key, and then select the code order option from the following choices:
–

Hadamard: To assign the number based on Walsh code order and display the measured
code power according to the assigned number in sequence.

–

Bit Reverse: Code number in binary bit is reversed relative to the Hadamard method.

3. Toggle the Base Code Length soft key and select the base Walsh code number: 64 or 128.
4. Select Page Up or Page Down as needed to scroll the screen up and down.

Setting limit for modulation tests
Procedure

1. Press the LIMIT hot key.
2. Press the Modulation Test Limits soft key.
3. Select the test item(s) and set the limit(s) depending on your selected measurement mode:
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To set the limit for

Select

Set

Frequency error

Frequency Error

High Limit
Low Limit

Time offset

Time Offset

High Limit
Low Limit
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Waveform quality (Rho)

Rho

Low Limit

Carrier feed through

Carrier Feed Through

High Limit

Pilot power

Pilot Power

High Limit [Abs|Rel]
Low Limit [Abs|Rel]

Highest level among inactive channels

Max Inactive

High Limit

4. Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit.
Toggle the Beep soft key between On and Off to enable or disable the beep sound.

5. Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings.
See “Using save” on page 31 for more information.
NOTE
The Time Offset compares the PN offset timing with the overall system time and the
instrument checks the start of PN offset in comparison to either the GPS signal or the
even second clock signal.
NOTE
The Rho measures the modulation quality for a CDMA transmitter along with EVM and
Walsh Channel Power. It includes all errors occurred along the transmitter chain such as
base band filtering, abnormality of I/Q modulator and distortion in power amplifier. A
perfect Rho value is 1.0 indicating that all of the power is being transmitted correctly.
NOTE
The Carrier Feed Through is a result of the RF carrier signal feeding through the I/Q
modulator and riding on the output circuitry without being modulated.

Performing auto measurements
The Auto Measure function of the JD780A series allows a complete signal profiling covering RF
characterization and modulation quality parameters of up to 10 different carriers, particularly useful on
an overlay architecture where base stations are transmitting in different frequencies.
The Auto Measure can be easily executed either by selecting a menu in the instrument or by running a
programmed scenario in the PC-based application so that the instrument automatically configure and
perform tests on every aspect of all the carriers.

Setting limit for auto measure
You can set test limits for test item(s) in the auto measurement.
Procedure

1. Press the LIMIT hot key.
2. Press the RF Test Limits soft key, and then enable test limits as desired.
3. Press the Modulation Test Limits soft key, and then enable test limits as desired.
4. Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit.
Toggle the Beep soft key between On and Off to enable or disable the beep sound.

5. Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings.
See “Using save” on page 31 for more information.
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Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 307, you
can continue your measurement. The measurement settings can be saved and recalled as a file. You
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load
the file on to the instrument.
Procedure

1. Press the MEASURE SETUP hot key.
2. Toggle the Configuration soft key and select the configuration option:
–

Current: to let the instrumnet use current frequency (single carrier) and determine pass or
fail based on the instrument’s limit settings in Auto Measure.

–

Scenario: to run a test with a programmed scenario in JDViewer.
The Scenario menu becomes activated.

3. To load a scenario, press the Scenario soft key, and then select a scenario file to load.
4. Toggle the Test Time soft key and select the test time option:
–

Now: to let the instrument run a test only once.

–

Schedule: to let the instrument repeat tests as defined in the Set Timing.
The Set Timing menu becomes activated.

5. To define a schedule for an auto measurement, complete the following steps:
a.

Press the Set Timing soft key.

b.

Press the Start Time (HH:MM) soft key.

c.

Enter the time in the HH:MM format, and then press the Enter soft key.

d.

Press the Stop Time (HH:MM) soft key.

e.

Enter the time in the HH:MM format, and then press the Enter soft key.

f.

Press the Time Interval soft key.

g.

Enter the amount of time in minutes, and then press the Enter soft key.

6. To set external offset, complete the following steps:
a.

Toggle the External Offset soft key and select On.

b.

Enter a value by using the numeric keys, and then press the dB soft key.

6. To save your settings and results, go to SAVE/LOAD > Save and then perform functions as you
desire. See “Using save” on page 31 for more information.

7. Press the Run Test soft key to start to run a test.
The Auto Measure Results window appears at the end of the test.

8. To stop running the test, press the Abort soft key.
9. To change the view on the screen during the test, press the Display and then select the view
option from the following choices:

–

Screen: You can view each measurement screen as the test progresses.

–

Results: You can view a measurement result table as the test progresses.

–

Settings: You can view a measurement setting table as the test progresses.

Setting display
After completion of the auto measurement, the screen menu changes to Trace/Display so that you can
view the results in different forms.
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Procedure

1. Toggle the Display soft key and select the display option:
–

Result: to view the result table.
The Display Result menu becomes activated.

–

Settings: to view the measurement settings for the auto measurement.

2. Toggle the Display Result soft key and select the display result option:
–

Full: to view detailed measurement readings with the pass/fail indication.

–

Quick: to view only the Pass/Fail results.

3. To view the measurement results for a different carrier, press the View Carrier soft key and then
select the carrier number to view.

Performing power statistics CCDF measurements
The Power Statistics Complementary Cumulative Distribution Function (CCDF) measurement
characterizes the power statistics of the input signal. It provides PAR (Peak to Average power Ratio)
versus different probabilities.

Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 307, you
can continue your measurement. The measurement settings can be saved and recalled as a file. You
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load
the file on to the instrument.
Procedure

1. Press the MEASURE SETUP hot key.
2. Press the CCDF Length soft key to set the length of the CCDF.
3. Enter a value between 1 and 100 by using the numeric keys. You can also use the rotary knob.
4. Press the Enter soft key.
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Measurement example
Figure 155 CCDF measurement with CDMA signal analyzer

Conducting CDMA OTA measurements
This Over The Air (OTA) measurement has channel scanner, PN scanner, multipath profile, and Code
Domain power screens. It is used to verify CDMA transmitter performance at any location providing
reflective measurements and identifying signals providing from different sites. The Code Domain
power shows not only modulation performance metric but also amplifier capacity and code utilization
metric. The Amplifier capacity (code utilization) measurement is an estimate of the amount of power
amplifier capacity (code utilization) that is being used expressed in percent of maximum.

Channel scanner
Setting channel/frequency
Procedure
To set the channels to be scanned:

1. Press the FREQ/DIST hard key.
2. Toggle the Unit soft key and select Channel.
3. Press the Index soft key, and then enter an index number between one and six by turning the
rotary knob or using the numeric keys.

4. To select the standard channel, complete the following steps:
a.

Press the Channel Std soft key. The standard channel window appears.
See “Appendix C – Band, frequency & channel standard” on page 541 for more information.

b.

Select the band to be measured by using the rotary knob, the arrow keys, or the Page
Up/Page Down soft keys.

c.

Press the Select soft key or the rotary knob to confirm the selection.

5. To set the channel number for the selected index, complete the following steps:
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a.

Press the Channel Number soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.
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c.

Press the Enter soft key.

The instrument displays a corresponding center frequency for the channel number.

6. To set the integration bandwidth for the selected index, complete the following steps:
a.

Press the Integration Bandwidth soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Select the unit: GHz, MHz, kHz, or Hz.

7. To add more channels to be scanned, repeat steps 3-6.
8. Press the ESC hard key to dismiss the channel list window and view the scanning result.
To set the frequencies to be scanned:

1. Press the FREQ/DIST hard key.
2. Toggle the Unit soft key and select Freq.
3. Press the Index soft key, and then enter an index number between one and six by turning the
rotary knob or using the numeric keys.

4. To set the center frequency for the selected index, complete the following steps:
a.

Press the Center Frequency soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Select the unit: GHz, MHz, kHz, or Hz.

5. To set the integration bandwidth for the selected index, complete the following steps:
a.

Press the Integration Bandwidth soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Select the unit: GHz, MHz, kHz, or Hz.

6. To add more channels to be scanned, repeat steps 3-5.
7. Press the ESC hard key to dismiss the channel list window and view the scanning result.
Setting measure setup
After configuring other test parameters as described in the “Configuring test parameters” on page 307,
you can continue your measurement. The measurement settings can be saved and recalled as a file.
You can also use JDViewer, PC application software to configure a measure setup, save as a file, and
load the file on to the instrument.
Procedure

1. Press the MEASURE SETUP hot key.
2. To set the incremental step for the PN offset, complete the following steps:
a.

Press the PN Increment soft key.

b.

Enter a value by using the numeric keys.

c.

Press the Enter soft key.

3. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available
for your measurement mode. See “Using save” on page 31 for more information.
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Setting limit for OTA channel scanner
Procedure

1. Press the LIMIT hot key.
2. Press the Limit Line soft key to set a threshold for the limit line and Pass/Fail indication.
3. Enter a value, and then press the dBm unit soft key.
4. Toggle the Limit Line soft key between On and Off to display or dismiss the limit line.
5. Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit.
Toggle the Beep soft key between On and Off to enable or disable the beep sound.

6. Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings.
See “Using save” on page 31 for more information.

Measurement example
Figure 156 Channel scanner measurement with CDMA OTA signal analyzer

PN scanner
Each access network sector has a unique PN offset. The PN Scanner is used to identify all the active
PNs in an area.
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 307, you
can continue your measurement. The measurement settings can be saved and recalled as a file. You
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load
the file on to the instrument.
Procedure

1. Press the MEASURE SETUP hot key.
2. To set the incremental step for the PN offset, complete the following steps:
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a.

Press the PN Increment soft key.

b.

Enter a value by using the numeric keys.

c.

Press the Enter soft key.

3. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available
for your measurement mode. See “Using save” on page 31 for more information.

Measurement example
Figure 157 PN scanner measurement with CDMA OTA signal analyzer

Multipath profile
The Multipath Profile enables you to determine RF environmental conditions of testing area. It
indicates the amount of power of the dominant pilot signal that is dispersed outside the main
correlation peak due to multipath echoes that are expressed in dB. This value should be very small
ideally.
The multipath profile is the result of portions of the original broadcast signal arriving at the receiving
antenna out of phase. This can be caused by the signal being reflected off objects such as buildings,
or being refracted through the atmosphere differently from the main signal.
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 307, you
can continue your measurement. The measurement settings can be saved and recalled as a file. You
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load
the file on to the instrument.
Procedure

1. Press the MEASURE SETUP hot key.
2. To set the incremental step for the PN offset, complete the following steps:
a.

Press the PN Increment soft key.
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b.

Enter a value by using the numeric keys.

c.

Press the Enter soft key.

3. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available
for your measurement mode. See “Using save” on page 31 for more information.

Measurement example
Figure 158 Multipath profile measurement with CDMA OTA signal analyzer

Code domain power
Channels with high correlation factors are determined to be active channels and are indicated as such
on the display. Once the channels are decoded, the analyzer determines the power of each channel
relative to the total signal power.
This measurement helps to verify that each code channel is operating at its proper level and helps to
identify problems throughout the transmitter design from the coding to the RF section. System
imperfections, such as the non-linearity of amplifiers, will present themselves as an undesired
distribution of power in the code domain.
Setting measure setup
After configuring test parameters as described in “Configuring test parameters” on page 307, you can
continue your measurement. The measurement settings can be saved and recalled as a file. You can
also use JDViewer, PC application software to configure a measure setup, save as a file, and load the
file on to the instrument.
Procedure

1. Press the MEASURE SETUP hot key.
2. To set the Pseudo-Noise (PN) offset, complete the following steps:
a.
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Toggle the PN Offset soft key between Auto and Manual.

Using CDMA Signal Analyzer

JD780A Series Analyzers

b.

Enter a value by using the numeric keys to set manually.

c.

Press the Enter soft key.

3. To set the incremental step for the PN offset, complete the following steps:
a.

Press the PN Increment soft key.

b.

Enter a value by using the numeric keys.

c.

Press the Enter soft key.

4. To set the threshold between Auto and Manual, complete the following steps:
a.

Press the Threshold soft key. Its default setting is -27 dB.

b.

Enter a value between -50 and zero by using the numeric keys to change the value in the
Manual mode.

c.

Press the Enter soft key.

5. Toggle the Q-Paging soft key between On and Off to enable or disable the quick page channel
that indicates the power of Quick Page Walsh code 80.

6. To set the maximum amplifier power, complete the following steps:
a.

Press the Max Amplifier Power soft key.

b.

Enter a value by using the numeric keys.

c.

Press the dBm soft key.

7. To set the pilot power, complete the following steps:
a.

Press the Pilot Power soft key.

b.

Enter a value by using the numeric keys.

c.

Press the dBm soft key.

8. To set the threshold for pilot dominance, complete the following steps:
a.

Press the More (1/2) > Pilot Dominance > soft key.

b.

Enter a value by using the numeric keys.

c.

Press the Enter soft key.
NOTE
Recommended value is 10. Color of the Pilot Dominance indicator on the screen bases
on this setting.

9. To set the threshold for multipath power, complete the following steps:
a.

Press the More (1/2) > Multipath Power < soft key.

b.

Enter a value by using the numeric keys.

c.

Press the Enter soft key.
NOTE
Recommended value is one. Color of the multipath power indicator on the screen bases
on this setting.

10. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available
for your measurement mode. See “Using save” on page 31 for more information.
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Measurement example
Figure 159 Code domain power measurement with CDMA OTA signal analyzer

NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication.

Setting display
You can view .your measurement results in a different view option.
Procedure

1. Press the TRACE/DISPLAY hard key.
2. Press the Code Order soft key, and then select the code order option from the following choices:
–

Hadamard: To assign the number based on Walsh code order and display the measured
code power according to the assigned number in sequence.

–

Bit Reverse: Code number in binary bit is reversed relative to the Hadamard method.

3. Toggle the Base Code Length soft key and select the base Walsh code number: 64 or 128.

Route map
The JD780A Series provides indoor and outdoor mapping function that allows a user to collect data of
points in an indoor or outdoor environment and track the received signals and coverage of RF
transmitters plotting real time directly on top of a loaded floor plan or a map.
Setting measure setup
Procedure

1. If required, connect a GPS receiver to your JD780A series for outdoor mapping.
Indoor mapping does not necessarily need a GPS antenna.

2. Configure test parameters as described in the “Configuring test parameters” on page 307.
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3. To load your map file, complete the following steps:
a.

Plug in your USB drive that has a floor map or .mcf file type created in JDMapCreator.
NOTE
The JDMapCreator converts and resizes any scanned floor plan or layout to fit onto your
instrument’s display. You must save your map files (.mcf) into the “SavedMap” folder of
your USB drive so that you can load them onto your instrument.

b.

Press SAVE/LOAD hot key, and then select Load > Load Map.
See “Using load” on page 34 for more information.

4. Press the MEASURE SETUP hot key.
5. Press the Plot Point soft key, and then select the plot point option from the following choices:
–

To collect data/plot points automatically as you move around in a vehicle or outside, press
the GPS soft key and then toggle the Screen Mode soft key between Map and Full.
NOTE
With the Map setting, you can view only the collected points that can be seen within the
boundary of the loaded map. If a point is off the map, the instrument displays an arrow to
indicate the direction of the current location on the map and the distance from the center
to the location at the top of the screen. With the Full setting, you can view all the
collected points of the route without the loaded map.

–

To collect data/plot points manually without a GPS antenna in an indoor environment, press
the Position soft key.

6. Press the Plot Item soft key, and then select the measurement option: Pilot Power or Ec/Io.
7. To set the incremental step for the PN offset, complete the following steps:
a.

Press the PN Increment soft key.

b.

Enter a value by using the numeric keys.

c.

Press the Enter soft key.

8. Toggle the Plot soft key and select Start.
9. Touch directly on the screen or press the ENTER hard key to collect data and plot points on the
loaded map for the Position setting.
NOTE
For the Position setting, you can change the direction of the route with the arrow keys
and the distance with the rotary knob.

10. Toggle the Plot soft key and select Stop to stop plotting.
11. Press the SAVE/LOAD hot key to save the result.
See “Using save” on page 31 for more information.
NOTE
The instrument does not automatically save the collected data. It is recommended that
you save the result. Otherwise, you will lose all the collected data.

Setting limit
You can set the thresholds for the four different color indicators for Pilot power or Ec/Io.
Procedure

1. Press the LIMIT hot key.
2. To set the limits for pilot power if you have selected Pilot for the plot item, complete the following
steps:
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a.

Press the Pilot Power soft key.

b.

Press the Excellent soft key to set its threshold.

c.

Enter a value, and then press the dBm soft key. You can also use the rotary knob.

d.

Press the Very Good soft key to set its threshold.

e.

Enter a value, and then press the dBm soft key. You can also use the rotary knob.

f.

Press the Good soft key to set its threshold.

g.

Enter a value, and then press the dBm soft key. You can also use the rotary knob.

h.

Press the Fair soft key to set its threshold.

i.

Enter a value, and then press the dBm soft key. You can also use the rotary knob.

j.

Press the Poor soft key to set its threshold.

k.

Enter a value, and then press the dBm soft key. You can also use the rotary knob.

3. To set the limits for Ec/Io if you have selected as for the plot item , complete the following steps:
a.

Press the Ec/Io soft key.

b.

Press the Good soft key to set its threshold.

c.

Enter a value, and then press the Enter soft key. You can also use the rotary knob.

d.

Press the Fair soft key to set its threshold.

e.

Enter a value, and then press the Enter soft key. You can also use the rotary knob.

f.

Press the Poor soft key to set its threshold.

g.

Enter a value, and then press the Enter soft key. You can also use the rotary knob.

4. Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings.
See “Using save” on page 31 for more information.

Measurement example
Figure 160 Route map measurement with CDMA OTA signal analyzer
1) Pilot Power
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2) Pilot Ec/Io
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Using EV-DO Signal Analyzer
This chapter provides instructions for using the EV-DO Signal Analyzer function (option 021) with the
EV-DO OTA Analyzer function (option 041). Topics discussed in this chapter are as follows:
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Introduction
The EV-DO Signal Analyzer of the JD780A series performs power and spectrum measurements as
well as modulation analysis to test the proper transmitter performance of EV-DO systems. It performs
conformance testing according to the following standards providing a simple Pass/Fail indication on
each test.


3GPP2 C.S0024-B. cdma2000 High Rate Packet Data Air Interface Specification



3GPP2 C.S0032-B. Recommended Minimum Performance Standards for cdma2000 High
Rate Packet Data Access Network

You may alter the measurement parameters for specialized analysis. Pass/Fail testing with standard
defined or user defined upper and lower limits and the Pass/Fail indictor help you to determine base
station performance easily.
This instrument provides the following measurement tools for EV-DO system:


Spectrum Analysis



RF Analysis
Channel Power
Occupied Bandwidth
Spectrum Emission Mask (SEM)
Adjacent Channel Power Ratio (ACLR)
Multi-ACPR
Spurious Emissions



Power vs. Time: Idle Slot and Active Slot



Modulation Analysis
Constellation
Code Domain Power
MAC Codogram
Received Code Strength Indicator (RCSI)
MAC CDP Table



Auto Measure



Power Statistics CCDF



Over The Air (OTA)
Channel Scanner
PN Scanner
Multipath Profile
Code Domain Power
Route Map

Display overview
Figure 161 provides descriptions for each segment of the measurement screen.
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Figure 161 EV-DO signal analyzer measurement screen

Connecting a cable
Direct connection
Procedure

1. Connect the Spectrum Analyzer RF In port of the JD780A series and the Power amplifier output
port of BTS.

Figure 162 Direct connection

JD785A/JD786A

JD788A

Indirect connection
Procedure

1. Connect the Spectrum Analyzer RF In port of the JD780A series and the monitor (test) port of
BTS.
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Figure 163 Indirect connection

JD785A/JD786A

JD788A

CAUTION
The maximum power for the Spectrum Analyzer RF In port is +25 dBm (0.316 W). If the
input signal level to be measured is greater than +25 dBm, use a High Power
Attenuator to prevent damage when you directly connect the signal to the instrument or
connect the signal from the coupling port of a directional coupler.

Over the air (OTA)
Procedure

1. Connect an Omni/directional RF antenna to the Spectrum Analyzer RF In port of the JD780A
series.

2. Connect a GPS antenna to the GPS port of the JD780A series.
Figure 164 OTA connection

JD785A/JD786A

JD788A

CAUTION
If the input signal level to be measured is less than 0 dBm, set 0 dB attenuation or turn on
the preamp to have better dynamic range for the OTA testing.
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Selecting measurement mode
Procedure

1. Press the MODE hard key.
2. Press the Signal Analyzer soft key.
3. Press the EV-DO soft key. The Spectrum mode is set by default.
4. Press the MEASURE hot key, and then select the measurement mode option from the following
choices:

–

Spectrum

–

RF Analysis > Channel Power, Occupied BW, Spectrum Emission Mask, ACPR,
Multi-ACPR, or Spurious Emissions

–

Power vs Time > Power vs Time (Idle Slot) or Power vs Time (Active Slot)

–

Modulation Analysis > Constellation > Composite 64, Composite 128, Pilot, MAC 64, MAC
128, or Data

–

Modulation Analysis > Code Domain Power > Pilot, MAC 64, MAC 128, or Data

–

Modulation Analysis > MAC Codogram, RCSI, or MAC CDP Table

–

Auto Measure

–

Power Statistics CCDF

–

OTA > Channel Scanner, PN Scanner, Multipath Profile, Code Domain Power, or
Route Map

Configuring test parameters
Setting frequency
You can set the frequency with either frequency or channel number. If a frequency to be set matches
to the frequency corresponding to the selected channel standard, the instrument calculates its channel
number and updates the screen with it automatically.
Procedure
To set the center frequency:

1. Press the FREQ/DIST hard key.
2. Toggle the Unit soft key and select Freq.
3. Press the Center Frequency soft key.
4. Enter a value by using the numeric keys. You can also use the rotary knob.
5. Select the unit: GHz, MHz, kHz, or Hz.
6. Optional. To define the amount of frequency increment for the rotary knob, complete the following
steps:
a.

Press the Frequency Step soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Press the unit: GHz, MHz, kHz, or Hz.

To set the channel number:

1. Press the FREQ/DIST hard key.
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2. Toggle the Unit soft key and select Channel.
3. To select the standard channel, complete the following steps:
a.

Press the Channel Std soft key. The standard channel window appears.
See “Appendix C – Band, frequency & channel standard” on page 541 for more information.

b.

Select the band to be measured by using the rotary knob, the arrow keys, or the Page
Up/Page Down soft keys.

c.

Press the Select soft key or the rotary knob to confirm the selection.

4. Press the Channel Number soft key.
5. Enter a value by using the numeric keys. You can also use the rotary knob.
6. Press the Enter soft key.
The instrument automatically displays the corresponding center frequency value for the selected
channel number.

7. Optional. To define the amount of channel increment for the rotary knob, complete the following
steps:
a.

Press the Channel Step soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Press the Enter soft key.

NOTE
This frequency setting is not used in the Multi-ACLR and Spurious Emissions modes.

Setting amplitude
Reference level and attenuation
You can set the reference and attenuation levels automatically or manually to optimize the display of
the traces measured, as you desire.
Procedure
To automatically set the reference and attenuation level:

1. Press the AMP/SCALE hard key.
2. Press the Auto Scale soft key.
Each time you press this key, both of the Y-axis scale and input attenuation level change to be
optimized with some margin.
To set the reference or attenuation level manually:

1. Press the AMP/SCALE hard key.
2. To set the maximum reference value on the Y-axis manually, complete the following steps:
a.

Press the Reference Level soft key.

b.

Enter a value by using the numeric keys or the rotary knob with 10 dB increments.

c.

Press the dBm soft key or the ENTER hard key.
NOTE
In the measurements such as Code Domain Power and MAC Codogram, you may
need to select the reference option between Relative and Absolute before setting the
reference level.

3. To set the attenuation option, select one from the following choices:
–

To set the input attenuator’s level automatically, select Attenuation > Auto.
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NOTE
It is recommended that you set the Attenuation to Auto in most situations so that the
level of the input attenuator can be set automatically according to your input signal level.

–

To set the input attenuation manually up to 55 dB to optimize S/N, complete the following
steps:

–

a.

Select Attenuation > Manual.

b.

Press the Attenuation Value soft key to set the level.

c.

Enter a value between 0 and 55 in fives by using the numeric keys.

d.

Press the dB soft key or the ENTER hard key.

To couple the input attenuator’s level with your reference level setting, select Attenuation >
Couple.
As you increse the reference setting, the attenuation level also increases acoordingly.

Optional. To change the scale unit:

1. Select More (1/2) > Units.
2. Select the unit of the display scale: dBm, dBV, dBmV, dBµV, V, or W.
The scale unit on the screen changes accordingly.
NOTE
This Units menu is available in the Spectrum and RF Analysis modes.

Scale per division
You can use the Scale/Div feature available for the spectrum and RF analysis. It represents the value
of one division on the horizontal scale. The default setting is 10 dB per division and the maximum
value can be set up to 20 dB.
Procedure
To set the scale per division:

1. Press the AMP/SCALE hard key.
2. Select More (1/2) > Scale/Div.
3. Enter a value between 1 and 20 by using the numeric keys.
4. Press the dB soft key to complete the entry.
Pre-amplifier
You can turn the internal pre-amplifier on to correct and compensate for the gain of the preamp so that
amplitude readings show the value at the input connector.
Procedure

1. Press the AMP/SCALE hard key.
2. Toggle the Preamp soft key and select On or Off as needed.
NOTE
You can turn the Preamp on when the input attenuation range is from 0 dB to 10 dB. If
the attenuation value is manually set to greater than 10 dB, the instrument will
automatically turn off the pre-amplifier to display low-level signal properly on the chart.
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External offset
You can turn the External Offset on and manually set the external offset value. An offset consists of a
cable loss and a user offset and the measurement result shows the value reflecting both offset values.
When the external offset value is set at 40 dB in the Spectrum mode, the measurement result
compensates 40 dB at both the Spectrum Analyzer and Signal Analyzer modes
Procedure
To set the external offset:

1. Press the AMP/SCALE hard key.
2. Toggle the External Offset soft key and select On.
3. Enter a value by using the numeric keys.
4. Press the dB soft key to complete the entry.
To turn the external offset off:

1. Press the AMP/SCALE hard key.
2. Toggle the External Offset soft key and select Off.

Setting average
You can set the number of measurements to be averaged for the trace presentation. A maximum of
100 times of averaging can be set. When the averaging reaches to your setting, a new measurement
value replaces the measurement value in sequence from the earliest.
Procedure

1. Press the BW/AVG hard key.
2. Press the Average soft key.
3. Enter a value between 1 and 100 as needed by using the numeric keys.
4. Press the Enter soft key.

Setting sweep mode
The default settings of the sweep mode are Continue and Normal to sweep continuously at a normal
speed for most on-going measurements. If you want to hold the measurement or get a single sweep,
you can change the sweep mode.
Procedure
To select the single sweep mode:

1. Press the SWEEP hot key.
2. Toggle the Sweep Mode soft key and select Single. You can also use the HOLD hot key.
The letter HOLD in red appears and the sweeping is paused.

3. Optional. Press the Sweep Once soft key to get a new measurement.
To return to the continuous sweep mode:

1. Toggle the Sweep Mode soft key and select Continue. You can also use the HOLD hot key.
The letter HOLD in red disappears and the sweeping resumes.
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Setting trigger source
You can set the trigger source option for your measurements. Connecting an external trigger is
necessary for accurate modulation measurements on EV-DO systems.
Procedure

1. Press the TRIGGER hot key.
2. Select the trigger source option from the following choices: Internal, External, or GPS.

Setting external clock
To enhance the reliability of modulation analysis measurements the JD780A series must be
synchronized with a base station. When an external clock is not supplied, the instrument works with its
built-in internal high-accuracy time base and some measurement results may exhibit inaccurate values.
Therefore, it is highly recommended that you use the same reference clock as the signal source. You
can use the TRIGGER hot key to set the external clock.
Table 18

Standards of external clock operation

Clock

Type

Reference

External Reference

Internal

Internal 10 MHz

External

External Ref Clock

Ext Ref (SMA)

Manual switching
(Input signal level >-3 dBm)

GPS

GPS Clock

GPS (SMA)

Automatic switching
(GPS signal received)

Internal

Internal Trigger

External

External Trigger

Trigger (SMA)

Manual switching

GPS

GPS

GPS (SMA)

Manual switching

Trigger

Port

Switching Standard
Default

Default

Figure 165 Connection ports for external reference clock

Procedure

1. Connect an external reference or a GPS antenna to the JD780A series.
2. Press the SYSTEM hot key.
3. Press the Freq Reference soft key, and then select the reference option: Internal, External 10
MHz, External 13 MHz, External 15 MHz, or GPS.
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NOTE
When a GPS antenna is connected and locked, GPS coordinates (longitude and latitude)
are displayed on the screen and frequency reference is automatically set to GPS in the
System > Freq Reference.

Table 19
Type

External reference indicators
Indicator

Description

Internal

(green)

The green INT icon indicates that the instrument uses the built-in
internal time base.

External

(green)

The green EXT icon indicates that an external reference is connected
and locked and that the instrument uses the same reference clock as
the signal source.

External

(red)

The red EXT icon indicates that an external reference is connect but not
locked.

GPS

(green)

The green GPS antenna icon indicates that a GPS antenna is
connected and locked.

GPS

(yellow)

The yellow GPS antenna icon indicates that a GPS antenna is
connected and locking is in progress.

GPS

(grey)

The grey GPS antenna icon indicates that a GPS antenna is not
connected, failed, or unable to be locked.

Conducting spectrum measurements
If you have configured test parameters as described in the “Configuring test parameters” on page 346,
your measurement result is displayed on the screen as like the following example, Figure 166.
Figure 166 Spectrum measurement screen with EV-DO signal analyzer

Setting trace
You can display up to six traces on the measurement chart simultaneously.
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Procedure

1. Press the TRACE/DISPLAY hard key.
2. Press the Select Trace soft key, and then select the trace number: T1, T2, T3, T4, T5, or T6.
The legend shape of the selected trace changes from square to round to indicate that the trace is
the active one now.

3. Toggle the Trace View soft key and select On.
4. To clear, write or capture, or hide the trace(s), do one of the following:
To

Select

Trace Legend

Clear current data and display with new
measurements

Clear Write

W

Display the input signal’s maximum response only

Max Hold

M

Display the input signal’s minimum response only

Min Hold

m

Capture the selected trace and compare traces

Capture

C

Load a saved trace

More (1/2) > Load

L

Hide the selected trace

Trace View > Off

F

Remove all the traces and initialize the trace
settings

More (1/2) > Trace
Clear All

5. Optional. Press the More (1/2) > Trace Info soft key, and then select the trace number to view
the trace’s parameter setting information stored at the time of the measurement or None to hide
the information display.

6. Optional. If you have the two traces T1 and T2, you can perform trace math. To view the power
difference between the traces, press the T1 – T2 -> T5 or T2 – T1 -> T6 soft key.
The result is overlaid on the screen along with the second Y-axis.

Conducting RF measurements
Channel power
The Channel Power measurement is a common test used in the wireless industry to measure the total
transmitted power of a radio within a defined frequency channel. It acquires a number of points
representing the input signal in the time domain, transforms this information into the frequency domain
using Fast Fourier Transform (FFT), and then calculates the channel power. The effective resolution
bandwidth of the frequency domain trace is proportional to the number of points acquired for the FFT.
The channel power measurement identifies the total RF power, power spectral density (PSD) and peak
to average ratio (PAR) of the signal in the EV-DO channel bandwidth (1.23 MHz).
After configuring test parameters as described in the “Configuring test parameters” on page 346, your
measurement result is displayed on the screen as like the following example, Figure 167.

352

Using EV-DO Signal Analyzer

JD780A Series Analyzers

Figure 167 Channel power measurement with EV-DO signal analyzer

NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 358 for more
information.

Occupied bandwidth
The Occupied Bandwidth measures the spectrum shape of the carrier. It is defined as the bandwidth,
which includes 99% of the transmitted power among total transmitted power.
After configuring test parameters as described in the “Configuring test parameters” on page 346, your
measurement result is displayed on the screen as like the following example, Figure 168.
Figure 168 Occupied bandwidth measurement with EV-DO signal analyzer
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NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 358 for more
information.

Spectrum emission mask (SEM)
The Spectrum Emission Mask (SEM) measurement required by 3GPP2 specifications encompasses
different power limits and different measurement bandwidths (resolution bandwidths) at various
frequency offsets. It may be expressed as a ratio of power spectral densities between the carrier and
the specified offset frequency band. It provides useful figures-of-merit for the spectral re-growth and
emissions produced by components and circuit blocks, without the rigor of performing a full SEM
measurement.
The SEM measures spurious signal levels in up to five pairs of offset or region frequencies and relates
them to the carrier power.
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 346, your
measurement result is displayed on the screen as like the following example, Figure 169.
Figure 169 SEM measurement with EV-DO signal analyzer

NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 358 for more
information.

ACPR
The Adjacent Channel Power Ratio (ACPR) is defined as the ratio of the average power in the
adjacent frequency channel (or offset) to the average power in the transmitted frequency channel. It
may be expressed as the ratio of the integrated signal power in the adjacent channel to the integrated
signal power in the main channel.
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After configuring test parameters as described in the “Configuring test parameters” on page 346, your
measurement result is displayed on the screen as like the following example, Figure 170.
Figure 170 ACPR measurement with EV-DO signal analyzer

NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 358 for more
information.

Multi-ACPR
The Multi-ACPR measurement is used to perform multi-channel ACPR measurements with as many
channels as possible. It helps you to measure ACPR in multi-channel transmitting Base Station
environment.
Setting frequency for Multi-ACPR
You can set the frequency with either frequency or channel number.
Procedure

1. Press the MEASURE SETUP hot key.
2. To set the frequency, do one of the following:
–

–

To set the center frequency, complete the following steps:
a.

Toggle the Unit soft key and select Freq.

b.

Press the Lowest Frequency soft key to set the starting center frequency.

c.

Enter a value by using the numeric keys. You can also use the rotary knob.

d.

Select the unit: GHz, MHz, kHz, or Hz.

e.

Press the Highest Frequency soft key to set the stopping center frequency.

f.

Enter a value by using the numeric keys. You can also use the rotary knob.

g.

Select the unit: GHz, MHz, kHz, or Hz.

To set the channel number, complete the following steps:
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a.

Toggle the Unit soft key and select Channel.

b.

To select the standard channel, press the Channel Std soft key and then select the
band to be measured.

c.

Press the Lowest Channel soft key to set the starting channel.

d.

Enter a value by using the numeric keys. You can also use the rotary knob.

e.

Press the Enter soft key.

f.

Press the Highest Channel soft key to set the stopping channel.

g.

Enter a value by using the numeric keys. You can also use the rotary knob.

h.

Press the Enter soft key.

After configuring the test parameters, your measurement result is displayed on the screen as like the
following example, Figure 171.
Figure 171 Multi-ACPR measurement with EV-DO signal analyzer

NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 358 for more
information.

Spurious emissions
Out-of-band emissions are unwanted emissions immediately outside the channel bandwidth resulting
from the modulation process and non-linearity in the transmitter but excluding spurious emissions. The
Spurious Emissions measurement is to identify and determine the power level of out-of-band spurious
emission within the necessary channel bandwidth and modulated signal measured at the RF port of
the Base Station.
Setting measure setup
Procedure

1. Press the MEASURE SETUP hot key.
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2. To set up the range table and frequency range, press the Range Table soft key and then
complete the following steps:
a.

Press the Range soft key, and then enter the range number to add a new range or change
an existing one.

b.

Press the Enter soft key.

c.

Press the Start Frequency soft key to set up the frequency range.

d.

Enter a value by using the numeric keys. You can also use the rotary knob.

e.

Select the unit: GHz, MHz, kHz, or Hz.

f.

Press the Stop Frequency soft key to set up the frequency range.

g.

Enter a value by using the numeric keys. You can also use the rotary knob.

h.

Select the unit: GHz, MHz, kHz, or Hz.

3. Toggle the Range soft key between On and Off to display or hide the selected range.
4. To set up the test limits for Pass/Fail indication, complete the following steps:
a.

Press the Start Limit soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Select the dBm soft key.

d.

Press the Stop Limit soft key.

e.

Enter a value by using the numeric keys. You can also use the rotary knob.

f.

Select the dBm soft key.

5. To set up the other parameters, complete the following steps:
a.

Select More (1/2) > Attenuation to set up the attenuation value.

b.

Enter a value in the multiple of five.

c.

Press the dB soft key or the ENTER hard key.

d.

Press the RBW soft key.

e.

Enter a value by using the numeric keys.

f.

Select the unit: GHz, MHz, kHz, or Hz.

g.

Press the VBW soft key.

h.

Enter a value by using the numeric keys.

i.

Select the unit: GHz, MHz, kHz, or Hz.

6. Press the PREV hard key.
7. Toggle the Measure Type soft key between Examine and Full to select the measurement type.
NOTE
The Examine mode displays only the selected range while the Full mode lets the
instrument automatically changes the selected range from one another.

8. Set the number of measurements to be averaged:
a.

Press the Average soft key.

b.

Enter a value between 1 and 100.

c.

Press the Enter soft key.

After configuring test parameters as described in the “Configuring test parameters” on page 346, your
measurement result is displayed on the screen as like the following example, Figure 172.
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Figure 172 Spurious emissions measurement with EV-DO signal analyzer

NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 358 for more
information.

Setting limit for RF tests
By default, test limits specified in the standard are set for you. You can change thresholds if you desire.
Procedure

1. Press the LIMIT hot key.
2. Press the RF Test Limits soft key.
3. Select the test item(s) and set the limit(s) depending on your selected measurement mode:
To set the limit for

Select

Set

Channel power

Channel Power

High Limit
Low Limit

Occupied bandwidth

Occupied BW

High Limit

Spectrum emission mask

Spectrum Emission Mask

(On/Off only)

ACPR

ACPR

(On/Off only)

Multi-ACPR

Multi-ACPR

(On/Off only)

Spurious emissions

Spurious Emissions

(On/Off only)

4. Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit.
Toggle the Beep soft key between On and Off to enable or disable the beep sound.

5. Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings.
See “Using save” on page 31 for more information.
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Conducting power vs. time measurements
The Power vs. Time (Idle Slot and Active Slot) in EV-DO Signal Analyzer verifies that the transmitter
output power has correct amplitude, shape, and timing for the EV-DO format.


Idle Slot: Slot with no data in traffic channel.



Active Slot: Slot with the loaded data in traffic channel.

Forward link of 1xEV-DO is a frame structure and each frame consists of 16 slots. The frame period for
1xEV-DO is 26.667 ms, which is also the period of one pilot channel. Each frame is divided into 16
slots of 1.666 ms. 1xEV-DO uses CDMA modulation scheme, but unlike its previous systems the Pilot,
MAC (Media Access Control), and Data (Traffic) Channel are not transmitted simultaneously; instead
they are transmitted in TDM (Time Division Multiplex).

Power vs. time (idle slot)
The Power vs. Time (Idle Slot) measurement provides the idle slot that includes the Pilot and MAC
channels with the masks in all regions.
After configuring test parameters as described in the “Configuring test parameters” on page 346, your
measurement result is displayed on the screen as like the following example, Figure 173.
Figure 173 Power vs. time (idle slot) measurement with EV-DO signal analyzer

NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication. See “Setting limit for power vs. time tests” on page 360 for
more information.

Power vs. time (active slot)
The Power vs. Time (Active Slot) measurement includes the Pilot, MAC, and Data channels with the
upper and lower masks.
After configuring test parameters as described in the “Configuring test parameters” on page 346, your
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measurement result is displayed on the screen as like the following example, Figure 174.
Figure 174 Power vs. time (active slot) measurement with EV-DO signal analyzer

NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication. See “Setting limit for power vs. time tests” on page 360 for
more information.

Setting limit for power vs. time tests
Procedure

1. Press the LIMIT hot key.
2. Press the PvsT Test Limits soft key.
3. Select the test item(s) and set the limit(s):
To set the limit for

Select

Set

Pilot power

Pilot Power

High Limit
Low Limit

Medium access control power

MAC Power

High Limit
Low Limit

Data power during the data period

Data Power

High Limit
Low Limit

On/off power ratio of the pilot and MAC
powers to the data power

On/Off Ratio

Low Limit

4. Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit.
Toggle the Beep soft key between On and Off to enable or disable the beep sound.

5. Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings.
See “Using save” on page 31 for more information.
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Conducting modulation measurements
In order to make accurate measurements of time offset and PN, you must connect an external trigger
before making a modulation measurement.

Constellation
The Constellation is used to observe some aspects of modulation accuracy and can reveal certain
fault mechanisms such as I/Q amplitude imbalance or quadrature imbalance. It displays constellation
diagram by modulation types.
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 346, you
can continue your measurement. The measurement settings can be saved and recalled as a file. You
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load
the file on to the instrument.
Procedure

1. Press the MEASURE SETUP hot key.
2. To set the Pseudo-Noise (PN) offset, complete the following steps:
a.

Toggle the PN Offset soft key between Auto and Manual.

b.

Enter a value by using the numeric keys to set manually.

c.

Press the Enter soft key.

3. To set the incremental step for the PN offset, complete the following steps:
a.

Press the PN Increment soft key.

b.

Enter a value by using the numeric keys.

c.

Press the Enter soft key.

4. Press the Detect Mode soft key, and then select the detection mode option: Auto, QPSK, 8PSK,
16 QAM, or 64 QAM.

5. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available
for your measurement mode. See “Using save” on page 31 for more information.
NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 370 for
more information. The Max Inactive is not used in the Constellation mode.
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Measurement example
Figure 175 Constellation measurement with EV-DO signal analyzer
1) Composite 64

2) Composite 128
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3) Pilot

4) MAC 64

5) MAC 128
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6) Data

Code domain power
The Code Domain Power (CDP) measures the distribution of power across the set of code channels,
normalized to the total EV-DO power. It helps to verify that each code channel is operating at its proper
level and to identify problems throughout the transmitter design from coding to the RF section. System
imperfections such as amplifier non-linearity will present themselves as an undesired distribution of
power in the code domain.
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 346, you
can continue your measurement. The measurement settings can be saved and recalled as a file. You
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load
the file on to the instrument.
Procedure

1. Press the MEASURE SETUP hot key.
2. To set the Pseudo-Noise (PN) offset, complete the following steps:
a.

Toggle the PN Offset soft key between Auto and Manual.

b.

Enter a value by using the numeric keys to set manually.

c.

Press the Enter soft key.

3. To set the incremental step for the PN offset, complete the following steps:
a.

Press the PN Increment soft key.

b.

Enter a value by using the numeric keys.

c.

Press the Enter soft key.

4. To set the threshold between Auto and Manual, complete the following steps:
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a.

Press the Threshold soft key. Its default setting is -27 dB.

b.

Enter a value between -50 and zero by using the numeric keys to change the value in the
Manual mode.

c.

Press the Enter soft key.
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5. Press the Detect Mode soft key, and then select the detection mode option: Auto, QPSK, 8PSK,
16 QAM, or 64 QAM.

6. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available
for your measurement mode. See “Using save” on page 31 for more information.
NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication for the Max Inactive. See “Setting limit for modulation tests”
on page 370 for more information.

Measurement example
Figure 176 Code domain power measurement with EV-DO signal analyzer
1) Pilot

2) MAC 64
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3) MAC 128

4) Data

MAC Codogram
The MAC Codogram displays the power variation for every code over time, presenting a clear view of
the traffic load per channels at any given time. The MAC Codogram measurements can be saved into
an external USB memory so that a post-analysis can be done with the application software JDViewer.
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 346, you
can continue your measurement. The measurement settings can be saved and recalled as a file. You
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load
the file on to the instrument.
Procedure

1. Press the MEASURE SETUP hot key.
2. To set the Pseudo-Noise (PN) offset, complete the following steps:
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a.

Toggle the PN Offset soft key between Auto and Manual.

b.

Enter a value by using the numeric keys to set manually.

c.

Press the Enter soft key.

3. To set the incremental step for the PN offset, complete the following steps:
a.

Press the PN Increment soft key.

b.

Enter a value by using the numeric keys.

c.

Press the Enter soft key.

4. To set the threshold between Auto and Manual, complete the following steps:
a.

Press the Threshold soft key. Its default setting is -27 dB.

b.

Enter a value between -50 and zero by using the numeric keys to change the value in the
Manual mode.

c.

Press the Enter soft key.

5. Toggle the MAC soft key and select the MAC Walsh code option: 64 or 128.
6. To set the time interval, complete the following steps:
a.

Press the Time Interval soft key.

b.

Enter a value by using the numeric keys.

c.

Press the Enter soft key.

7. To place the time cursor to analyze your measurements, complete the following steps:
a.

Toggle the Time Cursor soft key between On and Off to enable or disable the time cursor.

b.

Enter a value by using the numeric keys.

c.

Press the Enter soft key.
NOTE
When the time cursor is enabled, the measurement is put on hold and information about
the time cursor is displayed.

8. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available
for your measurement mode. See “Using save” on page 31 for more information.

Measurement example
Figure 177 MAC Codogram in full view with EV-DO signal analyzer
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RCSI
The Received Code Strength Indicator (RCSI) is used to track the power variation over time of EV-DO
channels: Pilot, MAC, Data, and Slot. The RCSI measurements can be saved into an external USB
memory so that a post-analysis can be done with the application software JDViewer.
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 346, you
can continue your measurement. The measurement settings can be saved and recalled as a file. You
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load
the file on to the instrument.
Procedure

1. Press the MEASURE SETUP hot key.
2. To set the Pseudo-Noise (PN) offset, complete the following steps:
a.

Toggle the PN Offset soft key between Auto and Manual.

b.

Enter a value by using the numeric keys to set manually.

c.

Press the Enter soft key.

3. To set the incremental step for the PN offset, complete the following steps:
a.

Press the PN Increment soft key.

b.

Enter a value by using the numeric keys.

c.

Press the Enter soft key.

4. To set the threshold between Auto and Manual, complete the following steps:
a.

Press the Threshold soft key. Its default setting is -27 dB.

b.

Enter a value between -50 and zero by using the numeric keys to change the value in the
Manual mode.

c.

Press the Enter soft key.

5. Toggle the MAC soft key and select the MAC Walsh code option: 64 or 128.
6. Press the Alarm Code soft key, and then select the alarm code option: None, Pilot, MAC, Data,
or Slot.

7. To set the alarm mask, complete the following steps:
a.

Press the Set Mask soft key.

b.

Enter a value by using the numeric keys.

c.

Press the [dB|dBm] soft key.

8. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available
for your measurement mode. See “Using save” on page 31 for more information.
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Measurement example
Figure 178 RCSI measurement with EV-DO signal analyzer

MAC CDP Table
The MAC CDP Table is used for the user to look at a numeric and textual description of all the active
control channels in the signal.
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 346, you
can continue your measurement. The measurement settings can be saved and recalled as a file. You
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load
the file on to the instrument.
Procedure

1. Press the MEASURE SETUP hot key.
2. To set the Pseudo-Noise (PN) offset, complete the following steps:
a.

Toggle the PN Offset soft key between Auto and Manual.

b.

Enter a value by using the numeric keys to set manually.

c.

Press the Enter soft key.

3. To set the incremental step for the PN offset, complete the following steps:
a.

Press the PN Increment soft key.

b.

Enter a value by using the numeric keys.

c.

Press the Enter soft key.

4. To set the threshold between Auto and Manual, complete the following steps:
a.

Press the Threshold soft key. Its default setting is -27 dB.

b.

Enter a value between -50 and zero by using the numeric keys to change the value in the
Manual mode.

c.

Press the Enter soft key.

5. Toggle the MAC soft key and select the MAC Walsh code option: 64 or 128.
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Measurement example
Figure 179 MAC CDP Table measurement with EV-DO signal analyzer

Setting display
If the MAC CDP table spans over to the next page(s), you can change pages up and down to
view .your measurement results.
Procedure

1. Press the TRACE/DISPLAY hard key.
2. Select Page Up or Page Down as needed to scroll the screen up and down.

Setting limit for modulation tests
Procedure

1. Press the LIMIT hot key.
2. Press the Modulation Test Limits soft key.
3. Select the test item(s) and set the limit(s) depending on your selected measurement mode:
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To set the limit for

Select

Set

Frequency error

Frequency Error

High Limit
Low Limit

Time offset

Time Offset

High Limit
Low Limit

Carrier feed through

Carrier Feed Through

High Limit

Highest level among inactive channels

Max Inactive

High Limit

Waveform quality (Rho) for pilot

Pilot Rho

Low Limit

Waveform quality (Rho) for MAC

MAC Rho

Low Limit

Waveform quality (Rho) for data

Data Rho

Low Limit
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4. Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit.
Toggle the Beep soft key between On and Off to enable or disable the beep sound.

5. Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings.
See “Using save” on page 31 for more information.
NOTE
The Time Offset compares the PN offset timing with the overall system time and the
instrument checks the start of PN offset in comparison to either the GPS signal or the
even second clock signal.
NOTE
The Carrier Feed Through is a result of the RF carrier signal feeding through the I/Q
modulator and riding on the output circuitry without being modulated.

Performing auto measurements
The Auto Measure function of the JD780A series allows a complete signal profiling covering RF
characterization and modulation quality parameters of up to 10 different carriers, particularly useful on
an overlay architecture where base stations are transmitting in different frequencies.
The Auto Measure can be easily executed either by selecting a menu in the instrument or by running a
programmed scenario in the PC-based application so that the instrument automatically configure and
perform tests on every aspect of all the carriers.

Setting limit for auto measure
You can set test limits for test item(s) in the auto measurement.
Procedure

1. Press the LIMIT hot key.
2. Press the RF Test Limits soft key, and then enable test limits as desired.
3. Press the PvsT Test Limits soft key, and then enable test limits as desired.
4. Press the Modulation Test Limits soft key, and then enable test limits as desired.
5. Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit.
Toggle the Beep soft key between On and Off to enable or disable the beep sound.

6. Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings.
See “Using save” on page 31 for more information.

Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 346, you
can continue your measurement. The measurement settings can be saved and recalled as a file. You
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load
the file on to the instrument.
Procedure

1. Press the MEASURE SETUP hot key.
2. Toggle the Configuration soft key and select the configuration option:
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–

Current: to let the instrumnet use current frequency (single carrier) and determine pass or
fail based on the instrument’s limit settings in Auto Measure.

–

Scenario: to run a test with a programmed scenario in JDViewer.
The Scenario menu becomes activated.

3. To load a scenario, press the Scenario soft key, and then select a scenario file to load.
4. Toggle the Test Time soft key and select the test time option:
–

Now: to let the instrument run a test only once.

–

Schedule: to let the instrument repeat tests as defined in the Set Timing.
The Set Timing menu becomes activated.

5. To define a schedule for an auto measurement, complete the following steps:
a.

Press the Set Timing soft key.

b.

Press the Start Time (HH:MM) soft key.

c.

Enter the time in the HH:MM format, and then press the Enter soft key.

d.

Press the Stop Time (HH:MM) soft key.

e.

Enter the time in the HH:MM format, and then press the Enter soft key.

f.

Press the Time Interval soft key.

g.

Enter the amount of time in minutes, and then press the Enter soft key.

6. Press the Settings soft key, and then set the following:
a.

Toggle the MAC soft key and select the MAC Walsh code option: 64 or 128.

b.

Toggle the PvsT soft key and select the slot option: Idle or Active.

c.

Toggle the External Offset soft key and select On.

d.

Enter a value by using the numeric keys, and then press the dB soft key.

7. To save your settings and results, go to SAVE/LOAD > Save and then perform functions as you
desire. See “Using save” on page 31 for more information.

8. Press the Run Test soft key to start to run a test.
The Auto Measure Results window appears at the end of the test.

9. To stop running the test, press the Abort soft key.
10. To change the view on the screen during the test, press the Display and then select the view
option from the following choices:

–

Screen: You can view each measurement screen as the test progresses.

–

Results: You can view a measurement result table as the test progresses.

–

Settings: You can view a measurement setting table as the test progresses.

Setting display
After completion of the auto measurement, the screen menu changes to Trace/Display so that you can
view the results in different forms.
Procedure

1. Toggle the Display soft key and select the display option:
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–

Result: to view the result table.
The Display Result menu becomes activated.

–

Settings: to view the measurement settings for the auto measurement.
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2. Toggle the Display Result soft key and select the display result option:
–

Full: to view detailed measurement readings with the pass/fail indication.

–

Quick: to view only the Pass/Fail results.

3. To view the measurement results for a different carrier, press the View Carrier soft key and then
select the carrier number to view.

Performing power statistics CCDF measurements
The Power Statistics Complementary Cumulative Distribution Function (CCDF) measurement
characterizes the power statistics of the input signal. It provides PAR (Peak to Average power Ratio)
versus different probabilities.

Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 346, you
can continue your measurement. The measurement settings can be saved and recalled as a file. You
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load
the file on to the instrument.
Procedure

1. Press the MEASURE SETUP hot key.
2. Press the CCDF Length soft key to set the length of the CCDF.
3. Enter a value between 1 and 100 by using the numeric keys. You can also use the rotary knob.
4. Press the Enter soft key.

Measurement example
Figure 180 CCDF measurement with EV-DO signal analyzer
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Conducting EV-DO OTA measurements
This Over The Air (OTA) measurement has channel scanner, PN scanner, multipath profile, and Code
Domain power screens. It is used to verify EV-DO transmitter performance at any location providing
reflective measurements and identifying signals providing from different sites. The Code Domain
power shows not only modulation performance metric but also amplifier capacity and code utilization
metric. The Amplifier capacity (code utilization) measurement is an estimate of the amount of power
amplifier capacity (code utilization) that is being used expressed in percent of maximum.

Channel scanner
Setting channel/frequency
Procedure
To set the channels to be scanned:

1. Press the FREQ/DIST hard key.
2. Toggle the Unit soft key and select Channel.
3. Press the Index soft key, and then enter an index number between one and six by turning the
rotary knob or using the numeric keys.

4. To select the standard channel, complete the following steps:
a.

Press the Channel Std soft key. The standard channel window appears.
See “Appendix C – Band, frequency & channel standard” on page 541 for more information.

b.

Select the band to be measured by using the rotary knob, the arrow keys, or the Page
Up/Page Down soft keys.

c.

Press the Select soft key or the rotary knob to confirm the selection.

5. To set the channel number for the selected index, complete the following steps:
a.

Press the Channel Number soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Press the Enter soft key.

The instrument displays a corresponding center frequency for the channel number.

6. To set the integration bandwidth for the selected index, complete the following steps:
a.

Press the Integration Bandwidth soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Select the unit: GHz, MHz, kHz, or Hz.

7. To add more channels to be scanned, repeat steps 3-6.
8. Press the ESC hard key to dismiss the channel list window and view the scanning result.
To set the frequencies to be scanned:

1. Press the FREQ/DIST hard key.
2. Toggle the Unit soft key and select Freq.
3. Press the Index soft key, and then enter an index number between one and six by turning the
rotary knob or using the numeric keys.

4. To set the center frequency for the selected index, complete the following steps:
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a.

Press the Center Frequency soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Select the unit: GHz, MHz, kHz, or Hz.
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5. To set the integration bandwidth for the selected index, complete the following steps:
a.

Press the Integration Bandwidth soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Select the unit: GHz, MHz, kHz, or Hz.

6. To add more channels to be scanned, repeat steps 3-5.
7. Press the ESC hard key to dismiss the channel list window and view the scanning result.
Setting measure setup
After configuring other test parameters as described in the “Configuring test parameters” on page 346,
you can continue your measurement. The measurement settings can be saved and recalled as a file.
You can also use JDViewer, PC application software to configure a measure setup, save as a file, and
load the file on to the instrument.
Procedure

1. Press the MEASURE SETUP hot key.
2. To set the incremental step for the PN offset, complete the following steps:
a.

Press the PN Increment soft key.

b.

Enter a value by using the numeric keys.

c.

Press the Enter soft key.

3. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available
for your measurement mode. See “Using save” on page 31 for more information.

Setting limit for OTA channel scanner
Procedure

1. Press the LIMIT hot key.
2. Press the Limit Line soft key to set a threshold for the limit line and Pass/Fail indication.
3. Enter a value, and then press the dBm unit soft key.
4. Toggle the Limit Line soft key between On and Off to display or dismiss the limit line.
5. Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit.
Toggle the Beep soft key between On and Off to enable or disable the beep sound.

6. Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings.
See “Using save” on page 31 for more information.
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Measurement example
Figure 181 Channel scanner measurement with EV-DO OTA signal analyzer

PN scanner
Each access network sector has a unique PN offset. The PN Scanner is used to identify all the active
PNs in an area.
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 346, you
can continue your measurement. The measurement settings can be saved and recalled as a file. You
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load
the file on to the instrument.
Procedure

1. Press the MEASURE SETUP hot key.
2. To set the incremental step for the PN offset, complete the following steps:
a.

Press the PN Increment soft key.

b.

Enter a value by using the numeric keys.

c.

Press the Enter soft key.

3. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available
for your measurement mode. See “Using save” on page 31 for more information.
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Measurement example
Figure 182 PN scanner measurement with EV-DO OTA signal analyzer

Multipath profile
The Multipath Profile enables you to determine RF environmental conditions of testing area. It
indicates the amount of power of the dominant pilot signal that is dispersed outside the main
correlation peak due to multipath echoes that are expressed in dB. This value should be very small
ideally.
The multipath profile is the result of portions of the original broadcast signal arriving at the receiving
antenna out of phase. This can be caused by the signal being reflected off objects such as buildings,
or being refracted through the atmosphere differently from the main signal.
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 346, you
can continue your measurement. The measurement settings can be saved and recalled as a file. You
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load
the file on to the instrument.
Procedure

1. Press the MEASURE SETUP hot key.
2. To set the incremental step for the PN offset, complete the following steps:
a.

Press the PN Increment soft key.

b.

Enter a value by using the numeric keys.

c.

Press the Enter soft key.

3. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available
for your measurement mode. See “Using save” on page 31 for more information.
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Measurement example
Figure 183 Multipath profile measurement with EV-DO OTA signal analyzer

Code domain power
Channels with high correlation factors are determined to be active channels and are indicated as such
on the display. Once the channels are decoded, the analyzer determines the power of each channel
relative to the total signal power.
This measurement helps to verify that each code channel is operating at its proper level and helps to
identify problems throughout the transmitter design from the coding to the RF section. System
imperfections, such as the non-linearity of amplifiers, will present themselves as an undesired
distribution of power in the code domain.
Setting measure setup
After configuring test parameters as described in “Configuring test parameters” on page 346, you can
continue your measurement. The measurement settings can be saved and recalled as a file. You can
also use JDViewer, PC application software to configure a measure setup, save as a file, and load the
file on to the instrument.
Procedure

1. Press the MEASURE SETUP hot key.
2. To set the Pseudo-Noise (PN) offset, complete the following steps:
a.

Toggle the PN Offset soft key between Auto and Manual.

b.

Enter a value by using the numeric keys to set manually.

c.

Press the Enter soft key.

3. To set the incremental step for the PN offset, complete the following steps:
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a.

Press the PN Increment soft key.

b.

Enter a value by using the numeric keys.

c.

Press the Enter soft key.
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4. To set the threshold between Auto and Manual, complete the following steps:
a.

Press the Threshold soft key. Its default setting is -27 dB.

b.

Enter a value between -50 and zero by using the numeric keys to change the value in the
Manual mode.

c.

Press the Enter soft key.

5. Toggle the MAC soft key and select the MAC Walsh code option: 64 or 128.
6. Press the Detect Mode soft key, and then select the detection mode option: Auto, QPSK, 8PSK,
16 QAM, or 64 QAM.

7. To set the threshold for pilot dominance, complete the following steps:
a.

Press the Pilot Dominance > soft key.

b.

Enter a value by using the numeric keys.

c.

Press the Enter soft key.
NOTE
Recommended value is 10. Color of the Pilot Dominance indicator on the screen bases
on this setting.

8. To set the threshold for multipath power, complete the following steps:
a.

Press the Multipath Power < soft key.

b.

Enter a value by using the numeric keys.

c.

Press the Enter soft key.
NOTE
Recommended value is one. Color of the multipath power indicator on the screen bases
on this setting.

9. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available
for your measurement mode. See “Using save” on page 31 for more information.

Measurement example
Figure 184 Code domain power measurement with EV-DO OTA signal analyzer
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NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication.

Route map
The JD780A Series provides indoor and outdoor mapping function that allows a user to collect data of
points in an indoor or outdoor environment and track the received signals and coverage of RF
transmitters plotting real time directly on top of a loaded floor plan or a map.
Setting measure setup
Procedure

1. If required, connect a GPS receiver to your JD780A series for outdoor mapping.
Indoor mapping does not necessarily need a GPS antenna.

2. Configure test parameters as described in the “Configuring test parameters” on page 346.
3. To load your map file, complete the following steps:
a.

Plug in your USB drive that has a floor map or .mcf file type created in JDMapCreator.
NOTE
The JDMapCreator converts and resizes any scanned floor plan or layout to fit onto your
instrument’s display. You must save your map files (.mcf) into the “SavedMap” folder of
your USB drive so that you can load them onto your instrument.

b.

Press SAVE/LOAD hot key, and then select Load > Load Map.
See “Using load” on page 34 for more information.

4. Press the MEASURE SETUP hot key.
5. Press the Plot Point soft key, and then select the plot point option from the following choices:
–

To collect data/plot points automatically as you move around in a vehicle or outside, press
the GPS soft key and then toggle the Screen Mode soft key between Map and Full.
NOTE
With the Map setting, you can view only the collected points that can be seen within the
boundary of the loaded map. If a point is off the map, the instrument displays an arrow to
indicate the direction of the current location on the map and the distance from the center
to the location at the top of the screen.
With the Full setting, you can view all the collected points of the route without the loaded
map.

–

To collect data/plot points manually without a GPS antenna in an indoor environment, press
the Position soft key.

6. Press the Plot Item soft key, and then select the measurement option: Pilot Power or Ec/Io.
7. To set the incremental step for the PN offset, complete the following steps:
a.

Press the PN Increment soft key.

b.

Enter a value by using the numeric keys.

c.

Press the Enter soft key.

8. Toggle the Plot soft key and select Start.
9. Touch directly on the screen or press the ENTER hard key to collect data and plot points on the
loaded map for the Position setting.
NOTE
For the Position setting, you can change the direction of the route with the arrow keys
and the distance with the rotary knob.
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10. Toggle the Plot soft key and select Stop to stop plotting.
11. Press the SAVE/LOAD hot key to save the result.
See “Using save” on page 31 for more information.
NOTE
The instrument does not automatically save the collected data. It is recommended that
you save the result. Otherwise, you will lose all the collected data.

Setting limit
You can set the thresholds for the four different color indicators for Pilot power or Ec/Io.
Procedure

1. Press the LIMIT hot key.
2. To set the limits for pilot power if you have selected Pilot for the plot item, complete the following
steps:
a.

Press the Pilot Power soft key.

b.

Press the Excellent soft key to set its threshold.

c.

Enter a value, and then press the dBm soft key. You can also use the rotary knob.

d.

Press the Very Good soft key to set its threshold.

e.

Enter a value, and then press the dBm soft key. You can also use the rotary knob.

f.

Press the Good soft key to set its threshold.

g.

Enter a value, and then press the dBm soft key. You can also use the rotary knob.

h.

Press the Fair soft key to set its threshold.

i.

Enter a value, and then press the dBm soft key. You can also use the rotary knob.

j.

Press the Poor soft key to set its threshold.

k.

Enter a value, and then press the dBm soft key. You can also use the rotary knob.

3. To set the limits for Ec/Io if you have selected as for the plot item , complete the following steps:
a.

Press the Ec/Io soft key.

b.

Press the Good soft key to set its threshold.

c.

Enter a value, and then press the Enter soft key. You can also use the rotary knob.

d.

Press the Fair soft key to set its threshold.

e.

Enter a value, and then press the Enter soft key. You can also use the rotary knob.

f.

Press the Poor soft key to set its threshold.

g.

Enter a value, and then press the Enter soft key. You can also use the rotary knob.

4. Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings.
See “Using save” on page 31 for more information.
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Measurement example
Figure 185 Route map measurement with EV-DO OTA signal analyzer
1) Pilot Power

2) Pilot Ec/Io
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Using TD-SCDMA Signal Analyzer
This chapter provides instructions for using the TD-SCDMA Signal Analyzer function (option 025) with
the TD-SCDMA OTA Analyzer function (option 045). Topics discussed in this chapter are as follows:
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Introduction
The Time Division-Synchronous Code Division Multiple Access, also known as TD-SCDMA, is a 3G
mobile telecommunications standard that is pursued by the Chinese Academy of Telecommunications
Technology (CATT) in the People's Republic of China. The TD-SCDMA uses the TDD scheme while
the WCDMA uses the FDD.
This TD-SCDMA Signal Analyzer can be used for testing of TD-SCDMA systems, made according to
the following standard documentation.


3GPP TS 25.105 Base Station radio transmission and reception (TDD)



3GPP TS 25.142 Base Station conformance testing (TDD)



3GPP TS 25.222 Multiplexing and channel coding (TDD)



3GPP TS 25.223 Spreading and modulation (TDD)

The instrument automatically makes standard defined measurements using the measurement
methods and limits as defined in the standard. The detailed results allow you to analyze TDSCDMA/HSDPA system performance. You may alter the measurement parameters for specialized
analysis. Pass/Fail testing with standard defined or user defined upper and lower limits and the
Pass/Fail indictor help you to determine base station performance easily.
This instrument provides the following measurement tools for TD-SCDMA system:


Spectrum Analysis



RF Analysis
Channel Power
Occupied Bandwidth
Spectrum Emission Mask
Adjacent Channel Leakage power Ratio (ACLR)
Multi-ACLR
Spurious Emissions



Power vs. Time:
Power vs. Time (Slot)
Power vs. Time (Frame)
Power vs. Time (Mask)
Timogram



Modulation Analysis
Constellation
Midamble Power
Code Power
Code Error



Auto Measure



Over The Air (OTA)
Sync-DL ID Scanner
Sync-DL ID vs. Tau
Sync-DL ID Multipath
Sync-DL ID Analyzer
Route Map
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Display overview
Figure 186 provides descriptions for each segment of the measurement screen.
Figure 186 TD-SCDMA signal analyzer measurement screen

Connecting a cable
Direct connection
Procedure

1. Connect the Spectrum Analyzer RF In port of the JD780A series and the Power amplifier output
port of BTS.

Figure 187 Direct connection

JD785A/JD786A
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Indirect connection
Procedure

1. Connect the Spectrum Analyzer RF In port of the JD780A series and the monitor (test) port of
BTS.

Figure 188 Indirect connection

JD785A/JD786A

JD788A

CAUTION
The maximum power for the Spectrum Analyzer RF In port is +25 dBm (0.316 W). If the
input signal level to be measured is greater than +25 dBm, use a High Power
Attenuator to prevent damage when you directly connect the signal to the instrument or
connect the signal from the coupling port of a directional coupler.

Over the air (OTA)
Procedure

1. Connect an Omni/directional RF antenna to the Spectrum Analyzer RF In port of the JD780A
series.

2. Connect a GPS antenna to the GPS port of the JD780A series.
Figure 189 OTA connection

JD785A/JD786A
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CAUTION
If the input signal level to be measured is less than 0 dBm, set 0 dB attenuation or turn on
the preamp to have better dynamic range for the OTA testing.

Selecting measurement mode
Procedure

1. Press the MODE hard key.
2. Press the Signal Analyzer soft key.
3. Press the More (1/2) > TD-SCDMA soft key. The Spectrum mode is set by default.
4. Press the MEASURE hot key, and then select the measurement mode option from the following
choices:

–

Spectrum

–

RF Analysis > Channel Power, Occupied BW, Spectrum Emission Mask, ACLR,
Multi-ACLR, or Spurious Emissions

–

Power vs Time > Power vs Time (Slot), Power vs Time (Frame),
Power vs Time (Frame), or Timogram

–

Modulation Analysis > Constellation, Midamble Power, Code Power, or Code Error

–

Auto Measure

–

OTA > Sync-DL ID Scanner, Sync-DL ID vs Tau, Sync-DL ID Multipath,
Sync-DL ID Analyzer, or Route Map

Configuring test parameters
Setting frequency
You can set the frequency with either frequency or channel number. If a frequency to be set matches
to the frequency corresponding to the selected channel standard, the instrument calculates its channel
number and updates the screen with it automatically.
Procedure
To set the center frequency:

1. Press the FREQ/DIST hard key.
2. Toggle the Unit soft key and select Freq.
3. Press the Center Frequency soft key.
4. Enter a value by using the numeric keys. You can also use the rotary knob.
5. Select the unit: GHz, MHz, kHz, or Hz.
6. Optional. To define the amount of frequency increment for the rotary knob, complete the following
steps:
a.

Press the Frequency Step soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Press the unit: GHz, MHz, kHz, or Hz.

To set the channel number:
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1. Press the FREQ/DIST hard key.
2. Toggle the Unit soft key and select Channel.
3. To select the standard channel, complete the following steps:
a.

Press the Channel Std soft key. The standard channel window appears.
See “Appendix C – Band, frequency & channel standard” on page 541 for more information.

b.

Select the band to be measured by using the rotary knob, the arrow keys, or the Page
Up/Page Down soft keys.

c.

Press the Select soft key or the rotary knob to confirm the selection.

4. Press the Channel Number soft key.
5. Enter a value by using the numeric keys. You can also use the rotary knob.
6. Press the Enter soft key.
The instrument automatically displays the corresponding center frequency value for the selected
channel number.

7. Optional. To define the amount of channel increment for the rotary knob, complete the following
steps:
a.

Press the Channel Step soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Press the Enter soft key.

NOTE
This frequency setting is not used in the Multi-ACLR and Spurious Emissions modes.

Setting amplitude
Reference level and attenuation
You can set the reference and attenuation levels automatically or manually to optimize the display of
the traces measured, as you desire.
Procedure
To automatically set the reference and attenuation level:

1. Press the AMP/SCALE hard key.
2. Press the Auto Scale soft key.
Each time you press this key, both of the Y-axis scale and input attenuation level change to be
optimized with some margin.
To set the reference or attenuation level manually:

1. Press the AMP/SCALE hard key.
2. To set the maximum reference value on the Y-axis manually, complete the following steps:
a.

Press the Reference Level soft key.

b.

Enter a value by using the numeric keys or the rotary knob with 10 dB increments.

c.

Press the dBm soft key or the ENTER hard key.
NOTE
In the measurements such as Midamble Power, Code Power, and Code Error, you
may need to select the reference option between Relative and Absolute before setting
the reference level.

3. To set the attenuation option, select one from the following choices:
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–

To set the input attenuator’s level automatically, select Attenuation > Auto.
NOTE
It is recommended that you set the Attenuation to Auto in most situations so that the
level of the input attenuator can be set automatically according to your input signal level.

–

–

To set the input attenuation manually up to 55 dB to optimize S/N, complete the following
steps:
a.

Select Attenuation > Manual.

b.

Press the Attenuation Value soft key to set the level.

c.

Enter a value between 0 and 55 in fives by using the numeric keys.

d.

Press the dB soft key or the ENTER hard key.

To couple the input attenuator’s level with your reference level setting, select Attenuation >
Couple.
As you increse the reference setting, the attenuation level also increases acoordingly.

Optional. To change the scale unit:

1. Select More (1/2) > Units.
2. Select the unit of the display scale: dBm, dBV, dBmV, dBµV, V, or W.
The scale unit on the screen changes accordingly.
NOTE
This Units menu is available in the Spectrum and RF Analysis modes.

Scale per division
You can use the Scale/Div feature available for the spectrum and RF analysis. It represents the value
of one division on the horizontal scale. The default setting is 10 dB per division and the maximum
value can be set up to 20 dB.
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Procedure
To set the scale per division:

1. Press the AMP/SCALE hard key.
2. Select More (1/2) > Scale/Div.
3. Enter a value between 1 and 20 by using the numeric keys.
4. Press the dB soft key to complete the entry.
Pre-amplifier
You can turn the internal pre-amplifier on to correct and compensate for the gain of the preamp so that
amplitude readings show the value at the input connector.
Procedure

1. Press the AMP/SCALE hard key.
2. Toggle the Preamp soft key and select On or Off as needed.
NOTE
You can turn the Preamp on when the input attenuation range is from 0 dB to 10 dB. If
the attenuation value is manually set to greater than 10 dB, the instrument will
automatically turn off the pre-amplifier to display low-level signal properly on the chart.

External offset
You can turn the External Offset on and manually set the external offset value. An offset consists of a
cable loss and a user offset and the measurement result shows the value reflecting both offset values.
When the external offset value is set at 40 dB in the Spectrum mode, the measurement result
compensates 40 dB at both the Spectrum Analyzer and Signal Analyzer modes
Procedure
To set the external offset:

1. Press the AMP/SCALE hard key.
2. Toggle the External Offset soft key and select On.
3. Enter a value by using the numeric keys.
4. Press the dB soft key to complete the entry.
To turn the external offset off:

1. Press the AMP/SCALE hard key.
2. Toggle the External Offset soft key and select Off.

Setting average
You can set the number of measurements to be averaged for the trace presentation in the spectrum
and RF analysis. A maximum of 100 times of averaging can be set. When the averaging reaches to
your setting, a new measurement value replaces the measurement value in sequence from the earliest.
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Procedure

1. Press the BW/AVG hard key.
2. Press the Average soft key.
3. Enter a value between 1 and 100 as needed by using the numeric keys.
4. Press the Enter soft key.

Setting sweep mode
The default settings of the sweep mode are Continue and Normal to sweep continuously at a normal
speed for most on-going measurements. If you want to hold the measurement or get a single sweep,
you can change the sweep mode.
Procedure
To select the single sweep mode:

1. Press the SWEEP hot key.
2. Toggle the Sweep Mode soft key and select Single. You can also use the HOLD hot key.
The letter HOLD in red appears and the sweeping is paused.

3. Optional. Press the Sweep Once soft key to get a new measurement.
To return to the continuous sweep mode:

1. Toggle the Sweep Mode soft key and select Continue. You can also use the HOLD hot key.
The letter HOLD in red disappears and the sweeping resumes.

Setting trigger source
You can set the trigger source option for your measurements.
Procedure

1. Press the TRIGGER hot key.
2. Select the trigger source option from the following choices: Internal, External, or GPS.

Setting external clock
To enhance the reliability of modulation analysis measurements the JD780A series must be
synchronized with a base station. When an external clock is not supplied, the instrument works with its
built-in internal high-accuracy time base and some measurement results may exhibit inaccurate values.
Therefore, it is highly recommended that you use the same reference clock as the signal source. You
can use the TRIGGER hot key to set the external clock.
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Figure 190 Connection ports for external reference clock

Procedure

1. Connect an external reference or a GPS antenna to the JD780A series.
2. Press the SYSTEM hot key.
3. Press the Freq Reference soft key, and then select the reference option: Internal, External 10
MHz, External 13 MHz, External 15 MHz, or GPS.

Table 20

External reference indicators

Type

Indicator

Description

Internal

(green)

The green INT icon indicates that the instrument uses the built-in
internal time base.

External

(green)

The green EXT icon indicates that an external reference is connected
and locked and that the instrument uses the same reference clock as
the signal source.

External

(red)

The red EXT icon indicates that an external reference is connect but not
locked.

GPS

(green)

The green GPS antenna icon indicates that a GPS antenna is
connected and locked.

GPS

(yellow)

The yellow GPS antenna icon indicates that a GPS antenna is
connected and locking is in progress.

GPS

(grey)

The grey GPS antenna icon indicates that a GPS antenna is not
connected, failed, or unable to be locked.

Conducting spectrum measurements
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 387, you
can continue your measurement.
Procedure

1. Press the MEASURE SETUP hot key.
2. Press the Slot Number soft key, and then select the time slot number to be displayed: TS0, TS1,
TS2, TS3, TS4, TS5, or TS6.

3. Optional. To set the delay, complete the following steps:
a.
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b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Press the µs soft key.
NOTE
The Delay setting is used only when there is a time offset in the signals to be measured.

Your measurement result is displayed on the screen as like the following example, Figure 191.
Figure 191 Spectrum measurement screen with TD-SCDMA signal analyzer

Setting trace
You can display up to six traces on the measurement chart simultaneously.
Procedure

1. Press the TRACE/DISPLAY hard key.
2. Press the Select Trace soft key, and then select the trace number: T1, T2, T3, T4, T5, or T6.
The legend shape of the selected trace changes from square to round to indicate that the trace is
the active one now.

3. Toggle the Trace View soft key and select On.
4. To clear, write or capture, or hide the trace(s), do one of the following:
To

Select

Trace Legend

Clear current data and display with new
measurements

Clear Write

W

Display the input signal’s maximum response only

Max Hold

M

Display the input signal’s minimum response only

Min Hold

m

Capture the selected trace and compare traces

Capture

C

Load a saved trace

More (1/2) > Load

L

Hide the selected trace

Trace View > Off

F
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Remove all the traces and initialize the trace
settings

More (1/2) > Trace
Clear All

5. Optional. Press the More (1/2) > Trace Info soft key, and then select the trace number to view
the trace’s parameter setting information stored at the time of the measurement or None to hide
the information display.

6. Optional. If you have the two traces T1 and T2, you can perform trace math. To view the power
difference between the traces, press the T1 – T2 -> T5 or T2 – T1 -> T6 soft key.
The result is overlaid on the screen along with the second Y-axis.

Conducting RF measurements
Channel power
The Channel Power measurement determines the average power of an RF signal burst at or above a
specified threshold value.
The purpose of the Channel Power measurement is to determine the power delivered to the antenna
system on the RF channel under test. The instrument acquires a TD-SCDMA signal in the time domain.
The average power level above the threshold is then computed and displayed.
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 387, you
can continue your measurement.
Procedure

1. Press the MEASURE SETUP hot key.
2. Press the Slot Number soft key, and then select the time slot number to be displayed: TS0, TS1,
TS2, TS3, TS4, TS5, or TS6.

3. Optional. To set the delay, complete the following steps:
a.

Press the Delay soft key to set the amount of delay in µs.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Press the µs soft key.
NOTE
The Delay setting is used only when there is a time offset in the signals to be measured.
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Measurement example
Figure 192 Channel power measurement with TD-SCDMA signal analyzer

NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 401 for more
information.

Occupied bandwidth
The Occupied Bandwidth measures the spectrum shape of the carrier. It is defined as the bandwidth,
which includes 99% of the transmitted power among total transmitted power.
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 387, you
can continue your measurement.
Procedure

1. Press the MEASURE SETUP hot key.
2. Press the Slot Number soft key, and then select the time slot number to be displayed: TS0, TS1,
TS2, TS3, TS4, TS5, or TS6.

3. Optional. To set the delay, complete the following steps:
a.

Press the Delay soft key to set the amount of delay in µs.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Press the µs soft key.
NOTE
The Delay setting is used only when there is a time offset in the signals to be measured.
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Measurement example
Figure 193 Occupied bandwidth measurement with TD-SCDMA signal analyzer

NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 401 for more
information.

Spectrum emission mask (SEM)
The Spectrum Emission Mask (SEM) measurement required by 3GPP specifications encompasses
different power limits and different measurement bandwidths (resolution bandwidths) at various
frequency offsets. It may be expressed as a ratio of power spectral densities between the carrier and
the specified offset frequency band. It provides useful figures-of-merit for the spectral re-growth and
emissions produced by components and circuit blocks, without the rigor of performing a full SEM
measurement.
The SEM measures spurious signal levels in up to five pairs of offset or region frequencies and relates
them to the carrier power.
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 387, you
can continue your measurement.
Procedure

1. Press the MEASURE SETUP hot key.
2. Press the Slot Number soft key, and then select the time slot number to be displayed: TS0, TS1,
TS2, TS3, TS4, TS5, or TS6.

3. To select the mask type according to the output power of the base station, complete the following
steps:
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a.

Press the Mask Type soft key.

b.

Select the mask type option: - 26 dBm, 26 – 34 dBm, or 34 dBm –.
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4. Optional. To set the delay, complete the following steps:
a.

Press the Delay soft key to set the amount of delay in µs.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Press the µs soft key.
NOTE
The Delay setting is used only when there is a time offset in the signals to be measured.

Measurement example
Figure 194 SEM measurement with TD-SCDMA signal analyzer

NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 401 for more
information.

ACLR
The Adjacent Channel Leakage power Ratio (ACLR) measures the amount of interference or power in
an adjacent frequency channel according to the standards.
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 387, you
can continue your measurement.
Procedure

1. Press the MEASURE SETUP hot key.
2. Press the Slot Number soft key, and then select the time slot number to be displayed: TS0, TS1,
TS2, TS3, TS4, TS5, or TS6.

3. Optional. To set the delay, complete the following steps:
a.

Press the Delay soft key to set the amount of delay in µs.
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b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Press the µs soft key.
NOTE
The Delay setting is used only when there is a time offset in the signals to be measured.

Measurement example
Figure 195 ACLR measurement with TD-SCDMA signal analyzer

NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 401 for more
information.

Multi-ACLR
The Multi-ACLR measurement is used to perform multi-channel ACLR measurements with as many
channels as possible. It helps you to measure ACLR in multi-channel transmitting Base Station
environment.
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 387, you
can continue your measurement.
Procedure

1. Press the MEASURE SETUP hot key.
2. To set the frequency, do one of the following:
–
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To set the center frequency, complete the following steps:
a.

Toggle the Unit soft key and select Freq.

b.

Press the Lowest Frequency soft key to set the starting center frequency.

c.

Enter a value by using the numeric keys. You can also use the rotary knob.
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–

d.

Select the unit: GHz, MHz, kHz, or Hz.

e.

Press the Highest Frequency soft key to set the stopping center frequency.

f.

Enter a value by using the numeric keys. You can also use the rotary knob.

g.

Select the unit: GHz, MHz, kHz, or Hz.

To set the channel number, complete the following steps:
a.

Toggle the Unit soft key and select Channel.

b.

To select the standard channel, press the Channel Std soft key and then select the
band to be measured.

c.

Press the Lowest Channel soft key to set the starting channel.

d.

Enter a value by using the numeric keys. You can also use the rotary knob.

e.

Press the Enter soft key.

f.

Press the Highest Channel soft key to set the stopping channel.

g.

Enter a value by using the numeric keys. You can also use the rotary knob.

h.

Press the Enter soft key.

Measurement example
Figure 196 Multi-ACLR measurement with TD-SCDMA signal analyzer

NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 401 for more
information.

Spurious emissions
Out-of-band emissions are unwanted emissions immediately outside the channel bandwidth resulting
from the modulation process and non-linearity in the transmitter but excluding spurious emissions. The
Spurious Emissions measurement is to identify and determine the power level of out-of-band spurious
emission within the necessary channel bandwidth and modulated signal measured at the RF port of
the Base Station.
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Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 387, you
can continue your measurement.
Procedure

1. Press the MEASURE SETUP hot key.
2. To set up the range table and frequency range, press the Range Table soft key and then
complete the following steps:
a.

Press the Range soft key, and then enter the range number to add a new range or change
an existing one.

b.

Press the Enter soft key.

c.

Press the Start Frequency soft key to set up the frequency range.

d.

Enter a value by using the numeric keys. You can also use the rotary knob.

e.

Select the unit: GHz, MHz, kHz, or Hz.

f.

Press the Stop Frequency soft key to set up the frequency range.

g.

Enter a value by using the numeric keys. You can also use the rotary knob.

h.

Select the unit: GHz, MHz, kHz, or Hz.

3. Toggle the Range soft key between On and Off to display or hide the selected range.
4. To set up the test limits for Pass/Fail indication, complete the following steps:
a.

Press the Start Limit soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Select the dBm soft key.

d.

Press the Stop Limit soft key.

e.

Enter a value by using the numeric keys. You can also use the rotary knob.

f.

Select the dBm soft key.

5. To set up the other parameters, complete the following steps:
a.

Select More (1/2) > Attenuation to set up the attenuation value.

b.

Enter a value in the multiple of five.

c.

Press the dB soft key or the ENTER hard key.

d.

Press the RBW soft key.

e.

Enter a value by using the numeric keys.

f.

Select the unit: GHz, MHz, kHz, or Hz.

g.

Press the VBW soft key.

h.

Enter a value by using the numeric keys.

i.

Select the unit: GHz, MHz, kHz, or Hz.

6. Press the PREV hard key.
7. Toggle the Measure Type soft key between Examine and Full to select the measurement type.
NOTE
The Examine mode displays only the selected range while the Full mode lets the
instrument automatically changes the selected range from one another.

8. Set the number of measurements to be averaged:
a.
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Press the Average soft key.
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b.

Enter a value between 1 and 100.

c.

Press the Enter soft key.

Measurement example
Figure 197 Spurious emissions measurement with TD-SCDMA signal analyzer

NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 401 for more
information.

Setting limit for RF tests
By default, test limits specified in the standard are set for you. You can change thresholds if you desire.
Procedure

1. Press the LIMIT hot key.
2. Press the RF Test Limits soft key.
3. Select the test item(s) and set the limit(s) depending on your selected measurement mode:
To set the limit for

Select

Set

Channel power

Channel Power

High Limit
Low Limit

Occupied bandwidth

Occupied BW

High Limit

Spectrum emission mask

Spectrum Emission Mask

(On/Off only)

ACLR

ACLR

(On/Off only)

Multi-ACLR

Multi-ACLR

(On/Off only)

Spurious emissions

Spurious Emissions

(On/Off only)

4. Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit.
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Toggle the Beep soft key between On and Off to enable or disable the beep sound.

5. Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings.
See “Using save” on page 31 for more information.

Conducting power vs. time measurements
The Power vs. Time (P vs T) measurement analyzes the amplitude profile and timing of the burst
signal and provides a time mask for the signal. It measures the mean transmit power during the “useful
part” of TD-SCDMA bursts and verifies that the power ramp fits within the defined mask. TD-SCDMA is
a Time Division Multiple Access (TDMA) scheme with seven time slots, or bursts, per RF channel and
by using the “Multi-Slot” function, up to seven slots in a frame can be viewed at one time.

Power vs. time (slot)
The Power vs. Time (Slot) in TD-SCDMA Signal Analyzer measures the modulation envelope in the
time domain, showing the signal rise and fall shape of TD-SCDMA signal.
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 387, you
can continue your measurement. The measurement settings can be saved and recalled as a file.
Procedure

1. Press the MEASURE SETUP hot key.
2. Press the Slot Number soft key, and then select the time slot number to be displayed: TS0, TS1,
TS2, TS3, TS4, TS5, or TS6.

3. Press the Spread Factor soft key, and then select the spread factor option: DL Auto for auto
detection of downlink, UL Auto for auto detection of uplink, SF1, SF2, SF4, SF8, or SF16

4. To set the number of maximum users, complete the following steps:
a.

Press the Max Users soft key.

b.

Enter a value up to 16 by using the numeric keys.

c.

Press the Enter soft key.

5. Optional. To set the delay, complete the following steps:
a.

Press the Delay soft key to set the amount of delay in µs.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Press the µs soft key.
NOTE
The Delay setting is used only when there is a time offset in the signals to be measured.

6. Optional. Press the Miscellaneous soft key, and then do the following(s) as needed:
–

To select how to determine scrambling estimation, toggle the Scramble soft key and select
Spec or Full.
NOTE
The Spec searches “Sync Sequence Number” from 0 to 31 based on the TD-SCDMA
specification and determines “Scrambling Code Number” by using the sync sequence
number, while the Full does from 0 to 127 fully.

–

402

To select how to determine the Midamble spread factor estimation either in full or maximum
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power search, toggle the Mid SF Map soft key and select Max or Spec.
NOTE
The Max determines the spread factor of the Midamble by using the maximum power of
the received Midamble, while the Spec searches “Default Midamble Allocation” based on
the TD-SCDMA specification.

–

To select the detect mode, press the Detect Mode soft key and then select the option:
Auto, QPSK/8PSK, QPSK, 8PSK, 16 QAM, or 64 QAM.

Measurement example
Figure 198 Power vs. time (slot) measurement with TD-SCDMA signal analyzer

NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication. See “Setting limit for power vs. time tests” on page 408 for
more information.

Power vs. time (frame)
The Power vs. Time (Frame) measures the modulation envelope in the time domain, showing the
power of each time slot of the TD-SCDMA signal.
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 387, you
can continue your measurement. The measurement settings can be saved and recalled as a file.
Procedure

1. Press the MEASURE SETUP hot key.
2. Press the Slot Number soft key, and then select the time slot number to be displayed: TS0, TS1,
TS2, TS3, TS4, TS5, or TS6.

3. Press the Spread Factor soft key, and then select the spread factor option: DL Auto for auto
detection of downlink, UL Auto for auto detection of uplink, SF1, SF2, SF4, SF8, or SF16
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4. To set the number of maximum users, complete the following steps:
a.

Press the Max Users soft key.

b.

Enter a value up to 16 by using the numeric keys.

c.

Press the Enter soft key.

5. Optional. To set the delay, complete the following steps:
a.

Press the Delay soft key to set the amount of delay in µs.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Press the µs soft key.
NOTE
The Delay setting is used only when there is a time offset in the signals to be measured.

6. Optional. Press the Miscellaneous soft key, and then do the following(s) as needed:
–

To select how to determine scrambling estimation, toggle the Scramble soft key and select
Spec or Full.
NOTE
The Spec searches “Sync Sequence Number” from 0 to 31 based on the TD-SCDMA
specification and determines “Scrambling Code Number” by using the sync sequence
number, while the Full does from 0 to 127 fully.

–

To select how to determine the Midamble spread factor estimation either in full or maximum
power search, toggle the Mid SF Map soft key and select Max or Spec.
NOTE
The Max determines the spread factor of the Midamble by using the maximum power of
the received Midamble, while the Spec searches “Default Midamble Allocation” based on
the TD-SCDMA specification.

–

To select the detect mode, press the Detect Mode soft key and then select the option:
Auto, QPSK/8PSK, QPSK, 8PSK, 16 QAM, or 64 QAM.

Measurement example
Figure 199 Power vs. time (frame) measurement with TD-SCDMA signal analyzer
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NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication. See “Setting limit for power vs. time tests” on page 408 for
more information. The On/Off Ratio is not used in the power vs. time (frame) tests.

Power vs. time (mask)
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 387, you
can continue your measurement. The measurement settings can be saved and recalled as a file.
Procedure

1. Press the MEASURE SETUP hot key.
2. Press the Slot Number soft key, and then select the time slot number to be displayed: TS0, TS1,
TS2, TS3, TS4, TS5, or TS6.

3. Press the Spread Factor soft key, and then select the spread factor option: DL Auto for auto
detection of downlink, UL Auto for auto detection of uplink, SF1, SF2, SF4, SF8, or SF16

4. To set the number of maximum users, complete the following steps:
a.

Press the Max Users soft key.

b.

Enter a value up to 16 by using the numeric keys.

c.

Press the Enter soft key.

5. Optional. To set the delay, complete the following steps:
a.

Press the Delay soft key to set the amount of delay in µs.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Press the µs soft key.
NOTE
The Delay setting is used only when there is a time offset in the signals to be measured.

6. Optional. Press the Miscellaneous soft key, and then do the following(s) as needed:
–

To select how to determine scrambling estimation, toggle the Scramble soft key and select
Spec or Full.
NOTE
The Spec searches “Sync Sequence Number” from 0 to 31 based on the TD-SCDMA
specification and determines “Scrambling Code Number” by using the sync sequence
number, while the Full does from 0 to 127 fully.

–

To select how to determine the Midamble spread factor estimation either in full or maximum
power search, toggle the Mid SF Map soft key and select Max or Spec.
NOTE
The Max determines the spread factor of the Midamble by using the maximum power of
the received Midamble, while the Spec searches “Default Midamble Allocation” based on
the TD-SCDMA specification.

–

To select the detect mode, press the Detect Mode soft key and then select the option:
Auto, QPSK/8PSK, QPSK, 8PSK, 16 QAM, or 64 QAM.
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Measurement example
Figure 200 Power vs. time (mask) measurement with TD-SCDMA signal analyzer

NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication. See “Setting limit for power vs. time tests” on page 408 for
more information. The DwPTS Power and UpPTS Power are not used in the power vs.
time (mask) tests.

Timogram
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 387, you
can continue your measurement. The measurement settings can be saved and recalled as a file.
Procedure

1. Press the MEASURE SETUP hot key.
2. Press the Spread Factor soft key, and then select the spread factor option: DL Auto for auto
detection of downlink, UL Auto for auto detection of uplink, SF1, SF2, SF4, SF8, or SF16

3. To set the number of maximum users, complete the following steps:
a.

Press the Max Users soft key.

b.

Enter a value up to 16 by using the numeric keys.

c.

Press the Enter soft key.

4. To set the time interval, complete the following steps:
a.

Press the Time Interval soft key.

b.

Enter a value by using the numeric keys.

c.

Press the Enter soft key.

5. To place the time cursor to analyze your measurements, complete the following steps:
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a.

Toggle the Time Cursor soft key between On and Off to enable or disable the time cursor.

b.

Enter a value by using the numeric keys.
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c.

Press the Enter soft key.
NOTE
When the time cursor is enabled, the measurement is put on hold and information about
the time cursor is displayed.

6. Optional. Press the Miscellaneous soft key, and then do the following(s) as needed:
–

To set the delay, complete the following steps:
a.

Press the Delay soft key to set the amount of delay in µs.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Press the µs soft key.

NOTE
The Delay setting is used only when there is a time offset in the signals to be measured.

–

To select how to determine scrambling estimation, toggle the Scramble soft key and select
Spec or Full.
NOTE
The Spec searches “Sync Sequence Number” from 0 to 31 based on the TD-SCDMA
specification and determines “Scrambling Code Number” by using the sync sequence
number, while the Full does from 0 to 127 fully.

–

To select how to determine the Midamble spread factor estimation either in full or maximum
power search, toggle the Mid SF Map soft key and select Max or Spec.
NOTE
The Max determines the spread factor of the Midamble by using the maximum power of
the received Midamble, while the Spec searches “Default Midamble Allocation” based on
the TD-SCDMA specification.

–

To select the detect mode, press the Detect Mode soft key and then select the option:
Auto, QPSK/8PSK, QPSK, 8PSK, 16 QAM, or 64 QAM.

Measurement example
Figure 201 Timogram with TD-SCDMA signal analyzer
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Setting limit for power vs. time tests
Procedure

1. Press the LIMIT hot key.
2. Press the PvsT Test Limits soft key.
3. Select the test item(s) and set the limit(s) depending on your selected measurement mode:
To set the limit for

Select

Set

Slot power

Slot Power

High Limit, Low Limit

Downlink pilot signal power

DwPTS Power

High Limit, Low Limit

Uplink pilot signal power

UpPTS Power

High Limit, Low Limit

Power between on and off
portions of the downlink slots

On/Off Ratio

High Limit, Low Limit

4. Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit.
Toggle the Beep soft key between On and Off to enable or disable the beep sound.

5. Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings.
See “Using save” on page 31 for more information.

Conducting modulation measurements
TD-SCDMA receivers rely on the frequency or phase quality of the QPSK or 8PSK signal in order to
achieve the expected carrier to noise performance. A transmitter with high frequency or phase error is
often still able to support phone calls during a functional test. It displays the frequency errors
numerically and graphically, showing the binary representation of the demodulated data bits of the
received signal using Constellation, Midamble Power, Code Power, and Code Error screens.

Constellation
The Constellation is used to observe some aspects of modulation accuracy and can reveal certain
fault mechanisms such as I/Q amplitude imbalance or quadrature imbalance. It displays constellation
diagram by modulation types.
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 387, you
can continue your measurement. The measurement settings can be saved and recalled as a file. You
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load
the file on to the instrument.
Procedure

1. Press the MEASURE SETUP hot key.
2. Toggle the Scramble soft key and select Auto or Manual to set the scramble code automatically
or manually.

3. Press the Slot Number soft key, and then select the time slot number to be displayed: TS0, TS1,
TS2, TS3, TS4, TS5, or TS6.

4. Press the Spread Factor soft key, and then select the spread factor option: DL Auto for auto
detection of downlink, UL Auto for auto detection of uplink, SF1, SF2, SF4, SF8, or SF16
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5. To set the number of maximum users, complete the following steps:
a.

Press the Max Users soft key.

b.

Enter a value up to 16 by using the numeric keys, and then press the Enter soft key.

6. Optional. Press the Miscellaneous soft key, and then do the following(s) as needed:
–

To set the delay, complete the following steps:
a.

Press the Delay soft key to set the amount of delay in µs.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Press the µs soft key.

NOTE
The Delay setting is used only when there is a time offset in the signals to be measured.

–

To select how to determine scrambling estimation, toggle the Scramble soft key and select
Spec or Full.
NOTE
The Spec searches “Sync Sequence Number” from 0 to 31 based on the TD-SCDMA
specification and determines “Scrambling Code Number” by using the sync sequence
number, while the Full does from 0 to 127 fully.

–

To select how to determine the Midamble spread factor estimation either in full or maximum
power search, toggle the Mid SF Map soft key and select Max or Spec.
NOTE
The Max determines the spread factor of the Midamble by using the maximum power of
the received Midamble, while the Spec searches “Default Midamble Allocation” based on
the TD-SCDMA specification.

–

To select the detect mode, press the Detect Mode soft key and then select the option:
Auto, QPSK/8PSK, QPSK, 8PSK, 16 QAM, or 64 QAM.

–

To set the relative threshold, complete the following steps:
a.

Press the Threshold soft key. Its default setting is -27 dB.

b.

Enter a value between -50 and zero by using the numeric keys.

c.

Press the Enter soft key.

Measurement example
Figure 202 Constellation measurement with TD-SCDMA signal analyzer
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NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 414 for
more information. The Max Inactive is not used in the Constellation mode.

Midamble power
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 387, you
can continue your measurement. The measurement settings can be saved and recalled as a file. You
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load
the file on to the instrument.
Procedure

1. Press the MEASURE SETUP hot key.
2. Toggle the Scramble soft key and select Auto or Manual to set the scramble code automatically
or manually.

3. Press the Slot Number soft key, and then select the time slot number to be displayed: TS0, TS1,
TS2, TS3, TS4, TS5, or TS6.

4. Press the Spread Factor soft key, and then select the spread factor option: DL Auto for auto
detection of downlink, UL Auto for auto detection of uplink, SF1, SF2, SF4, SF8, or SF16

5. To set the number of maximum users, complete the following steps:
a.

Press the Max Users soft key.

b.

Enter a value up to 16 by using the numeric keys.

c.

Press the Enter soft key.

6. Optional. Press the Miscellaneous soft key, and then do the following(s) as needed:
–

To set the delay, complete the following steps:
a.

Press the Delay soft key to set the amount of delay in µs.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Press the µs soft key.

NOTE
The Delay setting is used only when there is a time offset in the signals to be measured.

–

To select how to determine scrambling estimation, toggle the Scramble soft key and select
Spec or Full.
NOTE
The Spec searches “Sync Sequence Number” from 0 to 31 based on the TD-SCDMA
specification and determines “Scrambling Code Number” by using the sync sequence
number, while the Full does from 0 to 127 fully.

–

To select how to determine the Midamble spread factor estimation either in full or maximum
power search, toggle the Mid SF Map soft key and select Max or Spec.
NOTE
The Max determines the spread factor of the Midamble by using the maximum power of
the received Midamble, while the Spec searches “Default Midamble Allocation” based on
the TD-SCDMA specification.
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–

To select the detect mode, press the Detect Mode soft key and then select the option:
Auto, QPSK/8PSK, QPSK, 8PSK, 16 QAM, or 64 QAM.

–

To set the relative threshold, complete the following steps:
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a.

Press the Threshold soft key. Its default setting is -27 dB.

b.

Enter a value between -50 and zero by using the numeric keys.

c.

Press the Enter soft key.

Measurement example
Figure 203 Midamble measurement with TD-SCDMA signal analyzer

Code power
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 387, you
can continue your measurement. The measurement settings can be saved and recalled as a file. You
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load
the file on to the instrument.
Procedure

1. Press the MEASURE SETUP hot key.
2. Toggle the Scramble soft key and select Auto or Manual to set the scramble code automatically
or manually.

3. Press the Slot Number soft key, and then select the time slot number to be displayed: TS0, TS1,
TS2, TS3, TS4, TS5, or TS6.

4. Press the Spread Factor soft key, and then select the spread factor option: DL Auto for auto
detection of downlink, UL Auto for auto detection of uplink, SF1, SF2, SF4, SF8, or SF16

5. To set the number of maximum users, complete the following steps:
a.

Press the Max Users soft key.

b.

Enter a value up to 16 by using the numeric keys.

c.

Press the Enter soft key.

6. Optional. Press the Miscellaneous soft key, and then do the following(s) as needed:
–

To set the delay, complete the following steps:
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a.

Press the Delay soft key to set the amount of delay in µs.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Press the µs soft key.

NOTE
The Delay setting is used only when there is a time offset in the signals to be measured.

–

To select how to determine scrambling estimation, toggle the Scramble soft key and select
Spec or Full.
NOTE
The Spec searches “Sync Sequence Number” from 0 to 31 based on the TD-SCDMA
specification and determines “Scrambling Code Number” by using the sync sequence
number, while the Full does from 0 to 127 fully.

–

To select how to determine the Midamble spread factor estimation either in full or maximum
power search, toggle the Mid SF Map soft key and select Max or Spec.
NOTE
The Max determines the spread factor of the Midamble by using the maximum power of
the received Midamble, while the Spec searches “Default Midamble Allocation” based on
the TD-SCDMA specification.

–

To select the detect mode, press the Detect Mode soft key and then select the option:
Auto, QPSK/8PSK, QPSK, 8PSK, 16 QAM, or 64 QAM.

–

To set the relative threshold, complete the following steps:
a.

Press the Threshold soft key. Its default setting is -27 dB.

b.

Enter a value between -50 and zero by using the numeric keys.

c.

Press the Enter soft key.

Measurement example
Figure 204 Code power measurement with TD-SCDMA signal analyzer

NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication for the Max Inactive. See “Setting limit for modulation tests”
on page 414 for more information.
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Code error
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 387, you
can continue your measurement. The measurement settings can be saved and recalled as a file. You
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load
the file on to the instrument.
Procedure

1. Press the MEASURE SETUP hot key.
2. Toggle the Scramble soft key and select Auto or Manual to set the scramble code automatically
or manually.

3. Press the Slot Number soft key, and then select the time slot number to be displayed: TS0, TS1,
TS2, TS3, TS4, TS5, or TS6.

4. Press the Spread Factor soft key, and then select the spread factor option: DL Auto for auto
detection of downlink, UL Auto for auto detection of uplink, SF1, SF2, SF4, SF8, or SF16

5. To set the number of maximum users, complete the following steps:
a.

Press the Max Users soft key.

b.

Enter a value up to 16 by using the numeric keys.

c.

Press the Enter soft key.

6. Optional. Press the Miscellaneous soft key, and then do the following(s) as needed:
–

To set the delay, complete the following steps:
a.

Press the Delay soft key to set the amount of delay in µs.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Press the µs soft key.

NOTE
The Delay setting is used only when there is a time offset in the signals to be measured.

–

To select how to determine scrambling estimation, toggle the Scramble soft key and select
Spec or Full.
NOTE
The Spec searches “Sync Sequence Number” from 0 to 31 based on the TD-SCDMA
specification and determines “Scrambling Code Number” by using the sync sequence
number, while the Full does from 0 to 127 fully.

–

To select how to determine the Midamble spread factor estimation either in full or maximum
power search, toggle the Mid SF Map soft key and select Max or Spec.
NOTE
The Max determines the spread factor of the Midamble by using the maximum power of
the received Midamble, while the Spec searches “Default Midamble Allocation” based on
the TD-SCDMA specification.

–

To select the detect mode, press the Detect Mode soft key and then select the option:
Auto, QPSK/8PSK, QPSK, 8PSK, 16 QAM, or 64 QAM.

–

To set the relative threshold, complete the following steps:
a.

Press the Threshold soft key. Its default setting is -27 dB.

b.

Enter a value between -50 and zero by using the numeric keys.

c.

Press the Enter soft key.
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Measurement example
Figure 205 Code error measurement with TD-SCDMA signal analyzer

NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication for the Max Inactive. See “Setting limit for modulation tests”
on page 414 for more information.

Setting limit for modulation tests
Procedure

1. Press the LIMIT hot key.
2. Press the Modulation Test Limits soft key.
3. Select the test item(s) and set the limit(s) depending on your selected measurement mode:
To set the limit for

Select

Set

Frequency error

Frequency Error

High Limit
Low Limit

Error vector magnitude rms

EVM RMS

High Limit

Peak code domain error

PCDE

High Limit

Highest level among inactive channels

Max Inactive

High Limit

4. Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit.
Toggle the Beep soft key between On and Off to enable or disable the beep sound.

5. Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings.
See “Using save” on page 31 for more information.

Performing auto measurements
The Auto Measure function of the JD780A series allows a complete signal profiling covering RF
characterization and modulation quality parameters of up to 10 different carriers, particularly useful on
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an overlay architecture where base stations are transmitting in different frequencies.
The Auto Measure can be easily executed either by selecting a menu in the instrument or by running a
programmed scenario in the PC-based application so that the instrument automatically configure and
perform tests on every aspect of all the carriers.
Setting limit
You can set test limits for test item(s) in the auto measurement.
Procedure

1. Press the LIMIT hot key.
2. Press the RF Test Limits soft key, and then enable test limits as desired.
3. Press the PvsT Test Limits soft key, and then enable test limits as desired.
4. Press the Modulation Test Limits soft key, and then enable test limits as desired.
5. Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit.
Toggle the Beep soft key between On and Off to enable or disable the beep sound.

6. Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings.
See “Using save” on page 31 for more information.

Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 387, you
can continue your measurement. The measurement settings can be saved and recalled as a file. You
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load
the file on to the instrument.
Procedure

1. Press the MEASURE SETUP hot key.
2. Toggle the Configuration soft key and select the configuration option:
–

Current: to let the instrumnet use current frequency (single carrier) and determine pass or
fail based on the instrument’s limit settings in Auto Measure.

–

Scenario: to run a test with a programmed scenario in JDViewer.
The Scenario menu becomes activated.

3. To load a scenario, press the Scenario soft key, and then select a scenario file to load.
4. Toggle the Test Time soft key and select the test time option:
–

Now: to let the instrument run a test only once.

–

Schedule: to let the instrument repeat tests as defined in the Set Timing.
The Set Timing menu becomes activated.

5. To define a schedule for an auto measurement, complete the following steps:
a.

Press the Set Timing soft key.

b.

Press the Start Time (HH:MM) soft key.

c.

Enter the time in the HH:MM format, and then press the Enter soft key.

d.

Press the Stop Time (HH:MM) soft key.

e.

Enter the time in the HH:MM format, and then press the Enter soft key.

f.

Press the Time Interval soft key.
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g.

Enter the amount of time in minutes, and then press the Enter soft key.

7. Press the Settings soft key, and then set the following:
a.

Press the Slot Number soft key, and then select the time slot number to be displayed: TS0,
TS1, TS2, TS3, TS4, TS5, or TS6.

b.

Toggle the External Offset soft key and select On.

c.

Enter a value by using the numeric keys, and then press the dB soft key.

8. To save your settings and results, go to SAVE/LOAD > Save and then perform functions as you
desire. See “Using save” on page 31 for more information.

9. Press the Run Test soft key to start to run a test.
The Auto Measure Results window appears at the end of the test.

10. To stop running the test, press the Abort soft key.
11. To change the view on the screen during the test, press the Display and then select the view
option from the following choices:

–

Screen: You can view each measurement screen as the test progresses.

–

Results: You can view a measurement result table as the test progresses.

–

Settings: You can view a measurement setting table as the test progresses.

Setting display
After completion of the auto measurement, the screen menu changes to Trace/Display so that you can
view the results in different forms.
Procedure

1. Toggle the Display soft key and select the display option:
–

Result: to view the result table.
The Display Result menu becomes activated.

–

Settings: to view the measurement settings for the auto measurement.

2. Toggle the Display Result soft key and select the display result option:
–

Full: to view detailed measurement readings with the pass/fail indication.

–

Quick: to view only the Pass/Fail results.

3. To view the measurement results for a different carrier, press the View Carrier soft key and then
select the carrier number to view.

Conducting TD-SCDMA OTA measurements
Sync-DL ID scanner
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 387, you
can continue your measurement.
Procedure

1. Press the MEASURE SETUP hot key.
2. Toggle the Sync-DL ID soft key and select Auto or Manual to set the Sync Downlink ID
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automatically or manually.

3. Optional. To select the delay, complete the following steps:
a.

Press the Miscellaneous soft key.

b.

Press the Delay soft key to set the amount of delay in µs.

c.

Enter a value by using the numeric keys. You can also use the rotary knob.

d.

Press the µs soft key.
NOTE
The Delay setting is used only when there is a time offset in the signals to be measured.

4. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available
for your measurement mode. See “Using save” on page 31 for more information.

Measurement example
Figure 206 Sync-DL ID scanner measurement with TD-SCDMA OTA signal analyzer

Sync-DL ID vs. Tau
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 387, you
can continue your measurement.
Procedure

1. Press the MEASURE SETUP hot key.
2. Toggle the Sync-DL ID soft key and select Auto or Manual to set the Sync Downlink ID
automatically or manually.

3. Optional. To select the delay, complete the following steps:
a.

Press the Miscellaneous soft key.

b.

Press the Delay soft key to set the amount of delay in µs.

c.

Enter a value by using the numeric keys. You can also use the rotary knob.
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d.

Press the µs soft key.
NOTE
The Delay setting is used only when there is a time offset in the signals to be measured.

4. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available
for your measurement mode. See “Using save” on page 31 for more information.

Measurement example
Figure 207 Sync-DL ID vs. Tau measurement with TD-SCDMA OTA signal analyzer

Sync-DL ID multipath
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 387, you
can continue your measurement.
Procedure

1. Press the MEASURE SETUP hot key.
2. Toggle the Sync-DL ID soft key and select Auto or Manual to set the Sync Downlink ID
automatically or manually.

3. Optional. To select the delay, complete the following steps:
a.

Press the Miscellaneous soft key.

b.

Press the Delay soft key to set the amount of delay in µs.

c.

Enter a value by using the numeric keys. You can also use the rotary knob.

d.

Press the µs soft key.
NOTE
The Delay setting is used only when there is a time offset in the signals to be measured.

4. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available
for your measurement mode. See “Using save” on page 31 for more information.
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Measurement example
Figure 208 Sync-DL ID multipath measurement with TD-SCDMA OTA signal analyzer

Sync-DL ID analyzer
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 387, you
can continue your measurement.
Procedure

1. Press the MEASURE SETUP hot key.
2. Toggle the Sync-DL ID soft key and select Auto or Manual to set the Sync Downlink ID
automatically or manually.

3. Optional. To select the delay, complete the following steps:
a.

Press the Miscellaneous soft key.

b.

Press the Delay soft key to set the amount of delay in µs.

c.

Enter a value by using the numeric keys. You can also use the rotary knob.

d.

Press the µs soft key.
NOTE
The Delay setting is used only when there is a time offset in the signals to be measured.

4. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available
for your measurement mode. See “Using save” on page 31 for more information.

Setting limit for Sync-DL ID analyzer
Procedure

1. Press the LIMIT hot key.
2. To set the limit for rms of the error vector magnitude, complete the following steps:
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a.

Press the EVM RMS soft key.

b.

Toggle the Test Limits soft key between On and Off to enable or disable the limit.

c.

Press the High Limit soft key, and then enter a value for the upper threshold.

d.

Press the Enter soft key.

3. To set the limit for frequency error, complete the following steps:
a.

Press the Frequency Error soft key.

b.

Toggle the Test Limits soft key between On and Off to enable or disable the limit.

c.

Press the High Limit soft key, and then enter a value for the upper threshold.

d.

Press the ppm soft key.

e.

Press the Low Limit soft key, and then enter a value for the lower threshold.

f.

Press the ppm soft key.

4. Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit.
Toggle the Beep soft key between On and Off to enable or disable the beep sound.

5. Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings.
See “Using save” on page 31 for more information.

Measurement example
Figure 209 Sync-DL ID analyzer measurement with TD-SCDMA OTA signal analyzer

Route map
The JD780A Series provides indoor and outdoor mapping function that allows a user to collect data of
points in an indoor or outdoor environment and track the received signals and coverage of RF
transmitters plotting real time directly on top of a loaded floor plan or a map.
Setting measure setup
Procedure

1. If required, connect a GPS receiver to your JD780A series for outdoor mapping.
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Indoor mapping does not necessarily need a GPS antenna.

2. Configure test parameters as described in the “Configuring test parameters” on page 387.
3. To load your map file, complete the following steps:
a.

Plug in your USB drive that has a floor map or .mcf file type created in JDMapCreator.
NOTE
The JDMapCreator converts and resizes any scanned floor plan or layout to fit onto your
instrument’s display. You must save your map files (.mcf) into the “SavedMap” folder of
your USB drive so that you can load them onto your instrument.

b.

Press SAVE/LOAD hot key, and then select Load > Load Map.
See “Using load” on page 34 for more information.

4. Press the MEASURE SETUP hot key.
5. Press the Plot Point soft key, and then select the plot point option from the following choices:
–

To collect data/plot points automatically as you move around in a vehicle or outside, press
the GPS soft key and then toggle the Screen Mode soft key between Map and Full.
NOTE
With the Map setting, you can view only the collected points that can be seen within the
boundary of the loaded map. If a point is off the map, the instrument displays an arrow to
indicate the direction of the current location on the map and the distance from the center
to the location at the top of the screen.
With the Full setting, you can view all the collected points of the route without the loaded
map.

–

To collect data/plot points manually without a GPS antenna in an indoor environment, press
the Position soft key.

6. Toggle the Plot soft key and select Start to start plotting.
7. Touch directly on the screen or press the ENTER hard key to collect data and plot points on the
loaded map for the Position setting.
NOTE
For the Position setting, you can change the direction of the route with the arrow keys
and the distance with the rotary knob.

8. Toggle the Plot soft key and select Stop to stop plotting.
9. Press the SAVE/LOAD hot key to save the result.
See “Using save” on page 31 for more information.
NOTE
The instrument does not automatically save the collected data. It is recommended that
you save the result. Otherwise, you will lose all the collected data.

Setting limit for route map
You can set the thresholds for each test item.
Procedure

1. Press the LIMIT hot key.
2. Press the Excellent soft key to set its threshold.
3. Enter a value, and then press the Enter soft key. You can also use the rotary knob.
4. Press the Very Good soft key to set its threshold.
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5. Enter a value, and then press the Enter soft key. You can also use the rotary knob.
6. Press the Good soft key to set its threshold.
7. Enter a value, and then press the Enter soft key. You can also use the rotary knob.
8. Press the Fair soft key to set its threshold.
9. Enter a value, and then press the Enter soft key. You can also use the rotary knob.
10. Press the Poor soft key to set its threshold.
11. Enter a value, and then press the Enter soft key. You can also use the rotary knob.
12. Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings.
See “Using save” on page 31 for more information.

Measurement example
Figure 210 Route map measurement with TD-SCDMA OTA signal analyzer
1) Map view

2) Full view
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Using Mobile WiMAX Signal Analyzer
This chapter provides instructions for using the Mobile WiMAX Signal Analyzer function (option 026)
with the Mobile WiMAX OTA Analyzer function (option 046). Topics discussed in this chapter are as
follows:
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Introduction
The Mobile WiMAX Signal Analyzer performs power and spectrum measurements as well as
modulation analysis to test the proper transmitter performance of Mobile WiMAX systems. It performs
conformance testing according to the following standards providing a simple Pass/Fail indication on
each test.


IEEE 802.16e-2005



WiBro (Korean Mobile WiMAX OFDMA Service)

This instrument provides the following measurement tools for Mobile WiMAX system:


Spectrum Analysis



RF Analysis
Channel Power
Occupied Bandwidth
Spectrum Emission Mask
Spurious Emissions



Power vs. Time (Frame)



Modulation Analysis
Constellation
Spectral Flatness
EVM vs. Subcarrier
EVM vs. Symbol



Auto Measure



Power Statistics CCDF



Over The Air (OTA)
Preamble Scanner
Multipath Profile
Preamble Power Trend
Route Map

Display overview
Figure 211 provides descriptions for each segment of the measurement screen.
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Figure 211 Mobile WiMAX signal analyzer measurement screen

Connecting a cable
Direct connection
Procedure

1. Connect the Spectrum Analyzer RF In port of the JD780A series and the Power amplifier output
port of BTS.

Figure 212 Direct connection

JD785A/JD786A

JD788A

Indirect connection
Procedure

1. Connect the Spectrum Analyzer RF In port of the JD780A series and the monitor (test) port of
BTS.
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Figure 213 Indirect connection

JD785A/JD786A

JD788A

CAUTION
The maximum power for the Spectrum Analyzer RF In port is +25 dBm (0.316 W). If the
input signal level to be measured is greater than +25 dBm, use a High Power
Attenuator to prevent damage when you directly connect the signal to the instrument or
connect the signal from the coupling port of a directional coupler.

Over the air (OTA)
Procedure

1. Connect an Omni/directional RF antenna to the Spectrum Analyzer RF In port of the JD780A
series.

2. Connect a GPS antenna to the GPS port of the JD780A series.
Figure 214 OTA connection

JD785A/JD786A

JD788A

CAUTION
If the input signal level to be measured is less than 0 dBm, set 0 dB attenuation or turn on
the preamp to have better dynamic range for the OTA testing.
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Selecting measurement mode
Procedure

1. Press the MODE hard key.
2. Press the Signal Analyzer soft key.
3. Press the More (1/2) > Mobile WiMAX soft key. The Spectrum mode is set by default.
4. Press the MEASURE hot key, and then select the measurement mode option from the following
choices:

–

Spectrum

–

RF Analysis > Channel Power, Occupied BW, Spectrum Emission Mask, or
Spurious Emissions

–

Power vs Time (Frame)

–

Modulation Analysis > Constellation, Spectral Flatness, EVM vs Subcarrier, or
EVM vs. Symbol

–

Auto Measure

–

Power Statistics CCDF

–

OTA > Preamble Scanner, Multipath Profile, Preamble Power Trend, or Route Map

Configuring test parameters
Setting frequency
You can set the frequency with either frequency or channel number. If a frequency to be set matches
to the frequency corresponding to the selected channel standard, the instrument calculates its channel
number and updates the screen with it automatically.
Procedure
To set the center frequency:

1. Press the FREQ/DIST hard key.
2. Toggle the Unit soft key and select Freq.
3. Press the Center Frequency soft key.
4. Enter a value by using the numeric keys. You can also use the rotary knob.
5. Select the unit: GHz, MHz, kHz, or Hz.
6. Optional. To define the amount of frequency increment for the rotary knob, complete the following
steps:
a.

Press the Frequency Step soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Press the unit: GHz, MHz, kHz, or Hz.

To set the channel number:

1. Press the FREQ/DIST hard key.
2. Toggle the Unit soft key and select Channel.
3. To select the standard channel, complete the following steps:
a.

Press the Channel Std soft key. The standard channel window appears.

Using Mobile WiMAX Signal Analyzer

427

JD780A Series Analyzers

See “Appendix C – Band, frequency & channel standard” on page 541 for more information.
b.

Select the band to be measured by using the rotary knob, the arrow keys, or the Page
Up/Page Down soft keys.

c.

Press the Select soft key or the rotary knob to confirm the selection.

4. Press the Channel Number soft key.
5. Enter a value by using the numeric keys. You can also use the rotary knob.
6. Press the Enter soft key.
The instrument automatically displays the corresponding center frequency value for the selected
channel number.

7. Optional. To define the amount of channel increment for the rotary knob, complete the following
steps:
a.

Press the Channel Step soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Press the Enter soft key.

NOTE
This frequency setting is not used in the Spurious Emissions mode.

Setting amplitude
Reference level and attenuation
You can set the reference and attenuation levels automatically or manually to optimize the display of
the traces measured, as you desire.
Procedure
To automatically set the reference and attenuation level:

1. Press the AMP/SCALE hard key.
2. Press the Auto Scale soft key.
Each time you press this key, both of the Y-axis scale and input attenuation level change to be
optimized with some margin.
To set the reference or attenuation level manually:

1. Press the AMP/SCALE hard key.
2. To set the maximum reference value on the Y-axis manually, complete the following steps:
a.

Press the Reference Level soft key.

b.

Enter a value by using the numeric keys or the rotary knob with 10 dB increments.

c.

Press the dBm soft key or the ENTER hard key.
NOTE
In the measurements such as Midamble Power, Code Power, and Code Error, you
may need to select the reference option between Relative and Absolute before setting
the reference level.

3. To set the attenuation option, select one from the following choices:
–

To set the input attenuator’s level automatically, select Attenuation > Auto.
NOTE
It is recommended that you set the Attenuation to Auto in most situations so that the
level of the input attenuator can be set automatically according to your input signal level.
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–

To set the input attenuation manually up to 55 dB to optimize S/N, complete the following
steps:

–

a.

Select Attenuation > Manual.

b.

Press the Attenuation Value soft key to set the level.

c.

Enter a value between 0 and 55 in fives by using the numeric keys.

d.

Press the dB soft key or the ENTER hard key.

To couple the input attenuator’s level with your reference level setting, select Attenuation >
Couple.
As you increse the reference setting, the attenuation level also increases acoordingly.

Optional. To change the scale unit:

1. Select More (1/2) > Units.
2. Select the unit of the display scale: dBm, dBV, dBmV, dBµV, V, or W.
The scale unit on the screen changes accordingly.
NOTE
This Units menu is available in the Spectrum and RF Analysis modes.

Scale per division
You can use the Scale/Div feature available for the spectrum and RF analysis. It represents the value
of one division on the horizontal scale. The default setting is 10 dB per division and the maximum
value can be set up to 20 dB.
Procedure
To set the scale per division:

1. Press the AMP/SCALE hard key.
2. Select More (1/2) > Scale/Div.
3. Enter a value between 1 and 20 by using the numeric keys.
4. Press the dB soft key to complete the entry.
Pre-amplifier
You can turn the internal pre-amplifier on to correct and compensate for the gain of the preamp so that
amplitude readings show the value at the input connector.
Procedure

1. Press the AMP/SCALE hard key.
2. Toggle the Preamp soft key and select On or Off as needed.
NOTE
You can turn the Preamp on when the input attenuation range is from 0 dB to 10 dB. If
the attenuation value is manually set to greater than 10 dB, the instrument will
automatically turn off the pre-amplifier to display low-level signal properly on the chart.
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External offset
You can turn the External Offset on and manually set the external offset value. An offset consists of a
cable loss and a user offset and the measurement result shows the value reflecting both offset values.
When the external offset value is set at 40 dB in the Spectrum mode, the measurement result
compensates 40 dB at both the Spectrum Analyzer and Signal Analyzer modes
Procedure
To set the external offset:

1. Press the AMP/SCALE hard key.
2. Toggle the External Offset soft key and select On.
3. Enter a value by using the numeric keys.
4. Press the dB soft key to complete the entry.
To turn the external offset off:

1. Press the AMP/SCALE hard key.
2. Toggle the External Offset soft key and select Off.

Setting average
You can set the number of measurements to be averaged for the trace presentation. A maximum of
100 times of averaging can be set. When the averaging reaches to your setting, a new measurement
value replaces the measurement value in sequence from the earliest.
Procedure

1. Press the BW/AVG hard key.
2. Press the Average soft key.
3. Enter a value between 1 and 100 as needed by using the numeric keys.
4. Press the Enter soft key.

Setting sweep mode
The default settings of the sweep mode are Continue and Normal to sweep continuously at a normal
speed for most on-going measurements. If you want to hold the measurement or get a single sweep,
you can change the sweep mode.
Procedure
To select the single sweep mode:

1. Press the SWEEP hot key.
2. Toggle the Sweep Mode soft key and select Single. You can also use the HOLD hot key.
The letter HOLD in red appears and the sweeping is paused.

3. Optional. Press the Sweep Once soft key to get a new measurement.
To return to the continuous sweep mode:

1. Toggle the Sweep Mode soft key and select Continue. You can also use the HOLD hot key.
The letter HOLD in red disappears and the sweeping resumes.
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Setting trigger source
You can set the trigger source option for your measurements.
Procedure

1. Press the TRIGGER hot key.
2. Select the trigger source option from the following choices: Internal, External, or GPS.

Setting external clock
To enhance the reliability of modulation analysis measurements the JD780A series must be
synchronized with a base station. When an external clock is not supplied, the instrument works with its
built-in internal high-accuracy time base and some measurement results may exhibit inaccurate values.
Therefore, it is highly recommended that you use the same reference clock as the signal source. You
can use the TRIGGER hot key to set the external clock.
Figure 215 Connection ports for external reference clock

Procedure

1. Connect an external reference or a GPS antenna to the JD780A series.
2. Press the SYSTEM hot key.
3. Press the Freq Reference soft key, and then select the reference option: Internal, External 10
MHz, External 13 MHz, External 15 MHz, or GPS.

Table 21
Type

External reference indicators
Indicator

Description

Internal

(green)

The green INT icon indicates that the instrument uses the built-in
internal time base.

External

(green)

The green EXT icon indicates that an external reference is connected
and locked and that the instrument uses the same reference clock as
the signal source.

External

(red)

The red EXT icon indicates that an external reference is connect but not
locked.

GPS

(green)

The green GPS antenna icon indicates that a GPS antenna is
connected and locked.

GPS

(yellow)

The yellow GPS antenna icon indicates that a GPS antenna is
connected and locking is in progress.

GPS

(grey)

The grey GPS antenna icon indicates that a GPS antenna is not
connected, failed, or unable to be locked.
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Conducting spectrum measurements
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 427, you
can continue your measurement.
Procedure

1. Press the MEASURE SETUP hot key.
2. Press the System Config soft key, and then do the following:
a.

Press the Bandwidth soft key, and then select the nominal channel bandwidth to be
measured from the following choices:

–

7 MHz (8/7): Sets the channel bandwidth to 7 MHz with sampling factor 8/7. In
conjunction with nominal channel bandwidth

–

8.75 MHz (8/7): Sets the channel bandwidth to 8.75 MHz with sampling factor 8/7

–

10 MHz (28/25): Sets the channel bandwidth to 10 MHz with sampling factor 28/25

b.

Toggle the Frame Length soft key and select 5 ms or 10 ms.

c.

Press the TTG (RTG) soft key to set the transmit/receive transition gap between the last
sample of the downlink burst and the first sample of the subsequent uplink burst.

d.

Enter a value by using the numeric keys, and then press the Enter soft key.

e.

Press the CP Ratio soft key, and then select the cyclic prefix ratio option: 1/4, 1/8, 1/16, or
1/32.

f.

Press the DL Symbols soft key to set the number of downlink symbols.

g.

Enter a value by using the numeric keys, and then press the Enter soft key.

h.

Press the UL Symbols soft key to set the number of uplink symbols.

i.

Enter a value by using the numeric keys, and then press the Enter soft key.

3. Optional. To set the delay, complete the following steps:
a.

Press the Delay soft key to set the amount of delay in µs.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Press the µs soft key.
NOTE
The Delay setting is used only when there is a time offset in the signals to be measured.

Your measurement result is displayed on the screen as like the following example, Figure 216.
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Figure 216 Spectrum measurement screen with Mobile WiMAX signal analyzer

Setting trace
You can display up to six traces on the measurement chart simultaneously.
Procedure

1. Press the TRACE/DISPLAY hard key.
2. Press the Select Trace soft key, and then select the trace number: T1, T2, T3, T4, T5, or T6.
The legend shape of the selected trace changes from square to round to indicate that the trace is
the active one now.

3. Toggle the Trace View soft key and select On.
4. To clear, write or capture, or hide the trace(s), do one of the following:
To

Select

Trace Legend

Clear current data and display with new
measurements

Clear Write

W

Display the input signal’s maximum response only

Max Hold

M

Display the input signal’s minimum response only

Min Hold

m

Capture the selected trace and compare traces

Capture

C

Load a saved trace

More (1/2) > Load

L

Hide the selected trace

Trace View > Off

F

Remove all the traces and initialize the trace
settings

More (1/2) > Trace
Clear All

5. Optional. Press the More (1/2) > Trace Info soft key, and then select the trace number to view
the trace’s parameter setting information stored at the time of the measurement or None to hide
the information display.

6. Optional. If you have the two traces T1 and T2, you can perform trace math. To view the power
difference between the traces, press the T1 – T2 -> T5 or T2 – T1 -> T6 soft key.
The result is overlaid on the screen along with the second Y-axis.
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Conducting RF measurements
Channel power
The Channel Power measurement is a common test used in the wireless industry to measure the total
transmitted power of a radio within a defined frequency channel. It acquires a number of points
representing the input signal in the time domain, transforms this information into the frequency domain
using Fast Fourier Transform (FFT), and then calculates the channel power. The effective resolution
bandwidth of the frequency domain trace is proportional to the number of points acquired for the FFT.
The channel power measurement identifies the total RF power, power spectral density (PSD) and peak
to average ratio (PAR) of the signal in the Mobile WiMAX channel bandwidth.
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 427, you
can continue your measurement.
Procedure

1. Press the MEASURE SETUP hot key.
2. Press the System Config soft key, and then do the following:
a.

Press the Bandwidth soft key, and then select the nominal channel bandwidth to be
measured from the following choices:

–

7 MHz (8/7): Sets the channel bandwidth to 7 MHz with sampling factor 8/7. In
conjunction with nominal channel bandwidth

–

8.75 MHz (8/7): Sets the channel bandwidth to 8.75 MHz with sampling factor 8/7

–

10 MHz (28/25): Sets the channel bandwidth to 10 MHz with sampling factor 28/25

b.

Toggle the Frame Length soft key and select 5 ms or 10 ms.

c.

Press the TTG (RTG) soft key to set the transmit/receive transition gap between the last
sample of the downlink burst and the first sample of the subsequent uplink burst.

d.

Enter a value by using the numeric keys, and then press the Enter soft key.

e.

Press the CP Ratio soft key, and then select the cyclic prefix ratio option: 1/4, 1/8, 1/16, or
1/32.

f.

Press the DL Symbols soft key to set the number of downlink symbols.

g.

Enter a value by using the numeric keys, and then press the Enter soft key.

h.

Press the UL Symbols soft key to set the number of uplink symbols.

i.

Enter a value by using the numeric keys, and then press the Enter soft key.

3. Optional. To set the delay, complete the following steps:
a.

Press the Delay soft key to set the amount of delay in µs.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Press the µs soft key.
NOTE
The Delay setting is used only when there is a time offset in the signals to be measured.

4. To set the start/stop symbols, complete the following steps:
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a.

Press the Start Symbol soft key.

b.

Enter a value by using the numeric keys, and then press the Enter soft key.
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c.

Press the Stop Symbol soft key.

d.

Enter a value by using the numeric keys, and then press the Enter soft key.

Measurement example
Figure 217 Channel power measurement with Mobile WiMAX signal analyzer

NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 440 for more
information.

Occupied bandwidth
The Occupied Bandwidth measures the spectrum shape of the carrier. It is defined as the bandwidth,
which includes 99% of the transmitted power among total transmitted power.
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 427, you
can continue your measurement.
Procedure

1. Press the MEASURE SETUP hot key.
2. Press the System Config soft key, and then do the following:
a.

b.

Press the Bandwidth soft key, and then select the nominal channel bandwidth to be
measured from the following choices:

–

7 MHz (8/7): Sets the channel bandwidth to 7 MHz with sampling factor 8/7. In
conjunction with nominal channel bandwidth

–

8.75 MHz (8/7): Sets the channel bandwidth to 8.75 MHz with sampling factor 8/7

–

10 MHz (28/25): Sets the channel bandwidth to 10 MHz with sampling factor 28/25

Toggle the Frame Length soft key and select 5 ms or 10 ms.
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c.

Press the TTG (RTG) soft key to set the transmit/receive transition gap between the last
sample of the downlink burst and the first sample of the subsequent uplink burst.

d.

Enter a value by using the numeric keys, and then press the Enter soft key.

e.

Press the CP Ratio soft key, and then select the cyclic prefix ratio option: 1/4, 1/8, 1/16, or
1/32.

f.

Press the DL Symbols soft key to set the number of downlink symbols.

g.

Enter a value by using the numeric keys, and then press the Enter soft key.

h.

Press the UL Symbols soft key to set the number of uplink symbols.

i.

Enter a value by using the numeric keys, and then press the Enter soft key.

3. Optional. To set the delay, complete the following steps:
a.

Press the Delay soft key to set the amount of delay in µs.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Press the µs soft key.
NOTE
The Delay setting is used only when there is a time offset in the signals to be measured.

4. To set the start/stop symbols, complete the following steps:
a.

Press the Start Symbol soft key.

b.

Enter a value by using the numeric keys, and then press the Enter soft key.

c.

Press the Stop Symbol soft key.

d.

Enter a value by using the numeric keys, and then press the Enter soft key.

Measurement example
Figure 218 Occupied bandwidth measurement with Mobile WiMAX signal analyzer

NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 440 for more
information.
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Spectrum emission mask (SEM)
The Spectrum Emission Mask (SEM) measurement compares the total power level within the defined
carrier bandwidth and the given offset channels according to the standards.
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 427, you
can continue your measurement.
Procedure

1. Press the MEASURE SETUP hot key.
2. Press the System Config soft key, and then do the following:
a.

Press the Bandwidth soft key, and then select the nominal channel bandwidth to be
measured from the following choices:

–

7 MHz (8/7): Sets the channel bandwidth to 7 MHz with sampling factor 8/7. In
conjunction with nominal channel bandwidth

–

8.75 MHz (8/7): Sets the channel bandwidth to 8.75 MHz with sampling factor 8/7

–

10 MHz (28/25): Sets the channel bandwidth to 10 MHz with sampling factor 28/25

b.

Toggle the Frame Length soft key and select 5 ms or 10 ms.

c.

Press the TTG (RTG) soft key to set the transmit/receive transition gap between the last
sample of the downlink burst and the first sample of the subsequent uplink burst.

d.

Enter a value by using the numeric keys, and then press the Enter soft key.

e.

Press the CP Ratio soft key, and then select the cyclic prefix ratio option: 1/4, 1/8, 1/16, or
1/32.

f.

Press the DL Symbols soft key to set the number of downlink symbols.

g.

Enter a value by using the numeric keys, and then press the Enter soft key.

h.

Press the UL Symbols soft key to set the number of uplink symbols.

i.

Enter a value by using the numeric keys, and then press the Enter soft key.

3. Optional. To set the delay, complete the following steps:
a.

Press the Delay soft key to set the amount of delay in µs.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Press the µs soft key.
NOTE
The Delay setting is used only when there is a time offset in the signals to be measured.

4. To set the start/stop symbols, complete the following steps:
a.

Press the Start Symbol soft key.

b.

Enter a value by using the numeric keys, and then press the Enter soft key.

c.

Press the Stop Symbol soft key.

d.

Enter a value by using the numeric keys, and then press the Enter soft key.
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Measurement example
Figure 219 SEM measurement with Mobile WiMAX signal analyzer

NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 440 for more
information.

Spurious emissions
Out-of-band emissions are unwanted emissions immediately outside the channel bandwidth resulting
from the modulation process and non-linearity in the transmitter but excluding spurious emissions. The
Spurious Emissions measurement is to identify and determine the power level of out-of-band spurious
emission within the necessary channel bandwidth and modulated signal measured at the RF port of
the Base Station.
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 427, you
can continue your measurement.
Procedure

1. Press the MEASURE SETUP hot key.
2. To set up the range table and frequency range, press the Range Table soft key and then
complete the following steps:
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a.

Press the Range soft key, and then enter the range number to add a new range or change
an existing one.

b.

Press the Enter soft key.

c.

Press the Start Frequency soft key to set up the frequency range.

d.

Enter a value by using the numeric keys. You can also use the rotary knob.

e.

Select the unit: GHz, MHz, kHz, or Hz.

f.

Press the Stop Frequency soft key to set up the frequency range.
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g.

Enter a value by using the numeric keys. You can also use the rotary knob.

h.

Select the unit: GHz, MHz, kHz, or Hz.

3. Toggle the Range soft key between On and Off to display or hide the selected range.
4. To set up the test limits for Pass/Fail indication, complete the following steps:
a.

Press the Start Limit soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Select the dBm soft key.

d.

Press the Stop Limit soft key.

e.

Enter a value by using the numeric keys. You can also use the rotary knob.

f.

Select the dBm soft key.

5. To set up the other parameters, complete the following steps:
a.

Select More (1/2) > Attenuation to set up the attenuation value.

b.

Enter a value in the multiple of five.

c.

Press the dB soft key or the ENTER hard key.

d.

Press the RBW soft key.

e.

Enter a value by using the numeric keys.

f.

Select the unit: GHz, MHz, kHz, or Hz.

g.

Press the VBW soft key.

h.

Enter a value by using the numeric keys.

i.

Select the unit: GHz, MHz, kHz, or Hz.

6. Press the PREV hard key.
7. Toggle the Measure Type soft key between Examine and Full to select the measurement type.
NOTE
The Examine mode displays only the selected range while the Full mode lets the
instrument automatically changes the selected range from one another.

8. Set the number of measurements to be averaged:
a.

Press the Average soft key.

b.

Enter a value between 1 and 100.

c.

Press the Enter soft key.
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Measurement example
Figure 220 Spurious emissions measurement with Mobile WiMAX signal analyzer

NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 440 for more
information.

Setting limit for RF tests
By default, test limits specified in the standard are set for you. You can change thresholds if you desire.
Procedure

1. Press the LIMIT hot key.
2. Press the RF Test Limits soft key.
3. Select the test item(s) and set the limit(s) depending on your selected measurement mode:
To set the limit for

Select

Set

Channel power

Channel Power

High Limit
Low Limit

Occupied bandwidth

Occupied BW

High Limit

Spectrum emission mask

Spectrum Emission Mask

(On/Off only)

Spurious emissions

Spurious Emissions

(On/Off only)

4. Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit.
Toggle the Beep soft key between On and Off to enable or disable the beep sound.

5. Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings.
See “Using save” on page 31 for more information.
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Conducting power vs. time (frame) measurements
The Power vs. Time (Frame) measures the modulation envelope in the time domain, showing the
power of each time slot in a Mobile WiMAX signal.

Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 427, you
can continue your measurement. The measurement settings can be saved and recalled as a file.
Procedure

1. Press the MEASURE SETUP hot key.
2. Press the System Config soft key, and then do the following:
a.

Press the Bandwidth soft key, and then select the nominal channel bandwidth to be
measured from the following choices:

–

7 MHz (8/7): Sets the channel bandwidth to 7 MHz with sampling factor 8/7. In
conjunction with nominal channel bandwidth

–

8.75 MHz (8/7): Sets the channel bandwidth to 8.75 MHz with sampling factor 8/7

–

10 MHz (28/25): Sets the channel bandwidth to 10 MHz with sampling factor 28/25

b.

Toggle the Frame Length soft key and select 5 ms or 10 ms.

c.

Press the TTG (RTG) soft key to set the transmit/receive transition gap between the last
sample of the downlink burst and the first sample of the subsequent uplink burst.

d.

Enter a value by using the numeric keys, and then press the Enter soft key.

e.

Press the CP Ratio soft key, and then select the cyclic prefix ratio option: 1/4, 1/8, 1/16, or
1/32.

f.

Press the DL Symbols soft key to set the number of downlink symbols.

g.

Enter a value by using the numeric keys, and then press the Enter soft key.

h.

Press the UL Symbols soft key to set the number of uplink symbols.

i.

Enter a value by using the numeric keys, and then press the Enter soft key.

3. To set the start/stop symbols, complete the following steps:
a.

Press the Start Symbol soft key.

b.

Enter a value by using the numeric keys, and then press the Enter soft key.

c.

Press the Stop Symbol soft key.

d.

Enter a value by using the numeric keys, and then press the Enter soft key.

4. Toggle the Preamble Index soft key and select the preamble search method: Auto or Manual.
5. Toggle the Search Type soft key and select Full or Window.
6. Toggle the Video Filter soft key and select On or Off to enable or disable the video filter.
7. Optional. Press the Miscellaneous soft key, and then do the following as needed:
–

To set the delay, complete the following steps:
a.

Press the Delay soft key to set the amount of delay in µs.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Press the µs soft key.

NOTE
The Delay setting is used only when there is a time offset in the signals to be measured.
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–

To select the detect mode, press the Detect Mode soft key and then select the option:
Auto, QPSK, 16 QAM, or 64 QAM.

Setting limit for power vs. time tests
Procedure

1. Press the LIMIT hot key.
2. Press the PvsT Test Limits soft key.
3. Select the test item(s) and set the limit(s):
To set the limit for

Select

Set

Preamble power

Preamble Power

High Limit, Low Limit

Downlink burst power

DL Burst Power

High Limit, Low Limit

Uplink burst power

UL Burst Power

High Limit, Low Limit

Frame average power

Frame Average Power

High Limit, Low Limit

Time offset

Time Offset

High Limit, Low Limit

I/Q origin offset

IQ Origin Offset

High Limit

4. Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit.
Toggle the Beep soft key between On and Off to enable or disable the beep sound.

5. Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings.
See “Using save” on page 31 for more information.

Measurement example
Figure 221 Power vs. time (frame) measurement with Mobile WiMAX signal analyzer

442

Using Mobile WiMAX Signal Analyzer

JD780A Series Analyzers

Conducting modulation measurements
Constellation
The Constellation is used to observe some aspects of modulation accuracy and can reveal certain
fault mechanisms such as I/Q amplitude imbalance or quadrature imbalance. It displays constellation
diagram by modulation types.
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 427, you
can continue your measurement. The measurement settings can be saved and recalled as a file. You
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load
the file on to the instrument.
Procedure

1. Press the MEASURE SETUP hot key.
2. Press the System Config soft key, and then do the following:
a.

Press the Bandwidth soft key, and then select the nominal channel bandwidth to be
measured from the following choices:

–

7 MHz (8/7): Sets the channel bandwidth to 7 MHz with sampling factor 8/7. In
conjunction with nominal channel bandwidth

–

8.75 MHz (8/7): Sets the channel bandwidth to 8.75 MHz with sampling factor 8/7

–

10 MHz (28/25): Sets the channel bandwidth to 10 MHz with sampling factor 28/25

b.

Toggle the Frame Length soft key and select 5 ms or 10 ms.

c.

Press the TTG (RTG) soft key to set the transmit/receive transition gap between the last
sample of the downlink burst and the first sample of the subsequent uplink burst.

d.

Enter a value by using the numeric keys, and then press the Enter soft key.

e.

Press the CP Ratio soft key, and then select the cyclic prefix ratio option: 1/4, 1/8, 1/16, or
1/32.

f.

Press the DL Symbols soft key to set the number of downlink symbols.

g.

Enter a value by using the numeric keys, and then press the Enter soft key.

h.

Press the UL Symbols soft key to set the number of uplink symbols.

i.

Enter a value by using the numeric keys, and then press the Enter soft key.

3. To set the start/stop symbols, complete the following steps:
a.

Press the Start/Stop Symbol soft key.

b.

Enter a value by using the numeric keys, and then press the Enter soft key.

4. Toggle the Preamble Index soft key and select the preamble search method: Auto or Manual.
5. Toggle the Search Type soft key and select Full or Window.
6. Optional. Press the Miscellaneous soft key, and then do the following as needed:
–

To select the detect mode, press the Detect Mode soft key and then select the option:
Auto, QPSK, 16 QAM, or 64 QAM.

–

To select the downlink zone, press the DL Zone soft key and then select the permutation
zone option: Auto, PUSC for partial usage of subcarrier channels, FUSC for full usage of
subcarrier channels, or AMC2X3 for adaptive modulation and coding.
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NOTE
The permutation zone that is a number of contiguous OFDMA symbols in downlink that
use the same permutation. The DL subframe may contain more than one permutation
zone. The maximum number of DL zone is 8 in one DL subframe.

–

To set the delay, complete the following steps:
a.

Press the Delay soft key to set the amount of delay in µs.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Press the µs soft key.

NOTE
The Delay setting is used only when there is a time offset in the signals to be measured.

Measurement example
Figure 222 Constellation measurement with Mobile WiMAX signal analyzer

NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 450 for
more information. The Spectral Flatness is not used in the Constellation mode.

Spectral flatness
The Spectral Flatness is used to measure the flatness energy of the constellation according to the
WiMAX specification IEEE 802.16e.
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 427, you
can continue your measurement. The measurement settings can be saved and recalled as a file. You
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load
the file on to the instrument.
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Procedure

1. Press the MEASURE SETUP hot key.
2. Press the System Config soft key, and then do the following:
a.

Press the Bandwidth soft key, and then select the nominal channel bandwidth to be
measured from the following choices:

–

7 MHz (8/7): Sets the channel bandwidth to 7 MHz with sampling factor 8/7. In
conjunction with nominal channel bandwidth

–

8.75 MHz (8/7): Sets the channel bandwidth to 8.75 MHz with sampling factor 8/7

–

10 MHz (28/25): Sets the channel bandwidth to 10 MHz with sampling factor 28/25

b.

Toggle the Frame Length soft key and select 5 ms or 10 ms.

c.

Press the TTG (RTG) soft key to set the transmit/receive transition gap between the last
sample of the downlink burst and the first sample of the subsequent uplink burst.

d.

Enter a value by using the numeric keys, and then press the Enter soft key.

e.

Press the CP Ratio soft key, and then select the cyclic prefix ratio option: 1/4, 1/8, 1/16, or
1/32.

f.

Press the DL Symbols soft key to set the number of downlink symbols.

g.

Enter a value by using the numeric keys, and then press the Enter soft key.

h.

Press the UL Symbols soft key to set the number of uplink symbols.

i.

Enter a value by using the numeric keys, and then press the Enter soft key.

3. To set the start/stop symbols, complete the following steps:
a.

Press the Start Symbol soft key.

b.

Enter a value by using the numeric keys, and then press the Enter soft key.

c.

Press the Stop Symbol soft key.

d.

Enter a value by using the numeric keys, and then press the Enter soft key.

4. Toggle the Preamble Index soft key and select the preamble search method: Auto or Manual.
5. Toggle the Search Type soft key and select Full or Window.
6. Optional. Press the Miscellaneous soft key, and then do the following as needed:
–

To select the detect mode, press the Detect Mode soft key and then select the option:
Auto, QPSK, 16 QAM, or 64 QAM.

–

To select the downlink zone, press the DL Zone soft key and then select the permutation
zone option: Auto, PUSC for partial usage of subcarrier channels, FUSC for full usage of
subcarrier channels, or AMC2X3 for adaptive modulation and coding.
NOTE
The permutation zone, which is a number of contiguous OFDMA, symbols in downlink
that use the same permutation. The DL subframe may contain more than one
permutation zone. The maximum number of DL zone is 8 in one DL subframe.

–

To set the delay, complete the following steps:
a.

Press the Delay soft key to set the amount of delay in µs.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Press the µs soft key.

NOTE
The Delay setting is used only when there is a time offset in the signals to be measured.
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Measurement example
Figure 223 Spectral flatness measurement with Mobile WiMAX signal analyzer

NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication for the Spectral Flatness. See “Setting limit for modulation
tests” on page 450 for more information.

EVM vs. subcarrier
The EVM vs Subcarrier shows the error vector magnitude representing the average constellation error
of WIMAX OFDMA subcarriers.
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 427, you
can continue your measurement. The measurement settings can be saved and recalled as a file. You
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load
the file on to the instrument.
Procedure

1. Press the MEASURE SETUP hot key.
2. Press the System Config soft key, and then do the following:
a.
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Press the Bandwidth soft key, and then select the nominal channel bandwidth to be
measured from the following choices:

–

7 MHz (8/7): Sets the channel bandwidth to 7 MHz with sampling factor 8/7. In
conjunction with nominal channel bandwidth

–

8.75 MHz (8/7): Sets the channel bandwidth to 8.75 MHz with sampling factor 8/7

–

10 MHz (28/25): Sets the channel bandwidth to 10 MHz with sampling factor 28/25

b.

Toggle the Frame Length soft key and select 5 ms or 10 ms.

c.

Press the TTG (RTG) soft key to set the transmit/receive transition gap between the last
sample of the downlink burst and the first sample of the subsequent uplink burst.
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d.

Enter a value by using the numeric keys, and then press the Enter soft key.

e.

Press the CP Ratio soft key, and then select the cyclic prefix ratio option: 1/4, 1/8, 1/16, or
1/32.

f.

Press the DL Symbols soft key to set the number of downlink symbols.

g.

Enter a value by using the numeric keys, and then press the Enter soft key.

h.

Press the UL Symbols soft key to set the number of uplink symbols.

i.

Enter a value by using the numeric keys, and then press the Enter soft key.

3. To set the start/stop symbols, complete the following steps:
a.

Press the Start/Stop Symbol soft key.

b.

Enter a value by using the numeric keys, and then press the Enter soft key.

4. Toggle the Preamble Index soft key and select the preamble search method: Auto or Manual.
5. Toggle the Search Type soft key and select Full or Window.
6. Optional. Press the Miscellaneous soft key, and then do the following as needed:
–

To select the detect mode, press the Detect Mode soft key and then select the option:
Auto, QPSK, 16 QAM, or 64 QAM.

–

To select the downlink zone, press the DL Zone soft key and then select the permutation
zone option: Auto, PUSC for partial usage of subcarrier channels, FUSC for full usage of
subcarrier channels, or AMC2X3 for adaptive modulation and coding.
NOTE
The permutation zone, which is a number of contiguous OFDMA, symbols in downlink
that use the same permutation. The DL subframe may contain more than one
permutation zone. The maximum number of DL zone is 8 in one DL subframe.

–

To set the delay, complete the following steps:
a.

Press the Delay soft key to set the amount of delay in µs.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Press the µs soft key.

NOTE
The Delay setting is used only when there is a time offset in the signals to be measured.
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Measurement example
Figure 224 EVM vs. subcarrier measurement with Mobile WiMAX signal analyzer

NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 450 for
more information. The Spectral Flatness and Frequency Error are not used in the EVM
vs. Subcarrier mode.

EVM vs. symbol
The EVM vs Symbol is used to show the error vector magnitude representing the average
constellation error of WiMAX OFDMA symbols.
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 427, you
can continue your measurement. The measurement settings can be saved and recalled as a file. You
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load
the file on to the instrument.
Procedure

1. Press the MEASURE SETUP hot key.
2. Press the System Config soft key, and then do the following:
a.
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Press the Bandwidth soft key, and then select the nominal channel bandwidth to be
measured from the following choices:

–

7 MHz (8/7): Sets the channel bandwidth to 7 MHz with sampling factor 8/7. In
conjunction with nominal channel bandwidth

–

8.75 MHz (8/7): Sets the channel bandwidth to 8.75 MHz with sampling factor 8/7

–

10 MHz (28/25): Sets the channel bandwidth to 10 MHz with sampling factor 28/25

b.

Toggle the Frame Length soft key and select 5 ms or 10 ms.

c.

Press the TTG (RTG) soft key to set the transmit/receive transition gap between the last
sample of the downlink burst and the first sample of the subsequent uplink burst.
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d.

Enter a value by using the numeric keys, and then press the Enter soft key.

e.

Press the CP Ratio soft key, and then select the cyclic prefix ratio option: 1/4, 1/8, 1/16, or
1/32.

f.

Press the DL Symbols soft key to set the number of downlink symbols.

g.

Enter a value by using the numeric keys, and then press the Enter soft key.

h.

Press the UL Symbols soft key to set the number of uplink symbols.

i.

Enter a value by using the numeric keys, and then press the Enter soft key.

3. To set the start/stop symbols, complete the following steps:
a.

Press the Start/Stop Symbol soft key.

b.

Enter a value by using the numeric keys, and then press the Enter soft key.

4. Toggle the Preamble Index soft key and select the preamble search method: Auto or Manual.
5. Toggle the Search Type soft key and select Full or Window.
6. Optional. Press the Miscellaneous soft key, and then do the following as needed:
–

To select the detect mode, press the Detect Mode soft key and then select the option:
Auto, QPSK, 16 QAM, or 64 QAM.

–

To select the downlink zone, press the DL Zone soft key and then select the permutation
zone option: Auto, PUSC for partial usage of subcarrier channels, FUSC for full usage of
subcarrier channels, or AMC2X3 for adaptive modulation and coding.
NOTE
The permutation zone, which is a number of contiguous OFDMA, symbols in downlink
that use the same permutation. The DL subframe may contain more than one
permutation zone. The maximum number of DL zone is 8 in one DL subframe.

–

To set the delay, complete the following steps:
a.

Press the Delay soft key to set the amount of delay in µs.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Press the µs soft key.

NOTE
The Delay setting is used only when there is a time offset in the signals to be measured.
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Measurement example
Figure 225 EVM vs. symbol measurement with Mobile WiMAX signal analyzer

NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 450 for
more information. The Spectral Flatness and Frequency Error are not used in the EVM
vs. Subcarrier mode.

Setting limit for modulation tests
Procedure

1. Press the LIMIT hot key.
2. Press the Modulation Test Limits soft key to set the limits.
3. Select the test item(s) and set the limit(s) depending on your selected measurement mode:
To set the limit for

Select

Set

Spectral flatness

Spectral Flatness

On/Off

Frequency error

Frequency Error

High Limit
Low Limit

RMS for RCE

RCE RMS

High Limit

Peak for RCE

RCE Peak

High Limit

RMS for error vector magnitude

EVM RMS

High Limit

Peak for error vector magnitude

EVM Peak

High Limit

4. Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit.
Toggle the Beep soft key between On and Off to enable or disable the beep sound.

5. Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings.
See “Using save” on page 31 for more information.
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Performing auto measurements
The Auto Measure function of the JD780A series allows a complete signal profiling covering RF
characterization and modulation quality parameters of up to 10 different carriers, particularly useful on
an overlay architecture where base stations are transmitting in different frequencies.
The Auto Measure can be easily executed either by selecting a menu in the instrument or by running a
programmed scenario in the PC-based application so that the instrument automatically configure and
perform tests on every aspect of all the carriers.
Setting limit
You can set test limits for test item(s) in the auto measurement.
Procedure

1. Press the LIMIT hot key.
2. Press the RF Test Limits soft key, and then enable test limits as desired.
3. Press the PvsT Test Limits soft key, and then enable test limits as desired.
4. Press the Modulation Test Limits soft key, and then enable test limits as desired.
5. Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit.
Toggle the Beep soft key between On and Off to enable or disable the beep sound.

6. Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings.
See “Using save” on page 31 for more information.

Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 427, you
can continue your measurement. The measurement settings can be saved and recalled as a file. You
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load
the file on to the instrument.
Procedure

1. Press the MEASURE SETUP hot key.
2. Toggle the Configuration soft key and select the configuration option:
–

Current: to let the instrumnet use current frequency (single carrier) and determine pass or
fail based on the instrument’s limit settings in Auto Measure.

–

Scenario: to run a test with a programmed scenario in JDViewer.
The Scenario menu becomes activated.

3. To load a scenario, press the Scenario soft key, and then select a scenario file to load.
4. Toggle the Test Time soft key and select the test time option:
–

Now: to let the instrument run a test only once.

–

Schedule: to let the instrument repeat tests as defined in the Set Timing.
The Set Timing menu becomes activated.

5. To define a schedule for an auto measurement, complete the following steps:
a.

Press the Set Timing soft key.

b.

Press the Start Time (HH:MM) soft key.
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c.

Enter the time in the HH:MM format, and then press the Enter soft key.

d.

Press the Stop Time (HH:MM) soft key.

e.

Enter the time in the HH:MM format, and then press the Enter soft key.

f.

Press the Time Interval soft key.

g.

Enter the amount of time in minutes, and then press the Enter soft key.

7. Press the Settings soft key, and then set the following:
a.

Press the Start Symbol soft key.

b.

Enter a value by using the numeric keys, and then press the Enter soft key.

c.

Press the Stop Symbol soft key.

d.

Enter a value by using the numeric keys, and then press the Enter soft key.

e.

Toggle the External Offset soft key and select On or Off.

f.

Enter a value by using the numeric keys, and then press the dB soft key.

8. To save your settings and results, go to SAVE/LOAD > Save and then perform functions as you
desire. See “Using save” on page 31 for more information.

9. Press the Run Test soft key to start to run a test.
The Auto Measure Results window appears at the end of the test.

10. To stop running the test, press the Abort soft key.
11. To change the view on the screen during the test, press the Display and then select the view
option from the following choices:

–

Screen: You can view each measurement screen as the test progresses.

–

Results: You can view a measurement result table as the test progresses.

–

Settings: You can view a measurement setting table as the test progresses.

Setting display
After completion of the auto measurement, the screen menu changes to Trace/Display so that you can
view the results in different forms.
Procedure

1. Toggle the Display soft key and select the display option:
–

Result: to view the result table.
The Display Result menu becomes activated.

–

Settings: to view the measurement settings for the auto measurement.

2. Toggle the Display Result soft key and select the display result option:
–

Full: to view detailed measurement readings with the pass/fail indication.

–

Quick: to view only the Pass/Fail results.

3. To view the measurement results for a different carrier, press the View Carrier soft key and then
select the carrier number to view.

Performing power statistics CCDF measurements
The Power Statistics Complementary Cumulative Distribution Function (CCDF) measurement
characterizes the power statistics of the input signal. It provides PAR (Peak to Average power Ratio)
versus different probabilities.
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Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 427, you
can continue your measurement. The measurement settings can be saved and recalled as a file. You
can also use JDViewer, PC application software to configure a measure setup, save as a file, and load
the file on to the instrument.
Procedure

1. Press the MEASURE SETUP hot key.
2. Press the CCDF Length soft key to set the length of the CCDF.
3. Enter a value between 1 and 100 by using the numeric keys. You can also use the rotary knob.
4. Press the Enter soft key.

Measurement example
Figure 226 CCDF measurement with Mobile WiMAX signal analyzer

Conducting Mobile WiMAX OTA measurements
This Over The Air (OTA) measurement has preamble scanner, multipath profile, and preamble power
trend screens. Preamble scanner displays six preambles and relative powers to inform neighbor cells
existence. The multipath profile graph helps the user to determine testing area's RF environmental
condition. The preamble power trend shows power variations of selected preamble over time along
with relative power trend for strongest preamble.

Preamble scanner
The OTA Preamble Scanner displays the six strongest preambles to inform neighbor cells existence of
testing area. Preamble Index, Relative Power, Cell ID, and Sector ID are listed in for each preamble
signal with Time Offset in us. Positioning information, latitude, and longitude will be displayed if a GPS
antenna is supplied and locked to the GPS satellites on the bottom of the screen.
Using Mobile WiMAX Signal Analyzer
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Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 427, you
can continue your measurement.
Procedure

1. Press the MEASURE SETUP hot key.
2. Press the System Config soft key, and then do the following:
a.

Press the Bandwidth soft key, and then select the nominal channel bandwidth to be
measured from the following choices:

–

7 MHz (8/7): Sets the channel bandwidth to 7 MHz with sampling factor 8/7. In
conjunction with nominal channel bandwidth

–

8.75 MHz (8/7): Sets the channel bandwidth to 8.75 MHz with sampling factor 8/7

–

10 MHz (28/25): Sets the channel bandwidth to 10 MHz with sampling factor 28/25

b.

Toggle the Frame Length soft key and select 5 ms or 10 ms.

c.

Press the TTG (RTG) soft key to set the transmit/receive transition gap between the last
sample of the downlink burst and the first sample of the subsequent uplink burst.

d.

Enter a value by using the numeric keys, and then press the Enter soft key.

e.

Press the CP Ratio soft key, and then select the cyclic prefix ratio option: 1/4, 1/8, 1/16, or
1/32.

f.

Press the DL Symbols soft key to set the number of downlink symbols.

g.

Enter a value by using the numeric keys, and then press the Enter soft key.

h.

Press the UL Symbols soft key to set the number of uplink symbols.

i.

Enter a value by using the numeric keys, and then press the Enter soft key.

3. Optional. Press the Miscellaneous soft key, and then do the following as needed:
–

To set the delay, complete the following steps:
a.

Press the Delay soft key to set the amount of delay in µs.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Press the µs soft key.

NOTE
The Delay setting is used only when there is a time offset in the signals to be measured.

4. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available
for your measurement mode. See “Using save” on page 31 for more information.
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Measurement example
Figure 227 Preamble scanner measurement with Mobile WiMAX OTA signal analyzer

Multipath profile
The Multipath Profile enables the user to determine RF environmental conditions of testing area. It
indicates the multipath power with time delay in us up to six.
The multipath profile is the result of portions of the original broadcast signal arriving at the receiving
antenna out of phase. This can be caused by the signal being reflected off objects such as buildings,
or being refracted through the atmosphere differently from the main signal.
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 427, you
can continue your measurement.
Procedure

1. Press the MEASURE SETUP hot key.
2. Press the System Config soft key, and then do the following:
a.

Press the Bandwidth soft key, and then select the nominal channel bandwidth to be
measured from the following choices:

–

7 MHz (8/7): Sets the channel bandwidth to 7 MHz with sampling factor 8/7. In
conjunction with nominal channel bandwidth

–

8.75 MHz (8/7): Sets the channel bandwidth to 8.75 MHz with sampling factor 8/7

–

10 MHz (28/25): Sets the channel bandwidth to 10 MHz with sampling factor 28/25

b.

Toggle the Frame Length soft key and select 5 ms or 10 ms.

c.

Press the TTG (RTG) soft key to set the transmit/receive transition gap between the last
sample of the downlink burst and the first sample of the subsequent uplink burst.

d.

Enter a value by using the numeric keys, and then press the Enter soft key.

e.

Press the CP Ratio soft key, and then select the cyclic prefix ratio option: 1/4, 1/8, 1/16, or
1/32.
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f.

Press the DL Symbols soft key to set the number of downlink symbols.

g.

Enter a value by using the numeric keys, and then press the Enter soft key.

h.

Press the UL Symbols soft key to set the number of uplink symbols.

i.

Enter a value by using the numeric keys, and then press the Enter soft key.

3. Optional. Press the Miscellaneous soft key, and then do the following as needed:
–

To set the delay, complete the following steps:
a.

Press the Delay soft key to set the amount of delay in µs.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Press the µs soft key.

NOTE
The Delay setting is used only when there is a time offset in the signals to be measured.

4. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available
for your measurement mode. See “Using save” on page 31 for more information.

Measurement example
Figure 228 Multipath profile measurement with Mobile WiMAX OTA signal analyzer

Preamble power trend
The Preamble Power Trend shows power variations of a strongest preamble signal over time along
with the relative power trend compare to total preamble power. Searching preamble index can be set
auto to detect strongest or manual to search specific preamble. Positioning information, latitude, and
longitude will be displayed if a GPS antenna is supplied and locked to the GPS satellites on the bottom
of the screen.
Setting measure setup
After configuring test parameters as described in the “Configuring test parameters” on page 427, you
can continue your measurement.
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Procedure

1. Press the MEASURE SETUP hot key.
2. Press the System Config soft key, and then do the following:
a.

Press the Bandwidth soft key, and then select the nominal channel bandwidth to be
measured from the following choices:

–

7 MHz (8/7): Sets the channel bandwidth to 7 MHz with sampling factor 8/7. In
conjunction with nominal channel bandwidth

–

8.75 MHz (8/7): Sets the channel bandwidth to 8.75 MHz with sampling factor 8/7

–

10 MHz (28/25): Sets the channel bandwidth to 10 MHz with sampling factor 28/25

b.

Toggle the Frame Length soft key and select 5 ms or 10 ms.

c.

Press the TTG (RTG) soft key to set the transmit/receive transition gap between the last
sample of the downlink burst and the first sample of the subsequent uplink burst.

d.

Enter a value by using the numeric keys, and then press the Enter soft key.

e.

Press the CP Ratio soft key, and then select the cyclic prefix ratio option: 1/4, 1/8, 1/16, or
1/32.

f.

Press the DL Symbols soft key to set the number of downlink symbols.

g.

Enter a value by using the numeric keys, and then press the Enter soft key.

h.

Press the UL Symbols soft key to set the number of uplink symbols.

i.

Enter a value by using the numeric keys, and then press the Enter soft key.

3. Toggle the Preamble Index soft key and select the preamble search method: Auto or Manual.
4. Optional. Press the Miscellaneous soft key, and then do the following as needed:
–

To set the delay, complete the following steps:
a.

Press the Delay soft key to set the amount of delay in µs.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Press the µs soft key.

NOTE
The Delay setting is used only when there is a time offset in the signals to be measured.

5. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available
for your measurement mode. See “Using save” on page 31 for more information.
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Measurement example
Figure 229 Preamble power trend with Mobile WiMAX OTA signal analyzer

Route map
The JD780A Series provides indoor and outdoor mapping function that allows a user to collect data of
points in an indoor or outdoor environment and track the received signals and coverage of RF
transmitters plotting real time directly on top of a loaded floor plan or a map.
Setting measure setup
Procedure

1. If required, connect a GPS receiver to your JD780A series for outdoor mapping.
Indoor mapping does not necessarily need a GPS antenna.

2. Configure test parameters as described in the “Configuring test parameters” on page 427.
3. To load your map file, complete the following steps:
a.

Plug in your USB drive that has a floor map or .mcf file type created in JDMapCreator.
NOTE
The JDMapCreator converts and resizes any scanned floor plan or layout to fit onto your
instrument’s display. You must save your map files (.mcf) into the “SavedMap” folder of
your USB drive so that you can load them onto your instrument.

b.

Press SAVE/LOAD hot key, and then select Load > Load Map.
See “Using load” on page 34 for more information.

4. Press the MEASURE SETUP hot key.
5. Press the Plot Point soft key, and then select the plot point option from the following choices:
–

To collect data/plot points automatically as you move around in a vehicle or outside, press
the GPS soft key and then toggle the Screen Mode soft key between Map and Full.
NOTE
With the Map setting, you can view only the collected points that can be seen within the
boundary of the loaded map. If a point is off the map, the instrument displays an arrow to
indicate the direction of the current location on the map and the distance from the center
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to the location at the top of the screen.
With the Full setting, you can view all the collected points of the route without the loaded
map.

–

To collect data/plot points manually without a GPS antenna in an indoor environment, press
the Position soft key.

6. Toggle the Plot soft key and select Start to start plotting.
7. Touch directly on the screen or press the ENTER hard key to collect data and plot points on the
loaded map for the Position setting.
NOTE
For the Position setting, you can change the direction of the route with the arrow keys
and the distance with the rotary knob.

8. Toggle the Plot soft key and select Stop to stop plotting.
9. Press the SAVE/LOAD hot key to save the result.
See “Using save” on page 31 for more information.
NOTE
The instrument does not automatically save the collected data. It is recommended that
you save the result. Otherwise, you will lose all the collected data.

Setting limit for route map
You can set the thresholds for each test item.
Procedure

1. Press the LIMIT hot key.
2. Press the Excellent soft key to set its threshold.
3. Enter a value, and then press the Enter soft key. You can also use the rotary knob.
4. Press the Very Good soft key to set its threshold.
5. Enter a value, and then press the Enter soft key. You can also use the rotary knob.
6. Press the Good soft key to set its threshold.
7. Enter a value, and then press the Enter soft key. You can also use the rotary knob.
8. Press the Fair soft key to set its threshold.
9. Enter a value, and then press the Enter soft key. You can also use the rotary knob.
10. Press the Poor soft key to set its threshold.
11. Enter a value, and then press the Enter soft key. You can also use the rotary knob.
12. Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings.
See “Using save” on page 31 for more information.
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Measurement example
Figure 230 Route map measurement with Mobile WiMAX OTA signal analyzer
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Using Cable and Antenna Analyzer
This chapter provides instructions for using the Cable and Antenna Analyzer function, which is
available for the JD785A Base Station Analyzer and the JD786A RF Analyzer. Topics discussed in this
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Introduction
The Cable and Antenna Analyzer is a diagnostic tool needed to accurately detect operational problems
by performing cable and antenna measurements to verify the base station’s infrastructure, including
feed lines, connectors, antennas, cables, jumpers, amplifiers, and filters. The JD785A Base Station
Analyzer and the JD786A RF Analyzer have all of the measurement functions necessary to verify
cable and antenna systems from Voltage Standing Wave Ratio (VSWR) to power measurements. In
addition, the JD785A and the JD786A make distance-to-fault measurements to pinpoint a faulty
location accurately.
To get maximum power into a load it is required that the load impedance match the generator
impedance. Any difference in impedance or mismatching would not produce maximum power transfer.
An impedance mismatch at the antenna system produces a reflective ‘traveling wave’, which goes in
the opposite direction from the incident wave. As the two traveling waves cross each other in opposite
direction, it is produce an interference pattern called a "standing wave". VSWR is the ratio between the
power sent forward to the cable and/or antenna and the amount of power that is reflected back to the
transmitter.
Some of the consequences of having a high VSWR condition in cellular services include dropped calls,
poor reception, and an overall unacceptable performance in the cell (or section of cell) covered by the
base station antenna. Therefore, the VSWR of the antenna system including the feed line is one of the
most critical factors in the service and maintenance of the RF transmitter systems.
This Cable and Antenna Analyzer function performs following measurements:


Reflection: VSWR and Return Loss



Distance to Fault (DTF): VSWR and Return Loss



Reflection-DTF (dual measurement)



2 Port Measurements: Vector and Scalar (Optional)



Cable Loss (1 Port)



1 Port Phase



Smith Chart

Display overview
Figure 231 provides descriptions for each segment of the measurement screen.
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Figure 231 Reflection measurement screen

Selecting measurement mode
Procedure

1. Press the MODE hard key.
2. Press the Cable & Antenna Analyzer soft key. The Reflection (VSWR) mode is selected by
default.

3. To change the mode, press the MEASURE hot key and then select the measurement mode:
–

Reflection (Return Loss)

–

DTF (VSWR)

–

DTF (Return Loss)

–

Reflection-DTF

–

Cable Loss (1 Port)

–

1 Port Phase, Smith Chart

–

2 Port Measurement (Vector/Scalar)

Configuring test parameters
Setting frequency
You can set frequencies manually using the Start Frequency/Stop Frequency or Center
Frequency/Span. You can also select from the band list stored in the instrument. It is recommended to
set the frequency to a value that covers the normal range of the measurement with enough margins.
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Procedure
To set the start and stop frequencies:

1. Press the FREQ/DIST hard key.
2. Press the Start Frequency soft key.
3. Enter a value by using the numeric keys. You can also use the rotary knob or the arrow keys.
4. Select the unit: GHz, MHz, kHz, or Hz.
5. Press the Stop Frequency soft key.
6. Enter a value by using the numeric keys. You can also use the rotary knob or the arrow keys.
7. Select the unit: GHz, MHz, kHz, or Hz.
To set the center frequency and span:

1. Press the FREQ/DIST hard key.
2. Press the Center Frequency soft key.
3. Enter a value by using the numeric keys. You can also use the rotary knob or the arrow keys.
4. Select the unit: GHz, MHz, kHz, or Hz.
5. Press the Span soft key.
6. Enter a value by using the numeric keys. You can also use the rotary knob or the arrow keys.
7. Select the unit: GHz, MHz, kHz, or Hz.
To select the band from the band list:

1. Press the FREQ/DIST hard key.
2. Press the Band List soft key, and then select Standard Band or Custom Band.
The band list window appears.

3. Select a frequency band from the list, and then press the Select soft key.
The start and stop frequency information on the screen changes according to your choice.

Setting distance
In the DTF measurement mode, you need to set the start and stop distances. The maximum
measurable distance is displayed on the left side of the screen depending on the frequency setting.
You can set any distance within the maximum measurable distance. Optimum resolution is achieved
when the user setting distance is the same as the maximum measurable distance
Procedure

1. Press the FREQ/DIST hard key.
2. Press the Start Distance soft key.
3. Enter a value by using the numeric keys. You can also use the rotary knob or the arrow keys.
4. Select the Enter soft key.
5. Press the Stop Frequency soft key.
6. Enter a value by using the numeric keys. You can also use the rotary knob or the arrow keys.
7. Select the Enter soft key.
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Adjusting scale
You can adjust the Y-axis scale to optimize the display of measurement trace(s). Adjusting scale does
not affect the calibration state.
Procedure

1. Press the AMP/SCALE hard key.
2. Do one of the following choices:
–

Press the Auto Scale to optimize the display of the measured trace by letting the
instrument set the minimum and maximum values for the Y-axis automatically.
Each time this key is pressed, the top and bottom scales are set to the minimum and
maximum values with margin on the Y-axis of the chart.

–

Press the Full Scale to restore the insturment’s default amplitude range for the Y-scale
automatically.

–

To set the minimum and maximum values for the Y-axis manually, complete the following
steps:
a.

Press the Maximum (Top) soft key.

b.

Enter a value by using the numeric keys.

c.

Press the Enter soft key.

d.

Press the Minimum (Top) soft key.

e.

Enter a value by using the numeric keys.

f.

Press the Enter soft key.

NOTE
This setting is not used in the Smith Chart measurement mode.

Setting sweep mode
The default settings of the sweep mode are Continue and Normal to sweep continuously at a normal
speed for most on-going measurements. If you want to hold the measurement or get a single sweep,
you can change the sweep mode.
Procedure
To select the single sweep mode:

1. Press the SWEEP hot key.
2. Toggle the Sweep Mode soft key and select Single. You can also use the HOLD hot key.
The letter HOLD in red appears and the sweeping is paused.

3. Optional. Press the Sweep Once soft key to get a new measurement.
To return to the continuous sweep mode:

1. Toggle the Sweep Mode soft key and select Continue. You can also use the HOLD hot key.
The letter HOLD in red disappears and the sweeping resumes.

Performing calibration
To get reliable and accurate measurement results, you must perform a calibration on your instrument
after setting frequencies and prior to making a measurement. You need to have the following ready:
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Calibration accessories (optional).



Calibration Kit: Includes one 50-ohm load, one open standard, and one short standard.



Test Cable: Use a phase stable cable for reliable and consistent measurement results.

1-port calibration
Measurements that need the 1-port calibration are in the Reflection, DTF, Cable Loss, 1 Port Phase, or
Smith Chart mode.
Figure 232 illustrates the connection method when a port extension cable is used for calibration. To
compensate errors caused by a port extension cable or adapters, perform an Open-Short-Load
calibration including the port extension cable.
Figure 232 Connection for 1-port calibration

NOTE
Do not use an unnecessary extension cable or adapter in order to prevent a
measurement error.
Bending or moving the extension cable while making a measurement may cause errors in
the measurement.
NOTE
If O-S-L calibration is done at the end of the port extension cable for DTF measurement,
the length of the port extension cable is compensated automatically and is not included in
the distance to the point of discontinuity.

O-S-L calibration
The Open-Short-Load calibration must be performed after setting frequency and connecting a test
cable. When using an extension cable connected to the Cable and Antenna Analyzer Reflection/RF
Out port, the calibration kit must be connected to the other end of the extension cable.
Procedure

1. Press the MEASURE SETUP hot key.
2. Press the Calibrate soft key.
The on-screen instruction for the calibration appears.

3. Connect the OPEN connector of the CAL Kit directly to the Cable and Antenna Analyzer
Reflection/RF Out port or at the end of the connected extension cable.
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4. Press the Continue soft key to start calibration.
The calibration progress bar appears.

5. Connect the SHORT connector of the CAL Kit directly to the Cable and Antenna Analyzer
Reflection/RF Out port or at the end of the connected extension cable.

6. Press the Continue soft key to continue calibration.
The calibration progress bar appears.

7. Connect the LOAD connector of the CAL Kit directly to the Cable and Antenna Analyzer
Reflection/RF Out port or at the end of the connected extension cable.

8. Press the Continue soft key to continue calibration.
The calibration progress bar appears.
After completion, the calibration status on the screen changes to CAL ON.

Quick calibration
The Quick Calibration is useful when you want to measure only cable length in DTF measurements.
Procedure

1. Press the MEASURE SETUP hot key.
2. Press the Calibrate soft key.
3. Connect the OPEN connector of the CAL Kit directly to the Cable and Antenna Analyzer
Reflection/RF Out port or at the end of the connected extension cable.

4. Press the Quick Cal. soft key to turn the quick calibration off.
The calibration status on the screen changes back to the previous state.

2-port calibration
You must perform 2-port calibration for 2-port measurements before making a measurement.
Vector measurement
Figure 233 illustrates the connection diagram for calibration in Vector measurements.
Figure 233 Connection for 2-port calibration in vector measurement
1)

2)
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Procedure

1. Press the MEASURE SETUP hot key.
2. Press the Calibrate soft key.
The on-screen instruction for the calibration appears.

3. Connect the OPEN connector of the CAL Kit directly to the Cable and Antenna Analyzer
Reflection/RF Out port or at the end of the connected test cable as illustrated in Figure 233-1).

4. Press the Continue soft key to start calibration.
The calibration progress bar appears.

5. Connect the SHORT connector of the CAL Kit directly to the Cable and Antenna Analyzer
Reflection/RF Out port or at the end of the connected test cable.

6. Press the Continue soft key to continue calibration.
The calibration progress bar appears.

7. Connect the LOAD connector of the CAL Kit directly to the Cable and Antenna Analyzer
Reflection/RF Out port or at the end of the connected test cable.

8. Press the Continue soft key to continue calibration.
The calibration progress bar appears.

9. Connect the Reflection/RF Out port and the RF In port for the Cable and Antenna Analyzer with
the test cable (THRU cable) and the proper adapter as illustrated in Figure 233-2).

10. Press the Continue soft key to continue calibration.
The calibration progress bar appears.
After completion, the calibration status on the screen changes to CAL ON.

Scalar measurement
Figure 234 illustrates the connection diagram for calibration in Scalar measurements.
Figure 234 Connection for 2-port calibration in scalar measurement

Procedure

1. Press the MEASURE SETUP hot key.
2. Press the Calibrate soft key.
The on-screen instruction for the calibration appears.

3. Connect the Reflection/RF Out port for the Cable and Antenna Analyzer and the RF In port for
the Spectrum Analyzer with a test cable as illustrated in Figure 234.

4. Press the Continue soft key to continue calibration.
The calibration progress bar appears.
After completion, the calibration status on the screen changes to CAL ON.

Calibration status indicators
The instrument displays calibration status that is an important indicator to get reliable and accurate
measurement results from CAA testing. The calibration status includes CAL ON, CAL ON (I), CAL ON
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(Q), CAL OFF (T), and CAL OFF.
Table 22

Calibration status indicators

Indicator(s)

Description

CAL ON

Indicates that the O-S-L calibration is performed and the instrument is ready to make a
measurement.

CAL ON (I)

Indicates that the frequency setting is changed within the frequency range registered
for the O-S-L calibration and so the calibration is still valid. When the calibration status
changes from CAL ON to CAL ON (I), re-calibration is not necessarily required.

CAL ON (Q)

Indicates that quick calibration (Quick Cal) is performed. It is useful only if cable length
measurement is needed.

CAL OFF (T)

Indicates that the temperature registered during the calibration is changed by +/-10°C
or greater. It is recommended that you perform a new O-S-L calibration to obtain
accurate measurement results. When the temperature comes back within the
registered range, the status may be changed to CAL ON.

CAL OFF

Indicates that the frequency setting is changed off the frequency range registered for
the calibration. The calibration is no longer valid.

Connecting a cable
Connecting a cable for reflection, DTF, 1-port phase, and Smith
Chart measurements
Procedure

1. Connect the one end of the port extension cable to the Cable and Antenna Analyzer
Reflection/RF Out port of the instrument.

2. Connect the other end of the port extension cable to an antenna or feed line as illustrated in
Figure 235.
Measurement result is displayed on the screen.

Figure 235 Connection for reflection measurement
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NOTE
After calibration, do not change the connection of the port extension cable or the
frequency setting. It may cause a measurement error.
Changing any frequency settings will automatically turn the calibration status to OFF on
the display screen, which requires re-calibration to proceed next measurement.
CAUTION
The maximum input power for the Cable and Antenna Analyzer Reflection/RF Out port
is +25 dBm. Do not connect this port directly to the output port of the system to prevent
degraded performance or malfunctioning.

WARNING
Do not attempt to connect the instrument to the antenna when there is a risk of lightning.
Electric shock may cause malfunction of or damage to the instrument.

Connecting a cable for cable loss (1 port) measurements
Procedure

1. Connect the one end of the cable under test to the Cable and Antenna Analyzer Reflection/RF
Out port of the instrument.

2. Connect the SHORT standard of the Cal Kit to the other end of the cable under test as illustrated
in Figure 236.
Measurement result is displayed on the screen.

Figure 236 Connection for cable loss (1 port) measurement

Connecting a cable for 2-port vector measurements
Procedure

1. Connect the one end of the Thru test cable to the Cable and Antenna Analyzer Reflection/RF Out
port of the instrument and the other end of the cable to DUT.

2. Connect the DUT to the Cable and Antenna Analyzer RF In port of the instrument as illustrated
in Figure 237.
Measurement result is displayed on the screen.
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Figure 237 Connection for 2-port vector measurement

CAUTION
The maximum input power for the Cable and Antenna Analyzer RF In port is +25 dBm.
However, a proper level of input to the Cable and Antenna Analyzer RF In port is 0
dBm. When the input power is expected to be greater than 0 dBm, you must adjust the
output power for the RF Out.

Connecting a cable for 2-port scalar measurements
Procedure

1. Connect the one end of the Thru test cable to the Cable and Antenna Analyzer Reflection/RF Out
port of the instrument and the other end of the cable to DUT.

2. Connect the DUT to the Spectrum Analyzer RF In port of the instrument as illustrated in Figure
238. Measurement result is displayed on the screen.

Figure 238 Connection for 2-port scalar measurement

CAUTION
The maximum input power for the Spectrum Analyzer RF In port is +20 dBm.

Performing reflection measurements
The Reflection measurement can be used to characterize cable and antenna system to ensure
transmission line impedance performance and signal reflection characteristics of cell-site across a
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specific frequency range in voltage standing-wave ration (VSWR) or return loss.

Making a measurement
Procedure

1. Make a proper cable connection as described in “Connecting a cable for reflection, DTF, 1-port
phase, and Smith Chart measurements” on page 469.

2. Press the MEASURE SETUP hot key.
3. Press the Data Points soft key to change the resolution of your measurement, and then select
the data point option: 126, 251, 501, 1001, and 2001. Changing the data point does not affect
current calibration.
NOTE
The larger number you choose, the higher resolution you get and the longer the
instrument takes to sweep and display results. Selecting the data point larger than what
you need for a measurement will result in unnecessarily long sweep time. It is
recommended that you select high resolution data points only for an instance of
measuring wide frequency bands or requiring precise measurement data.

4. Optional. To turn the bias tee on, complete the following steps:
a.

Toggle the Bias Tee soft key and select On.

b.

Enter a value between 12 and 32 with 0.1 V step.

c.

Enter the V soft key.
NOTE
The instrument’s built-in bias tee function (option 002) supplies 12-32 VDC bias to active
devices through the RF In port, eliminating the need of an external power supply.

5. Optional. To select the output power, toggle the Output Power soft key between 0 dBm and -30
dBm.
NOTE
When an amplifier’s reflection is measured, it is recommended that you change this
output power level to -30 dBm and then re-calibrate. Changing to -30 dBm may result in
reduced measurement dynamic range.

6. Optional. To turn the interference rejection on, toggle the Interference Rej soft key between On
and Off to enable or disable the feature.
NOTE
It is recommended that you use this feature only when you suspect interfering signals in
the area as turning this on slows down the measurement.
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Measurement example
Figure 239 Reflection measurement in return loss scale

NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication. See “Setting limit for cable and antenna analyzer” on page
486 for more information.
NOTE
You can go to MEASURE SETUP > Zone to view your measurements in detail with the
user-definable zoom zones. See “Setting zoom zones” on page 484 for more information.

Performing DTF measurements
The Distance-To-Fault (DTF) measurement can be used to accurately identify fault locations in the
cell-site transmission (cable and feed line) system, indicating signal discontinuities in VSWR or return
loss over distance in meter or foot. This measurement precisely pinpoints the location of such things
as damaged or degraded antennas, connectors, amplifiers, filters, and duplexers.

Making a measurement
Procedure

1. Make a proper cable connection as described in “Connecting a cable for reflection, DTF, 1-port
phase, and Smith Chart measurements” on page 469.

2. Press the MEASURE SETUP hot key.
3. Press the Data Points soft key to change the resolution of your measurement, and then select
the data point option: 126, 251, 501, 1001, and 2001. Changing the data point does not affect
current calibration.
NOTE
The larger number you choose, the higher resolution you get and the longer the
instrument takes to sweep and display results. Selecting the data point larger than what
you need for a measurement will result in unnecessarily long sweep time. It is
recommended that you select high resolution data points only for an instance of
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measuring wide frequency bands or requiring precise measurement data.

4. Press the DTF Settings soft key, and then do the following:
–

–

To select a cable from the list, complete the following steps:
a.

Press the Cable List soft key, and then select Standard Cable or Custom Cable.
The cable list window appears.

b.

Select a cable by using the rotary knob or the Page Up/Page Down soft keys.

c.

Press the Select soft key.

d.

Optional. In the standard cable list window, press the Add to Custom soft key to add
the selected cable to the custom list.

To define a new cable, complete the following steps:
a.

Press the Prop Velocity soft key to define the cable’s relative propagation delay.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Press the Enter soft key.

d.

Press the Cable Loss soft key to define the cable’s cable loss.

e.

Enter a value by using the numeric keys. You can also use the rotary knob.

f.

Press the Enter soft key.

NOTE
The propagatin velocity affects the calucation of the distance and the cable loss does the
peak level of the discontinuity in a DTF measurement.

–

Toggle the Metrics soft key and select the unit option for the X-axis: Meter or Foot.

–

Press the Windowing soft key, and then select the video filtering option: Rectangular,
Blackman, Nominal Side Lobe, Low Side Lobe, or Minimum Side Lobe.

5. Optional. To turn the bias tee on, complete the following steps:
a.

Toggle the Bias Tee soft key and select On.

b.

Enter a value between 12 and 32 with 0.1 V step.

c.

Enter the V soft key.
NOTE
The instrument’s built-in bias tee function (option 002) supplies 12-32 VDC bias to active
devices through the RF In port, eliminating the need of an external power supply.

6. Optional. To select the output power, toggle the Output Power soft key between 0 dBm and -30
dBm.
NOTE
When an amplifier’s reflection is measured, it is recommended that you change this
output power level to -30 dBm and then re-calibrate. Changing to -30 dBm may result in
reduced measurement dynamic range.

7. Optional. To turn the interference rejection on, toggle the Interference Rej soft key between On
and Off to enable or disable the feature.
NOTE
It is recommended that you use this feature only when you suspect interfering signals in
the area as turning this on slows down the measurement.
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Measurement example
Figure 240 DTF measurement

NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication. See “Setting limit for cable and antenna analyzer” on page
486 for more information.

Figure 241 DTF measurement with the alternate sweep on

NOTE
You can go to MEASURE SETUP > Alternate Sweep Settings to scale down a specific
sub-band. See “Setting alternate sweep” on page 485 for more information.
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Performing reflection-DTF measurements
You can view two measurement results simultaneously on the screen as you configure each
measurement setting.

Making a measurement
Procedure

1. Make a proper cable connection as described in “Connecting a cable for reflection, DTF, 1-port
phase, and Smith Chart measurements” on page 469.

2. Press the MEASURE SETUP hot key.
3. Toggle the Active Window soft key between Top and Bottom and select the window to be
active for setting.

4. Press the Dual Config soft key, and then select the dual configuration option:
–

To select the measurement mode for the top window, press the Top soft key, and then
select Reflection (VSWR) or Reflection (Return Loss).

–

To select the measurement mode for the bottom window, press the Bottom soft key, and
then select DTF (VSWR) or DTF (Return Loss).

–

To configure DTF settings for the bottom window, select Bottom > DTF Settings.
See “Performing DTF measurements” on page 473 for more information.

–

To set the alternate sweep settings for the bottom window, select Bottom > Alternate
Sweep Settings. See “Setting alternate sweep” on page 485 for more information.
NOTE
See “Performing reflection measurements” and “Performing DTF measurements” for
more information on how to set other measurement setup parameters for the ReflectionDTF measurement.

Measurement example
Figure 242 Reflection-DTF dual measurement
1) Alternate sweep off:
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2) Alternate sweep on:

NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication. See “Setting limit for cable and antenna analyzer” on page
486 for more information.

Performing cable loss (1 port) measurements
The Cable Loss (1 Port) measurement quantifies signal loss through a cable or other device over a
defined frequency range by range by connecting one end of the cable to the instrument measurement
port and terminating the other end of the cable with a short, or leaving it open altogether. This
measurement can be particularly useful in measuring the loss of feed line connected to the antenna.

Making a measurement
Procedure

1. Make a proper cable connection as described in “Connecting a cable for cable loss (1 port)
measurements” on page 470.

2. Press the MEASURE SETUP hot key.
3. Press the Data Points soft key to change the resolution of your measurement, and then select
the data point option: 126, 251, 501, 1001, and 2001. Changing the data point does not affect
current calibration.
NOTE
The larger number you choose, the higher resolution you get and the longer the
instrument takes to sweep and display results. Selecting the data point larger than what
you need for a measurement will result in unnecessarily long sweep time. It is
recommended that you select high resolution data points only for an instance of
measuring wide frequency bands or requiring precise measurement data.

4. Optional. To turn the bias tee on, complete the following steps:
a.

Toggle the Bias Tee soft key and select On.

b.

Enter a value between 12 and 32 with 0.1 V step.

c.

Enter the V soft key.
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NOTE
The instrument’s built-in bias tee function (option 002) supplies 12-32 VDC bias to active
devices through the RF In port, eliminating the need of an external power supply.

NOTE
See “Performing reflection measurements” for more information on how to set other
measurement setup parameters for the Cable Loss (1 Port) measurement.

Measurement example
Figure 243 Cable loss (1 port) measurement

NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication. See “Setting limit for cable and antenna analyzer” on page
486 for more information.

Figure 244 Cable loss (1 port) measurement with the zone enabled
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NOTE
You can go to MEASURE SETUP > Zone to view your measurements in detail with the
user-definable zoom zones. See “Setting zoom zones” on page 484 for more information.

Performing 1-port phase measurements
The 1-port Phase measurement is used to measure S11 phase to tune antennas and to phase-match
cables.

Making a measurement
Procedure

1. Make a proper cable connection as described in “Connecting a cable for reflection, DTF, 1-port
phase, and Smith Chart measurements” on page 469.

2. Press the MEASURE SETUP hot key.
3. Press the Data Points soft key to change the resolution of your measurement, and then select
the data point option: 126, 251, 501, 1001, and 2001. Changing the data point does not affect
current calibration.
NOTE
The larger number you choose, the higher resolution you get and the longer the
instrument takes to sweep and display results. Selecting the data point larger than what
you need for a measurement will result in unnecessarily long sweep time. It is
recommended that you select high resolution data points only for an instance of
measuring wide frequency bands or requiring precise measurement data.

4. Optional. To turn the bias tee on, complete the following steps:
a.

Toggle the Bias Tee soft key and select On.

b.

Enter a value between 12 and 32 with 0.1 V step.

c.

Enter the V soft key.
NOTE
The instrument’s built-in bias tee function (option 002) supplies 12-32 VDC bias to active
devices through the RF In port, eliminating the need of an external power supply.

NOTE
See “Performing reflection measurements” on page 471 for more information on how to
set other measurement setup parameters for the Cable Loss (1 Port) measurement.
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Measurement example
Figure 245 Cable loss (1 port) measurement

Figure 246 Cable loss (1 port) measurement with zoom

NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication. See “Setting limit for cable and antenna analyzer” on page
486 for more information.
NOTE
You can go to MEASURE SETUP > Zone to view your measurements in detail with the
user-definable zoom zones. See “Setting zoom zones” on page 484 for more information.

Performing Smith chart measurements
The Smith Chart measurement is used to measure DUTs’ impedance and phase to properly tune RF
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devices. Smith chart also displays impedance-matching characteristics in cable and antenna systems
or filter and duplexer devices.

Making a measurement
Procedure

1. Make a proper cable connection as described in “Connecting a cable for reflection, DTF, 1-port
phase, and Smith Chart measurements” on page 469.

2. Press the MEASURE SETUP hot key.
3. Press the Data Points soft key to change the resolution of your measurement, and then select
the data point option: 126, 251, 501, 1001, and 2001. Changing the data point does not affect
current calibration.
NOTE
The larger number you choose, the higher resolution you get and the longer the
instrument takes to sweep and display results. Selecting the data point larger than what
you need for a measurement will result in unnecessarily long sweep time. It is
recommended that you select high resolution data points only for an instance of
measuring wide frequency bands or requiring precise measurement data.

4. Optional. To turn the bias tee on, complete the following steps:
a.

Toggle the Bias Tee soft key and select On.

b.

Enter a value between 12 and 32 with 0.1 V step.

c.

Enter the V soft key.
NOTE
The instrument’s built-in bias tee function (option 002) supplies 12-32 VDC bias to active
devices through the RF In port, eliminating the need of an external power supply.

NOTE
See “Performing reflection measurements” on page 471 for more information on how to
set other measurement setup parameters for the Smith Chart measurement.

Performing 2-port vector measurements
The Vector measurement is used to perform faster and more accurate measurement with around 80
dB dynamic range. It also provides antenna isolation measurement. You can determine DUT’s S21
phase characteristic by selecting the measurement display type as Phase.

Making a measurement
Procedure

1. Make a proper cable connection as described in “Connecting a cable for 2-port vector
measurements” on page 470.

2. Press the MEASURE SETUP hot key.
3. Press the Data Points soft key to change the resolution of your measurement, and then select
the data point option: 126, 251, 501, 1001, and 2001. Changing the data point does not affect
current calibration.
NOTE
The larger number you choose, the higher resolution you get and the longer the
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instrument takes to sweep and display results. Selecting the data point larger than what
you need for a measurement will result in unnecessarily long sweep time. It is
recommended that you select high resolution data points only for an instance of
measuring wide frequency bands or requiring precise measurement data.

4. Toggle the Display soft key and select Magnitude to view measurements in dB or Phase in
degree.

5. Optional. To turn the bias tee on, complete the following steps:
a.

Toggle the Bias Tee soft key and select On.

b.

Enter a value between 12 and 32 with 0.1 V step.

c.

Enter the V soft key.
NOTE
The instrument’s built-in bias tee function (option 002) supplies 12-32 VDC bias to active
devices through the RF In port, eliminating the need of an external power supply.

6. Optional. To select the output power, toggle the Output Power soft key between 0 dBm and -30
dBm.
NOTE
When an amplifier’s reflection is measured, it is recommended that you change this
output power level to -30 dBm and then re-calibrate. Changing to -30 dBm may result in
reduced measurement dynamic range.

7. Optional. To set the number of measurements to be averaged, press the Average soft key and
then adjust the number between one and five by using the rotary knob.

8. Optional. To turn the interference rejection on, toggle the Interference Rej soft key between On
and Off to enable or disable the feature.
NOTE
It is recommended that you use this feature only when you suspect interfering signals in
the area as turning this on slows down the measurement.

Measurement example
Figure 247 2-port vector measurement
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Performing 2-port scalar measurements
The Scalar measurement enables full characterization of DUT with dynamics over 100 dB.

Making a measurement
Procedure

1. Make a proper cable connection as described in “Connecting a cable for 2-port scalar
measurements” on page 471.

2. Press the MEASURE SETUP hot key.
3. Press the Data Points soft key to change the resolution of your measurement, and then select
the data point option: 126, 251, 501, 1001, and 2001. Changing the data point does not affect
current calibration.
NOTE
The larger number you choose, the higher resolution you get and the longer the
instrument takes to sweep and display results. Selecting the data point larger than what
you need for a measurement will result in unnecessarily long sweep time. It is
recommended that you select high resolution data points only for an instance of
measuring wide frequency bands or requiring precise measurement data.

4. Optional. To select the output power, toggle the Output Power soft key between 0 dBm and -30
dBm.
NOTE
When an amplifier’s reflection is measured, it is recommended that you change this
output power level to -30 dBm and then re-calibrate. Changing to -30 dBm may result in
reduced measurement dynamic range.

Measurement example
Figure 248 2-port scalar measurement
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Analyzing measurements
Setting trace and display
You can display up to six traces on the measurement chart simultaneously.
Procedure

1. Press the TRACE/DISPLAY hard key.
2. Press the Select Trace soft key, and then select the trace number: T1, T2, T3, T4, T5, or T6.
The legend shape of the selected trace changes from square to round to indicate that the trace is
the active one now.

3. Toggle the Trace View soft key and select On to display the selected trace.
4. To clear, write or capture, or hide the trace(s), do one of the following:
To

Select

Trace Legend

Clear current data and display with new
measurements

Clear Write

W

Capture the selected trace and compare traces

Capture

C

Load a saved trace

Load

L

Hide the selected trace

Trace View > Off

F

Remove all the traces and initialize the trace
settings

Trace Clear All

5. Optional. If you have at least two traces (T1 and T2), you can perform trace math:
a.

Press the Trace Math soft key.

b.

Press the T1 – T2 -> T5 or T2 – T1 -> T6 soft key.

NOTE
The trace to be loaded must be in the same measurement mode and has the same
frequency setting as the current measurement.

Setting zoom zones
You can define up to three zoom-in zones so that you can view uplink and downlink frequencies in
detail on a single measurement window for compliance verification.
Procedure

1. Press the MEASURE SETUP hot key.
2. Press the Zone soft key.
3. To zoom in a zone, complete the following steps:
a.

Press the Zoom soft key, and then select the zone number to zoom in: Zone 1, Zone 2, or
Zone 3.

b.

Toggle the Zoom soft key and select On.

The zoom-in chart for the selected zone appears under the measurement result.

4. To define a zone range, complete the following steps:
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a.

Press the Zone [1|2|3] soft key to select an active zone.

b.

Toggle the Zone [1|2|3] soft key between On and Off to view or dismiss the active zone.

Using Cable and Antenna Analyzer

JD780A Series Analyzers

c.

Press the Start Frequency soft key.

d.

Enter a value by using the numeric keys. You can also use the rotary knob.

e.

Select the unit: GHz, MHz, kHz, or Hz.

f.

Press the Stop Frequency soft key.

g.

Enter a value by using the numeric keys. You can also use the rotary knob.

h.

Select the unit: GHz, MHz, kHz, or Hz.

5. To clear all the zone settings, press the Clear All soft key.

Setting alternate sweep
You can use the Alternate Sweep in DTF measurements to scale down a specific sub-band without a
need of an additional calibration.
Procedure

1. Press the MEASURE SETUP hot key.
2. Press the Alternate Sweep Settings soft key.
3. Toggle the Alternate Sweep soft key and select On or Off to enable or disable the alternate
sweep feature.

4. To set the start and stop distances for the alternate sweep, complete the following steps:
a.

Press the Start Distance soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob or the arrow
keys.

c.

Select the Enter soft key.

d.

Press the Stop Frequency soft key.

e.

Enter a value by using the numeric keys. You can also use the rotary knob or the arrow
keys.

f.

Select the Enter soft key.

5. To set the start and stop frequencies for the alternate sweep, complete the following steps:
a.

Press the Alternate Start Frequency soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob or the arrow
keys.

c.

Select the unit: GHz, MHz, kHz, or Hz.

d.

Press the Alternate Stop Frequency soft key.

e.

Enter a value by using the numeric keys. You can also use the rotary knob or the arrow
keys.

f.

Select the unit: GHz, MHz, kHz, or Hz.

6. To set the center and span frequencies for the alternate sweep, complete the following steps:
a.

Press the Alternate Center Frequency soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob or the arrow
keys.

c.

Select the unit: GHz, MHz, kHz, or Hz.

d.

Press the Alternate Span Frequency soft key.

e.

Enter a value by using the numeric keys. You can also use the rotary knob or the arrow
keys.

f.

Select the unit: GHz, MHz, kHz, or Hz.
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Setting limit for cable and antenna analyzer
Procedure

1. Press the LIMIT hot key.
2. Press the Multi Segment Line soft key for Pass/Fail indication.
3. Toggle the Limit soft key between Upper and Lower to select the one to be displayed.
4. Set the number of segments for the selected upper or lower limit line. You can set up to 50
segments.
a.

Press the # of Line soft key.

b.

Enter a value between 1 and 50 by using the numeric keys.

c.

Press the Enter soft key.

5. Press the Autoset soft key to let the instrument set the limit for each segment and display the
line.

6. Optional. To move the limit line, complete the following steps:
a.

Select Limit Up/Down or Limit Left/Right.

b.

Turn the rotary knob to move the line as desired. You can also manually enter a value.

7. Optional. To edit the segment properties, complete the following steps:
a.

Press the Edit Limit soft key.

b.

Press the Move soft key and then turn the rotary knob to select the segment to edit.

c.

Select the menu option, from the following choices:

–

To hide the line for the selected segment, toggle the Line soft key and select Off.

–

To add a new point, press the Add Point soft key.

–

To delete the selected point, press the Delete Point soft key.

–

To change the position, press the Frequency or Amplitude soft key, and then turn the
rotary knob to change the value as desired.

8. Optional. Go to SAVE/LOAD > Save, and then select Limit to save the limit settings.
See “Using save” on page 31 for more information.
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Using E1 Analyzer
This chapter provides instructions for using the E1 Analyzer function (option 004). Topics discussed in
this chapter are as follows:


Introduction ..............................................................................................................................488



Display overview ......................................................................................................................488



Connecting a cable ..................................................................................................................489



Monitoring transmission ...........................................................................................................490



Performing BERT testing .........................................................................................................491
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Introduction
The European Conference of Postal and Telecommunications Administrations (CEPT) originally
standardized the E-carrier system, which revised and improved the earlier American T-carrier
technology, and this has now been adopted by the International Telecommunication Union
Telecommunication Standardization Sector (ITU-T).
E1 is transmitted physically as 32 timeslots, but one is used for framing and typically one allocated for
signaling call setup and tear down. Unlike Internet data services, E-carrier systems permanently
allocate capacity for a voice call for its entire duration. This ensures high call quality because the
transmission arrives with the same short delay (Latency) and capacity at all times.
This portable test instrument can be a useful tool to check the overall health of the transmission
system and assist in locating the source of problems or defects.
The E1 Analyzer function provides following measurements:


Monitoring



BERT Testing (PCM31 only)

Display overview
Figure 249 provides descriptions for each segment of the measurement screen.
Figure 249 E1 analyzer screen
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Connecting a cable
Out-of-service testing
Figure 250 Point-to-point connection

Figure 251 Loop-back connection

Figure 252 Error injection and measurement connection

In-service monitoring
Figure 253 In-service connection
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Monitoring transmission
Making a test
Procedure
To select the measurement mode:

1. Press the MODE hard key.
2. Press the E1/T1 Analyzer soft key.
3. Select E1 Analyzer > Monitoring.
To configure measurement parameters:

1. Press the MEASURE SETUP hot key.
2. Press the RX Mode soft key, and then select the receiver input option from the following choices:
–

Terminate: Provides 120-ohm nominal input impedance, according to the framing and line
code settings.

–

Bridge: Provides input impedance greater than one kilohm for in-service monitoring,
bridging the receiver input across lines that are terminated elsewhere in the network.

–

Monitor: Provides 120-ohm nominal input impedance for the in-service monitoring of E1
lines.

3. Toggle the Framing soft key between PCM30 and PCM31 and select the framing type for your
receiver setting:

–

PCM30: Timeslots from 1 to 15 correspond to channels from 1 to 15 and timeslots from 17
to 31 to channels from 16 to 30. Timeslot 16 is for the multi-frame alignment and Channel
Associated Signaling (CAS).

–

PCM31: Timeslots from 1 to 31 correspond to channels from 1 to 31.
NOTE
If the framing type does not match with your receiver setting, a framing alarm occurs.

4. Toggle the Line Code soft key between AMI and HDB3 and select the line code type to send an
E1 signal:

–

AMI: It stands for Alternate Mark Inversion. A line code uses one three level signal to
convey binary digits in which successive binary ones (“marks” or pulses) are of alternating
polarity, either positive or negative, equal in amplitude. A binary zero (“space”) is
transmitted as no pulse or zero amplitude.

–

HDB3: It stands for High Density Bipolar order 3 encoding. It is a bipolar signaling
technique (using both positive and negative pulses) based on the AMI. It extends AMI by
inserting violation codes whenever there is a run of four or more zeros.

To start or stop monitoring:

1. Press the MEASURE hot key.
2. Press the Monitoring soft key, and then select the monitoring option as needed: Start, Stop, or
Clear.
Optional. You can save event records automatically by using the Save Result as CSV Format soft key.
See “Using save” on page 31 for more information.
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Measurement example
Figure 254 E1 transmission monitoring for framing PCM30

NOTE
Bit Error is not supported for the framing type PCM30.

Performing BERT testing
There are three RX modes available for the BERT testing.


Terminate Mode: The Terminate mode is used when you wish to send and receive an E1
signal. The instrument terminates the received signal with a low impedance termination, and
requires that the circuit be disrupted for testing.



Bridge Mode: The Bridge mode is similar to the monitor mode. However, in the Bridge mode,
the instrument applies high impedance isolation resistors to the circuit under test. This
isolation circuitry will protect the signal from any possible disruption. There is no need to plug
into the TX jack of the test set while in the Bridge mode, and there is no need to specify a test
pattern to be transmitted. However, the transmitter in the test set is sending the selected test
pattern, framing, coding, and CRC.



Monitor Mode: The Monitor (protected monitoring point) mode is used when a monitor access
is to be made. The network element has isolated the MON signal from the live signal with high
impedance resistors. It is useful that it protects the live signal from any possible disruptions
caused by the testing process.

Making a test
Procedure
To select the measurement mode:

1. Press the MODE hard key.
2. Press the E1/T1 Analyzer soft key.
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3. Select E1 Analyzer > BERT.
To configure measurement parameters:

1. Press the MEASURE SETUP hot key.
2. Press the RX Mode soft key, and then select the receiver input option from the following choices:
–

Terminate: Provides 120-ohm nominal input impedance, according to the framing and line
code settings.

–

Bridge: Provides input impedance greater than one kilohm for in-service monitoring,
bridging the receiver input across lines that are terminated elsewhere in the network.

–

Monitor: Provides 120-ohm nominal input impedance for the in-service monitoring of E1
lines.

3. Toggle the Framing soft key between PCM30 and PCM31 and select the framing type for your
receiver setting:

–

PCM30: Timeslots from 1 to 15 correspond to channels from 1 to 15 and timeslots from 17
to 31 to channels from 16 to 30. Timeslot 16 is for the multi-frame alignment and Channel
Associated Signaling (CAS).

–

PCM31: Timeslots from 1 to 31 correspond to channels from 1 to 31.
NOTE
If the framing type does not match with your receiver setting, a framing alarm occurs.

4. Toggle the Line Code soft key between AMI and HDB3 and select the line code type to send an
E1 signal:

–

AMI: It stands for Alternate Mark Inversion. A line code uses one three level signal to
convey binary digits in which successive binary ones (“marks” or pulses) are of alternating
polarity, either positive or negative, equal in amplitude. A binary zero (“space”) is
transmitted as no pulse or zero amplitude.

–

HDB3: It stands for High Density Bipolar order 3 encoding. It is a bipolar signaling
technique (using both positive and negative pulses) based on the AMI. It extends AMI by
inserting violation codes whenever there is a run of four or more zeros.

5. Press the Pattern soft key, and then select the stress pattern option from the following choices:
–

1-4: A four-bit pattern that contains a single one, being used to test clock recovery.

–

1-8: An eight-bit pattern that contains a single one, being used to test clock recovery.

–

All 1’S: A pattern that causes line drivers to consume the maximum power.

–

All 0’S: A pattern that is often selected to verify HDB3 provisioning. Circuit will drop if
optioned for AMI.

–

Alternate: A pattern that alternates between ones and zeroes.

6. Toggle the TX Clock soft key between Internal and RX and select the timing source option to
measure frequency and timing:

–

Internal: Internal clock uses an internal oscillator in case of external reference is not
available and the instrument does not transmit signal to synchronized equipment. The
instrument provides the clock to the unit under test and most cases in Loopback test mode.

–

RX: Transmit clock uses the frequency recovered from the received signal (Network Loop),
if accurate frequency measurement is required.

7. Toggle the TX LBO soft key between 0 dB and -6 dB and select the level for TX Line Build Out.
8. Toggle the CRC-4 soft key between On and Off to activate or deactivate the CRC-4.
NOTE
CRC-4 is used to detect errors in blocks of data transmitted across communication links.
The detection is determined by a formula applied at both ends of transmit and receive. E1
uses a four-bit CRC (CRC-4) for error checking.
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To start or stop testing:

1. Press the MEASURE hot key.
2. Press the BERT soft key, and then select the testing option as needed: Start, Stop, or Clear.
To select the error injection type:

1. Press the Error Injection soft key, and then select the error injection type: None, 1E-3, 1E-4,
1E-5, or Single.
Optional. You can save event records automatically by using the Save Result as CSV Format soft key.
See “Using save” on page 31 for more information.

Measurement example
Figure 255 E1 BERT testing for framing PCM30

NOTE
Bit Error is not supported for the framing type PCM30.
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Using T1 Analyzer
This chapter provides instructions for using the T1 Analyzer function (option 005). Topics discussed in
this chapter are as follows:


Introduction ..............................................................................................................................495



Display overview ......................................................................................................................495



Connecting a cable ..................................................................................................................496



Monitoring transmission ...........................................................................................................497



Performing BERT testing .........................................................................................................498



Performing RX signal testing ...................................................................................................500



Performing loop testing ............................................................................................................502
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Introduction
The T1 is what telephone companies have traditionally used to transport digitized telephone
conversations between central offices. As early as the 1960’s, a single T1 circuit made it possible for a
telephone company to deliver 24 high quality voice conversations. T1 is a fully digitalized service with
no possibility of crosstalk, which is common in analog carrier networks where copper pairs pickup
emissions from neighboring pairs. Significant increases in noise immunity were also achieved by
adopting this new digital transmission standard.
Since the early 1980’s, T1 service has been available to private industry throughout the country. This
document will discuss the various types of T1 measurement items, how to measure them, and
understand the general guidelines of T1 analysis using the JD785A Base Station Analyzer.
This portable test instrument can be a useful tool to check the overall health of the transmission
system and assist in locating the source of problems or defects. The T1 Analyzer function provides
following measurements:


Monitoring



RX Signal Level



BERT Testing



Loop Testing

Display overview
Figure 256 provides descriptions for each segment of the measurement screen.
Figure 256 T1 analyzer screen
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Connecting a cable
Out-of-service testing
Figure 257 Point-to-point connection

Figure 258 Loop-back connection

Figure 259 Error injection and measurement connection

In-service monitoring
Figure 260 In-service connection
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Monitoring transmission
Making a test
Procedure
To select the measurement mode:

1. Press the MODE hard key.
2. Press the E1/T1 Analyzer soft key.
3. Select T1 Analyzer > Monitoring.
To configure measurement parameters:

1. Press the MEASURE SETUP hot key.
2. Press the RX Mode soft key, and then select the receiver input option from the following choices:
–

Terminate: Provides 100-ohm nominal input impedance, according to the framing, line
code, and BER pattern settings.

–

Bridge: Provides input impedance greater than one kilohm for in-service monitoring,
bridging the receiver input across lines that are terminated elsewhere in the network.

–

Monitor: Provides 100-ohm nominal input impedance for the in-service monitoring of T1
lines.

3. Toggle the Framing soft key between SF-D4 and ESF and select the framing type for your
receiver setting:

–

SF-D4 (Super Frame-D4): Group of 12 frames, used to align equipment for framing.

–

ESF (Extended Super Frame): Group of 24 frames, used to align equipment for framing.
4K for a maintenance channel (Facilities Data Link), 2K for CRC-6 checksum, and 2K for
framing/synchronization.
NOTE
If the framing type does not match with your receiver setting, a framing alarm occurs.

4. Toggle the Line Code soft key between AMI and B8ZS and select the line code type to send an
T1 signal:

–

AMI: It stands for Alternate Mark Inversion. A line code uses one three level signal to
convey binary digits in which successive binary ones (“marks” or pulses) are of alternating
polarity, either positive or negative, equal in amplitude. A binary zero (“space”) is
transmitted as no pulse or zero amplitude.

–

B8ZS: It stands for Bipolar with 8-Zero Substitution. A coding scheme in which the
transmitter "substitutes" a fixed pattern of ones, zeros, and BPVs in place of 8 consecutive
zeros.

To start or stop monitoring:

1. Press the MEASURE hot key.
2. Press the Monitoring soft key, and then select the monitoring option as needed: Start, Stop, or
Clear.
Optional. You can save event records automatically by using the Save Result as CSV Format soft key.
See “Using save” on page 31 for more information.
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Measurement example
Figure 261 T1 transmission monitoring

Performing BERT testing
Making a test
Procedure
To select the measurement mode:

1. Press the MODE hard key.
2. Press the E1/T1 Analyzer soft key.
3. Select T1 Analyzer > BERT.
To configure measurement parameters:

1. Press the MEASURE SETUP hot key.
2. Press the RX Mode soft key, and then select the receiver input option from the following choices:
–

Terminate: Provides 100-ohm nominal input impedance, according to the framing, line
code, and BER pattern settings.

–

Bridge: Provides input impedance greater than one kilohm for in-service monitoring,
bridging the receiver input across lines that are terminated elsewhere in the network.

–

Monitor: Provides 100-ohm nominal input impedance for the in-service monitoring of T1
lines.

3. Toggle the Framing soft key between SF-D4 and ESF and select the framing type for your
receiver setting:

–

SF-D4 (Super Frame-D4): Group of 12 frames, used to align equipment for framing.

–

ESF (Extended Super Frame): Group of 24 frames, used to align equipment for framing.
4K for a maintenance channel (Facilities Data Link), 2K for CRC-6 checksum, and 2K for
framing/synchronization.
NOTE
If the framing type does not match with your receiver setting, a framing alarm occurs.
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4. Toggle the Line Code soft key between AMI and B8ZS and select the line code type to send an
T1 signal:

–

AMI: It stands for Alternate Mark Inversion. A line code uses one three level signal to
convey binary digits in which successive binary ones (“marks” or pulses) are of alternating
polarity, either positive or negative, equal in amplitude. A binary zero (“space”) is
transmitted as no pulse or zero amplitude.

–

B8ZS: It stands for Bipolar with 8-Zero Substitution. A coding scheme in which the
transmitter "substitutes" a fixed pattern of ones, zeros, and BPVs in place of 8 consecutive
zeros.

5. Press the Pattern soft key, and then select the stress pattern option from the following choices:
–

1-8: An eight-bit pattern that contains a single one, being used to test clock recovery.

–

1-16: A sixteen-bit pattern that contains a single one, being used to test clock recovery.

–

All 1’S: A pattern that causes line drivers to consume the maximum power.

–

All 0’S: A pattern that is often selected to verify HDB3 provisioning. Circuit will drop if
optioned for AMI.

–

Alternate: A pattern that alternates between ones and zeroes.

–

3-24: A twenty-four bit-pattern containing 3 ones with the longest length of consecutive
zeroes constrained to fifteen. It has ones density of 12.5% and is used to check clock
recovery.

–

QRSS: A pseudorandom pattern that is a common test pattern and simulates live traffic on
a circuit.

–

2e23: A pseudorandom pattern based on a 23 bit shift register.

–

2e15: A pseudorandom pattern based on a 15 bit shift register.

–

2e23 INV: Bit inversed pseudorandom pattern based on a 23 bit shift register.

–

2e15 INV: Bit inversed pseudorandom pattern based on a 15 bit shift register.

6. Toggle the TX Clock soft key between Internal and RX and select the timing source option to
measure frequency and timing:

–

Internal: Internal clock uses an internal oscillator in case of external reference is not
available and the instrument does not transmit signal to synchronized equipment. The
instrument provides the clock to the unit under test and most cases in Loopback test mode.

–

RX: Transmit clock uses the frequency recovered from the received signal (Network Loop),
if accurate frequency measurement is required.

7. Press the TX LBO soft key, and then select the level for TX Line Build Out option from the
following choices:

–

0 dB: Is used in most cases including that the test set is connected to the DSX front panel,
to CSU, to NIU or Channel Bank or that the cabling is less than about 130 feet in-between
test set and DSX.

–

-7.5 dB: Is used in cases that attenuation is needed where the T1 line is series connected
to 7.5 dB attenuator.

–

-15 dB: Is used in cases that attenuation is needed where the T1 line is series connected to
15 dB attenuator.

To start or stop testing:

1. Press the MEASURE hot key.
2. Press the BERT soft key, and then select the testing option as needed: Start, Stop, or Clear.
To select the error injection type:

1. Press the Error Injection soft key, and then select the error injection type: None, 1E-3, 1E-4,
1E-5, or Single.
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To set the error injection optios:

1. Press the Alarm Injection soft key.
2. Toggle the AIS Alarm soft key between On and Off to enable or disable the Alarm Indication
Signal.

3. Toggle the RAI Alarm soft key between On and Off to enable or disable the Remote Alarm
Indication.
Optional. You can save event records automatically by using the Save Result as CSV Format soft key.
See “Using save” on page 31 for more information.

Measurement example
Figure 262 T1 BERT testing

Performing RX signal testing
Making a test
Procedure
To select the measurement mode:

1. Press the MODE hard key.
2. Press the E1/T1 Analyzer soft key.
3. Select T1 Analyzer > RX Signal.
To configure measurement parameters:

1. Press the MEASURE SETUP hot key.
2. Press the RX Mode soft key, and then select the receiver input option from the following choices:

500

–

Terminate: Provides 100-ohm nominal input impedance, according to the framing, line
code, and BER pattern settings.

–

Bridge: Provides input impedance greater than one kilohm for in-service monitoring,
bridging the receiver input across lines that are terminated elsewhere in the network.
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–

Monitor: Provides 100-ohm nominal input impedance for the in-service monitoring of T1
lines.

3. Toggle the Framing soft key between SF-D4 and ESF and select the framing type for your
receiver setting:

–

SF-D4 (Super Frame-D4): Group of 12 frames, used to align equipment for framing.

–

ESF (Extended Super Frame): Group of 24 frames, used to align equipment for framing.
4K for a maintenance channel (Facilities Data Link), 2K for CRC-6 checksum, and 2K for
framing/synchronization.
NOTE
If the framing type does not match with your receiver setting, a framing alarm occurs.

4. Toggle the Line Code soft key between AMI and B8ZS and select the line code type to send an
T1 signal:

–

AMI: It stands for Alternate Mark Inversion. A line code uses one three level signal to
convey binary digits in which successive binary ones (“marks” or pulses) are of alternating
polarity, either positive or negative, equal in amplitude. A binary zero (“space”) is
transmitted as no pulse or zero amplitude.

–

B8ZS: It stands for Bipolar with 8-Zero Substitution. A coding scheme in which the
transmitter "substitutes" a fixed pattern of ones, zeros, and BPVs in place of 8 consecutive
zeros.

To start or stop testing:

1. Press the MEASURE hot key.
2. Press the RX Signal soft key, and then select the testing option as needed: Start, Stop, or
Clear.
Optional. You can save event records automatically by using the Save Result as CSV Format soft key.
See “Using save” on page 31 for more information.

Measurement example
Figure 263 T1 RX signal testing
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Performing loop testing
Making a test
Procedure
To select the measurement mode:

1. Press the MODE hard key.
2. Press the E1/T1 Analyzer soft key.
3. Select T1 Analyzer > Loop Test.
To configure measurement parameters:

1. Press the MEASURE SETUP hot key.
2. Press the RX Mode soft key, and then select the receiver input option from the following choices:
–

Terminate: Provides 100-ohm nominal input impedance, according to the framing, line
code, and BER pattern settings.

–

Bridge: Provides input impedance greater than one kilohm for in-service monitoring,
bridging the receiver input across lines that are terminated elsewhere in the network.

–

Monitor: Provides 100-ohm nominal input impedance for the in-service monitoring of T1
lines.

3. Toggle the Framing soft key between SF-D4 and ESF and select the framing type for your
receiver setting:

–

SF-D4 (Super Frame-D4): Group of 12 frames, used to align equipment for framing.

–

ESF (Extended Super Frame): Group of 24 frames, used to align equipment for framing.
4K for a maintenance channel (Facilities Data Link), 2K for CRC-6 checksum, and 2K for
framing/synchronization.
NOTE
If the framing type does not match with your receiver setting, a framing alarm occurs.

4. Toggle the Line Code soft key between AMI and B8ZS and select the line code type to send an
T1 signal:

–

AMI: It stands for Alternate Mark Inversion. A line code uses one three level signal to
convey binary digits in which successive binary ones (“marks” or pulses) are of alternating
polarity, either positive or negative, equal in amplitude. A binary zero (“space”) is
transmitted as no pulse or zero amplitude.

–

B8ZS: It stands for Bipolar with 8-Zero Substitution. A coding scheme in which the
transmitter "substitutes" a fixed pattern of ones, zeros, and BPVs in place of 8 consecutive
zeros.

5. Press the Pattern soft key, and then select the stress pattern option from the following choices:
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–

1-8: An eight-bit pattern that contains a single one, being used to test clock recovery.

–

1-16: A sixteen-bit pattern that contains a single one, being used to test clock recovery.

–

All 1’S: A pattern that causes line drivers to consume the maximum power.

–

All 0’S: A pattern that is often selected to verify HDB3 provisioning. Circuit will drop if
optioned for AMI.

–

Alternate: A pattern that alternates between ones and zeroes.

–

3-24: A twenty-four bit-pattern containing 3 ones with the longest length of consecutive
zeroes constrained to fifteen. It has ones density of 12.5% and is used to check clock
recovery.

–

QRSS: A pseudorandom pattern that is a common test pattern and simulates live traffic on
a circuit.
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–

2e23: A pseudorandom pattern based on a 23 bit shift register.

–

2e15: A pseudorandom pattern based on a 15 bit shift register.

–

2e23 INV: Bit inversed pseudorandom pattern based on a 23 bit shift register.

–

2e15 INV: Bit inversed pseudorandom pattern based on a 15 bit shift register.

6. Toggle the TX Clock soft key between Internal and RX and select the timing source option to
measure frequency and timing:

–

Internal: Internal clock uses an internal oscillator in case of external reference is not
available and the instrument does not transmit signal to synchronized equipment. The
instrument provides the clock to the unit under test and most cases in Loopback test mode.

–

RX: Transmit clock uses the frequency recovered from the received signal (Network Loop),
if accurate frequency measurement is required.

7. Press the TX LBO soft key, and then select the level for TX Line Build Out option from the
following choices:

–

0 dB: Is used in most cases including that the test set is connected to the DSX front panel,
to CSU, to NIU or Channel Bank or that the cabling is less than about 130 feet in-between
test set and DSX.

–

-7.5 dB: Is used in cases that attenuation is needed where the T1 line is series connected
to 7.5 dB attenuator.

–

-15 dB: Is used in cases that attenuation is needed where the T1 line is series connected to
15 dB attenuator.

8. Press the Loop Codes soft key, and then do one of the following option:
–

To select the link option, toggle press the Link soft key between Inband and Datalink.
Datalink is used when the framing is set to ESF.

–

To select the Channel Service Unit, press the CSU soft key.

–

To select the Network Interface Unit, press the NIU soft key.

To start or stop testing:

1. Press the MEASURE hot key.
2. Press the Loop Test soft key, and then select the testing option as needed: Start, Stop, or
Clear.
To activate or deactiave the external loop back:

1. Press the Remote Loop Up to activate the external loop back so that the instrument sends the
system a request of the loop back mode.

2. Press the Remote Loop Dn to deactivate the external loop back so that the instrument sends
the system a request to clean the loop back mode.
To activate or deactiave the internal loop back:

1. Press the Self Loop Up to activate the internal loop back.
2. Press the Self Loop Dn to deactivate the internal loop back, reverting the instrument to a
through mode.
To select the error injection type:

1. Press the Error Injection soft key, and then select the error injection type: None, 1E-3, 1E-4,
1E-5, or Single.
To set the error injection optios:

1. Press the Alarm Injection soft key.
2. Toggle the AIS Alarm soft key between On and Off to enable or disable the Alarm Indication
Signal.
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3. Toggle the RAI Alarm soft key between On and Off to enable or disable the Remote Alarm
Indication.
Optional. You can save event records automatically by using the Save Result as CSV Format soft key.
See “Using save” on page 31 for more information.

Measurement example
Figure 264 T1 loop testing
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Using Channel Scanner
This chapter provides instructions for using the Channel Scanner function (option 012). Topics
discussed in this chapter are as follows:


Introduction ..............................................................................................................................506



Display overview ......................................................................................................................506



Connecting a cable ..................................................................................................................506



Selecting measurement mode .................................................................................................508



Configuring test parameters ....................................................................................................508



Making channel scanner measurements ................................................................................. 511



Making frequency scanner measurements .............................................................................512



Making custom scanner measurements ..................................................................................513



Analyzing measurements ........................................................................................................515
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Introduction
A Channel Scanner is a radio receiver that can automatically tune or scan two or more discrete
frequencies and multi-channels, indicating when it finds a signal on one of them and then continuing
scanning when that frequency goes silent.
You can measure up to 20 channels with this channel scanner. Using existing format-based or custom
parameters, you will be able to easily verify improper multi-channel power levels.


Channel Scanner



Frequency Scanner



Custom Scanner (Channel or Frequency)

Display overview
Figure 265 provides descriptions for each segment of the measurement screen.
Figure 265 Channel scanner screen

Connecting a cable
Direct connection
Procedure

1. Connect the Spectrum Analyzer RF In port of the JD780A series and the Power amplifier output
port of BTS.
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Figure 266 Direct connection

JD785A/JD786A

JD788A

Indirect connection
Procedure

1. Connect the Spectrum Analyzer RF In port of the JD780A series and the monitor (test) port of
BTS.

Figure 267 Indirect connection

JD785A/JD786A

JD788A

CAUTION
The maximum power for the Spectrum Analyzer RF In port is +25 dBm (0.316 W). If the
input signal level to be measured is greater than +25 dBm, use a High Power
Attenuator to prevent damage when you directly connect the signal to the instrument or
connect the signal from the coupling port of a directional coupler.

Over the air (OTA)
Procedure

1. Connect an Omni/directional RF antenna to the Spectrum Analyzer RF In port of the JD780A
series.

2. Connect a GPS antenna to the GPS port of the JD780A series.
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Figure 268 OTA connection

JD785A/JD786A

JD788A

CAUTION
If the input signal level to be measured is less than 0 dBm, set 0 dB attenuation or turn on
the preamp to have better dynamic range for the OTA testing.

Selecting measurement mode
Procedure

1. Press the MODE hard key.
2. Press the Channel Scanner soft key. The Channel Scanner mode is selected by default.
3. To change the measurement mode, press the MEASURE hot key and then select the
measurement mode:

–

Channel Scanner

–

Frequency Scanner

–

Custom Scanner

Configuring test parameters
Setting frequency
You need to set the channel or frequency to be scanned depending on the scanner mode: channel
scanner, frequency scanner, and custom scanner. Refer to each scanner mode for how to set the
channel or frequency.

Setting amplitude
Reference level and attenuation
You can set the reference and attenuation levels automatically or manually to optimize the display of
the traces measured, as you desire.
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Procedure
To automatically set the reference and attenuation level:

1. Press the AMP/SCALE hard key.
2. Press the Auto Scale soft key.
Each time you press this key, both of the Y-axis scale and input attenuation level change to be
optimized with some margin.
To set the reference or attenuation level manually:

1. Press the AMP/SCALE hard key.
2. To set the maximum reference value on the Y-axis manually, complete the following steps:
a.

Press the Reference Level soft key.

b.

Enter a value by using the numeric keys or the rotary knob with 10 dB increments.

c.

Press the dBm soft key or the ENTER hard key.

3. To set the attenuation option, select one from the following choices:
–

To set the input attenuator’s level automatically, select Attenuation > Auto.
NOTE
It is recommended that you set the Attenuation to Auto in most situations so that the
level of the input attenuator can be set automatically according to your input signal level.

–

To set the input attenuation manually up to 55 dB to optimize S/N, complete the following
steps:

–

a.

Select Attenuation > Manual.

b.

Press the Attenuation Value soft key to set the level.

c.

Enter a value between 0 and 55 in fives by using the numeric keys.

d.

Press the dB soft key or the ENTER hard key.

To couple the input attenuator’s level with your reference level setting, select Attenuation >
Couple.
As you increse the reference setting, the attenuation level also increases acoordingly.

Optional. To change the scale unit:

1. Select More (1/2) > Units.
2. Select the unit of the display scale: dBm, dBV, dBmV, dBµV, V, or W.
The scale unit on the screen changes accordingly.

Pre-amplifier
You can turn the internal pre-amplifier on to correct and compensate for the gain of the preamp so that
amplitude readings show the value at the input connector.
Procedure

1. Press the AMP/SCALE hard key.
2. Toggle the Preamp soft key and select On or Off as needed.
NOTE
You can turn the Preamp on when the input attenuation range is from 0 dB to 10 dB. If
the attenuation value is manually set to greater than 10 dB, the instrument will
automatically turn off the pre-amplifier to display low-level signal properly on the chart.
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External offset
You can turn the External Offset on and manually set the external offset value. An offset consists of a
cable loss and a user offset and the measurement result shows the value reflecting both offset values.
When the external offset value is set at 40 dB in the Spectrum mode, the measurement result
compensates 40 dB at both the Spectrum Analyzer and Signal Analyzer modes
Procedure
To set the external offset:

1. Press the AMP/SCALE hard key.
2. Toggle the External Offset soft key and select On.
3. Enter a value by using the numeric keys.
4. Press the dB soft key to complete the entry.
To turn the external offset off:

1. Press the AMP/SCALE hard key.
2. Toggle the External Offset soft key and select Off.

Setting average
You can set the number of measurements to be averaged for the trace presentation. A maximum of
100 times of averaging can be set. When the averaging reaches to your setting, a new measurement
value replaces the measurement value in sequence from the earliest.
Procedure

1. Press the BW/AVG hard key.
2. Press the Average soft key.
3. Enter a value between 1 and 100 as needed by using the numeric keys.
4. Press the Enter soft key.

Setting sweep mode
The default settings of the sweep mode are Continue and Normal to sweep continuously at a normal
speed for most on-going measurements. If you want to hold the measurement or get a single sweep,
you can change the sweep mode.
Procedure
To select the single sweep mode:

1. Press the SWEEP hot key.
2. Toggle the Sweep Mode soft key and select Single. You can also use the HOLD hot key.
The letter HOLD in red appears and the sweeping is paused.

3. Optional. Press the Sweep Once soft key to get a new measurement.
To return to the continuous sweep mode:

1. Toggle the Sweep Mode soft key and select Continue. You can also use the HOLD hot key.
The letter HOLD in red disappears and the sweeping resumes.
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NOTE
Selecting Sweep Mode > Fast may reduce the measurement accuracy, but you can use
this fast sweep mode to identify the existence of interfering signals.

Making channel scanner measurements
Setting channel
You need to set the channel to be scanned.
Procedure

1. Press the FREQ/DIST hard key.
2. To select the standard channel, complete the following steps:
a.

Press the Channel Std soft key. The standard channel window appears.
See “Appendix C – Band, frequency & channel standard” on page 541 for more information.

b.

Select the band to be measured by using the rotary knob, the arrow keys, or the Page
Up/Page Down soft keys.

c.

Press the Select soft key or the rotary knob to confirm the selection.

3. Toggle the Link soft key to select the scanning direction and select Fwd for forward or Rev for
reverse.

4. To set the starting channel, complete the following steps:
a.

Press the Start Channel soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Press the Enter soft key.

5. To set the amount of channel increment in scanning channels, complete the following steps:
a.

Press the Channel Step soft key.

b.

Enter a value by suing the numeric keys. You can also use the rotary knob.

c.

Press the Enter soft key.

6. To set the integration bandwidth, complete the following steps:
a.

Press the Integration Bandwidth soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Select the unit: GHz, MHz, kHz, or Hz.

7. To set the number of channels to be displayed in the measurement table, complete the following
steps:
a.

Press the # of Channels soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Press the Enter soft key.

Measurement example
Test results can be saved as a *.csv file format so that you can work on it in any spreadsheet
software.
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Figure 269 Channel scanner measurement

NOTE
You can use the LIMIT hot key to analyze your measurements with the display line and
channel limit. See “Setting limit for channel scanner” on page 515 for more information.

Making frequency scanner measurements
Setting frequency
You need to set the frequency to be scanned.
Procedure

1. Press the FREQ/DIST hard key.
2. To set the starting center frequency, complete the following steps:
a.

Press the Start Frequency soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Select the unit: GHz, MHz, kHz, or Hz.

3. To set the amount of frequency increment in scanning channels, complete the following steps:
a.

Press the Frequency Step soft key.

b.

Enter a value by suing the numeric keys. You can also use the rotary knob.

c.

Select the unit: GHz, MHz, kHz, or Hz.

4. To set the integration bandwidth, complete the following steps:
a.

Press the Integration Bandwidth soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Select the unit: GHz, MHz, kHz, or Hz.

5. To set the number of frequencies to be displayed in the measurement table, complete the
following steps:
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a.

Press the # of Frequency soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.
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c.

Press the Enter soft key.

Measurement example
Figure 270 Frequency scanner measurement

NOTE
You can use the LIMIT hot key to analyze your measurements with the display line and
channel limit. See “Setting limit for channel scanner” on page 515 for more information.

Making custom scanner measurements
Setting channel/frequency
You can customize channels or frequencies to be scanned as you desire.
Procedure
To set the channels to be scanned:

1. Press the FREQ/DIST hard key.
2. Toggle the Unit soft key and select Channel.
3. To select the standard channel, complete the following steps:
a.

Press the Channel Std soft key. The standard channel window appears.
See “Appendix C – Band, frequency & channel standard” on page 541 for more information.

b.

Select the band to be measured by using the rotary knob, the arrow keys, or the Page
Up/Page Down soft keys.

c.

Press the Select soft key or the rotary knob to confirm the selection.

4. Toggle the Link soft key to select the scanning direction and select Fwd for forward or Rev for
reverse.

5. Press the Index soft key, and then enter an index number by turning the rotary knob or using the
numeric keys.

6. To set the channel number for the selected index, complete the following steps:
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a.

Press the Channel Number soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Press the Enter soft key.

The instrument displays a corresponding center frequency for the channel number.

7. To set the integration bandwidth for the selected index, complete the following steps:
a.

Press the Integration Bandwidth soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Select the unit: GHz, MHz, kHz, or Hz.

8. To add more channels to be scanned, repeat steps 5-7.
9. Press the ESC hard key to dismiss the channel list window and view the scanning result.
To set the frequencies to be scanned:

1. Press the FREQ/DIST hard key.
2. Toggle the Unit soft key and select Freq.
3. Press the Index soft key, and then enter an index number by turning the rotary knob or using the
numeric keys.

4. To set the center frequency for the selected index, complete the following steps:
a.

Press the Center Frequency soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Select the unit: GHz, MHz, kHz, or Hz.

5. To set the integration bandwidth for the selected index, complete the following steps:
a.

Press the Integration Bandwidth soft key.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Select the unit: GHz, MHz, kHz, or Hz.

6. To add more channels to be scanned, repeat steps 3-5.
7. Press the ESC hard key to dismiss the channel list window and view the scanning result.
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Measurement example
Figure 271 Custom scanner measurement

NOTE
You can use the LIMIT hot key to analyze your measurements with the display line and
channel limit. See “Setting limit for channel scanner” on page 515 for more information.

Analyzing measurements
Setting limit for channel scanner
Procedure
To use the display line:

1. Press the LIMIT hot key.
2. Press the Display Line soft key to set a threshold for the limit line and Pass/Fail indication.
3. Enter a value, and then press the dBm unit soft key.
4. Toggle the Display Line soft key between On and Off to display or dismiss the limit line.
To use the channel limit:

1. Press the LIMIT hot key.
2. Press the Channel Limit soft key to set the limits for each channel index.
3. Press the Index soft key, and then select the channel/frequency index number by turning the
rotary knob or using the numeric keys.

4. Toggle the Limit soft key between On and Off to enable or disable the Pass/Fail indication.
5. Set the upper threshold:
a.

Press the High Limit soft key.

b.

Enter a value for the upper limit.

c.

Press the dBm unit soft key.

6. Set the lower threshold:
a.

Press the Low Limit soft key.
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b.

Enter a value for the lower limit.

c.

Press the dBm unit soft key.

7. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available
for your measurement mode. See “Using save” on page 31 for more information.
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Using Power Meter
This chapter provides instructions for using the RF Power Meter function and the Optical Power Meter
function. Topics discussed in this chapter are as follows:


Introduction ..............................................................................................................................519



Display overview ......................................................................................................................519



Performing internal RF power measurements .........................................................................519



Performing external RF power measurements ........................................................................524



Performing optical power measurements ................................................................................527



Setting limit for power meter ....................................................................................................530
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Introduction
The Power Meter of the JD780A series uses power measurement based on spectrum measurement
results to provide an accurate power measurement result unlike a general spectrum analyzer, of which
power accuracy may be degraded if the span is set too wide.
The power meter also provides Pass/Fail indication with user-defined lower and upper limits.
The Power Meter function provides following measurements:


Internal RF Power Measurement



External RF Power Measurement



Optical Power Measurement

Display overview
Figure 272 provides descriptions for each segment of the measurement screen.
Figure 272 Power measurement screen

Performing internal RF power measurements
The internal power measurement of the JD780A series collects powers from the raw data of spectrum
analyzer in the optimal span and integrates the powers up to the specified user span, which results in
an accurate power measurement, independent of the span setting.
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Connecting a cable
Direct connection
Procedure

1. Connect the Spectrum Analyzer RF In port of the JD780A series and the Power amplifier output
port of BTS as shown in Figure 273.

Figure 273 Direct connection

JD785A/JD786A

JD788A

Indirect connection
Procedure

1. Connect the Spectrum Analyzer RF In port of the JD780A series and the monitor (test) port of
BTS as shown in Figure 274.

Figure 274 Indirect connection

JD785A/JD786A

JD788A

CAUTION
The maximum power for the Spectrum Analyzer RF In port is +25 dBm (0.316 W). If the
input signal level to be measured is greater than +25 dBm, use a High Power
Attenuator to prevent damage when you directly connect the signal to the instrument or
connect the signal from the coupling port of a directional coupler.
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Selecting measurement mode
Procedure

1. Press the MODE hard key.
2. Select More (1/2) > Power Meter > Internal RF Power Meter.

Setting frequency
You need to set the frequency range to be measured either with the center frequency and span or with
the start and stop frequencies. You can also set the frequency with the channel number and span.
Procedure
To set the center frequency and span:

1. Press the FREQ/DIST hard key.
2. Toggle the Unit soft key and select Freq.
3. Press the Center Frequency soft key.
4. Enter a value by using the numeric keys. You can also use the rotary knob or the arrow keys.
5. Select the unit: GHz, MHz, kHz, or Hz.
6. Press the Span soft key, and then do one of the following:
–

To set the span manually, select Span, enter a value, and then select the unit.

–

To set the span automatically, select Full Span, Zero Span, or Last Span as needed.
NOTE
The Zero Span option is available only in the Spectrum mode. If you have selected Zero
Span, select TRIGGER > Free Run, External, GPS, Video, or Display Position.

To set the start and stop frequencies:

1. Press the FREQ/DIST hard key.
2. Toggle the Unit soft key and select Freq.
3. Press the Start Frequency soft key.
4. Enter a value by using the numeric keys. You can also use the rotary knob or the arrow keys.
5. Select the unit: GHz, MHz, kHz, or Hz.
6. Press the Stop Frequency soft key.
7. Enter a value by using the numeric keys. You can also use the rotary knob or the arrow keys.
8. Select the unit: GHz, MHz, kHz, or Hz.
To set the channel number and span:

1. Press the FREQ/DIST hard key.
2. Toggle the Unit soft key and select Channel.
3. To select the standard channel, complete the following steps:
a.

Press the Channel Std soft key. The standard channel window appears.
See “Appendix C – Band, frequency & channel standard” on page 541 for more information.

b.

Select the band to be measured by using the rotary knob, the arrow keys, or the Page
Up/Page Down soft keys.

c.

Press the Select soft key or the rotary knob to confirm the selection.
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4. Toggle the Link soft key to select the sweep direction and select Fwd for forward or Rev for
reverse.

5. To set the channel number, complete the following steps:
a.

Press the Channel Number soft key.

b.

Enter a value by using the numeric keys.

c.

Press the Enter soft key or ENTER hard key to complete the entry.
The instrument automatically displays the corresponding center frequency value for the
selected channel number.

6. To set the span, complete the following steps:
a.

Press the Span soft key.

b.

Select the span option, from the following choices:

–

To set the span manually, select Span, enter a value, and then select the unit.

–

To set the span automatically, select Full Span, Zero Span, or Last Span as needed.

NOTE
The Zero Span option is available only in the Spectrum mode. If you have selected Zero
Span, select TRIGGER > Free Run, External, GPS, Video, or Display Position.
Optional. To define the amount of frequency increment for the rotary knob:

1. Press the Frequency Step soft key, if the Freq is selected.
2. Enter a value by using the numeric keys.
3. Press the unit: GHz, MHz, kHz, or Hz.
Optional. To define the amount of channel increment for the rotary knob:

1. Press the Channel Step soft key, if the Channel is selected.
2. Enter a value by using the numeric keys.
3. Press the Enter soft key.

Setting amplitude
Procedure

1. Press the AMP/SCALE hard key.
2. Toggle the Display soft key and select the display method: Relative or Absolute.
3. If the Relative is selected, press the Set Reference soft key to set the current value as the
reference.

4. To specify the display range, complete the following steps:
a.

Press the Display Maximum soft key to set the maximum value for the power meter.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Press the dBm soft key.

d.

Press the Display Minimum soft key to set the minimum value for the power meter.

e.

Enter a value by using the numeric keys. You can also use the rotary knob.

f.

Press the dBm soft key.

5. Optional. To enable the external offset, complete the following steps:
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a.

Toggle the External Offset soft key and select On.

b.

Enter a value between 0 and 60 by using the numeric keys.
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c.

Press the dB soft key.

Setting sweep mode
The default setting of the sweep mode is Continue. If you want to hold the measurement, you can
change the sweep mode.
Procedure
To select the single sweep mode:

1. Press the SWEEP hot key.
2. To select the single sweep mode, toggle the Sweep Mode soft key and select Single. You can
also use the HOLD hot key.
The letter HOLD in red appears and the sweeping is paused.

3. To return to the continuous sweep mode, toggle the Sweep Mode soft key and select Continue.
You can also use the HOLD hot key.
The letter HOLD in red disappears and the sweeping resumes.

Making a measurement
Procedure

1. Press the MEASURE SETUP hot key.
2. Press the Resolution soft key, and then select the resolution option from the following choices:
–

0 to display the reading with no decimal place

–

1 to display the reading with one decimal place

–

2 to display the reading with two decimal places

3. To set the resolution bandwidth, complete the following steps:
a.

Press the RBW soft key.

b.

Enter a value by using the numeric keys.

c.

Press the unit: MHz, kHz, or Hz.

4. Press the Accuracy Mode soft key, and then select the accuracy mode option: Low, Middle,
and High.

5. To specify the number of measurements to be averaged, complete the following steps:
a.

Press the Average soft key.

b.

Enter a value between 1 and 100 by using the numeric keys.

c.

Press the Enter soft key.

Using Power Meter

523

JD780A Series Analyzers

Measurement example
Figure 275 Internal power measurement

NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication. See “Setting limit for power meter” on page 530 for more
information.

Performing external RF power measurements
This instrument performs radio output power measurement with the use of optional external power
sensors including JD730 series power sensors. It serves as the highly accurate RF power meter and
gives wider range of power measurement.

Connecting a cable
There are two types of power sensors. Directional power sensors are used in in-service power
measurement. Terminating power sensors are used in out-of-service power measurement.
Table 23
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External power sensor type

Part No.

Description

Frequency Range

Power Range

JD731B

Directional Power Sensor

300-3800 MHz

Average: +21.76 to +51.76 dBm
(0.15 to 150 W)
Peak: +36.02 to +56.02 dBm
(4 to 400 W)

JD732B

Terminating Power Sensor

20-3800 MHz

Average: -30 to +20 dBm

JD733A

Directional Power Sensor

150-3500 MHz

Average/Peak: +20 to +47 dBm
(0.1 to 50 W)

JD734B

Terminating Power Sensor

20-3800 MHz

Peak: -30 to +20 dBm

JD736B

Terminating Power Sensor

20-3800 MHz

Average/Peak: -30 to +20 dBm
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Terminating power sensor connection
Procedure

1. Connect an external power sensor to the USB Host port of the JD780A series and to the RF
output port of BTS.
The JD780A series automatically detects and initializes the power sensor connected to the
instrument. Connecting an external power sensor is mandatory

Table 24

Terminating power sensor connection

JD788A

JD785A/JD786A

Directional power sensor connection
Procedure

1. Connect an external power sensor to the USB Host port of the JD780A series and to the RF
output port of BTS as shown in Figure 276.
The JD780A series automatically detects and initializes the power sensor connected to the
instrument. Connecting an external power sensor is mandatory.

Figure 276 Directional power sensor connection

JD785A/JD786A

JD788A

Selecting measurement mode
Procedure

1. Press the MODE hard key.
2. Select More (1/2) > Power Meter > External RF Power Meter.
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Setting frequency
You need to set the frequency to be measured depending on your connected external power sensor.
Procedure

1. Press the FREQ/DIST hard key.
2. Press the Frequency soft key.
3. Enter a value by using the numeric keys. You can also use the rotary knob.
4. Select the unit: GHz, MHz, kHz, or Hz.

Setting amplitude
Procedure

1. Press the AMP/SCALE hard key.
2. Toggle the Display soft key and select the display method: Relative or Absolute.
3. If the Relative is selected, press the Set Reference soft key to set the current value as the
reference.

4. To specify the display range, complete the following steps:
a.

Press the Display Maximum soft key to set the maximum value for the power meter.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Press the dBm soft key.

d.

Press the Display Minimum soft key to set the minimum value for the power meter.

e.

Enter a value by using the numeric keys. You can also use the rotary knob.

f.

Press the dBm soft key.

5. Optional. To enable the external offset, complete the following steps:
a.

Toggle the External Offset soft key and select On.

b.

Enter a value between 0 and 60 by using the numeric keys.

c.

Press the dB soft key.

Making a measurement
Procedure

1. Press the MEASURE hot key.
2. Depending your connected power sensor, do one of the following:
–

For JD736B, select the power range option: Average Power, Peak Power, or Pulse Power.

–

For JD734B, select Peak Power.

–

For JD732B, select Average Power.

–

For JD731B, select the power range option: Forward Avg Power, Reverse Avg Power,
Forward Peak Power, Pulse Power, or VSWR.

–

For JD733A, select the power range option: Forward Avg Power, Reverse Avg Power,
Forward Peak Power, or VSWR.

3. Press the MEASURE SETUP hot key.
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4. Press the Resolution soft key, and then select the resolution option from the following choices:
–

0 to display the reading with no zero decimal place

–

1 to display the reading with one decimal place

–

2 to display the reading with two decimal places

Measurement example
You can measure and understand a trend of a system output in operation where output power
constantly varies depending on the amount of calls being processed by the BTS or Repeater. In
addition, the Log graph benefits you to easily examine the discontinuance of output power caused by
the transmission problems or defective connection.
Figure 277 External power measurement of pulse power

NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication. See “Setting limit for power meter” on page 530 for more
information.

Performing optical power measurements
The optical power measurement is available in conjunction with MP-series power sensor, which
measures optical power via a USB connection.

Connecting a cable
There are two types of optical power sensors.
Table 25

Optical power sensors

Part No.

Wavelength Range

Dynamic Range

MP-60A

780-1650 nm

1300, 1310, 1490, 1550 nm: -50 to +10 dBm
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850 nm: -45 to +10 dBm
MP-80A

780-1650 nm

1300, 1550 nm: -35 to +23 dBm
980 nm: -30 to +23 dBm

Optical power sensor connection
Procedure

1. Connect a MP-series optical power sensor to the USB Host port of the JD780A series as shown
in Figure 278.

Figure 278 Optical power sensor connection

JD788A

JD785A/JD786A

Selecting measurement mode
Procedure

1. Press the MODE hard key.
2. Select More (1/2) > Power Meter > Optical Power Meter.

Setting amplitude
Procedure

1. Press the AMP/SCALE hard key.
2. Toggle the Display soft key and select the display method: Relative or Absolute.
3. If the Relative is selected, press the Set Reference soft key to set the current value as the
reference.

4. To specify the display range, complete the following steps:
a.

Press the Display Maximum soft key to set the maximum value for the power meter.

b.

Enter a value by using the numeric keys. You can also use the rotary knob.

c.

Press the dBm soft key.

d.

Press the Display Minimum soft key to set the minimum value for the power meter.

e.

Enter a value by using the numeric keys. You can also use the rotary knob.

f.

Press the dBm soft key.

5. Optional. To enable the external offset, complete the following steps:
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a.

Toggle the External Offset soft key and select On.

b.

Enter a value between 0 and 60 by using the numeric keys.

c.

Press the dB soft key.

Making a measurement
Procedure

1. Press the MEASURE SETUP hot key.
2. Toggle the Wavelength soft key and select the wavelength option:
–

To set the wave length automatically, select Auto.

–

To select the wave length from the standard wave list, select StdWave.
The StdWave soft key becomes activated.

3. Press the StdWave soft key, and then select the standard wavelength option: 850 nm, 980 nm,
1300 nm, 1310 nm, 1480 nm, 1490 nm, or 1550 nm.

4. Press the Resolution soft key, and then select the resolution option from the following choices:
–

0 to display the reading with nodecimal place

–

1 to display the reading with one decimal place

–

2 to display the reading with two decimal places

Measurement example
Figure 279 optical power measurement

NOTE
You can use the LIMIT hot key to analyze your measurements with the user-definable
limit and Pass/Fail indication. See “Setting limit for power meter” on page 530 for more
information.
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Setting limit for power meter
You can use the Limit hot key to set the threshold for the Pass/Fail indication.
Procedure

1. Press the LIMIT hot key.
2. Toggle the Limit soft key between On and Off to enable or disable the Pass/Fail indication.
3. To set the upper and lower limits, complete the following steps:
a.

Press the High Limit soft key.

b.

Enter a value for the upper threshold by using the numeric keys.

c.

Press the dBm unit soft key.

a.

Press the Low Limit soft key.

b.

Enter a value for the lower threshold by using the numeric keys.

c.

Press the dBm unit soft key.

4. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available
for your measurement mode. See “Using save” on page 31 for more information.
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Performing Fiber Inspection
This chapter provides instructions for using the fiber testing function with a P5000i fiberscope. Topics
discussed in this chapter are as follows:


Introduction ..............................................................................................................................532



Display overview ......................................................................................................................532



Connecting a fiber microscope ................................................................................................532



Selecting measurement mode .................................................................................................533



Configuring test parameters ....................................................................................................533
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Introduction
Inspection of fiber optic connections is essential for the optimal performance and longevity of fiber
optic connectivity. Throughout their lives, fiber connectors must be inspected, analyzed, and cleaned
to maintain an acceptable level of functionality. The JD780A series makes it fast and easy to
troubleshoot and certify that every connection at a cell site is optimized for a lifetime of performance.
The JD780A series supports the handheld fiber microscope P5000i that can capture video images
from the sensor and analyzes the images for fiber end face defects and contamination with reliable
PASS/FAIL results to guarantee the performance of your optical connections.

Display overview
Figure 272 provides descriptions for each segment of the measurement screen.
Figure 280 Fiber inspection screen

Connecting a fiber microscope
Connecting an optional fiber microscope P5000i is mandatory for fiber inspection and analysis. See
“JD780A Series Common Options” on page 555 for available options.
Procedure

1. Connect your fiber microscope P5000i to the USB Host port of the JD780A series.
The instrument detects the connected microscope automatically and displays the icon.
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Selecting measurement mode
Procedure

1. Press the MODE hard key.
2. Select More (1/2) > Fiber Inspection.

Configuring test parameters
Selecting profile and tip
You can select analysis profiles and inspection tips from the list.
Procedure

1. Press the MEASURE SETUP hot key.
2. Press the Profile & Tip soft key.
The profile and tip pane appears.

3. To select one of the pre-configured analysis profiles that match the PASS/FAIL criteria in the IEC
visual inspection standard, complete the following steps:
a. Tap the drop-down list button for the Profile.
b.

Select the profile that you want to use, from the following choices:

–
–
–
–
–
–

MM (IEC-61300-3-35)
Ribbon, MM (IEC-61300-3-35)
Ribbon, SM APC (IEC-61300-3-35)
SM APC (IEC-61300-3-35)
SM PC (IEC-61300-3-35)
SM UPC (IEC-61300-3-35)
NOTE
All of the profiles are factory set and cannot be edited or removed.

4. To select the inspection tip (optical settings) that you want to use, complete the following steps:
a.

Tap the drop-down list button for the Tip.

b.

Select one of the tips available to your selected profile, from the following choices:

–
–

Standard Tips (with BAP1) and Simplex Long Reach (-L) Tips
Ribbon Tips and Ribbon Tips – Long Reach
NOTE
This setting allows you to select the best optical settings for the type of inspection tip
that is attached to your microscope probe.

5. Tap the Apply button or press the Apply soft key to save and return to the previous state.

Setting preferences
You can set your preferences of auto center and QuickCapture button function. The QuickCapture
button is the small grey round button on the side of the microscope.
Procedure

1. To set the function of the QuickCapture button on the side of the P5000i, toggle the Test Button
soft key and select the option from the following choices:
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–

Test: Sets the capture button to function as Test. Pressing the Quickcapture button
analyzes fiber image as like the Test soft key on your JD780A series.

–

Freeze: Sets the capture button to function as Freeze. Pressing the Quickcapture button
captures fiber image as like the Freeze soft key on your JD780A series.

2. To turn the auto center feature on or off, toggle the Auto Center soft key between On and Off
and select the option you want to set. Default setting is On. It automatically displays the center of
the fiber when viewing at high magnification.

Performing fiber inspection
Capturing fiber image
Procedure

1. Connect the fiber to be inspected to the tip of your microscope P5000i.
The live image of the fiber is displayed on the screen.
See the user manual of your fiber microscope for details on using the P5000i.

2. Focus the image by rotating the Focus Control on the P5000i until the image is in focus.
3. Toggle the Magnification soft key between Low and High and select the option you want to use.
You can also press the Magnification Control button on either side of the P5000i.

4. Press the Freeze soft key to capture the properly focused image.
The text “Capturing…” appears.

5. Optional. To save the captured image as a file (.png), complete the following steps:
a.

Tap the Save PNG soft key.
The Save window appears with the on-screen key.

b.

Type a file name in the File Name field.

c.

Select a folder where you want to save the file, if desired.

d.

Press the Save soft key.

6. Press the Live soft key to return to the live image screen or press the Quit soft key to exit.
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Measurement example
Figure 281 Captured fiber image

Testing a fiber
Procedure

1. Connect the fiber to be inspected to the tip of your microscope P5000i.
The live image of the fiber is displayed on the screen.
See the user manual of your fiber microscope for details on using the P5000i.

2. Focus the image by rotating the Focus Control on the P5000i until the image is in focus.
3. Toggle the Magnification soft key between Low and High and select the option you want to use.
You can also press the Magnification Control button on either side of the P5000i.

4. Press the Test soft key to start fiber analysis.
The text “Analyzing…” appears.

5. Once the test is completed, check the result displayed on the screen with the following
information:

–

Image overlay of the zone locations, defects, and scratches

–

PASS or FAIL result

–

Specific test result for each zone

6. To show or hide image overlays, press the Overlay soft key.
Each time this key is pressed, the selection changes.

7. Optional. To save the fiber inspection result with specific details as a report (.pdf), complete the
following steps:
a.

Tap the Save PDF soft key.
The Save window appears with the on-screen key.

b.

Type a file name in the File Name field.

c.

Select a folder where you want to save the file, if desired.

d.

Press the Save soft key.
The information input window appears.

e.

Type in information as required.
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f.

Tap the Apply button or press the Apply soft key to save and return to the previous state.

8. Press the Live soft key to return to the live image screen or press the Quit soft key to exit the
fiber inspection.

Measurement example
Figure 282 Analyzed fiber image and fiber inspection result

Figure 283 Fiber inspection report
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Appendix A – Product general information
JD785A/JD786A

JD788A

Supplemental Information

RF In
Connector
Impedance
Damage Level

Type-N female
50 Ω
>+33 dBm, >±50 V DC

Type-N female
50 Ω
>+33 dBm, >±50 V DC

Reflection/RF Out
Connector
Impedance
Damage Level

Type-N female
50 Ω
>+40 dBm, >±50 V DC

Type-N female
50 Ω
>+40 dBm, >±50 V DC

RF In
Connector
Impedance
Damage Level

Type-N female
50 Ω
>+25 dBm, >±50 V DC

N/A
N/A
N/A

Nominal
Nominal

SMA female
50 Ω

SMA female
50 Ω

Nominal

SMA female
50 Ω
10, 13, 15 MHz
-5 to +5 dBm

SMA female
50 Ω
10, 13, 15 MHz
-5 to +5 dBm

Type A, 1 port
Type B, 1 port

Type A, 1 port
Type B, 1 port

RJ45, 10/100 Base-T

RJ45, 10/100 Base-T

E1/T1

RJ45

N/A

Available in JD785A

GPIO

N/A

RJ45

Available in JD786A and JD788A

3.5 mm headphone
jack

3.5 mm headphone
jack

5.5 mm barrel
connector

5.5 mm barrel
connector

Speaker

Built-in speaker

Built-in speaker

Type

Resistive touch
screen
8”

Resistive touch
screen
8”

800 x 600

800 x 600

Inputs and Outputs

External Trigger, GPS
Connector
Impedance
External Ref
Connector
Impedance
Input Frequency
Input Range
USB
USB Host
USB Client
LAN

Audio Jack

External Power

Spectrum Analyzer
Nominal
Nominal
Cable and Antenna Analyzer
Nominal
Nominal
Cable and Antenna Analyzer

Nominal

Display

Size
Resolution
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JD785A/JD786A

JD788A

Supplemental Information

18 V DC
37 W

18 V DC
37 W

10.8 V, 7800 mA-h
> 3 hours (Typical)
2.5 hours (80 %)
5 hours (100 %)
0 to 25°C
(32 to 77°F)

10.8 V, 7800 mA-h
> 3 hours (Typical)
2.5 hours (80 %)
5 hours (100 %)
0 to 25°C
(32 to 77°F)

Lithium Ion
In balance mode
In case of a fully discharged
battery
The battery pack should be
stored in an environment with
low humidity. Extended
exposure to temperature above
45°C could degrade battery
performance and life.

Maximum 100 MB
Limited to the size of
USB flash drive

Maximum 100 MB
Limited to the size of
USB flash drive

Up to 3800 traces
Supports USB 2.0 compatible
memory devices

0 to 40°C
(32 to 104°F)
0 to 40°C
(32 to 104°F)
-10 to 55 °C
(14 to 131 °F)
95% RH
MIL-PRF-28800F Class
2
-30 to 71°C
(-22 to 160°F)

0 to 40°C
(32 to 104°F)
0 to 40°C
(32 to 104°F)
-10 to 55 °C
(14 to 131 °F)
95% RH
MIL-PRF-28800F Class
2
-30 to 71°C
(-22 to 160°F)

With no derating

IEC/EN 61326-1:2006
CISPR11:2009+A1:2010

IEC/EN 61326-1:2006
CISPR11:2009+A1:2010

Complies with European EMC

IEC/EN 61000-4-2

IEC/EN 61000-4-2

Power
External DC Input
Power Consumption

49 W maximum when charging
battery

Battery
Operating Time
Charge Time
Storage Temperature

Data Storage
Internal
External

Environmental
Operating Temperature
AC Power
Battery

Maximum Humidity
Shock and Vibration
Storage Temperature

At charging
At discharging
Non-condensing

With the battery pack removed

EMC

ESD

Size and Weight (Standard Configuration)
Weight <4.3 kg (9.5 lb.)
Size

<3.9 kg (8.6 lb.)

With battery

295 x 195 x 82 (mm)
11.6 x 7.7 x 3.2 (Inch)

295 x 195 x 82 (mm)
11.6 x 7.7 x 3.2 (Inch)

Approximately (W x H x D)

2 years

2 years

1 year

1 year

Warranty

Calibration Cycle
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Cable Type

Relative Propagation
Velocity (V¦)

Nominal Attenuation dB/m
@ 1000 MHz

FSJ1-50A
FSJ250
FSJ4-50B
HCC 12-50J
HCC 158-50J
HCC 300-50J
HCC 312-50J
HCC 78-50J
HF 4-1/8” Cu2Y
HF 5” Cu2Y
HF 6-1/8”Cu2Y
HJ4.5-50
HJ4-50
HJ5-50
HJ7-50A
LDF12-50
LDF4-50A
LDF5-50A
LDF6-50
LDFF7-50A
LMR100
LMR1200
LMR1700
LMR200
LMR240
LMR400
LMR500
LMR600
LMR900
RG142
RG17, 17A
RG174
RG178B
RG187, 188
RG213/U
RG214
RG223
RG55, 55A, 55B
RG58, 58B
RG58A, 58C
RG8, 8A, 10, 10A
RG9, 9A
HFSC-12D(1/2")
HFC-12D(1/2")
HFC-22D(7/8")
HFC-33D(1_1/4")
HFC-42D(1_5/8")
RFCX-12D(1/2")
RFCX-22D(7/8")
RFCX-33D(1_1/4")
RFCX-42D(1_5/8")
RFCL-22D(7/8")
RFCL-33D(1_1/4")
RFCL-42D(1_5/8")

0.84
0.83
0.81
0.915
0.95
0.96
0.96
0.915
0.97
0.96
0.97
0.92
0.914
0.916
0.921
0.88
0.88
0.89
0.89
0.88
0.8
0.88
0.89
0.83
0.84
0.85
0.86
0.87
0.87
0.69
0.659
0.66
0.69
0.69
0.66
0.659
0.659
0.659
0.659
0.659
0.659
0.659
0.81
0.88
0.88
0.88
0.87
0.88
0.88
0.88
0.87
0.88
0.88
0.87

0.197
0.134
0.119
0.092
0.023
0.014
0.013
0.042
0.01
0.007
0.006
0.054
0.087
0.042
0.023
0.022
0.077
0.043
0.032
0.027
0.792
0.044
0.033
0.344
0.262
0.135
0.109
0.087
0.056
0.443
0.18
0.984
1.509
1.017
0.292
0.292
0.165
0.541
1.574
0.787
0.262
0.289
0.112
0.072
0.041
0.0294
0.0243
0.088
0.049
0.038
0.028
0.044
0.034
0.0315
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Appendix C – Band, frequency & channel standard
Standard

Uplink
Start Freq
(MHz)

Stop Freq
(MHz)

Valid Channels

GSM
GSM 450
GSM 480
GSM 850
P-GSM 900

450.40
478.80
824.00
890.00

457.60
486.00
849.00
915.00

E-GSM 900

880.00

915.00

R-GSM 900

876.00

915.00

885.00
1710.00
1850.00

889.00
1785.00
1910.00

824.00

849.00

1850.00

1910.00

Band 2 (TACS)

872.0125

914.9875

Band 3 (JTACS)

887.0125

924.9875

Band 4 (KR PCS)

1750.00

1780.00

Band 5 (450)

411.675

483.480

Band 6 (2100)
Band 7 (700)
Band 8 (1800)
Band 9 (900)

1920.00
776.00
1710.00
880.00

1980.00
794.00
1784.95
914.95

Band 10 (2nd 800)

806.000

900.975

1920.0

1980.0

1850.0

1910.0

1710.0

1780.0

1710.0

1775.0

824.0

849.0

830.0

840.0

2500.0

2570.0

880.0
1749.9

915.0
1784.9

1710.0

1770.0

1427.9

1447.9

699.0

716.0

777.0

787.0

788.0

798.0

830.0

845.0

832.0

862.0

R-GSM 900 (China)
DCS 1800
PCS 1900
CDMA
Band 0 (800)
Band 1 (NA PCS)

WCDMA
Band Global
Band 1 (2100-General)
Band 2 (1900-General)
Band 2 (1900-Additional)
Band 3 (1800-General)
Band 4 (1700-General)
Band 4 (1700-Additional)
Band 5 (850-General)
Band 5 (850-Additional)
Band 6 (800-General)
Band 6 (800-Additional)
Band 7 (2600-General)
Band 7 (2600-Additional)
Band 8 (900-General)
Band 9 (1700-General)
Band 10 (1700-General)
Band 10 (1700-Additional)
Band 11 (1500-General)
Band 12 (700-General)
Band 12 (700-Additional)
Band 13 (700-General)
Band 13 (700-Additional)
Band 14 (700-General)
Band 14 (700-Additional)
Band 19 (800-General)
Band 19 (800-Additional)
Band 20 (800-General)

259≤n≤293
306≤n≤340
128≤n≤251
1≤n≤124
0≤n≤124
975≤n≤1023
0≤n≤124
955≤n≤1023
999≤n≤1019
512≤n≤885
512≤n≤810
1≤n≤799
991≤n≤1023
0≤n≤1199
0≤n≤1000
1329≤n≤2047
1≤n≤799
801≤n≤1039
1041≤n≤1199
1201≤n≤1600
0≤n≤599
1≤n≤300
539≤n≤871
1039≤n≤1473
1792≤n≤2016
0≤n≤1199
0≤n≤359
0≤n≤1499
0≤n≤699
0≤n≤719
720≤n≤919

9612≤n≤9888
9262≤n≤9538
12≤n≤287
937≤n≤1288
1312≤n≤1513
1662≤n≤1862
4132≤n≤4233
782≤n≤862
4162≤n≤4188
812≤n≤837
2012≤n≤2338
2362≤n≤2687
2712≤n≤2863
8762≤n≤8912
2887≤n≤3163
3187≤n≤3462
3487≤n≤3562
3617≤n≤3678
3707≤n≤3767
3792≤n≤3818
3842≤n≤3867
3892≤n≤3918
3942≤n≤3967
312≤n≤363
387≤n≤437
4287≤n≤4413
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Downlink
Start Freq
(MHz)

Stop Freq
(MHz)

460.40
488.80
869.00
935.00

467.60
496.00
894.00
960.00

925.00

960.00

921.00

960.00

930.00
1805.00
1930.00

934.00
1880.00
1990.00

869.00

894.00

1930.00

1990.00

917.0125

959.9875

832.0125

869.9875

1840.00

1870.00

421.6750

493.4800

2100.00
746.00
1805.00
925.00

2170.00
764.00
1879.95
959.95

851.000

939.975

2110.0

2170.0

1930.0

1990.0

1805.0

1880.0

2110.0

2155.0

869.0

894.0

875.0

885.0

2620.0

2690.0

925.0
1844.9

960.0
1879.9

2110.0

2170.0

1475.9

1495.9

729.0

746.0

746.0

756.0

758.0

768.0

875.0

890.0

791.0

821.0

Valid Channels
259≤n≤293
306≤n≤340
128≤n≤251
1≤n≤124
0≤n≤124
975≤n≤1023
0≤n≤124
955≤n≤1023
999≤n≤1019
512≤n≤885
512≤n≤810
1≤n≤799
991≤n≤1023
0≤n≤1199
0≤n≤1000
1329≤n≤2047
1≤n≤799
801≤n≤1039
1041≤n≤1199
1201≤n≤1600
0≤n≤599
1≤n≤300
539≤n≤871
1039≤n≤1473
1792≤n≤2016
0≤n≤1199
0≤n≤359
0≤n≤1499
0≤n≤699
0≤n≤719
720≤n≤919

10562≤n≤10838
9662≤n≤9938
412≤n≤687
1162≤n≤1513
1537≤n≤1738
1887≤n≤2087
4357≤n≤4458
1007≤n≤1087
4387≤n≤4413
1037≤n≤1062
2237≤n≤2563
2587≤n≤2912
2937≤n≤3088
9237≤n≤9387
3112≤n≤3388
3412≤n≤3687
3712≤n≤3787
3842≤n≤3903
3932≤n≤3992
4017≤n≤4043
4067≤n≤4092
4117≤n≤4143
4167≤n≤4192
712≤n≤763
787≤n≤837
4512≤n≤4638
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Band 21 (1500-General)
Band 22 (3500-General)
Band 25 (1900-General)
Band 25 (1900-Additional)
Band 26 (800-General)
Band 26 (800-Additional)
LTE - FDD
Band Global
Band 1 (2100)
Band 2 (1900)
Band 3 (1800)
Band 4 (1700)
Band 5 (850)
Band 7 (2600)
Band 8 (900)
Band 9 (1700)
Band 10 (1700)
Band 11 (1500)
Band 12 (700)
Band 13 (700)
Band 14 (700)
Band 17 (700)
Band 18 (800)
Band 19 (800)
Band 20 (800)
Band 21 (1500)
Band 22 (3500)
Band 23 (2100)
Band 24 (1500)
Band 25 (1900)
Band 26 (800)
LTE - TDD
Band Global
Band 33 (1900)
Band 34 (2100)
Band 35 (1850)
Band 36 (1930)
Band 37 (1910)
Band 38 (2570)
Band 39 (1880)
Band 40 (2300)
Band 41 (2496)
Band 42 (3400)
Band 43 (3600)
TD-SCDMA
FBN 0
FBN 1
FBN 2
FBN 3
FBN 4
FBN 5
FBN 6
FBN 7
FBN 8
WiMAX
ProfR1 (1.25 2150)
ProfR2 (1.25 2305)
ProfR3 (1.25 2361)
ProfR4 (1.25 2500)
ProfR5 (1.25 3400)
ProfR6 (3.5 2598)
ProfR7 (3.5 3461)
ProfR8 (3.5 3551)
ProfR9 (3.5 3651)
ProfR10 (3.5 3751)
ProfR11 (7 2600)
ProfR12 (7 3463)
ProfR13 (7 3553)
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1447.9
3410.0

1462.9
3490.0

462≤n≤512
4437≤n≤4813
4887≤n≤5188
5212≤n≤5512
5537≤n≤5688
5712≤n≤5862

1495.9
3510.0

1510.9
3590.0

1850.0

1915.0

814.0

849.0

1920.0
1850.0
1710.0
1710.0
824.0
2500.0
880.0
1749.9
1710.0
1427.9
699.0
777.0
788.0
704.0
815.0
830.0
832.0
1447.9
3410.0
2000.0
1626.5
1850.0
814.0

1930.0

1995.0

859.0

894.0

1980.0
1910.0
1785.0
1755.0
849.0
2570.0
915.0
1784.9
1770.0
1447.9
716.0
787.0
798.0
716.0
830.0
845.0
862.0
1462.9
3490.0
2020.0
1660.5
1915.0
849.0

18000≤n≤18599
18600≤n≤19199
19200≤n≤19949
19950≤n≤20399
20400≤n≤20649
20750≤n≤21449
21450≤n≤21799
21800≤n≤22149
22150≤n≤22749
22750≤n≤22949
23010≤n≤23179
23180≤n≤23279
23280≤n≤23379
23730≤n≤23849
23850≤n≤23999
24000≤n≤24149
24150≤n≤24449
24450≤n≤24599
24600≤n≤25399
25500≤n≤25699
25700≤n≤26039
26040≤n≤26689
26690≤n≤27039

2110.0
1930.0
1805.0
2110.0
869.0
2620.0
925.0
1844.9
2110.0
1475.9
729.0
746.0
758.0
734.0
860.0
875.0
791.0
1495.9
3510.0
2180.0
1525.0
1930.0
859.0

2170.0
1990.0
1880.0
2155.0
894.0
2690.0
960.0
1879.9
2170.0
1495.9
746.0
756.0
768.0
746.0
875.0
890.0
821.0
1510.9
3590.0
2200.0
1559.0
1995.0
894.0

0≤n≤599
600≤n≤1199
1200≤n≤1949
1950≤n≤2399
2400≤n≤2649
2750≤n≤3449
3450≤n≤3799
3800≤n≤4149
4150≤n≤4749
4750≤n≤4949
5010≤n≤5179
5180≤n≤5279
5280≤n≤5379
5730≤n≤5849
5850≤n≤5999
6000≤n≤6149
6150≤n≤6449
6450≤n≤6599
6600≤n≤7399
7500≤n≤7699
7700≤n≤8039
8040≤n≤8689
8690≤n≤9039

1900.0
2010.0
1850.0
1930.0
1910.0
2570.0
1880.0
2300.0
2496.0
3400.0
3600.0

1920.0
2025.0
1910.0
1990.0
1930.0
2620.0
1920.0
2400.0
2690.0
3600.0
3800.0

36000≤n≤36199
36200≤n≤36349
36350≤n≤36949
36950≤n≤37549
37550≤n≤37749
37750≤n≤38249
38250≤n≤38649
38650≤n≤39649
39650≤n≤41589
41590≤n≤43589
43590≤n≤45589

1785.0
1900.0
1920.0
1920.0
1980.0
2010.0
2100.0
2100.0
2170.0

1805.0
1920.0
1980.0
1980.0
2010.0
2025.0
2170.0
2170.0
2220.0

0≤n≤92
0≤n≤92
0≤n≤255
0≤n≤36
0≤n≤142
0≤n≤67
0≤n≤255
0≤n≤36
0≤n≤242

2150.625
2305.625
2361.875
2500.625
3400.625
2524.750
3411.750
3501.750
3601.750
3701.750
2526.500
2413.500
3503.500

2159.375
2320.625
2375.625
2688.125
3700.625
2591.250
3443.250
3598.000
3698.000
3798.000
2589.500
3441.500
3596.250

0≤n≤7
0≤n≤12
13≤n≤24
0≤n≤150
0≤n≤240
0≤n≤38
0≤n≤18
0≤n≤55
0≤n≤55
0≤n≤55
0≤n≤36
0≤n≤16
0≤n≤53

2598.750
3461.750
3551.750
3651.750
3751.750
2600.50
3463.50
3553.50

2665.250
3493.250
3648.000
3748.000
3848.000
2663.50
3491.50
3646.25

0≤n≤38
0≤n≤18
0≤n≤55
0≤n≤55
0≤n≤55
0≤n≤36
0≤n≤16
0≤n≤53
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4662≤n≤5038
5112≤n≤5413
5437≤n≤5737
5762≤n≤5913
5937≤n≤6087
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ProfR14 (7 3653)
ProfR15 (7 3753)
ProfR26 (10 5275)
ProfR27 (10 5740)
ProfR28 (10 5735)
ProfR29 (8.75 2304)

3603.500
3703.500
5275.000
5740.000
5735.000
2304.375

3696.250
3796.250
5335.000
5830.000
5845.000
2395.625

0≤n≤53
0≤n≤53
55≤n≤67
148≤n≤166
147≤n≤169
0≤n≤730

Appendix

3653.50
3753.50

3746.25
3846.25

0≤n≤53
0≤n≤53
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Appendix D – VSWR-Return loss conversion table
This information is for the Cable and Antenna Analyzer mode of the JD785A Base Station Analyzer
and the JD786A RF Analyzer.


Return Loss=20log10(VSWR+1/VSWR-1) (dB)



VSWR=(10

R.L./20

+1/10

R.L./20

-1)

VSWR

Return
Loss
(dB)

Trans.
Loss
(dB)

Volt.
Refl
Coeff

Power
Trans
(%)

Power
Refl
(%)

VSWR

Return
Loss
(dB)

Trans.
Loss
(dB)

Volt.
Refl
Coeff

Power
Trans
(%)

Power
Refl
(%)

1.00
1.01
1.02
1.03
1.04
1.05
1.06
1.07
1.08
1.09
1.10
1.11
1.12
1.13
1.14
1.15
1.16
1.17
1.18
1.19
1.20
1.21
1.22
1.23
1.24
1.25
1.26
1.27
1.28
1.29
1.30
1.32
1.34
1.36
1.38
1.40
1.42
1.44
1.46
1.48
1.50
1.52
1.54
1.56
1.58
1.60
1.62

-46.1
40.1
36.6
34.2
32.3
30.7
29.4
28.3
27.3
26.4
25.7
24.9
24.3
23.7
23.1
22.6
22.1
21.7
21.2
20.8
20.4
20.1
19.7
19.4
19.1
18.8
18.5
18.2
17.9
17.7
17.2
16.8
16.3
15.9
15.8
15.2
14.9
14.6
14.3
14.0
13.7
13.4
13.2
13.0
12.7
12.5

0.000
0.000
0.000
0.001
0.002
0.003
0.004
0.005
0.006
0.008
0.010
0.012
0.014
0.016
0.019
0.021
0.024
0.027
0.030
0.033
0.036
0.039
0.043
0.046
0.050
0.054
0.058
0.062
0.066
0.070
0.075
0.083
0.093
0.102
0.112
0.122
0.133
0.144
0.155
0.166
0.177
0.189
0.201
0.213
0.225
0.238
0.250

0.00
0.00
0.01
0.01
0.02
0.02
0.03
0.03
0.04
0.04
0.05
0.05
0.06
0.06
0.07
0.07
0.07
0.08
0.08
0.09
0.09
0.10
0.10
0.10
0.11
0.11
0.12
0.12
0.12
0.13
0.13
0.14
0.15
0.15
0.16
0.17
0.17
0.18
0.19
0.19
0.20
0.21
0.21
0.22
0.22
0.23
0.24

100.0
100.0
100.0
100.0
100.0
99.9
99.9
99.9
99.9
99.8
99.8
99.7
99.7
99.6
99.6
99.5
99.5
99.4
99.3
99.2
99.2
99.1
99.0
98.9
98.9
98.8
98.7
98.6
98.5
98.4
98.3
98.1
97.9
97.7
97.5
97.2
97.0
96.7
96.5
96.3
96.0
95.7
95.5
95.2
94.9
94.7
94.4

0.0
0.0
0.0
0.0
0.0
0.1
0.1
0.1
0.1
0.2
0.2
0.3
0.3
0.4
0.4
0.5
0.5
0.6
0.7
0.8
0.8
0.9
1.0
1.1
1.1
1.2
1.3
1.4
1.5
1.6
1.7
1.9
2.1
2.3
2.5
2.8
3.0
3.3
3.5
3.7
4.0
4.3
4.5
4.8
5.1
5.3
5.6

1.64
1.66
1.68
1.70
1.72
1.74
1.76
1.78
1.80
1.82
1.84
1.86
1.88
1.90
1.92
1.94
1.96
1.98
2.00
2.50
3.00
3.50
4.00
4.50
5.00
5.50
6.00
6.50
7.00
7.50
8.00
8.50
9.00
9.50
10.00
11.00
12.00
13.00
14.00
15.00
16.00
17.00
18.00
19.00
20.00
25.00
30.00

12.3
12.1
11.9
11.7
11.5
11.4
11.2
11.0
10.9
10.7
10.6
10.4
10.3
10.2
10.0
9.9
9.8
9.7
9.5
7.4
6.0
5.1
4.4
3.9
3.5
3.2
2.9
2.7
2.5
2.3
2.2
2.1
1.9
1.8
1.7
1.6
1.5
1.3
1.2
1.2
1.1
1.0
1.0
0.9
0.9
0.7
0.6

0.263
0.276
0.289
0.302
0.315
0.329
0.342
0.356
0.370
0.384
0.398
0.412
0.426
0.440
0.454
0.468
0.483
0.497
0.512
0.881
1.249
1.603
1.938
2.255
2.553
2.834
3.100
3.351
3.590
3.817
4.033
4.240
4.437
4.626
4.807
5.149
5.466
5.762
6.040
6.301
6.547
6.780
7.002
7.212
7.413
8.299
9.035

0.24
0.25
0.25
0.26
0.26
0.27
0.28
0.28
0.29
0.29
0.30
0.30
0.31
0.31
0.32
0.32
0.32
0.33
0.33
0.43
0.50
0.56
0.60
0.64
0.67
0.69
0.71
0.73
0.75
0.76
0.78
0.79
0.80
0.81
0.82
0.83
0.85
0.86
0.87
0.88
0.88
0.89
0.89
0.90
0.90
0.92
0.94

94.1
93.8
93.6
93.3
93.0
92.7
92.4
92.1
91.8
91.5
91.3
91.0
90.7
90.4
90.1
89.8
89.5
89.2
88.9
81.6
75.0
69.1
64.0
59.5
55.6
52.1
49.0
46.2
43.7
41.5
39.5
37.7
36.0
34.5
33.1
30.6
28.4
26.5
24.9
23.4
22.1
21.0
19.9
19.0
18.1
14.8
12.5

5.9
6.2
6.4
6.7
7.0
7.3
7.6
7.9
8.2
8.5
8.7
9.0
9.3
9.6
9.9
10.2
10.5
10.8
11.1
18.4
25.0
30.9
36.0
40.5
44.4
47.9
51.0
53.8
56.3
58.5
60.5
62.3
64.0
65.5
66.9
69.4
71.6
73.5
75.1
76.6
77.9
79.0
80.1
81.0
81.9
85.2
87.5
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Appendix E – Cyclic prefix table
This information is for the LTE – FDD Signal Analyzer mode and the LTE – TDD Signal Analyzer mode
of the JD785A Base Station Analyzer and the JD788A Signal Analyzer. Following table shows OFDM
parameter details by different bandwidth.

Cyclic Prefix Length
Bandwidth

Configuration (Downlink)

Normal CP
20 MHz

Extended CP

Normal CP
15 MHz

Extended CP

Normal CP
10 MHz

Extended CP

Normal CP
5 MHz

Extended CP

Normal CP
3 MHz

Extended CP

Normal CP
1.4 MHz

Extended CP

∆f=15 kHz
∆f=15 kHz
∆f=7.5 kHz
∆f=15 kHz
∆f=15 kHz
∆f=7.5 kHz
∆f=15 kHz
∆f=15 kHz
∆f=7.5 kHz
∆f=15 kHz
∆f=15 kHz
∆f=7.5 kHz
∆f=15 kHz
∆f=15 kHz
∆f=7.5 kHz
∆f=15 kHz

TS

µs

l =0
l =1,2,..,6
512 for l =0,1,…,5
1024 for l =0,1,2
120 for l =0
108 for l =1,2,..,6
384 for l =0,1,…,5
768 for l =0,1,2
80 for l =0
72 for l =1,2,..,6
256 for l =0,1,…,5
512 for l =0,1,2

5.208
4.6875

l =0
36 for l =1,2,..,6
128 for l =0,1,…,5
248 for l =0,1,2
20 for l =0
18 for l =1,2,..,6
64 for l =0,1,…,5
128 for l =0,1,2
10 for l =0
9 for l =1,2,..,6

5.208
4.6875

160 for
144 for

40 for

16.667
33.333
5.208
4.6875
16.667
33.333
5.208
4.6875
16.667
33.333

16.667
33.333
5.208
4.6875
16.667
33.333
5.208
4.6875

∆f=15 kHz

32 for

l =0,1,…,5

16.667

∆f=7.5 kHz

64 for

l =0,1,2

33.333
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Appendix F – Motorola CDMA/EV-DO LMF
Motorola’s CDMA/EV-DO base stations (BTS) are optimized with the assistance of Local Maintenance
Facility (LMF), a Motorola’s software tool that interfaces with the cell site and the instrument. The
optimization process identifies the accumulated loss (or gain) for all receiving and transmitting paths at
the cell site and stores that value in the system’s database.

Using JD780A series LMF interface
An emulation interface to LMF has been implemented in JDSU’s base station analyzer (JD785A) in
order to perform BTS optimization procedures. The scope of this emulation is to do maintenance tests
of TX Calibration and TX Audit required in routine maintenance practices with or without the use of an
external power sensor. Using the external power sensor, you can get highly accurate measurement
results.

Setting up for a LMF test
Procedure

1. To connect your instrument both with BTS and PC, do one of the following:
–

Internal power sensor: Connect the Motorola CDMA/EV-DO BTS with the Spectrum
Analyzer RF In 50 Ω port of JD785A and connect the WinLMF running PC with JD785A via
a hub as illustrated in the Figure 284.

–

External power sensor: Connect an external power sensor to the USB Host port of JD785A
and to the BTS and connect the WinLMF running PC with JD785A via a hub as illustrated in
the Figure 285.

Figure 284 Using internal power sensor
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Figure 285 Using external power sensor

Performing a LMF test
Procedure

1. Press the SYSTEM hot key.
2. To set the IP address, complete the following steps:
a.

Select System Configuration > Ethernet Config.

b.

Toggle the Mode soft key and select Static.

c.

Press the Field > IP Address soft key.

d.

Set the IP address as “192.167.10.1”.

3. Select Remote Interface > LAN > LMF.
4. To set up the LMF settings, complete the following steps:
a.

Press the LMF Settings soft key.

b.

Select the power measurement and BTS option from the following choices:

–

External PM 800 MHz Band for external measurement on cellular basestation

–

External PM 1900 MHz Band for external meausrement on PCS basestation

–

Internal PM 800 MHz Band for internal measurement on celluar basestation

–

Internal PM 1900 MHz Band for internal measurement on PCS basestation

5. To select the measurement mode, complete the following steps:
a.

Press the MODE hard key.

b.

Press the Power Meter soft key.

c.

Select Internal RF Power Meter or External RF Power Meter depending on your LMF
settings. The measurement result is displayed on the screen.
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Appendix G – Bluetooth connection
JD780A series’ Bluetooth mode is used for communication between the instrument and your computer
with JDRemote or a storage device in order to use the following services if needed.


Bluetooth Personal Area Network (PAN) profile service for JDRemote.



Bluetooth File Transfer Profile (FTP) or Object Push Profile (OPP) service for file transfer from
the instrument to a Bluetooth storage device.

The Bluetooth Connectivity option includes a pair of Bluetooth USB Parani-UD100 Adapters and 5 dBi
Dipole Antennas as well as the BlueSoleil application software.

Installing and Setting up Bluetooth software
The BlueSoleil application must be installed in your computer prior to making a Bluetooth connection.
After installing the software, you must disable DHCP Server option in order to use the PAN service
properly.
Procedure

1. Insert the provided CD-ROM into your computer and install the software as instructed.
The BlueSoleil Space shortcut icon appears on the desktop.
NOTE
For more information on installation, refer to the Quick Start Guide or the User Guide
provided with the adapter.

2. Double-click the BlueSoleil Space shortcut icon on your computer desktop to launch the
application.
The BlueSoleil program window appears.

3. Right-click the My Device icon (the orange ball) in the center of the window, and then click
Properties > Services tab.
The My Device Properties window appears.

4. Select the Bluetooth Personal Area Network from the list, and then click the Properties button.
The Bluetooth Personal Area Network Properties window appears.

5. Click the Options tab, and then uncheck the Enable DHCP Server option.
NOTE
As the Enable DHCP Server option is checked by default, you must disable this option.

6. Click the OK button.
The Bluetooth Personal Area Network Properties window dismisses.

7. Click the OK button.
The My Device Properties window dismisses.

Making Bluetooth connection
The JD780A series detects a connected Parani-UD100 USB Bluetooth Adapter automatically.
Procedure

1. Connect the 5 dBi Dipole Antenna to the Parani-UD100 Bluetooth USB Adapter: one for the
computer and the other for JD780A series.
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2. Plug in the Bluetooth adapters to the USB port of the computer and the instrument.
The instrument detects the connected adapter and turns the Bluetooth mode on automatically.
The Bluetooth icon appears in the status bar at the top of the instrument screen.

3. Double-click the BlueSoleil Space icon on the computer desktop to launch the application if not
opened already.
The BlueSoleil program window appears.

4. Double-click the My Device icon (orange ball) in the center of the application window to search
the JD780A series.
You can view an added icon around the orange ball labeled with the detected JD780A series’ BD
address or model and serial numbers.

5. Right-click the device icon for the JD780A series, and then click the Pair.
The Bluetooth Passkey window appears.

6. Enter 0000 in the Passkey box, and then click the OK button.
The word “Paired” appears on the window. The instrument also turns the Bluetooth Mode on
automatically and displays the paired device and service information on the screen.

7. Double-click the device icon for the JD780A series to search services.
8. Right-click the icon for the JD780A series, and then select either the Connect Bluetooth
Personal Area Network or the Connect Bluetooth File Transfer.
NOTE
Select one of these services as needed. If the Connect Bluetooth Personal Area Network
is selected, a fixed IP address (192.168.10.10) is assigned for JD780A series and this
address must be typed into the TCP/IP setting on JDViewer or JDRemote. See “Setting
up communication in application” on page 549 for more information.

Setting up communication in application
If the Connect Bluetooth Personal Area Network service is selected on BlueSoleil, you need to
configure communication setting on the application JDViewer or JDRemote by entering the fixed IP
address for the instrument.
JDViewer setup
Procedure

1. Launch the JDViewer application.
2. Go to Settings > Communication.
The Settings dialog box appears.

3. Click the drop-down list in the Instrument pane, and then select the instrument series to be
communicated.

4. In the Connection Method pane, select the TCP/IP, and then enter 192.168.10.10 without dots.
5. Click OK to finish the communication setup.
6. Go to Load > Connect to make a connection between the instrument and JDViewer.
JD780A series and JDViewer become ready for communication.

JDRemote setup
Procedure

1. Launch the JDRemote application.
The Select Model dialog box appears.
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2. Select the 740A, 780A Series, and then click the OK button.
3. Right-click on the JDRemote window, and then click the Communication.
The Communication dialog box appears.

4. Select the TCP/IP, and then enter 192.168.10.10 without dots.
5. Click OK to finish the communication setup.
6. Right-click on the JDRemote window, and then click the Connect.
This enables communication between the instrument and JDRemote.

7. Right-click on the JDRemote window, and then click the Start.
JD780A series and JDRemote become ready for communication.

8. Optional. To adjust the image quality, complete the following steps:
a.

Right-click on the JDRemote.

b.

Click the Quality.

c.

Select the image quality option among High, Medium, or Low.
You can improve refresh rate, if experiencing low-quality signal, by adjusting the image
quality in JDRemote.

Turning Bluetooth mode on/off manually
JD780A series turns the Bluetooth Mode on automatically if connected. You can also turn it on and off
manually.
Procedure

1. Press the SYSTEM hot key.
2. Press the System Configuration > Remote Interface > Bluetooth soft key.
The Bluetooth screen appears with the device information.

3. Toggle the Bluetooth soft key between On and Off to turn it on and off.
Connecting or disconnecting the adapter also turns the mode on or off automatically.
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Appendix H – Device driver installation
JD780A series can be controlled from the application software JDViewer or JDRemote installed on
your computer. You must install driver software for the instrument on to the computer if USB Client
connection is used for communication.
Procedure

1. Go to Control Panel > System > Device Manager.
The Device Manager window appears.

2. Right-click the Unknown Device under the Other Devices, and then click the Update Driver
Software.
The Update Driver Software – Unknown Device window appears as shown in the Figure 286
below.

3. Select the Browse my computer for driver software, and then click the Browse button to
search for the location where the driver software is.
The Browse For Folder window appears.

4. Search for the JDRemote folder, and then select the driver folder for the installed OS.
For example, OSDisk (C:) > Program Files (x86) > JDRemote > Driver > Win7 > 64bit.

5. Click the OK button.
The Browse For Folder window dismisses.

6. Click the Next button to start installation.
If the Windows Security window appears, select the Install this driver software anyway.
Installing driver software starts.

7. Click the Close button at the end of the installation.
Figure 286 Device manager screen
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Appendix I – Ordering information
JD785A Base Station Analyzer
JD785A
9 kHz to 8 GHz
5 MHz to 6 GHz
10 MHz to 8 GHz

Spectrum Analyzer
1
Cable and Antenna Analyzer
RF Power Meter

Internal mode

Options
NOTE: Upgrade options for the JD785A use the designation JD785AU before the respective last three-digit
option number.
JD785A001
JD785A002
JD785A003
JD785A004
JD785A005
JD785A006
JD785A010
JD785A011
JD785A012
JD785A020
JD785A021
JD785A022
JD785A023
JD785A025
JD785A026
JD785A028
JD785A029
JD785A030
JD785A031
JD785A040
JD785A041
JD785A042
JD785A043
JD785A045
JD785A046
JD785A048
JD785A049
Standard Accessories
G710550326
G710550335
GC73050515
GC72450518
G710550325
G710550323
G710550316
JD780A361

2

2-Port Transmission Measurements
Bias Tee
CW Signal Generator
3
E1 Analyzer
3
T1 Analyzer
Bluetooth Connectivity
GPS Receiver and Antenna
4, 5
Interference Analyzer
Channel Scanner
cdmaOne/cdma2000 Signal Analyzer
EV-DO Signal Analyzer
GSM/GPRS/EDGE Signal Analyzer
WCDMA/HSPA+ Signal Analyzer
TD-SCDMA Signal Analyzer
Mobile WiMAX Signal Analyzer
LTE-FDD Signal Analyzer
LTE-TDD Signal Analyzer
LTE Advanced-FDD Signal Analyzer
LTE Advanced-TDD Signal Analyzer
5
cdmaOne/cdma2000 OTA Analyzer
5
EV-DO OTA Analyzer
5
GSM/GPRS/EDGE OTA Analyzer
5
WCDMA/HSPA+ OTA Analyzer
5
TD-SCDMA OTA Analyzer
5
Mobile WiMAX OTA Analyzer
5
LTE-FDD OTA Analyzer
5
LTE-TDD OTA Analyzer

(Requires option 01)

(Requires option 20)

(Requires option 28)
(Requires option 29)
(Requires option 10)
(Requires option 10)
(Requires option 10)
(Requires option 10)
(Requires option 10)
(Requires option 10)
(Requires option 10)
(Requires option 10)

6

AC/DC Power Adapter
6
Cross LAN Cable (1.5 m)
6
USB A to B Cable (1.8 m)
6
> 1 G Byte USB Memory
6
Rechargeable Lithium Ion Battery
6
Automotive Cigarette Lighter 12 V DC Adapter
6
Stylus Pen
JD780A Series User’s Manual and Application Software – CD
1

Requires Calibration Kit
Requires Dual Port Calibration Kit
3
Requires Test Cable
4
Highly recommended adding JD785A010
5
Highly recommended adding G70005035x and/or G70005036x
6
Standard accessories can be purchased separately.
2
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JD786A RF Analyzer
JD786A
9 kHz to 8 GHz
5 MHz to 6 GHz
10 MHz to 8 GHz

Spectrum Analyzer
1
Cable and Antenna Analyzer
RF Power Meter

Internal mode

Options
NOTE: Upgrade options for the JD786A use the designation JD786AU before the respective last three-digit
option number.
JD786A001
JD786A002
JD786A003
JD786A010
JD786A011
JD786A012
Standard Accessories
G710550326
G710550335
GC73050515
GC72450518
G710550325
G710550323
G710550316
JD780A361

2

2-Port Transmission Measurements
Bias Tee
CW Signal Generator
GPS Receiver and Antenna
3,4
Interference Analyzer
Channel Scanner

(Requires option 01)

5

AC/DC Power Adapter
5
Cross LAN Cable (1.5 m)
5
USB A to B Cable (1.8 m)
5
> 1 G Byte USB Memory
5
Rechargeable Lithium Ion Battery
5
Automotive Cigarette Lighter 12 V DC Adapter
5
Stylus Pen
JD780A Series User’s Manual and Application Software – CD
1

Requires Calibration Kit
Requires Dual port Calibration Kit
3
Highly recommended adding JD786A010
4
Highly recommended adding G70005035x and/or G70005036x
5
Standard accessories can be purchased separately.
2
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JD788A Signal Analyzer
JD788A
9 kHz to 8 GHz
10 MHz to 8 GHz

Spectrum Analyzer
RF Power Meter

Internal mode

Options
NOTE: Upgrade options for the JD788A use the designation JD788AU before the respective last three-digit
option number.
JD785A001
JD785A003
JD788A006
JD788A009
JD788A010
JD788A011
JD788A012
JD788A020
JD788A021
JD788A022
JD788A023
JD788A025
JD788A026
JD788A028
JD788A029
JD788A030
JD788A031
JD788A040
JD788A041
JD788A042
JD788A043
JD788A045
JD788A046
JD788A048
JD788A049
Standard Accessories
G710550326
G710550335
GC73050515
GC72450518
G710550325
G710550323
G710550316
JD780A361

1

2-Port Transmission Measurements
CW Signal Generator
Bluetooth Connectivity
20 MHz Demodulation Hardware
GPS Receiver and Antenna
2,3
Interference Analyzer
Channel Scanner
cdmaOne/cdma2000 Signal Analyzer
EV-DO Signal Analyzer
GSM/GPRS/EDGE Signal Analyzer
WCDMA/HSPA+ Signal Analyzer
TD-SCDMA Signal Analyzer
Mobile WiMAX Signal Analyzer
LTE-FDD Signal Analyzer
LTE-TDD Signal Analyzer
LTE Advanced-FDD Signal Analyzer
LTE Advanced-TDD Signal Analyzer
3
cdmaOne/cdma2000 OTA Analyzer
3
EV-DO OTA Analyzer
3
GSM/GPRS/EDGE OTA Analyzer
3
WCDMA/HSPA+ OTA Analyzer
3
TD-SCDMA OTA Analyzer
3
Mobile WiMAX OTA Analyzer
3
LTE-FDD OTA Analyzer
3
LTE-TDD OTA Analyzer

(Requires option 9)
(Requires option 9 and 20)
(Requires option 9)
(Requires option 9)
(Requires option9)
(Requires option 9)
(Requires option 9)
(Requires option 9)
(Requires options 9 and 28)
(Requires options 9 and 29)
(Requires options 9 and 10)
(Requires options 9 and 10)
(Requires options 9 and 10)
(Requires options 9 and 10)
(Requires options 9 and 10)
(Requires options 9 and 10)
(Requires options 9 and 10)
(Requires options 9 and 10)

4

AC/DC Power Adapter
4
Cross LAN Cable (1.5 m)
4
USB A to B Cable (1.8 m)
4
> 1 G Byte USB Memory
4
Rechargeable Lithium Ion Battery
4
Automotive Cigarette Lighter 12 V DC Adapter
4
Stylus Pen
JD780A Series User’s Manual and Application Software – CD
1

Requires Dual Port Calibration Kit
Highly recommended adding JD788A010
3
Highly recommended adding G70005035x and/or G70005036x
4
Standard accessories can be purchased separately.
2
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JD780A Series Common Options
Optional RF Power Sensors
JD731B
Directional Power Sensor (peak and average power)
Frequency: 300 MHz to 3.8 GHz
Power: Average 0.15 to 150 W, Peak 4 to 400 W
JD733A
Directional Power Sensor (peak and average power)
Frequency: 150 MHz to 3.5 GHz
Power: Average/Peak 0.1 to 50 W
JD732B
Terminating Power Sensor (average power)
Frequency: 20 MHz to 3.8 GHz
Power: -30 to +20 dBm
JD734B
Terminating Power Sensor (peak power)
Frequency: 20 MHz to 3.8 GHz
Power: -30 to +20 dBm
JD736B
Terminating Power Sensor (peak and average power)
Frequency: 20 MHz to 3.8 GHz
Power: -30 to +20 dBm

Optional Optical Power Sensors
MP-60A
USB Optical Power Meter, with software, 2.5 mm and 1.25 mm interfaces,
30" USB extender, carrying pouch
MP-80A
USB Optical Power Meter-High Power, with software, 2.5 mm and 1.25 mm interfaces,
30" USB extender, carrying pouch

Optional Calibration Kits
JD72450509
Y - Calibration Kit, Type-N(m), DC to 6 GHz, 50 
JD71050507
Dual Port Type-N Calibration Kit, 50 
- Y - Calibration Kit, Type-N(m), DC to 6 GHz, 50 
- Two Adapters Type-N(f) to Type-N(f), DC to 6 GHz, 50 
- Two 1 m RF Test Cables, Type-N(m) to Type-N(m), DC to 18 GHz, 50 

Optional Fiber Microscope Kits
FBP-SD101
FBP-P5000i Digital Probe, FiberChekPRO SW, Case, and Tips (FBPT-SC, FBPT-LC, FBPTU25M, FBPT-U12M)
FBP-MTS-101
FBP-P5000i Digital Probe, FiberChekPRO SW, Case, and Tips (FBPT-SC, FBPT-SC/APC,
FBPT-FC, FBPT-LC, FBPT-U25M, FBPT-U25MA, FBPT-U12M)
FIT-SD103
FBP-P5000i Digital Probe, MP-60 USB Power Meter, FiberChekPRO SW, Case, Tips and
Adapters (FBPT-SC, FBPT-LC, FBPT-U25M, FBPT-U12M)
FIT-SD103-C
FBP-P5000i Digital Probe, MP-60 USB Power Meter, FiberChekPRO SW, Case, Tips and
Adapters (FBPT-SC, FBPT-LC, FBPT-U25M, FBPT-U12M), Cleaning Materials
FIT-SD113
FBP-P5000i Digital Probe, MP-60 USB Power Meter, FiberChekPRO SW, Case, Tips and
Adapters (FBPT-SC, FBPT-LC, FBPT-U25M, FBPT-U12M)
Optional RF Cables
G710050530
G710050531
G710050532
G710050533
G710050534
G710050535

1.0 m (3.28 ft) RF Cable, DC to 18 GHz, Type-N(m) to Type-N(m), 50 
1.5 m (4.92 ft) RF Cable, DC to 18 GHz, Type-N(m) to Type-N(f), 50 
3.0 m (9.84 ft) RF Cable, DC to 18 GHz, Type-N(m) to Type-N(f), 50 
1.5 m (4.92 ft) RF Cable, DC to 18 GHz, Type-N(m) to SMA(m), 50 
1.5 m (4.92 ft) RF Cable, DC to 18 GHz, Type-N(m) to QMA(m), 50 
1.5 m (4.92 ft) RF Cable, DC to 18 GHz, Type-N(m) to SMB(m), 50 

Appendix

555

JD780A Series Analyzers

Optional Omni Antennas
G700050353
RF Omni Antenna
G700050354
RF Omni Antenna
G700050355
RF Omni Antenna
G700050356
RF Omni Antenna
G700050357
RF Omni Antenna
Optional Yagi Antennas
G700050364
RF Yagi Antenna
G700050365
RF Yagi Antenna
G700050363
RF Yagi Antenna
G700050366
RF Yagi Antenna

Type-N(m), 806 MHz to 896 MHz
Type-N(m), 870 MHz to 960 MHz
Type-N(m), 1.71 GHz to 2.17 GHz
Type-N(m), 720 MHz to 800 MHz
Type-N(m), 2.3 GHz to 2.7 GHz

Type-N(f), 806 MHz to 896 MHz, 10.2 dBd
Type-N(f), 866 MHz to 960 MHz, 10.2 dBd
Type-N(f), 1.75 GHz to 2.39 GHz, 9.8 dBd
SMA(f), 700 MHz to 4 GHz, 1.85 dBd

Optional RF Adapters
G710050570
Adapter Type-N(f) to Type-N(f), DC to 6 GHz, 50 
G710050571
Adapter Type-N(m) to DIN(f), DC to 4 GHz, 50 
G710050572
Adapter DIN(m) to DIN(m), DC to 4 GHz, 50 
G710050573
Adapter Type-N(m) to SMA(f), DC to 18 GHz, 50 
G710050574
Adapter Type-N(m) to BNC(f), DC to 1.5 GHz, 50 
G710050575
Adapter Type-N(f) to Type-N(f), DC to 4 GHz, 50 
G710050576
Adapter Type-N(m) to DIN(m), DC to 4 GHz, 50 
G710050577
Adapter Type-N(f) to DIN(f), DC to 4 GHz, 50 
G710050578
Adapter Type-N(f) to DIN(m), DC to 4 GHz, 50 
G710050579
Adapter DIN(f) to DIN(f), DC to 4 GHz, 50 
Optional E1/T1 Test Cables
G710050317
RJ45 to Y Bantam Cable
G710050318
RJ45 to Y BNC Cable
G710050319
RJ45 to 4 Alligator Clips
StrataSync Subscription
STRATASYNC-AM-CA-SA-1Yr
STRATASYNC-TDM-CA-SA-1Yr

StrataSync Asset Management Annual Subscription
1
StrataSync Test Data Management Annual Subscription
1

Requires STRATASYNC-AM-CA-SA-1Yr

Optional Miscellaneous
G710050581
Attenuator 40 dB, 100 W, DC to 4 GHz (Unidirectional)
JD74050341
Soft Carrying Case
JD71050342
Hard Carrying Case
JD70050342
Hard Carrying Case with wheels
JD70050343
CellAdvisor Backpack Carrying Case
JD70050006
USB Bluetooth Dongle and 5 dBi Dipole Antenna
G710050585
RF Directional Coupler, 700 MHz to 4 GHz, 30 dB, Input/Output;
2
Type-N(m) to Type-N(f), Tap Off; Type-N(f)
2
G710050586
RF Combiner, 700 MHz to 4 GHz, Type-N(f) to Type-N(m)
3
G710050587
4x1 RF Combiner, 700 MHz to 4 GHz, Type-N(f) to Type-N(m)
G710550324
External Battery Charger
JD780A362
JD785A Series User’s Manual – Printed Version
2

Highly recommended for LTE Testing
Highly recommended for LTE Advanced Testing

3
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Appendix J – RoHS information
This appendix describes the RoHS (Restriction of Hazardous Substances) information, which is a mandatory
requirement from China. The RoHS directive consists in the restriction on the use of certain hazardous
substances in electrical or electronic equipment sold or used in the European Union, after July 1, 2006. These
substances are: lead, mercury, cadmium, hexavalent chromium, polybrominated biphenyls, and polybrominated
diphenyl ethers.

Appendix

557

JD780A Series Analyzers

Appendix K – On-screen keyboard
You can use the on-screen keyboard to type in texts, file names, and folder names.

Adding or deleting letters
Procedure

1. Tap keys on the on-screen keyboard. As you type, each letter is displayed in the name field. If
you want to change the letter case between uppercase and lowercase, tap the Caps key.

2. To delete a letter, tap the Back key on the keyboard or press the backspace key on the keypad.
3. To move the cursor along the name field, tap the < or > key, turn the rotary knob, or touch in
between letters in the name field.

4. To delete all the letters displayed in the name field, tap the Clear key on the on-screen keyboard.
Figure 287 On-screen keyboard

Editing or adding a custom keyword
You can edit and delete a keyword or add a new one, as you desire.
Procedure

1. Tap the Edit Keywords bar on the on-screen keyboard.
The edit keywords keyboard appears.

2. To edit a keyword, select the keyword box and then change the letters.
3. To delete a keyword, select the keyword box and then tap the Clear key.
4. To add a keyword, select a blank keyword box and then type in a keyword.
5. Tap the Save key on the keyboard to save and continue saving.
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Figure 288 Edit keywords keyboard

Appending a keyword
You can append a factory-stored or custom-defined keyword, as you want.
Procedure

1. Tap the Append Keywords bar on the on-screen keyboard.
The append keywords window appears.

2. To append a keyword, complete the following steps:

3.

a.

Select the keyword tag button to view available keywords for the tag.

b.

Select one keyword, from the following choices for each keyword tag:
Keyword tag

Keyword (tag value)

Site-ID*

SiteA, SiteB, and SiteC

Sector*

Alpha, Beta, and Gamma

Technology*

GSM900, WCDMA850, and LTE180

Test Type*

RL, VSWR, DTF-RL, DTF-VSWR, and CL

Termination*

Open, Load, and Antenna

Custom

Any keywords you have added

c.

To delete the keyword you have added to the keyword field, tap the Delete button.

d.

To clear the keyword field, tap the Clear button.

Optional. You can edit any of the custom keyword tags or tag values by tapping the Edit Tags
Values or Edit Tags button, but not the factory keyword tags marked with the asterisk (*).
NOTE
You must keep the keywords marked with the asterisk (*) intact as the StrataSync
server uses them when transferring data.

4.
5.

Select the Separator option from the choices: hyphen [-], underscore [_], or None.

6.

Tap the Save and Exit button to save and exit or the Keyboard button to return to the keyboard.

Select the As a filename option between On and Off. If you select Off, the keyword will not be
placed in a file name, but in the trace/PNG file information.
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Figure 289 Append keywords window
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